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1. Introduction

R is a general software and language system for data analysis and graphics1 and
considered a dialect of the S language created by Bell Laboratories, commercialized
as S-PLUS by Insightful2.
General information about R can be found at http://www.r-project.org/

BioConductor3 is a collection
of specialized software packages
that run with the R engine.
Packages can run independently
with R or call on one or more other
packages.
The sum of all the hundreds of
packages dedicated to the analysis
of microarrays collectively loosely
create the “BioConductor” software.

pacakge
1

pacakge
2

R

“BioConductor is an open source […] software project for the analysis and
comprehension of genomic data […] primarily based on the R programming
language.” 4

2. Installation for R
Since BioConductor runs within R, the first thing to do is to download and install R
before anything else can be installed. R can be downloaded from “The
Comprehensive R Archive Network” or CRAN at http://cran.r-project.org/
Frequently asked questions (FAQ) both about R for all platforms and also about
Macintosh and Windows are accessible at http://cran.rproject.org/faqs.html

2.1 R versions

1

Ihaka R. & Gentleman R. 1996. R: a language for data analysis and graphics. Journal of Computational
and Graphical Statistics 5:299-314
2
See http://www.insightful.com/products/splus/
3
Gentleman R.C. et al. Bioconductor: Open software development for computational biology and
bioinformatics. Genome Biology 2004, 5:R80 doi:10.1186/gb-2004-5-10-r80
4
See http://www.bioconductor.org
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R is updated every 6 months and that is an important fact to remember. Updates and
changes are invariably introduced and older code and scripts can fail when run in an
updated version of R.
To each R version corresponds a Bioconductor version with updates. They are usually
only compatible with each other.
The steps to install R and Bioconductor remain relatively stable, and while some of the
images below are for some specific versions, it is nevertheless an appropriate
illustration to newer installations.

2.2 Download install file(s)
A lot of information is given to “getting and unpacking source” and “build from
source.” These options are reserved for veteran programmers. Most users will need
to install files called “precompiled binaries” or simply “binaries” which are “readymade” for the operating system of choice.
Step 1: go to the CRAN web site http://cran.r-project.org/
Step 2: most likely one of the options given at the top of the page will be the correct
one
Step 3: decide for which platform you want to install R

2.3 Installation for Linux
Selecting the “Linux” link will bring the next page, where the Linux version has to be
selected.
The current options are for the
Debian, RedHat, SUSE and
Ubuntu flavors.
If you are running a Linux system it
means that you know which
version you are running, or you
have a close relationship with your
IT administrator which should be
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Choosing the 32 or 64 bit version will depend on the Linux OS you are running.
Use the back button from the browser to go back to the previous page if you were just
exploring.

2.4 Installation on Mac OS X
Note: If you have an older version of R that you would like to
preserve, go now to the Applications directory and change the
name from R (or R.app) to another name, e.g. R.2.9.app
(.app is shown as an option, normally this filename extension is
hidden)
To install on a Mac OS X system go to http://cran.r-project.org/ and click on
“MacOS X”
Macintosh files are commonly archived as files ending with .dmg (disk image.) To
install the current version choose file R-2.11.1.pkg The file is downloaded in the
browser default area (e.g. “downloads” for Safari). The installer will start automatically.

Click “Continue” at each step after reviewing question(s).
You will need to know the administrator password for your computer if there is one.
When installation is finished a screen “Install Succeeded” will appear.
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R is installed in the Applications directory.
It will appear as R or R.app depending on
your viewing options and also as R64.app
However a larger portion of R, namely the libraries and sample data will be located
within the Library directory in the directory called “Framework”. For example, the “affy”
module will be stored in the following path:
/Library/Frameworks/R.framework/Versions/2.7/Resources/library/affy

but multiple versions can coexist:
/Library/Frameworks/R.framework/Versions/2.9/Resources/library/affy

Note that when installing a new version of R the older modules are kept independently
within the Versions directory (see path above.)
Note: Quartz is the native graphical output based on the Mac OS and is similar to PDF
for its renderings, including anti-aliasing (see:
http://en.wikipedia.org/wiki/Quartz_2D)
Note: the description of the archive specifies: “This image also contains Tcl/Tk libraries
(for X11).” These libraries are important for graphical output.
WARNING, IMPORTANT Note: X11 is a method for displaying and
manipulating windows and graphical output. X11 is standard on all
Unix and Linux systems. Mac OS X is based on Unix but uses the
“Aqua” windowing/graphics environment based on “Quartz”. For
newer Macs, starting with Leopard (10.5) X11 is pre-installed.
For Tiger (10.4) you may need to insert the install DVD to install
X11.

2.5 Installation on Windows
Click on “Windows” in http://cran.r-project.org/ to install on a Windows
system.
Click on “base” in the next page as the “contrib" directory contains specialized
packages.
It is possible to go there directly with the following address (which will not show the left
side panel menus): http://cran.r-project.org/bin/windows/base/
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R is in constant development and many
alpha or beta version releases may be
available. It is advised to install only
stable versions. Stable versions are not
“snapshot build” and not “test builds”.
As of this writing the current version is
R2.11.1
To download this version click on
Download R 2.11.1 for Windows
If you are asked click Save File:

This will download a file with a
similar icon shown at right.

Note: the latest version is always under the link:
http://cran.r-project.org/bin/windows/base/release.htm
where cran.r-project.org can be replaced by any CRAN mirror listed at
http://cran.r-project.org/mirrors.html
Installing R : 1- double-click on the .exe file that was just
downloaded,

2- Security warning might
come up.
Review and answer Run.

3- Select language.
Default is English.
Click OK.

Page - 8 -

4- A “Wizard” installer is
initiated.
Click Next.
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5- Acknowledge the licensing
agreement. Click Next

8- Default is “No (accept
defaults)”. If you prefer R
windows to be independent
select Yes and in the next
panel select SDI. Click Next

6- Program location. Default is
C:\Program Files\R\R2.9.0. Note: directory R can
contain multiple versions e.g.
2.7 and 2.8. Click Next

7- Not all is selected by
default. Custom
installation is available.
For example install the
PDF help pages.
Click Next

9- Name of program
shortcut.

10- Select all additional
options.

Change name to R2.9.0.
Click Next

Click Next

Files are installed in the system:
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11-When files have installed, the
final Wizard window appears. Click
Finish

12- A new shortcut
icon will be
created on the
desktop.

13- right-click on the shortcut icon to see its
properties.

You can ask R to use more than
the default by following these
instructions: (to see this panel
right-click on the short-cut
icon.)
The Target is the original
software, named here Rgui.exe.
In windows the default is to run R
within a GUI (graphical user
interface) to easily accommodate
some set-up and data
manipulations.
To have R use 2 Gb of the RAM,
add the following line after the
target name:
--max-mem-size=2Gb
or --max-mem-size=2000M
(note the double dash -- at the
beginning.)
Start in: this is the default
working directory. R will look for
DATA files here. By default it will
be in “My Documents”.
You can change the start
directory by specifying the correct
path of another directory.
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3. Installing BioConductor
Details for installing BioConductor can be found at the following URL:
http://www.bioconductor.org/docs/install-howto.html
The first requirement is that R should already be installed. This was accomplished in
the previous section.
Note: for every release of R there is a corresponding release of BioConductor. For
example, BioConductor 2.4 is the version necessary for R 2.9.x.
BioConductor is a cohort of modules named packages. Each package can be
independent or depend on other packages. There are more modules created or
updated on a regular basis so it is virtually impossible to install the “ultimate”
BioConductor on any given system.
The site offers a Lite (biocLite) and larger (getBioC) version of BioConductor that is
no longer documented. The Lite version is a subset of the other. In both cases it is
then possible to add additional modules.
The site uses biocLite as the default example.
Steps to install BioConductor:
Start R (double click on R icon (Mac/Windows), or type R in X11 terminal in
Linux/Unix)
To install BioConductor type the following commands at the R> prompt:
source("http://www.bioconductor.org/biocLite.R")
biocLite()
this will require a little time to complete as each package is downloaded from the
web, unarchived and installed.
Example of a running session:
> source("http://bioconductor.org/biocLite.R")
> biocLite()
Running biocinstall version 2.4.10 with R version 2.9.0
Your version of R requires version 2.4 of Bioconductor.
Will install the following packages:
[1] "affy"
"affydata"
"affyPLM"
"annaffy"
"annotate"
[6] "Biobase"
"biomaRt"
"Biostrings"
"DynDoc"
[11] "genefilter"
"geneplotter" "hgu95av2.db" "limma"
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[16] "multtest"
Please wait...

"vsn"

"xtable"

"affyQCReport"

also installing the dependencies ‘DBI’, ‘RSQLite’, ‘affyio’,
‘preprocessCore’, ‘GO.db’, ‘KEGG.db’, ‘AnnotationDbi’, ‘XML’, ‘RCurl’,
‘IRanges’, ‘RColorBrewer’, ‘simpleaffy’
[................]
package 'xtable' successfully unpacked and MD5 sums checked
package 'affyQCReport' successfully unpacked and MD5 sums checked
The downloaded packages are in
C:\Documents and Settings\Administrator\Local
Settings\Temp\RtmpruLvjY\downloaded_packages
updating HTML package descriptions
>

3.1 Installing and updating BioConductor packages
Addition and maintenance of modules will eventually be necessary. Additionally, R is
updated on a regular basis (every 6 months), and new versions become available. The
best option is usually to re-install all the BioConductor packages for the new R
version, as R can exist as multiple versions within the computer system.
3.1.1 Line command
Adding packages can be accomplished by line-command or by graphical interface
depending on the computer system. Line-commands always work regardless of the
computer environment and is rather simple as detailed on
http://www.bioconductor.org/docs/install-howto.html
The “source” command specifies the address of a web site.
If there are additional BioConductor or CRAN packages which you would like to install,
use biocLite [or getBioC] to install them like so:
biocLite(c("pkg1", "pkg2"))
Where "pkg1" and "pkg2" are the names of the packages you would like to install.
Similarly the command could be written getBioC(c("pkg1", "pkg2"))
3.1.2 GUI, Macintosh
The menu “Packages & Data” can be used to inspect the
current installation status and can be used to update or install
packages.
R also has a series of sample data which can be inspected
with the Data Manager menu.
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3.1.2.1

Package Manager

Follow this menu cascade:
Packages & Data > Package
Manager to open the Package
Manager.
The top panel lists packages that
are installed on this system.
When R is used, packages are
loaded as needed. Therefore the
manager also indicates which
packages are currently in use.
Clicking on the name of any
package (loaded or not) will
populate the bottom panel with a
web-like interface giving information
about all the functions and
commands for this package.
Clicking on any blue-underlined
entry will show the information for
this or that command.
We’ll see later for other ways to get
help and access the same
information for specific commands.
3.1.2.2

Package Installer

Packages can also be installed with the GUI interface. With the line command, it is
necessary to know the exact name of the package. The the GUI interface the packages
can be chosen from an extensive list.
Follow this menu cascade:
Packages & Data > Package Installer to open the
Package Installer.
Within the top left of the new window CRAN is for general
R packages. Select “BioConductor (binaries)” as the
source for the lising. Press Get List if the window
remains blank.
Page - 13 -
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A long list of all available packages is presented within the list panel, with columns
specifying which are installed and at which version, while another column displays
the current version. For example, in the image above, the package “plgem” is at
version 1.0.0 but the current version is at 1.6.0.
To update or install a new package, use the mouse to highlight the package(s) you
wish to install and press the button “Install Selected.”
Note: Since some packages may depend on resources in other packages, there may
be cases where some packages cannot be upgraded individually.
3.1.2.3

Data Manager

Follow this menu cascade:
Packages & Data > Data Manager
to open the Data Manager.
The Data manager is a 2 panel
window similar to the Package
Manager. The top window displays a
list of available sample sets the
bottom window provides a hypertext
description of any sample that is
clicked on.
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Sample data are sometimes useful to try commands presented during help.
3.1.3 GUI, Windows
3.1.3.1

Packages Menu

On Windows, packages can be installed and
updated from the Packages menu which has a
different menu and interface than the
Macintosh version.

3.1.3.2

Load Packages

The first menu “Load packages” can be used to load a package that has previously
been installed. However, we shall see later a line command that is more often used that
has the same function.
3.1.3.3

Set CRAN mirror

The menu “Set CRAN mirror…” is used to select the (international) source of the
downloaded package. It is recommended to select a source geographically close. For
example in Wisconsin we could choose IL, MI or MO.
Select a suitable source, for example USA(IL)
and press OK.
This menu is equivalent to the R command
chooseCRANmirror()
(we shall see later why the parenthesis are
necessary.)
Note: we saw previously that CRAN = The
Comprehensive R Archive Network.
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3.1.3.4

Select repositories

The next menu “Select repositories…” is
used to add BioConductor as an
additional source to CRAN.
Make sure that at least BioConductor is
highlighted and press OK

or

This menu is equivalent to the R command setRepositories()
Note: if you press
Cancel, the R console
will still require an
answer, in that case
select option 3.

3.1.3.5

> setRepositories()
--- Please select repositories for use in this session --1: + CRAN
2: + CRAN (extras)
3: + Bioconductor
4:
Omegahat
Enter one or more numbers separated by spaces
1: 3

Install packages

The menu “Install package(s)…” is used to
install specific packages from a list which is
called upon by the menu.
To select more than one package, hold the
Ctrl key on the keyboard while clicking.
This menu is equivalent to the R command
utils:::menuInstallPkgs()
The length and contents of the list depends
on the chcoices that were made with the
menu “Select repositories” above.
If only BioConductor was chosen, the list will
contain only those packages that are
relevant to BioConductor.
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3.1.3.6

Update packages

The menu “Update packages…” will bring a
window listing the packages that can be updated.
Press OK to proceed with the update.
This is equivalent to R command:
update.packages(ask='graphics')

3.1.3.7

Update packages‐ local zip files

The menu “Install package(s) from local zip files…” is used for manually installing a
package that is not yet part of bioconductor. Such zip file archive will first be
downloaded or provided by the author of the package.

4. General R Help and Resources
4.1 Online help
R contains a large amount of general help in addition to help available for each
individual command or package.
4.1.1 manuals
The manuals can be found online at http://cran.rproject.org/doc/manuals/
All entries are available in PDF or HTML format.
Noteworthy is “R-intro” (PDF is 93 USLetter pages), a document also available as a
156 pages paperback book (Publisher: Network Theory. (May 2002) ISBN:
0954161742)
The full language reference is a 13 Mb doument. However individual entries are
available with the help command within R as shown further below.
4.1.2 Contributed manuals
Other, contributed documentation: http://cran.rproject.org/doc/contrib/
Some of these help files are in multiple languages. Noteworthy is the R tutorial “R for
beginners” by Emmanuel Paradis available in English (Paradisrdebuts_en.pdf) or French (Paradis-rdebuts_fr.pdf), “simpleR – Using R
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for Introductory Statistics” by John Verzani (Verzani-SimpleR.pdf, note: print
with Page Set-up at 90% to avoid cutting the bottom of pages!), “Using R for Data
Analysis and Graphics, Introduction, Code and Commentary” by J H Maindonald
(usingR.pdf and/or
usingR-2.pdf)
These resources are general “R” resources best suited for statistics, and not
BioConductor resources. Bioconductor resources will be discussed later.

4.2 General R Help in Windows
The Windows GUI interface provides
access to general help and R
manuals from the menu “Help.”
The Manuals (in PDF) are the same
entries discussed for the online help
above

4.3 General R Help in Macintosh

----------------------------------------------------------The menu cascade Help > R Help brings up
the hypertext window illustrated here.
All entries are in hypertext form. For
printable PDF version, refer to the Online
help section above.
Within the “Manuals” section “An Introduction to R” is the book referenced above in the
Online help section, here presented in hypertext form.
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The “Reference” section contains information about the currently installed packages
under the link “Packages.”

5. Help for BioConductor
BioConductor is not a simple software. Rather it is a collection of packages that can be
installed individually or as groups. Some packages can depend on other packages
being present.
The complete list of BioConductor packages can be seen on the BioConductor web site
at http://www.bioconductor.org/packages/release/Software.html
or within the Windows or Macintosh GUI environments as detailed above.
Help for BioConductor packages is
built in the packages and typically
called “Vignettes.”
For example, here is the online
package information for the “affy”
package showing 5 vignettes
associated with this package.

Windows and Mac GUIs also provide access to the package vignettes with the following
menus:

(windows)

(Macintosh)
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In Windows, the chosen
vignette will open with the
default PDF reader
(typically Acrobat reader;
not shown.)

On Macintosh the GUI
opens a 2 panels window
listing all the available
vignettes on the bottom
panel as illustrated here.
The top panel shows the
(PDF) vignette when a
selection is made on the
bottom panel.

6. Starting R
R is mostly a line-command language in spite of the GUI interface, and all commands
can be given as line commands. Indeed R can be started from the line command within
the appropriate text terminal, with the command R (or r) within an X11 text terminal
(Linux/Mac OS X) or within a DOS cmd window with the command R.exe in Windows.
However the most useful method is as follows:
Double-click on the R icon to start an R
session

Windows:

Macintosh:

The Graphical User Interface (GUI) is illustrated below for Windows and Macintosh.

6.1 Windows GUI
6.1.1 Windows GUI and Console
R will open with a standard Windows window containing all the R GUI as a selfcontained window. Some versions have short-cut icons explained below.
The > prompt will later be used for entering line commands.
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The menu items are part of the GUI. The various icons have the following meaning:
Open script

Load image

Save image

Copy

Paste

Copy and
paste

Stop current
computation

Print

The user will decide the usefulness of each of these short-cut icons.
6.1.2 Windows GUI for graphics
When a graphical output exists, the mini-icons will be the
following:
with the following meanings:
The
image
part

In addition, the displayed graphic can be saved from the new menu, or by right-clicking
on the plot to be saved:
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Use menu to save plot image

Right-click on plot to be
saved

6.2 Macintosh GUI
R will open with a standard text console within the GUI, and an R menu will appear on
the top window as illustrated below. The > prompt will later be used for entering line
commands.

The top portion of the window together with the Apple menus make up the GUI. The
various icons have the following meaning:
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Authorize R to run system
commands as root
Create a new, empty document in
the editor
Quit R

(opens print window)

The user will decide how useful all these little icons are. In class we might use the
Show/Hide R history but most likely none of these will be used.

7. END of INSTALLATION SESSION
-------------------------

---------------------------
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Within the text, user input is shown as bold text or commands
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This section is based on Emmanuel Paradis’s “R for beginners” which can be
downloaded from http://cran.r-project.org/doc/contrib/Paradisrdebuts_en.pdf (English, 72 pages) or Paradis-rdebuts_fr.pdf (French, 77
pages).
Therefore the following Copyright notice applies:
© 2002, 2005, Emmanuel Paradis (12th September 2005)
Permission is granted to make and distribute copies, either in part or in full and in any
language, of this document on any support provided the above copyright notice is
included in all copies. Permission is granted to translate this document, either in part or
in full, in any language provided the above copyright notice is included.
Additional material is © Jean-Yves Sgro (2007- 2010) and subject to permissions
identical to those above.
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1. Preamble
The origin, download and installation of R was covered in the previous section.
The R language allows the user, for instance, to program loops to successively analyze
several data sets. It is also possible to combine, in a single program different statistical
functions to perform more complex analyses.
At first, R could seem too complex for a non-specialist. This may not be true actually. In
fact, a prominent feature of R is its flexibility. Whereas a classical software displays
immediately the results of an analysis, R stores these results in an “object”, so that an
analysis can be done with no result displayed.

2. A few concepts before starting
Once R is installed on your computer, the software is executed by launching the corresponding executable. The prompt “>” indicates that R is waiting for your command. In the
previous section we saw some of the commands that can be executed with pull-down
menu or icons (Mac and Windows). At this stage, a new user is likely to wonder “What
do I do now?” It is indeed very useful to have a few ideas on how R works when it is
used for the first time, and this is what we will see now. We shall see first briefly how R
works. Then, I will describe the “assign” operator that allows creating objects, how to
manage objects in memory, and finally how to use the on-line help which is very useful
when running R.

2.1 How R works
When R is running, variables, data, functions, results, etc, are stored in the active
memory (RAM) of the computer in the form of objects that have a name. The user can
perform actions on these objects with operators (arithmetic, logical, comparison, . . .)
and functions (which are themselves objects). The use of operators is relatively intuitive.
We will see the details later. An R function may be sketched as follows:
The arguments can be objects (“data”,
formulae, expressions, . . .), some of
which could be defined by default in the
function; these default values may be
modified by the user by specifying
options.
All the actions of R are done on objects stored in the active memory of the
computer: no temporary files are used (Figure 1). The readings and writings of files are
used for input and output of data and results (text tables, graphics, . . .). The user
executes the functions with commands. The results are displayed directly on the screen,
stored in an object, or written on the disk (particularly for graphics). Since the results are
themselves objects, they can be considered as data and further analyzed as such. Data
files can be read from the local disk or from a remote server through Internet.
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Figure 1: A schematic view of how R works
In the previous section we learned how to install R and about packages that are specific
to analyzing DNA chip data. R functions are all stored in packages within a library
localized on the user’s hard drive called R_HOME/library (where R_HOME is the
directory where R is installed on Windows, typically C:\Program Files\R\R-2.9.0.
; on Macintosh:
/Library/Frameworks/R.framework/Versions/2.9/Resources/library/)
This directory contains packages of functions, which are themselves structured in
directories. The package base is in a way the core of R and contains the basic
functions of the language, particularly, for reading and manipulating data. Each package
has a directory called R with a file named like the package (for instance, for the package
base, this is the file R_HOME/library/base/R/base). This file contains all the
functions of the package.

2.2 Simplest, implicit command
One of the simplest commands is to type the name of an object to display its content.
For instance, if an object n contents the value 15:
> n
[1] 15
The digit 1 within brackets indicates that the display starts at the first element of n. This
command is an implicit use of the function print() and the above example is similar to
print(n).

The name of an object must start with a letter
(A–Z and a–z) but can include letters, digits (0–9), dots (.), and
underscores ( ). R discriminates between uppercase letters and
lowercase ones in the names of the objects, so that x and X can
name two distinct objects (even under Windows).
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2.3 The “assign” operator (= or <‐) : creating, listing and deleting the object
in memory
An object can be created with the “assign” operator which is written as an arrow created
with a minus sign and a less-than or greater than symbol (<- or ->); this symbol can be
oriented left-to-right or the reverse:. In most cases the equal sign (=) can also be used:
(Note: user’s input is in bold letters)
> n
> n
[1]
> 5
> n
[1]
> x
> X
> x
[1]
> X
[1]

<- 15
15
-> n
5
= 1
= 10
1
10

If the object already exists, its previous value is erased (the modification affects only the
objects in the active memory, not the data on the disk). The value assigned this way
may be the result of an operation and/or a function:
> n <- 10 + 2
> n
[1] 12

Note that you can simply type an expression without assigning its value to an object, the
result is thus displayed on the screen but is not stored in memory:
> (10 + 2) * 5
[1] 60
R can therefore be used as a calculator:
> 2 + 2
[1] 4
> sqrt(10)
[1] 3.162278
> 2*3*4
[1] 24
> 3^2
[1] 9
> 2^16
[1] 65536
> exp(1)
[1] 2.718282
# value of “e”
> log(10)
# natural log
[1] 2.302585
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> log10(1000)
# log base 10
[1] 3
> pi
[1] 3.141593
> sin(30*pi/180) # convert angles to radians and then sinus
function
[1] 0.5
> n <- 15
> 4*n
[1] 60
Note: In R, in order to be executed, a function always needs to be written with
parentheses, even if there is nothing within them (e.g., ls()). If one just types the
name of a function without parentheses, R will display the content of the function.
The semi-colon (;) can be used to separate distinct commands on the same line:
> name <- "Carmen"; n1 <- 10; n2 <- 100; m <- 0.5
The function ls()simply lists the R objects currently in memory: only the names of the
objects are displayed:
> ls()
[1] "m" "n1" "n2" "name"
(Note: if you typed n <- 15 in the above section, there will also be “n” listed here)
If there are a large number of objects in memory, it may be useful to list only those of
interest, for example those containing the letter “m” within their name. In a Windows
DOS command that could be done with C> DIR *m* while in Unix it could be done with
% ls *m*. Within R the search pattern (option pattern is abbreviated pat) is placed
within the parentheses and there is no need for the wild card (*):
> ls(pat = "m")
[1] "m" "name"
To restrict the search to objects that start with the letter m (regular expression):
> ls(pat = "^m")
[1] "m"
To delete objects in memory, we use the function rm: rm(x) deletes the
object x, rm(x,y) deletes both the objects x and y, rm(list=ls()) deletes all
the objects in memory; the same options mentioned for the function ls() can
then be used to delete selectively some objects: rm(list=ls(pat="^m")).

2.4 Online help
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Help pages are accessed with the simple command ? or help(). For example the
following two commands have the same effect:
> ?ls
> help(ls)
The help page may appear within the R console or within a separate window depending
on the version and operating system.
Note that the functions usually have a series of optional parameters that have a default.
For example the function ls() has the following definition of which we already know
“pattern”
ls(name, pos = -1, envir = as.environment(pos),all.names = FALSE,
pattern)

For functions that contain special characters, it is necessary to use quotes:
> ?”*”
> help(“*”)

3. Data with R
3.1

Objects

R works with objects, which are characterized by their name and content. Objects have
also an attribute that specifies which kind of data is represented by an object. All objects
have two intrinsic attributes: mode and length. The mode is the basic type of the
elements contained within the object; there are four main modes: numeric, character,
complex and logical (FALSE or TRUE). The length is the number of elements of the
object. The functions mode() and length() are used to display the mode and length
of an object.
Example: (user’s input in bold character)
> x <- 1
> mode(x)
[1] "numeric"
> length(x)
[1] 1
> A <- "bacteria"; compar <- TRUE; z <- 1i
> mode(A); mode(compar); mode(z)
[1] "character"
[1] "logical"
[1] "complex"
- Whatever the mode, missing data are represented with NA (not available).
- Values that are not numbers are represented with NaN (not a number).
- Infinity is represented with Inf and –Inf.
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A value of mode character is input with single or double quotes. The echo is always double
quotes.

> A <- "bacteria"
> B <- ‘E.coli’
> A; B
[1] "bacteria"
[1] "E. coli"
The backslash can be used to “escape” a special character. The two characters
altogether \" will be treated in a specific way by some functions such as cat for display
on screen:
> x <- "Double quotes \" delimitate R’s strings."
> x
[1] "Double quotes \" delimitate R’s strings."
> cat(x)
Double quotes " delimitate R’s strings.
The following table gives an overview of the type of objects representing data.

A vector is a variable in the commonly admitted meaning.
A factor is a categorical variable.
An array is a table with k dimensions, a matrix being a particular case of array with k =
2. Note that the elements of an array or of a matrix are all of the same mode.
A data frame is a table composed with one or several vectors and/or factors all of the
same length but possibly of different modes.
A ‘ts’ is a time series data set and so contains additional attributes such as frequency
and dates.
Finally, a list can contain any type of object, included lists!
For a vector, its mode and length are sufficient to describe the data. For other objects,
other information is necessary and it is given by non-intrinsic attributes. Among these
attributes, we can cite dim which corresponds to the dimensions of an object. For
example, a matrix with 2 lines and 2 columns has for dim the pair of values [2, 2], but its
length is 4.
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3.2

Reading data in a file

For reading and writing in files, R uses the working directory. To find this directory, the
command getwd() (get working directory) can be used, and the working directory can
be changed with setwd("C:/data") or setwd("/home/- paradis/R"). It is
necessary to give the path to a file if it is not in the working directory.
On the Windows and Mac system the working directory can be changed with one of the
pull-down menu:

then
Windows

Macintosh

The following R functions can read data stored in plain text format (ASCII):
read.table() (there are several variants, shown below), scan and read.fwf()
(read fixed width format). These functions are part of the R base package. Other
packages offer functions to read files from Excel or other statistical packages and only
useful for more advanced R sessions (not shown here.)
The function read.table() creates a data frame (see definition above) when the file
is read.
For instance, if one has a file named data.dat, the command:
> mydata <- read.table("data.dat")
will create a data frame named mydata, and each variable will be named, by default,
V1, V2, . . . and can be accessed individually by mydata$V1, mydata$V2, . . . , or by
mydata["V1"], mydata["V2"], . . . , or, still another solution, by mydata[, 1],
mydata[,2 ], . . . However, there is a difference: mydata$V1 and mydata[, 1] are
vectors whereas mydata["V1"] is a data frame. We shall see later how to manipulate
objects.
There are several options whose default values (i.e. those used by R if they are omitted
by the user) are detailed in the following table:
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read.table(file, header = FALSE, sep = "", quote = "\"'",
dec = ".", row.names, col.names,
as.is = !stringsAsFactors,
na.strings = "NA", colClasses = NA, nrows = -1,
skip = 0, check.names = TRUE, fill = !blank.lines.skip,
strip.white = FALSE, blank.lines.skip = TRUE,
comment.char = "#", allowEscapes = FALSE, flush = FALSE,
stringsAsFactors = default.stringsAsFactors())
file
header
sep
quote
dec
row.names
col.names
nrows
skip
fill

the name of the file to be opened (within quotes””). \ symbol is not allowed even under
Windows and must be replaced by /
a logical (FALSE or TRUE) indicating if the file contains the name of the variables on its
first line.
field separator used in the file. For instance, TAB-delimited tabulation: sep = “\t”
the character used to cite the variables of mode character
the character used for decimal point
a vector or row names. If row.names is missing, the rows are numbered.
Using row.names = NULL forces row numbering.
a vector with the names of the variables (by default V1, V2, V3 …)
the maximum number of rows to read in. Negative values are ignored.
the number of lines of the data file to skip before beginning to read data.
Logical. If TRUE then in case the rows have unequal length, blank fields are implicitly
added.

The complete description of all the parameters are in the help file:
> help(read.table)
The read.table variants differ in the default values of some of the parameters:
Comma delimited text:
read.csv(file, header = TRUE, sep = ",", quote="\"", dec=".",
fill = TRUE, comment.char="", ...)
read.csv2(file, header = TRUE, sep = ";", quote="\"", dec=",",
fill = TRUE, comment.char="", ...)

Tab delimited text:
read.delim(file, header = TRUE, sep = "\t", quote="\"", dec=".",
fill = TRUE, comment.char="", ...)
read.delim2(file, header = TRUE, sep = "\t", quote="\"", dec=",",
fill = TRUE, comment.char="", ...)

3.3

Saving data in a file

The function write.table writes in a file an object, typically a data frame but this
could well be another kind of object (vector, matrix, . . .). The arguments and options
are:
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write.table(x, file = "", append = FALSE, quote = TRUE, sep = " ",
eol = "\n", na = "NA", dec = ".", row.names = TRUE,
col.names = TRUE, qmethod = c("escape", "double"))
x
file
append
quote

sep
eol
na
dec
row.names
col.names
qmethod

the name of the object to be written.
the name of the file. "" indicates output to the console.
if TRUE adds the data without erasing those possibly existing in the file.
a logical or a numeric vector: if TRUE the variables of mode character and the factors are
written within "", otherwise the numeric vector indicates the numbers of the variables to
write within "" (in both cases the names of the variables are written within "" but not if quote
= FALSE)
the field separator used in the file.
(end of line) the character to be used at the end of each line ("\n" is a carriage-return).
the string (word) to use for missing values in the data.
character to use for decimal point.
a logical indicating whether the names of the lines are written in the file.
same, for the names of columns.
specifies, if quote=TRUE, how double quotes " included in variables of mode character are
treated: if "escape" (or "e", the default) each " is replaced by \", if "d" each " is replaced by
""

To write in a simpler way an object in a file, the command write(x,
file="data.txt") can be used, where x is the name of the object (which can be a
vector, a matrix, or an array). There are two options: nc (or ncol) which defines the
number of columns in the file (by default nc=1 if x is of mode character, nc=5 for the
other modes), and append (a logical) to add the data without deleting those possibly
already in the file (TRUE) or deleting them if the file already exists (FALSE, the default).
To record a group of objects of any type, we can use the command save(x, y, z,
file= "xyz.RData"). To ease the transfert of data between different machines, the
option ascii = TRUE can be used. The data (which are now called a workspace in R’s
jargon) can be loaded later in memory with load("xyz.RData"). The function
save.image() is a short-cut for save(list =ls(all=TRUE), file=".RData").

3.4

Generating data
3.4.1

Regular sequences

> x <- 1:30
will generate an object with 30 elements:
> x
[1] 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15
[16] 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30
>
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The operator “:” has priority over the arithmetic operators
> 1:10-1
[1] 0 1 2 3 4 5 6 7 8 9
> (1:10)-1
[1] 0 1 2 3 4 5 6 7 8 9
> 1:(10-1)
[1] 1 2 3 4 5 6 7 8 9
> 1:10-0.1
[1] 0.9 1.9 2.9 3.9 4.9 5.9 6.9 7.9 8.9 9.9

The function seq() can also generate real numbers series:
> seq(1, 5, 0.4)
[1] 1.0 1.4 1.8 2.2 2.6 3.0 3.4 3.8 4.2 4.6 5.0
or alternatively:
> seq(length=11, from=1, to=5)
[1] 1.0 1.4 1.8 2.2 2.6 3.0 3.4 3.8 4.2 4.6 5.0
where the first number indicates the beginning of the sequence, the second one the
end, and the third one the increment to be used to generate the sequence.
One can also type the values directly with the combine function c():
> c(1.0, 1.4, 1.8, 2.2, 2.6, 3.0, 3.4, 3.8, 4.2, 4.6, 5.0)
[1] 1.0 1.4 1.8 2.2 2.6 3.0 3.4 3.8 4.2 4.6 5.0
Note: the c() function is used very often the type explicit data within the input of
other functions. This is a generic function which combines its arguments. The
default method combines its arguments to form a vector.
It is also possible, if one wants to enter some data on the keyboard, to use the function
scan() with simply the default options:
> z <- scan()
1: 1.0 1.4 1.8 2.2 2.6 3.0 3.4 3.8 4.2 4.6 5.0
12: <return>
Read 11 items
> z
[1] 1.0 1.4 1.8 2.2 2.6 3.0 3.4 3.8 4.2 4.6 5.0
The function rep() creates a vector with all its elements identical:
> rep(1, 20)
[1] 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
The function sequence creates a series of sequences of integers each ending by the
numbers given as arguments (underline added for clarity)
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> sequence(2:5)
[1] 1 2 1 2 3 1 2 3 4 1 2 3 4 5
> sequence(c(2,5))
[1] 1 2 1 2 3 4 5
The function gl (generate levels) is very useful because it generates regular series of
factors. The usage of this fonction is gl(k, n) where k is the number of levels (or
classes), and n is the number of replications in each level. Two options may be used:
length to specify the number of data produced, and labels to specify the names of
the levels of the factor. Examples:
> gl(3, 5)
[1] 1 1 1 1 1 2 2 2 2 2 3 3 3 3 3
Levels: 1 2 3
> gl(3, 5, length=30)
[1] 1 1 1 1 1 2 2 2 2 2 3 3 3 3 3 1 1 1 1 1 2 2 2 2 2 3 3 3 3 3
Levels: 1 2 3
> gl(2, 6, label=c("Male", "Female"))
[1] Male Male Male Male Male Male
[7] Female Female Female Female Female Female
Levels: Male Female
> gl(2,
[1] 1 1
Levels:
> gl(2,
[1] 1 2
Levels:
> gl(2,
[1] 1 1
Levels:

10)
1 1 1 1 1 1 1 1 2 2 2 2 2 2 2 2 2 2
1 2
1, length=20)
1 2 1 2 1 2 1 2 1 2 1 2 1 2 1 2 1 2
1 2
2, length=20)
2 2 1 1 2 2 1 1 2 2 1 1 2 2 1 1 2 2
1 2

Finally, expand.grid() creates a data frame with all possible combinations of vectors
or factors given as arguments: (Note the extensive use of the c() function for each
argument!)
> expand.grid(h=c(60,80), w=c(100, 300), sex=c("Male",
"Female"))
h w sex
1 60 100 Male
2 80 100 Male
3 60 300 Male
4 80 300 Male
5 60 100 Female
6 80 100 Female
7 60 300 Female
8 80 300 Female
> expand.grid(myX=c(1,2), myY=c(10, 20), Case=c("A", "B", "C"))
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1
2
3
4
5
6
7
8
9
10
11
12

myX myY Case
1 10
A
2 10
A
1 20
A
2 20
A
1 10
B
2 10
B
1 20
B
2 20
B
1 10
C
2 10
C
1 20
C
2 20
C

Note: the number of combination is the multiplication of the number of arguments, here
2 x 2 x 3 = 12 cases.
3.4.2

Random sequences

Most of the statistical functions are available within R such as Gaussian (Normal),
Poisson, Student t test etc.
Example for the Gaussian function:

> help(dnorm)
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dnorm

pnorm

qnorm

rnorm

The normal function is abbreviated “norm” with one of the added prefix: d, p, q or r
meaning density, distribution, quantile and random respectively: dnorm, pnorm,
qnorm and rnorm.
To generate random numbers, the function rnorm() can be used. The number of
desired random numbers is given as argument. Since these are random, the answers
are never the same:
> rnorm(1)
[1] 0.01160411
> rnorm(1)
[1] 0.1730448
> rnorm(2)
[1] 0.83653193 -0.06752702
> rnorm(2)
[1] 0.4218784 -0.7225086
> rnorm(2)
[1] 0.7537601 1.2409371

Note that with rnorm() the
values are different each time!
The number in parentheses
indicates how many random
numbers we want to generate.

calculate 10 random numbers using variable x:
> x <- 1:10
> x
[1] 1 2 3 4 5 6 7 8 9 10
> rnorm(x)
[1] -0.93522503 -1.02403529 -0.28424994 -0.38654353
[6] -1.16811404 1.94047238 -0.40547335 -0.46233971

3.5

0.19821089
0.07283259

Manipulating objects

Section 3.5 of the Emmanuel Paradis’s “R for Beginners” (pages18 – 35) is 18 pages long and
the reader is encouraged to review these pages (reminder download from:
http://cran.r-project.org/doc/contrib/Paradis-rdebuts_en.pdf)

Methods for accessing objects values by indexing will be reviewed here.
Accessing and changing the value within a simple number vector:
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> x <- 0:5
> x
[1] 0 1 2 3 4 5
> x[3]
[1] 2
> x[3] <- 100
> x
[1]
0
1 100

3

4

First create a vector named x
containing numbers from zero to 5.
There are therefore six values within
x.
x[3] displays the 3rd value of x.
The 3rd value is reassigned a new
value (here 100)
The new values of x are displayed

5

If x is a matrix or a data frame, the value of the i th line and j th column is accessed with
x[i, j]. To access all values of a given row or column, one has simply to omit the
appropriate index (without forgetting the comma!):
> x <- matrix(1:6, 2, 3)
> x
[,1] [,2] [,3]
[1,]
1
3
5
[2,]
2
4
6
> x[1,]
[1] 1 3 5
> x[,1]
[1] 1 2
> x[1,1]
[1] 1

Note the difference between x[1,] which
types the first row and x[,1] which types
the data of the first column.
x[1,1] prints the value of the data in first
row / first column

The value of any column, row or single value can be changed by simply assigning new
values:
> x[, 3] <- 21:22
> x
[,1] [,2] [,3]
[1,] 1 3 21
[2,] 2 4 22
> x[, 3]
[1] 21 22
You have certainly noticed that the last result is a vector and not a matrix. The default
behavior of R is to return an object of the lowest dimension possible. This can be
altered with the option drop which default is TRUE:
> x[, 3, drop = FALSE]
[,1]
[1,] 21
[2,] 22
Accessing or printing subsets:
> z <- matrix(1:30, 5,6)

First create a matrix named z
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containing 5 rows of 6 values each.
[,1] [,2] [,3] [,4] [,5] [,6]
[1,]
1
6
11
16
21
26 Then show the content of the matrix.
[2,]
2
7
12
17
22
27
[3,]
3
8
13
18
23
28 Finally, write out a subset of the large
[4,]
4
9
14
19
24
29 matrix from 3rd row and 4th column to
[5,]
5
10
15
20
25
30 4th row and 5th column.
> z[3:4, 4:5]
[,1] [,2]
Note that the columns and rows are
[1,]
18
23
renumbered 1 and 2.
[2,]
19
24
> z

Note: the matrix is by default
filled first by column as the
default parameter byrow is
FALSE. This behavior can be
changed:
Of course the result of the
subset will be changed
accordingly:

> z2 <- matrix(1:30, 5, 6, byrow=TRUE)
> z2
[,1] [,2] [,3] [,4] [,5] [,6]
[1,]
1
2
3
4
5
6
[2,]
7
8
9
10
11
12
[3,]
13
14
15
16
17
18
[4,]
19
20
21
22
23
24
[5,]
25
26
27
28
29
30
> z2[3:4, 4:5]
[,1] [,2]
[1,]
16
17
[2,]
22
23

This indexing system is easily generalized to arrays, with as many indices as the
number of dimensions of the array. Example for a three dimensional array: x[i, j,
k], x[, , 3], x[, , 3, drop = FALSE], and so on).
In some cases, it may be very useful to bind or “glue” 2 matrices or data tables together.
The functions rbind() and cbind() can bind matrices with respect to lines or
columns respectively:
> m1 <- matrix(1, nr = 2, nc = 2)
> m1
[,1] [,2]
[1,]
1
1
[2,]
1
1
> m2 <- matrix(2, nr = 2, nc = 2)
> m2
[,1] [,2]
[1,]
2
2
[2,]
2
2
> cbind(m1, m2)
[,1] [,2] [,3] [,4]
[1,]
1
1
2
2
[2,]
1
1
2
2
> rbind(m1 , m2)
[,1] [,2]
[1,]
1
1

Matrix m1 is created to contain the digit
1 in all rows and colums. There are 2
rows (nr = number of rows) and 2
columns (nc = number of columns).
Matrix m2 is created in a similar manner
with the value 2.
cbind() is used to bind (glue) the 2
matrices next to each other. It is implied
that the number of rows is identical.
rbind() is used to collate the matrices
above each other. It is implied that the
number of columns is identical.
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[2,]
1
1
[3,]
2
2
[4,]
2
2
> m3 <- matrix(3, nc=2, nr=3)
> m3
[,1] [,2]
[1,]
3
3
[2,]
3
3
[3,]
3
3
> cbind(m1,m3)
Error in cbind(deparse.level,
...) : number of rows of matrices
must match (see arg 2)
> cbind(m1, m3[1:2,1:2])
[,1] [,2] [,3] [,4]
[1,]
1
1
3
3
[2,]
1
1
3
3
> rbind(m1, m3)
[,1] [,2]
[1,]
1
1
[2,]
1
1
[3,]
3
3
[4,]
3
3
[5,]
3
3

Matrix m3 contains 2 columns but 3
rows.

Therefore the cbind() function cannot
be used on the entire matrix.
However it can be used if the some
rows are eliminated. Since all numbers
are the value 3, the subset
m3[2:3,1:2] would provide the same
result.
> m3[2:3,1:2]
[,1] [,2]
[1,]
3
3
[2,]
3
3
rbind() in this case works because
the number of columns is identical.

4. Graphics with R
Section 4 of the Emmanuel Paradis’s “R for Beginners” (pages 36 – 54) is a 19 page
segment covering many aspects of graphics.
The following mini exercise will be useful to understand later plots:
First create a list of 1000 points, and display the first 10 and last 10 of the series.
Create an object containing numbers 1 through
1000
> x[1:10] ; x[990:1000]
Display first and last 10 of the series to verify
[1] 1 2 3 4 5 6 7 8 9 10
[1] 990 991 992 993 994 995 996 997 998 999 1000
> data <- rnorm(x)
Create a data vector of 1000 random numbers
> x <- 1:1000

>
>
>
>

Plot the data on a graphics (should be automatic)
Plot a horizontal line at y axis values –2,0 and +2

plot(data)
abline(h=2)
abline(h=0)
abline(h=-2)

> above2 <- data
> sum(above2)
[1] 23

> 2

Create an index vector describing which data
points are above the value of +2. (data > 2)
Calculate how many there are: there are 23
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> above2[35:39]
[1] FALSE FALSE

Data points satisfying condition gave a value TRUE
TRUE FALSE FALSE

> below_2 <- data < (-2)
> sum(below_2)
[1] 24

Do the same calculations for points below –2.
Note that below_2 is a valid vector name but
below-2 is not!
There are 24 points that satisfy this condition

> points(x[above2], data[above2], pch=20, col="red")
> points(x[below_2],data[below_2],pch=20, col="blue")

Replot
points with
specific
colors.

Points above 2 are colored
red

Points in the middle were not
changed

Points less than –2 are
colored blue

4.1 Plotting symbols
Here is a table of many available
symbols as described in E.
Paradis’s manual “R for beginners”
(English version, page 44.
http://cran.rproject.org/doc/contrib/Paradisrdebuts_en.pdf
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You can try the following example code1 which shows all 25 symbols that can be used
to produce points in graphs:
# Make an empty chart
plot(1, 1, xlim=c(1,5.5), ylim=c(0,7), type="n", ann=FALSE)
# Plot digits 0-4 with increasing size and color
text(1:5, rep(6,5), labels=c(0:4), cex=1:5, col=1:5)
# Plot symbols 0-4 with increasing size and color
points(1:5, rep(5,5), cex=1:5, col=1:5, pch=0:4)
text((1:5)+0.4, rep(5,5), cex=0.6, (0:4))
# Plot symbols 5-9 with labels
points(1:5, rep(4,5), cex=2, pch=(5:9))
text((1:5)+0.4, rep(4,5), cex=0.6, (5:9))
# Plot symbols 10-14 with labels
points(1:5, rep(3,5), cex=2, pch=(10:14))
text((1:5)+0.4, rep(3,5), cex=0.6, (10:14))

3

4

0

1

2

5

6

7

8

9

10

11

12

13

14

15

20

# Plot symbols 15-19 with labels
points(1:5, rep(2,5), cex=2, pch=(15:19))
text((1:5)+0.4, rep(2,5), cex=0.6, (15:19))

3

2

1

0

1

16

21

2

18

17

22

23

3

19

25

24

4

5

# Plot symbols 20-25 with labels
points((1:6)*0.8+0.2, rep(1,6), cex=2, pch=(20:25))
text((1:6)*0.8+0.5, rep(1,6), cex=0.6, (20:25))

Notes:
cex determines the size of the plotted pch symbol.
rep(n,5) repeats the n value for plotting 5 times as a horizontal line. In
essence that is the y coordinate for the point to be plotted.
In truth, since numbers and letters can be used for plotting there are over 100
characters that can be used to plot.
Using what we know about matrices and the example code above we can write:
# Create a Matrix Mt containing 12 rows of numbers
# from 0 to 143, filled by row
> Mt<- matrix (c(0:143), ncol=12,byrow=TRUE)
> Mt
[1,]
[2,]
[3,]
[4,]
[5,]
[6,]
[7,]
[8,]
[9,]
[10,]
[11,]
[12,]

[,1] [,2] [,3] [,4] [,5] [,6] [,7] [,8] [,9] [,10] [,11] [,12]
0
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86
87
88
89
90
91
92
93
94
95
96
97
98
99 100 101 102 103 104
105
106
107
108 109 110 111 112 113 114 115 116
117
118
119
120 121 122 123 124 125 126 127 128
129
130
131
132 133 134 135 136 137 138 139 140
141
142
143

# plot an empty chart
> plot(1, 1, xlim=c(0,13), ylim=c(12,-1), type="n", ann=FALSE)
1

From: bottom of page http://www.harding.edu/fmccown/R/
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# repetitive plot based on i
> for(i in 0:11)
{
points((1:12),rep(i,12), pch=Mt[i+1,])
}

2

0

to create the following plot:
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The command could easily be alterned to print everything in blue with the few objects
with a fill in yellow by altering the line with the points command:
points((1:12),rep(i,12), pch=Mt[i+1,], col="blue", bg="yellow")
It is to be noted that there are no symbols for values ranging from 25 to 31 and the plot
appears blank for these coordinates.

4.2 Multiple plots on the same figure
The parameters mfrow and mfcol can be used to split the plotting surface into
specified numbers of rows and columns respectively. The combinations can be quite
complex (see Paradis’s tutorial for that) and the number of parameters also quite large.
Type ?par to see the help file and the list of parameters! Here is the help definition
for those 2 parameters
mfcol, mfrow
A vector of the form c(nr, nc). Subsequent figures will be drawn in an nr-by-nc array
on the device by columns (mfcol), or rows (mfrow), respectively.
Typically it is the par(mfrow = c(nr, nc)) version that is more often used.
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Note that the screen will remain “split” until specified otherwise!
The following example2 helps understand this. First we create a series of 50 random
numbers that are plotted in 4 separate methods (type=) on a split screen (mfrow):
> x1 <- rnorm(50)
> par(mfrow = c(2,2))
> plot(x1, type = "p",
> plot(x1, type = "l",
> plot(x1, type = "b",
> plot(x1, type = "o",
"")

main
main
main
main

=
=
=
=

"points", ylab = "", xlab = "")
"lines", ylab = "", xlab = "")
"both", ylab = "", xlab = "")
"both overplot", ylab = "", xlab =

1
0
-1
-2

-2

-1

0

1

2

lines

2

points

0

10

20

30

40

50

0
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40

50

1
0
-1
-2

-2

-1

0

1

2

both overplot

2

both
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0
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0
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5. End of Lab -------------------------

2

---------------------------

From http://en.wikibooks.org/wiki/R_Programming/Graphics
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Microarray Data
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Within the text, user input is usually shown as bold text or
command
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Table of Contents
1.

Setup .............................................................................................................................................49
1.1

2.
3.

Required software............................................................................................................................. 49

Estrogen data set ........................................................................................................................51
Analyzing the data in R.............................................................................................................53
3.1 Loading the affy package................................................................................................................. 53
3.2 Preparing and reading the RNA Target file .............................................................................. 55
3.3 Preparing and reading the RNA Target file .............................................................................. 57
3.4 Diagnostic plots.................................................................................................................................. 58
3.4.1 Image plots.......................................................................................................................................................58
3.4.2 Histograms: pm and mm............................................................................................................................59
3.4.3 Histograms: raw vs log intensities ........................................................................................................59
3.4.4 MA plots (using raw, un‐normalized data) ........................................................................................61
3.5 Normalization ..................................................................................................................................... 62
3.5.1 RMA Normalization......................................................................................................................................62
3.5.2 Examining the effect of normalization using boxplot ...................................................................67
3.6 More diagnostic plots: scatter plots ............................................................................................ 68
3.7 More diagnostic plots: MA plots ................................................................................................... 69
3.8 More diagnostic plots: distance cluster of chips ..................................................................... 70
3.9 Overview Plot...................................................................................................................................... 70
3.10 Saving R workspace........................................................................................................................ 71
3.11 Saving analyzed data into table(s) ............................................................................................ 72

4.

Plots and output results on our RMA set............................................................................73
4.1
4.2

5.

Heatmap ............................................................................................................................................... 73
ANOVA ................................................................................................................................................... 74

END of SESSION ...........................................................................................................................79
Page - 48 -

R and Bioconductor- Affymetrix.

1. Set-up
These exercises are set-up for the BTCI Windows machines, with R version 2.11.1 or
later.
R may be available as a shortcut icon on the desktop
R should also be available
as the usual
Start > All Programs
menu cascade.
(Shown here for R 2.9.0)
The following section lists the required software and packages. In this way you can
configure your own system with the necessary elements.

1.1 Required software
Required software for these exercises (see install section, Part 0): R version 2.10, or R
2.11.1 or later.
BioConductor packages: affy, affydata , affyPLM, Biobase, estrogen, hgu95av2cdf,
hgu95av2probes, gcrma, matchprobes.
(info at http://www.bioconductor.org/packages/bioc/)
1.1. INSTALLING Required software
R and BioConductor are already installed. To install on your own system refer to the
Installation instructions in the previous section.
Three of the required packages need to be installed. The simplest way to install a
package is by line-command as we have seen in Installation instructions.
Please do the following:
Launch R from the R icon on the desktop or the Start menu.
At the > prompt type the following commands:
> source("http://bioconductor.org/biocLite.R")
> biocLite("hgu95av2probe")
Running biocinstall version 2.4.10 with R version 2.9.0
Your version of R requires version 2.4 of Bioconductor.
trying URL
'http://bioconductor.org/packages/2.4/data/annotation/bin/windows/contrib/2.9/hgu95av2probe_2.4.0
.zip'
Content type 'application/zip' length 2551429 bytes (2.4 Mb)
opened URL
downloaded 2.4 Mb
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package 'hgu95av2probe' successfully unpacked and MD5 sums checked

>
>
>
>

biocLite("hgu95av2cdf")
biocLite("estrogen")
biocLite("hgu95av2.db")
biocLite("made4")

Note: the estrogen package contains 8 data files about 40Mb) and may take a few seconds/minutes to
download.
Note: Package update/download can also be
accomplished using mouse clicks on Macintosh
and Windows systems according to their
respective GUI interface (see Installation
instructions).
On a Macintosh this can be done with the
package installer from menu Packages&Data >
Package Installer
Here we can see that the 3 packages for
hgu95av2 are up to date.

1.2. PATH: where R finds and writes data (review)
The PATH to a file depends on the computer system. On a Windows system most paths
start with the letter C:\ and then continue down the list of nested directories all the way
to the final directory or file that the path needs to describe.
For example C:\Program Files\R\R-2.9.0. Sometimes Windows systems have a
D: drive to place data. On Macintosh, Linux and Unix systems the path is written in a
similar way, with a forward slash (/) instead of a backslash (\).
When R is launched, it is set to find and read files within the default path. To see the
current path within your R session type the command getwd() (get working directory)
after the > prompt: (ignore warnings)
> getwd()
[1] "C:/Documents and Settings/Administrator/My Documents"
(Note: We have seen the GUI way to do this in R-Basics.)
Thus the command getwd() shows where the current path for R at the > prompt. The
similar command setwd() changes the path to the new, given path (see below.)
Understanding PATH and knowing how to switch where R reads and writes data is very
useful.
Note: If you are on a system where you do not have write privileges into R, you can
create your own custom directory where you will download the necessary packages and
files with the .libPaths() function (note that the name starts with a dot.)
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This command with no argument will echo the current library path.
For example, the BTCI Windows machine will echo:
> .libPaths()
[1] "C:/PROGRA~1/R/R-29~1.0/library"
On Macintoshes it would look like this:
> .libPaths()
[1] "/Library/Frameworks/R.framework/Resources/library"
Here is an example to create a new Library path on Windows (note the double back
slashes.)
> .libPaths(“C:\\Custom\\R\\library\\directory”)
Reminder: R uses the Unix forward slash (/) as the default standard. If you use a
backslash it has to be “escaped” with another backslash, or simply use the forward
slash notation:
> .libPaths(“C:/Custom/R/library/directory”)

2. Estrogen data set1
The experiments were performed on 8 Affymetrix chips to measure changes in the gene
expression of breast cancer cells.
Description of dataset (from vignette): “The investigators in this
experiment were interested in the effect of estrogen on the
genes in ER+ breast cancer cells over time. After serum
Table 1: Experimental
starvation of all eight samples, they exposed four samples to
Conditions for .cel Files
estrogen, and then measured mRNA transcript abundance after
10 hours for two samples and 48 hours for the other two. They
left the remaining four samples untreated, and measured mRNA
transcript abundance at 10 hours for two samples, and 48 hours
for the other two. Since there are two factors in this experiment
(estrogen and time), each at two levels, (estrogen: absent or
present,time: 10 hours or 48 hours), this experiment is said to
have a 2×2 factorial design. Table 1 shows the correspondence
of the sample names in estrogen with the experimental
conditions.”
Note: the data can be downloaded independently from R from the bioconductor web
site:
http://www.bioconductor.org/packages/2.0/data/experiment/bin/win
dows/contrib/2.5/estrogen_1.8.2.zip
1

Scholtens D, Miron A, Merchant F, Miller A, Miron P, Iglehart JD, Gentleman R.
Analyzing factorial designed microarray experiments. Journal of Multivariate Analysis,
2004; 90(1): 19-43.
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The estrogen package was downloaded/installed within R earlier. The data files are
located within a subdirectory called extdata within the R package library (location
depends on hardware.)
Inspect the Estrogen package within R. Type the following commands at the > prompt to
change the R > prompt PATH to the extdata subdirectory of the estrogen R
package:
> setwd(system.file("extdata",package="estrogen"))
Now look where this is located on your system (here the NMC Macintosh)
> getwd()
[1] "C:/PROGRA~1/R/R-29~1.0/library/estrogen/extdata"
(Note that the R version appears within the path.)
Now list the contents of the current directory:
> dir()
[1] "bad.cel"
[5] "high48-1.cel"
[9] "low48-1.cel"

"estrogen.txt"
"high48-2.cel"
"low48-2.cel"

"high10-1.cel" "high10-2.cel"
"low10-1.cel"
"low10-2.cel"
"phenoData.txt" "targLimma.txt"

The Affymetrix data is contained within the .cel files.
The file phenoData.txt is a tab-delimited text file describing the 2x2 factorial
experiment with the absent/present test within the estrogen column and the time, 10 or
48 within the time.h column (see below.)
One hardware-independent method to see the contents of the file is as follows (user
input in bold): create an object called p with the readtable() function, and then print
p.
> p <- read.table("phenoData.txt")
> p
1
2
3
4
5
6
7
8
9

V1
V2
V3
filename estrogen time.h
low10-1.cel
absent
10
low10-2.cel
absent
10
high10-1.cel present
10
high10-2.cel present
10
low48-1.cel
absent
48
low48-2.cel
absent
48
high48-1.cel present
48
high48-2.cel present
48

There are 2 possibilities in column V2 (present / absent) and 2 possibilities in column V3
(10 / 48)
Side-Note: On a Macintosh or Unix/Linux the system-specific command can be given as:
> system("cat phenoData.txt")
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system() is the R command that passes it’s argument to the operating system. “cat” is the Unix
command invoked and differs from the R command cat(). On Windows replacing “cat” with “type”
should work, but doesn’t.

The phenoData.txt table describes the 2 variables (presence or absence of estrogen
and time) in 2 columns. To make calculation simpler we shall use a simpler version
where the 2 variates are described within a single name in a single column. Since there
were 2 possibilities each in columns V2 and V3 above, we will have 2 x 2 = 4 different
names in the “Target” column below.
For this effect we can create the following tab-delimited table within Excel or download it
from the web with the following command show below the table:
Name
Abs10.1
Abs10.2
Pres10.1
Pres10.2
Abs48.1
Abs48.2
Pres48.1
Pres48.2

FileName
low10-1.cel
low10-2.cel
high10-1.cel
high10-2.cel
low48-1.cel
low48-2.cel
high48-1.cel
high48-2.cel

Target
EstAbsent10
EstAbsent10
EstPresent10
EstPresent10
EstAbsent48
EstAbsent48
EstPresent48
EstPresent48

Important: the current directory should be “extdata” as set above with setwd(). The
following command download.file() will download the given Internet file from the
typed URL and the file will be given the name EstrogenTargets.txt.
>download.file("http://genic.biotech.wisc.edu/R/MATERIALS/DATA/E
strogenTargets.txt","EstrogenTargets.txt")
trying URL
'http://genic.biotech.wisc.edu/R/MATERIALS/DATA/EstrogenTargets.
txt'
Content type 'text/plain' length 289 bytes
opened URL
==================================================
downloaded 289 bytes
A new dir() command will now show the downloaded file within the directory:
> dir()
[1] "bad.cel"
...

"estrogen.txt"

"EstrogenTargets.txt"

3. Analyzing the data in R
3.1 Loading the affy package
Affy is a BioConductor package for R to analyze Affymetrix data.
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Many packages can be installed within R, but packages need to be loaded in memory in
order to use them. The function library() loads a package into memory. Other
packages may be loaded at the same time if the desired package has dependency on
other packages; for affy these are Biobase, tools and affyio.
Again, there is a GUI way to do that, but line-command is common amongst all
systems, and can additionally be part of a script.
> library(affy)
Loading required package: Biobase
Welcome to Bioconductor
Vignettes contain introductory material. To view, type
'openVignette()'. To cite Bioconductor, see
'citation("Biobase")' and for packages 'citation(pkgname)'.
>

Each package contains a series of functions.
The line-command way to list all the functions within a package is objects():
(Note: on a Macintosh, clicking on any package name listed within the Package Manager will echo the list
of all functions contained within the package in hypertext format (see Installation instructions.))

> objects("package:affy")
[1] "$.AffyBatch"
[2] "affy.scalevalue.exprSet"
[3] "AffyRNAdeg"
[4] "AllButCelsForReadAffy"
[5] "avdiff"
[6] "barplot"
[..........]
[114] "updateMe"
[115] "whatcdf"
[116] "xy2indices"

For affy there are therefore 116 entries. Help for each command can then be obtained
with the help command e.g. ?MAplot or help(MAplot).
To know which packages are currently loaded (underlined are added here to show what
is new after loading affy.)
> search()
[1] ".GlobalEnv"
[4] "package:stats"
[7] "package:utils"
[10] "Autoloads"
>

"package:affy"
"package:graphics"
"package:datasets"
"package:base"

"package:Biobase"
"package:grDevices"
"package:methods"

We have already changed the working directory and explored its content in the previous
section. This can be verified with:
> getwd()
> dir()
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If you are not within the estrogen package, then re-issue the following command:
> setwd(system.file("extdata",package="estrogen"))

3.2 Preparing and reading the RNA Target file
In the previous section we used the download.file() function to download the file
EstrogenTargets.txt within the extdata subdirectory of directory estrogen
located in the R library.
Let’s read-in this file into an R object called pd (short for pheno data.)
We will specify that there is a header as the first line with the name of the variables.
> pd <- read.AnnotatedDataFrame("EstrogenTargets.txt",
header=TRUE,row.names=1)
> pd
An object of class "AnnotatedDataFrame"
rowNames: Abs10.1, Abs10.2, ..., Pres48.2 (8 total)
varLabels and varMetadata description:
FileName:
Target:
>
In previous examples, simply retyping the name of the object showed it’s content within
the R text console. This was equivalent to assuming the print() function.
This is the first example of an R object of this nature that we encounter (it is called an
S4 class object – see box below).

S4 class - object-oriented programming paradigm S4 proposed
by John Chambers (developer of S).
• A class provides a software abstraction and reflects how we think about certain
objects and what information should be contained.
• Classes are defined in terms of slots, or compartments within the class that
contain the actual data. These are like the components in a list.
• The class for microarray expression data is ExpressionSet. The slot in an
ExpressionSet object containing the matrix of expression values is named exprs.
Just typing the name as above is equivalent to invoking the function show():
> show(pd)
An object of class "AnnotatedDataFrame"
rowNames: Abs10.1, Abs10.2, ..., Pres48.2
varLabels and varMetadata description:
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FileName:
Target:
The table has been reorganized within the R object for logical access. You can imagine
the object pd as a box with various compartments, or slots. The table is within one of
the slots called data. To see the various slots of an R object, use the function
slotNames():
> slotNames(pd)
[1] "varMetadata"
".__classVersion__"

"data"

"dimLabels"

To see the contents of a slot, we call the R object (here pd) and add the name of the
slot we want to inspect after the @ sign:
> pd@data
Abs10.1
Abs10.2
Pres10.1
Pres10.2
Abs48.1
Abs48.2
Pres48.1
Pres48.2

FileName
low10-1.cel
low10-2.cel
high10-1.cel
high10-2.cel
low48-1.cel
low48-2.cel
high48-1.cel
high48-2.cel

Target
EstAbsent10
EstAbsent10
EstPresent10
EstPresent10
EstAbsent48
EstAbsent48
EstPresent48
EstPresent48

Note that the word “Name” (above Abs10.1) has disappeared from the first column/first
row from the original .txt file.
Similarly, the slot named varMetadata contains 2 items, which names are the titles of
the table columns: FileName and Target.
> pd@varMetadata
labelDescription
FileName
Target
>
The variables are accessible from within R with the special notation that includes the $
sign. Thus we can call the name of the files to be analyzed:
> pd$FileName
[1] low10-1.cel
[5] low48-1.cel
> pd$Target
[1] EstAbsent10
[5] EstAbsent48

low10-2.cel
low48-2.cel

high10-1.cel high10-2.cel
high48-1.cel high48-2.cel

EstAbsent10
EstAbsent48

EstPresent10 EstPresent10
EstPresent48 EstPresent48

This notation is used in the next section to read-in the .cel datafiles.
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3.3 Preparing and reading the RNA Target file
Let’s read-in the data files into an R object called rawAffyData (here we can use any
name we want.) The data will be read by the affy package function ReadAffy(), to
which we will provide the name of the CEL files contained within pd$FileName.
However we first need to place the name of the files within quotes for this to work. We
will use the command paste to paste nothing (shown as 2 consecutive quotes) and the
file names contained within the slot FileName of object pd:
> files <- paste("",pd$FileName,sep="")
> files
[1] "low10-1.cel" "low10-2.cel" "high10-1.cel" "high10-2.cel"
[5] "low48-1.cel" "low48-2.cel" "high48-1.cel" "high48-2.cel"
> rawAffyData <- ReadAffy(filenames=files)
>
> rawAffyData
AffyBatch object
size of arrays=640x640 features (8 kb)
cdf=HG_U95Av2 (12625 affyids)
number of samples=8
number of genes=12625
annotation=hgu95av2
notes=
>
> slotNames(rawAffyData)
[1] "cdfName"
[4] "assayData"
[7] "experimentData"

"nrow"
"phenoData"
"annotation"

"ncol"
"featureData"
".__classVersion__"

Here is the output of each of these slots:
> rawAffyData@cdfName
[1] "HG_U95Av2"
> rawAffyData@nrow
[1] 640
> rawAffyData@ncol
[1] 640
> rawAffyData@assayData
<environment: 0x0a61ce98>
> rawAffyData@phenoData
An object of class "AnnotatedDataFrame"
sampleNames: low10-1.cel, low10-2.cel, ..., high48-2.cel
total)
varLabels and varMetadata description:
sample: arbitrary numbering
> rawAffyData@featureData
An object of class "AnnotatedDataFrame"
featureNames: 1, 2, ..., 409600 (409600 total)
varLabels and varMetadata description: none
> rawAffyData@experimentData
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Experiment data
Experimenter name:
Laboratory:
Contact information:
Title:
URL:
PMIDs:
No abstract available.
Information is available on: preprocessing
notes:
:
> rawAffyData@annotation
[1] "hgu95av2"
(Note if you are using a previous version of R, you may get a different result! For example here is the
output for R 2.4 with BioConductor 1.9 (indeed some of these would contain different information!)
> slotNames(rawAffyData)
[1] "cdfName"
[4] "exprs"
[7] "annotation"
[10] "phenoData"

"nrow"
"ncol"
"se.exprs"
"description"
"notes"
"reporterInfo"
".__classVersion__" )

3.4 Diagnostic plots
The quality of the array can be assessed visually by plotting image and histograms.
3.4.1 Image plots
Image plot of the first array, this may take a minute or two for each plot
> image(rawAffyData[,1])
Note that the name above the picture is
the name of the file from Name column in
the phenoData file. The data comes from
file low10-1.cel
If you make the window big enough you
can see the name of the chip etched at
the top right :
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You can image more samples depending on the time remaining. The data is accessible
with the bracket notation we studied for matrices and arrays e.g. [,1]
There is an extra .cel file with bad spatial
artefact:
> badcel <- ReadAffy(file="bad.cel")
Note: 'file' is short for 'filenames'
> image(badcel)

To save computer memory (RAM), we can overwrite this object with an insignificant size
object number, e.g.:
> badcel <- 1
3.4.2 Histograms: pm and mm
Histograms are another diagnostic method. Affymetrix chips contains PM (Perfect
Match) and MM (MisMatch) intensities. A histogram of the log of these intensities is
most useful because of the dynamic range of data
Each of the R commands below a histogram of log2 intensities for the first Estrogen
microarray chip. The first command includes only the PM probes in the histogram,
whereas the second command includes only the MM probes.
> hist(log2(pm(rawAffyData[,1])), breaks=100, col="blue")
> hist(log2(mm(rawAffyData[,1])), breaks=100, col="blue")

MM

PM

3.4.3 Histograms: raw vs log intensities
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We could look at all the histograms at the same time for both the raw values and the
log2 values intensities. We will split the graphics window into 2 rows which will receive
on histogram plot each.
The graphics command par() (type ?par for help) sets parameters for how many rows
and/or columns to split the graphical output. The variables mfrow and mfcol contain the
values for rows and columns. The default is a single window of 1 row and 1 column:
> par("mfrow")
[1] 1 1
> par("mfcol")
[1] 1 1
We can conserve the old paramters into the R object we call opar (or choose another
name!) so that we can easily restore the defaults once we are done and then change
the value of mfrow to accommodate a second plot on the same page (2 rows, 2
column):
> opar <- par("mfrow")
> par(mfrow=c(2,1))
Now we can perform the plot and then restore the graphics parameters to the old
setting. The subcommand main= prints the title of the plot:

> hist(rawAffyData, main=”Raw
intensities”,log=FALSE)
> hist(rawAffyData, main=”Log
intensities”,log=TRUE)
> par(mfrow=opar)
Note: The log2 intensities are not on the
same scale along both axes, and that is
the main reason why normalization
needs to be performed.

Note: Emmanuel Paradis’s “R for beginners” cited in the previous section has an
extensive section to learn about how to divide the graphical output in complex sets of
rows and columns.
http://cran.r-project.org/doc/contrib/Paradis-rdebuts_en.pdf
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3.4.4 MA plots (using raw, un‐normalized data)
MA is typically used in 2-colors arrays, to compare the red and green intensities. Since
Affymetrix chips have only one color channel, it is only possible to calculate similar plots
when comparing different chips.
The MA-plot captures the relationship between log2 ratio, or relative log2 intensity, on
the vertical axis (M), and mean log2 intensity value on the horizontal axis (A).
To keep the same nomenclature as in
the 2-color arrays, we can name one
channel R and one channel G, but in our
case they would represent one
Affymetrix chip each.
M is called a “log ratio” simply because it is the logarithm of the ratio of R over G. A is
also called the average log intensity simply because it can be written as an average due
to properties of log: A = 1/2(log2R + log2G). In the same way, because of log properties
M could be rewritten as M = log2R - log2G
Since there are 8 chips, there would be 282 possible MA plots. Since we have not yet
normalized the data, there would be up to 20 measurements for each gene. Instead of
making all possible comparisons, we will ignore replicate chips (2,4,6, and 8) and use
chips (1,3,5, and 7). We will use the PM (Perfect Match) probes to calculate log ratios
(M) and log intensities (A) using the function mva.pairs() which calculates with log in
base 2.
If you are pressed with time you can skip this command as this will require several
minutes to compute (and might even crash the computer). There will be a similar plot
created later after normalization that will take less time and less computer power.
IF you want to go ahead the command is:
> mva.pairs(pm(rawAffyData)[,c(1,3,5,7)])
Once more, note the use of the c() function to write the requested numbers.

2n

Cr = n! / r!(n-r)! thus 8C2 = 8! / 2!(8-2)! = (8 x 7) / 2 = 28
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It appears from these plots that there is a significant time effect: MA plots comparing 10
vs 48 hours are not centered on M = 0. The reader should be aware that the
normalization will remove this effect, because normalization generally assumes that the
majority of genes are not differentially expressed. The experimenters felt that there was
no possible biological reason why EVERY gene on the chip would be expressed so
differently at the later time (48 hours), and that it must be an artifact due to the
microarray technology. Therefore, it seemed reasonable to use the traditional
normalization methods.

3.5 Normalization
3.5.1 RMA Normalization
There are several normalization methods available for Affymetrix data. We will use
RMA3 (Robust Multichip Averaging). A Frequently Asked Questions list is available at
http://bmbolstad.com/misc/ComputeRMAFAQ/ComputeRMAFAQ.html

3

Bolstad, B.M., Irizarry R. A., Astrand M., and Speed, T.P. (2003), A Comparison of Normalization
Methods for High Density Oligonucleotide Array Data Based on Bias and Variance. Bioinformatics
19(2):185-193
Rafael. A. Irizarry, Benjamin M. Bolstad, Francois Collin, Leslie M. Cope, Bridget Hobbs and Terence P.
Speed (2003), Summaries of Affymetrix GeneChip probe level data Nucleic Acids Research 31(4):e15
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RMA consists of three steps:
- a background adjustment,
- quantile normalization,
- and finally summarization.
We will normalize the Estrogen data using the rma() function, which will create an
object of class exprSet.
Note: In order to run rma() on the Estrogen data, you must either have the CDF (Chip
Definition File) package hgu95av2cdf installed or have reposTools installed and be
connected to the Internet for automatic download of the CDF package by the rma()
function.
> eset <- rma(rawAffyData)
Background correcting
Normalizing
Calculating Expression

> slotNames(eset)
[1] "assayData"
"phenoData"
"featureData"
[4] "experimentData"
"annotation"
".__classVersion__"
>
> eset
ExpressionSet (storageMode: lockedEnvironment)
assayData: 12625 features, 8 samples
element names: exprs
phenoData
sampleNames: low10-1.cel, low10-2.cel, ..., high48-2.cel (8
total)
varLabels and varMetadata description:
sample: arbitrary numbering
featureData
featureNames: 100_g_at, 1000_at, ..., AFFX-YEL024w/RIP1_at
(12625 total)
fvarLabels and fvarMetadata description: none
experimentData: use 'experimentData(object)'
Annotation: hgu95av2
>
> class(eset)
[1] "ExpressionSet"
attr(,"package")
[1] "Biobase"
Note: Difference(s) with R 2.4 and BioConductor 1.9 with R 2.5 and BioConductor 2.0 The output are somewhat
different:
> eset

Irizarry, RA, Hobbs, B, Collin, F, Beazer-Barclay, YD, Antonellis, KJ, Scherf, U, Speed, TP (2003)
Exploration, Normalization, and Summaries of High Density Oligonucleotide Array Probe Level Data.
Biostatistics .Vol. 4, Number 2: 249-264
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Expression Set (exprSet) with
12625 genes
8 samples
phenoData object with 2 variables and 8 cases
varLabels
FileName: read from file
Target: read from file
> slotNames(eset)
[1] "exprs"
"se.exprs"
"description"
[4] "annotation"
"notes"
"reporterInfo"
[7] "phenoData"
".__classVersion__"
> class(eset)
[1] "ExpressionSet"
attr(,"package")
[1] "Biobase"
>
Expression summary values: after the rma() command, all PM and MM probe intensities for any given gene have
been combined into a single number, the “expression summary” which reflects the concentration of the probe set’s
target RNA. This number is located within the slot “exprs” of the R object eset.
We can verify that eset is of class expression set:
> class(eset)
[1] "exprSet"
attr(,"package")
[1] "Biobase"
Therefore starting with R 2.5 and BioConductor 2.0 the command:
> eset@exprs
Error: no slot of name "exprs" for this object of class "ExpressionSet"
gives an error. However it is still possible to access the expression value with the following notation:

> exprs(eset)
Note: the command SlotNames(eset) no longer lists exprs as one of the slots,
however it is obvious that it is there! We can interpret it as being “assumed” and the
authors no longer find it necessary to list it.
> slotNames(eset)
[1] "assayData"
[4] "experimentData"
>

"phenoData"
"annotation"

"featureData"
".__classVersion__"

We will learn later how to save the expression values into a text table, but for now we
can use the View() command to look what the contents is: (note that it is Capial V)
> View(exprs(eset))
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The log2 intensity value for each probe is shown. This image shows the table roughly in
the center of the 12625 rows.
The line-commands head() and tail() are useful to look at the first (head) or last
(tail) few lines of the table. Since the table is too wide, the table is split and the row
names are repeated at the left:
>

head(exprs(eset))

low10-1.cel low10-2.cel high10-1.cel high10-2.cel low48-1.cel
9.642896
9.741496
9.537036
9.353625
9.591697
10.398169
10.254362
10.003971
9.903528
10.374866
5.717613
5.881008
5.859563
5.954028
5.960540
5.512596
5.801807
5.571065
5.608132
5.390064
7.783927
8.007975
8.037999
7.835120
7.926487
7.289162
7.603670
7.488539
7.771506
7.521789
low48-2.cel high48-1.cel high48-2.cel
100_g_at
9.570590
9.475796
9.530655
1000_at
10.033520
10.345066
9.863321
1001_at
6.020889
5.981080
6.285192
1002_f_at
5.494511
5.508104
5.630107
1003_s_at
8.138870
7.994937
8.233338
1004_at
7.599544
7.456149
7.675171
100_g_at
1000_at
1001_at
1002_f_at
1003_s_at
1004_at

> tail(exprs(eset))
low10-1.cel low10-2.cel high10-1.cel high10-2.cel
4.920698
5.435014
5.226347
5.050387
5.176600
5.490783
5.125255
5.175405
4.582392
4.910316
4.731237
5.003490
4.518523
4.871328
4.694346
4.885317
4.973010
4.997918
4.935513
5.158614
4.734067
4.854784
4.728044
5.063832
low48-1.cel low48-2.cel high48-1.cel high48-2.cel
AFFX-TrpnX-5_at
5.508327
5.147436
5.355916
5.263012
AFFX-TrpnX-M_at
5.808963
5.781554
5.447328
5.621852
AFFX-YEL002c/WBP1_at
5.048046
5.197251
4.995843
5.355615
AFFX-YEL018w/_at
5.090567
5.116262
4.977370
5.292459
AFFX-YEL021w/URA3_at
5.550414
6.669628
5.685904
5.468872
AFFX-YEL024w/RIP1_at
5.037900
4.993075
4.769720
5.094432
AFFX-TrpnX-5_at
AFFX-TrpnX-M_at
AFFX-YEL002c/WBP1_at
AFFX-YEL018w/_at
AFFX-YEL021w/URA3_at
AFFX-YEL024w/RIP1_at

They can also be included within the View command for a graphical table output:
> View(head(exprs(eset)))

> View(tail(exprs(eset)))
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RMA variations: within the affy package the function justRMA() (spelling is case-sensitive!)
calculates similar values that requires less RAM memory and can be useful in case the computer has little
RAM memory. The following example should read in all 8 arrays, normalize them, and create an object of
class exprSet with as little as 128 Megabytes of RAM:
> library(affy)
> setwd(system.file("data",package="estrogen"))
> pd <read.phenoData("EstrogenTargets.txt",header=TRUE,row.names=1,as.is=TRUE)
> eset <- justRMA(filenames=pData(pd)$FileName,phenoData=pd)
> eset
Or to read in only the first four arrays, you can use:
> eset <- justRMA(filenames=pData(pd)$FileName[1:4],phenoData=pd)
> eset
There also exists a package called gcrma which takes the base composition into account. However this
calculation requires more RAM than is currently available on the BNMC Macintoshes. The commands
would be:
> library(gcrma)
> esetGCRMA <- gcrma(rawAffyData)
> esetGCRMA

ADVANCED NOTE: The affy package offers the expresso() function which can combine many
variations of methods for calculating an expression value. The affy vignette “Built-in Processes” describes
the expresso() function in detail, however the built-in R help for this function (use ?expresso to call it)
is not very detailed.
Expresso parameters call methods for background correction, normalization, PM correction, and
summarization (how should the PM and/or MM should be combined into a single number). Each one of
these components have many possible options, some of them not compatible with each other. The
options can be listed as follows:
> bgcorrect.methods
[1] "mas" "none" "rma" "rma2"
> normalize.AffyBatch.methods
[1] "constant"
"contrasts"
"invariantset"
"loess"
[5] "qspline"
"quantiles"
"quantiles.robust"
> pmcorrect.methods
[1] "mas"
"pmonly"
"subtractmm"
> express.summary.stat.methods
[1] "avgdiff"
"liwong"
"mas"
"medianpolish" "playerout"
Citing from the affy “Built-in Processes” vignette:
The function that you should use is expresso. It is important to note that not every preprocessing
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method can be combined together. In particular the rma backgrounds adjust only PM probe intensities
and so they should only be used in conjunction with the pmonly PM correction. Also remember that the
mas and medianpolish summarization methods log2 transform the data, thus they should not be used
in conjunction with any preprocessing steps that are likely to yield negatives like the subtractmm pm
correction method. The following is a typical call to expresso.
> data(affybatch.example)
> eset <- expresso(affybatch.example,bgcorrect.method="rma",
normalize.method="quantiles", pmcorrect.method="pmonly",
summary.method="medianpolish")
This would give you the RMA expression measure, but […] there are other ways of computing RMA
(chiefly rma).
expresso() can also be extended to using methods that are not listed in the options listed above. For
example, the vignette for the estrogen package calls upon the vsn package (“Variance stabilization and
calibration”) for normalizing the estrogen data with expresso(). The command can be rewritten to
accomondate the name of the read data called “a” in the original, and called “rawAffyData” in our set of
exercises:
> library(vsn)
> x <- expresso(rawAffyData, bg.correct = FALSE, normalize.method = "vsn",
normalize.param = list(subsample = 1000), pmcorrect.method = "pmonly",
summary.method = "medianpolish")
Note however the calculation may take up to 10 min and may require more RAM than currently installed.

3.5.2 Examining the effect of normalization using boxplot
Before RMA normalization:
> boxplot(rawAffyData,col="red")
After RMA normalization:
> boxplot(data.frame(exprs(eset)),col="blue")

Before RMA normalization
After RMA normalization
- Boxplot of probe-level array data before and after normalization. -
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Normalization has had a dramatic effect. It is now possible to compare the expression
level of one chip with that of another.

3.6 More diagnostic plots: scatter plots
The scatter plot is a visualization that is useful for assessing the variation or
reproducibility between chips. The following commands compare the first 2 chips
(Abs10.1 and Abs10.2) for the raw data (all), pm, mm and RMA normalized
respectively:
> plot(exprs(rawAffyData)[,1:2], log = "xy", pch=".",
main="all")
log = “xy” forces log scale
pch = “.” chooses the dot to plot each point
main = “all” writes a title at the top of the plot
> plot(pm(rawAffyData)[,1:2],log = "xy", pch=".", main="pm")
> plot(mm(rawAffyData)[,1:2],log = "xy", pch=".", main="mm")
> plot(exprs(eset)[,1:2],log = "xy", pch=".", main="RMA eset")
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Note: R may warn you that it is omitting negative values with the following warning message:
Warning message:
1 x value <= 0 omitted from logarithmic plot in: xy.coords(x, y, xlabel,
ylabel, log)

3.7 More diagnostic plots: MA plots
We can now create MA plots with the normalized data. These calculate faster because
all data for each gene are summarized within the “expression summary” “exprs” of the
R object eset. As previously we will use only one chip per replicate group:
> mva.pairs(exprs(eset)[,c(1,3,5,7)],log.it=FALSE)
The normalization removes a time effect in this case, but the experimenters felt certain
that there was no possible biological effect which can change the expression level of
EVERY gene so dramatically. It is therefore reasonable to assume that this effect is due
to different calibrations of the microarray technology, and should therefore be removed
by normalization.
It is therefore important to consider replicates carefully.
The reason that we specify log.it=FALSE in mva.pairs() is that the expression
measurements in eset have already been log-transformed. (See the help for rma,
using ?rma).
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3.8 More diagnostic plots: distance cluster of chips
The data can be clustered using a hierarchically algorithm to see how chips compare
overall.
Note: for R2.4.0 & Bioconductor 1.9 you could use > dst <- dist(t(eset@exprs))
> dst <- dist(t(exprs(eset)))
> hh <- hclust(dst, method="average")
> plot(hh)
First calculate a distance
based on the summary
expression set (exprs)
and place this into an R
object called dst. Then
hierarchically cluster the
distance with the average
method and place this data
into an R object called hh.
Finally plot the obtained
distance cluster.

3.9 Overview Plot
The R package “made4” contains a command that will create a quick overview and
similar plots as before in a single command:
> library(made4)
> overview(eset,label=pd@data$Target)
The simpler command overview(eset) alone would label the dendogram with the file
names instead.
The subcommand label= requests the data within the R object pd, in the slot data for
column Target (review above if you have forgotten how pd was created!)
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Note: The R packages arrayQualityMetrics and arrayQuality also offer
options to test the quality of the arrays and automatically generate multiple plots.

3.10 Saving R workspace
This is a good time to learn about saving the current data within R into an image file, so
that it can be recalled later to resume calculations or analyzes.

save() and save.image() R Documentation Description
save() writes an external representation of R objects to the specified file. The objects
can be read back from the file at a later date by using the function load (or data in
some cases).
save.image() is just a short-cut for “save my current workspace”, i.e., save(list
= ls(all=TRUE), file = ".RData"). It is also what happens with q("yes").
If you are using this feature on your own computer, you may want to change the current
directory to a directory where you keep analysis data with setwd() or the GUI method.
To see a list of the objects currently in R, the commands objects() or ls() are
synonymous:
> objects()
[1] "dst"
[6] "pd"
>

"eset"
"files"
"rawAffyData"
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To save the current workspace within the current directory (it is OK to save it within the
estrogen R package) follow command below. Here the chosen name reflects that RMA
has already been applied and is underlined in the list below.)
> save.image("estrogenRMA.RData")
> dir()
[1]
[4]
[7]
[10]
[13]

"EstrogenTargets.txt"
"estrogenRMA.RData"
"high48-1.cel"
"low10-2.cel"
"phenoData.txt"

"bad.cel"
"high10-1.cel"
"high48-2.cel"
"low48-1.cel"
"targLimma.txt"

"estrogen.txt"
"high10-2.cel"
"low10-1.cel"
"low48-2.cel"

IF you now quit R and restart it, this is how you reload the saved data:
Quit R: Either type q() and answer no, or use menu File > Exit
restart R
> setwd(system.file("extdata",package="estrogen"))
> load("estrogenRMA.RData")
> ls()
[1] "dst"
"eset"
"files"
"hh"
"mapCdfName"
[6] "pd"
"rawAffyData"
>

3.11 Saving analyzed data into table(s)
For this section, it may be worth switching the current working directory to the desktop
to more easily recover or copy the saved data.
For example (UWBC is the name of MY computer…. Adjust
to your desktop!)
> setwd("C:/Documents and

Settings/UWBC/Desktop")
Or with the Windows GUI: File > Change dir…, then click
browse and select Desktop.
To write the exprs expression values of eset to a text table:
> write.exprs(eset,file="Estrogen-RMA.txt")
The data has now been normalized and summarized into a single number for each gene
and saved into a table. This format could be used for analyzes within Excel (not covered
here.)
The R object eset containing the same data can also be further analyzed by other
packages to perform statistical analyses on these results for example with the
multtest package, which we shall not see here however. In the next lab we will
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explore another package that can help sort the differentially expressed genes called
limma.
In the mean time, we can have a little fun with the current data, even if at this level it is
not completely clear if the results will be relevant either statistically or biologically.

4. Plots and output results on our RMA set
Note: The following exercise is based on the estrogen package vignette. Their
expression set was calculated with expresso() and vsn (see special section on
normalization above). Therefore our results here will be different than those in the
vignette.

4.1 Heatmap
This exercise calls upon function rowSds() which is part of the package genefilter
that is installed with the full BioConductor set. This is a very simple function that
calculates a simple standard deviation on each row of data (each row represents one
gene, while the columns would represent the chips.) Typing the command rowSds
(without the parentheses) at the R prompt > will reveal the very simple formula used to
calculate these standard deviations values. Since we have a small number of replicates,
the statistical value of these standard deviations may be questioned.
Select 50 genes with the highest variation (standard deviation) across chips:
> library(genefilter)
> rsd <- rowSds(exprs(eset))
> selection <- order(rsd,
decreasing = TRUE)[1:50]
> heatmap(exprs(eset)[selection, ])
The replicates cluster together. Indeed the
default clustering function is hclust(), the
same function we used during some diagnostic
data analysis earlier.
Note: defaults colors are heat.colors
probably with default of 256 colors. Other
options are:
rainbow
terrain.colors(n)
topo.colors(n)
cm.colors(n)
where n is a number >= 1 (e.g. 256)
Note: it may be necessary to resize the graphical window to render visible the sample
names at the bottom row.
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The following images result form the color variations:
>
>
>
>

heatmap(exprs(eset)[selection,
heatmap(exprs(eset)[selection,
heatmap(exprs(eset)[selection,
heatmap(exprs(eset)[selection,

rainbow(256):
see ?rainbow for
all options.

terrain.colors(256
)

green, salmon,
yellow

],
],
],
],

col
col
col
col

=
=
=
=

rainbow(256))
terrain.colors(256))
topo.colors(256))
cm.colors(256))

topo.colors(256)

:
purple, blue, cyan,
green, yellow

cm.colors(256)
: cyan and
magenta

4.2 ANOVA
ANOVA is short for ANalysis Of VAriance. Our eset dataset is an R expression set, for
which we have one measurement per gene on each chip after we have applied RMA.
The average of the 2 replicates can provide an estimate of the mean value for this gene.
The question is: can the mean value for this same gene in different conditions (e.g.
with estrogen added and therefore on another set of chips) be considered different or
similar to that of the original condition (e.g. no estrogen added)?
A linear model can be set up with main effects for the level of estrogen and time.
In R a simple linear model for the x and y variables can be calculated with the simple
formula: (R for beginners, E. Paradis):
mod <- lm(y ~ x)
def.residual(mod)

linear regression placed in R object mod
returns the number of residual degrees of
freedom

In the original phenoData these would be under the estrogen and time.h variables,
each with 2 levels of values for 4 possible combinations. Our modified phenoData file
"EstrogenTargets.txt" offers 4 levels within a single column named “Target” and is
therefore equivalent.
The estrogen vignette formula can be rewritten as:
> lm.coef <- function(y) lm(y ~ pd$Target)$coefficients
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> eff <- esApply(eset, 1, lm.coef)
This may take 2 to 5 minutes to compute. You can ignore the warnings if any.
For each gene we obtain the fitted coefficient for main effect and interaction:
> dim(eff)
[1]
4 12625
We can note that there are 4 levels for each of the 12625 rows of genes. These are the
4 levels taken from the Target column in the phenoData info. The first 2 rows are
renamed (Intercept) and serve as the baseline.
eff is therefore a table with 4 rows and 12625 columns.
> rownames(eff)
[1] "(Intercept)"
"pd$TargetEstAbsent48"
"pd$TargetEstPresent10"
[4] "pd$TargetEstPresent48"

>
The name of the genes as defined by Affymetrix (probe names) can be placed in a
separate R object:
> affyids <- colnames(eff)
We can list all of them (12625) by simply typing the name of the R object affyids, or
we can simply list the first and last 10 with the following commands:
> affyids[1:10]
[1] "1000_at"
"1005_at"
[7] "1006_at"

"1001_at"

"1002_f_at" "1003_s_at" "1004_at"

"1007_s_at" "1008_f_at" "1009_at"

> affyids[12615:12625]
[1] "AFFX-ThrX-3_at"
[4] "AFFX-TrpnX-3_at"
[7] "AFFX-YEL002c/WBP1_at"
YEL021w/URA3_at"
[10] "AFFX-YEL024w/RIP1_at"

"AFFX-ThrX-5_at"
"AFFX-TrpnX-5_at"
"AFFX-YEL018w/_at"

"AFFX-ThrX-M_at"
"AFFX-TrpnX-M_at"
"AFFX-

"AFFX-hum_alu_at"

Note: the AFFX names reflect internal Affymetrix reporter genes.
We can now map the gene probe names to actual gene names with the help of the
library specific to that chip set:

Note: R is constantly evolving, and so are the packages.
# > library(hgu95av2) used to be the correct command
Starting with R.2.7 a “depreciation” warning appeared. This meant that in the
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near future the command would no longer work.
In R.2.7.1:
> library(hgu95av2)
******* Deprecation warning *******:
The package 'hgu95av2' is deprecated and will not be supported in the
future.
[...]

Now in R.2.9.0 there is no longer a warning:
> library(hgu95av2)
Error in library(hgu95av2) : there is no package called
'hgu95av2'
>
Solution: install the new package suggested during the depreciation period
with a similar name with .db added:
> source("http://bioconductor.org/biocLite.R")
> biocLite("hgu95av2.db")
However, this new package is now part of the default biocLite installation and
one only needs to issue the command as:
> library(hgu95av2.db)
> library(hgu95av2.db)
Loading required package: AnnotationDbi
Loading required package: DBI
>
> ls("package:hgu95av2.db")
[1]
[4]
[7]
[10]
[13]
[16]
[19]
[22]
[25]
[28]
[31]
[34]
>

"hgu95av2"
"hgu95av2_dbInfo"
"hgu95av2ALIAS2PROBE"
"hgu95av2CHRLOC"
"hgu95av2ENSEMBL2PROBE"
"hgu95av2ENZYME2PROBE"
"hgu95av2GO2ALLPROBES"
"hgu95av2MAPCOUNTS"
"hgu95av2PATH"
"hgu95av2PMID"
"hgu95av2REFSEQ"
"hgu95av2UNIPROT"

"hgu95av2_dbconn"
"hgu95av2_dbschema"
"hgu95av2CHR"
"hgu95av2CHRLOCEND"
"hgu95av2ENTREZID"
"hgu95av2GENENAME"
"hgu95av2GO2PROBE"
"hgu95av2OMIM"
"hgu95av2PATH2PROBE"
"hgu95av2PMID2PROBE"
"hgu95av2SYMBOL"

"hgu95av2_dbfile"
"hgu95av2ACCNUM"
"hgu95av2CHRLENGTHS"
"hgu95av2ENSEMBL"
"hgu95av2ENZYME"
"hgu95av2GO"
"hgu95av2MAP"
"hgu95av2ORGANISM"
"hgu95av2PFAM"
"hgu95av2PROSITE"
"hgu95av2UNIGENE"

Estrogen main effect (according to our RMA data,) will be different than the vignette
because they calculated with different parameters.
Let’s print the top 10 genes with the largest effect in one direction (highest) and the
other (lowest). The names are then matched with the actual gene name. The command
rownames() (repeated here) shows which data are in which column. For estrogen
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effect we can look in the 3rd column ("TargetEstPresent10") with the subset
written as eff[3, ] rather than eff[2, ] as it is written in the vignette:
> rownames(eff)
[1] "(Intercept)"
"pd$TargetEstAbsent48"
"pd$TargetEstPresent10"
[4] "pd$TargetEstPresent48"
>
> lowest <- sort(eff[3, ], decreasing = FALSE)[1:10]
Above we placed the first 10 lowest values in the R object called lowest. Below we
use the command mget() to fetch the actual gene name from the GENENAME section
of the hgu95av2 annotation package:
> mget(names(lowest), hgu95av2GENENAME)
$`37294_at`
[1] "B-cell translocation gene 1, anti-proliferative"
$`846_s_at`
[1] "BCL2-antagonist/killer 1"
$`34363_at`
[1] "selenoprotein P, plasma, 1"
$`38551_at`
[1] "L1 cell adhesion molecule"
$`36634_at`
[1] "BTG family, member 2"
$`1913_at`
[1] "cyclin G2"
$`34964_at`
[1] "histone cluster 1, H3d"
$`39827_at`
[1] "DNA-damage-inducible transcript 4"
$`40767_at`
[1] "tissue factor pathway inhibitor (lipoprotein-associated coagulation inhibitor)"
$`35803_at`
[1] "Rho family GTPase 3"

We then do the same calculation with “highest” instead:
> highest <- sort(eff[3, ], decreasing = TRUE)[1:10]
> mget(names(highest), hgu95av2GENENAME)
$`910_at`
[1] "thymidine kinase 1, soluble"
$`39642_at`
[1] "elongation of very long chain fatty acids (FEN1/Elo2, SUR4/Elo3, yeast)-like 2"
$`38827_at`
[1] "anterior gradient homolog 2 (Xenopus laevis)"
$`31798_at`
[1] "trefoil factor 1"
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$`1884_s_at`
[1] "proliferating cell nuclear antigen"
$`1536_at`
[1] "cell division cycle 6 homolog (S. cerevisiae)"
$`40117_at`
[1] "minichromosome maintenance complex component 6"
$`1854_at`
[1] "v-myb myeloblastosis viral oncogene homolog (avian)-like 2"
$`36134_at`
[1] "olfactomedin 1"
$`1505_at`
[1] "thymidylate synthetase"

Finally effect of both time and estrogen together with eff[4, ] (corresponds to
"TargetEstPresent48")
> hist(eff[4, ], breaks = 100, col = "yellow", main =
"estrogen:time interaction")

> highia <- sort(eff[4, ], decreasing = TRUE)[1:10]
> mget(names(highia), hgu95av2GENENAME)
$`31798_at`
[1] "trefoil factor 1"
$`39969_at`
[1] "histone cluster 1, H4c"
$`1854_at`
[1] "v-myb myeloblastosis viral oncogene homolog (avian)-like 2"
$`910_at`
[1] "thymidine kinase 1, soluble"
$`36134_at`
[1] "olfactomedin 1"
$`33371_s_at`
[1] "RAB31, member RAS oncogene family"
$`1884_s_at`
[1] "proliferating cell nuclear antigen"
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$`41400_at`
[1] "thymidine kinase 1, soluble"
$`947_at`
[1] "minichromosome maintenance complex component 7"
$`1055_g_at`
[1] "replication factor C (activator 1) 4, 37kDa"

Next lab: Differentially expressed genes with Limma from the data analyzed here.

5. END of SESSION
-------------------------

---------------------------
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Notes
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Within the text, user input is shown as bold text or command
Acknowledgment:
Source material: James Wettenhall,
http://bioinf.wehi.edu.au/marray/ibc2004/
Gene filter section adapted from Massimiliano Gentile, BBU
“Identifying differentially expressed genes, 3.4.2007”
http://www.giu.fi/Default.aspx?tabid=249
BioMart section adapted from R news by Steffen Durinck
http://www.r-project.org/doc/Rnews/Rnews_2006-5.pdf

Page - 82 -

R and Bioconductor- Limma.

Table of Contents
1.

Setup .............................................................................................................................................84
1.1

2.

Required software............................................................................................................................. 84

Estrogen data set ........................................................................................................................85
2.1 setting the PATH ................................................................................................................................ 86
2.2 Previously calculated estrogen RMA data................................................................................. 86
2.2.1 Reloading the previous RMA data .........................................................................................................86
2.2.2 Recreating the RMA data ...........................................................................................................................86

3.

Limma package: LInear Models for MicroArray data ....................................................87
3.1 Summary of package and methods.............................................................................................. 87
3.2 defining a design matrix.................................................................................................................. 88
3.2.1 Preliminary R notion: factor.....................................................................................................................88
3.2.2 Building the design matrix........................................................................................................................89
3.3 Fitting the linear model................................................................................................................... 92
3.4 Defining a contrasts matrix............................................................................................................ 92
3.5 Fitting a linear model to the contrasts ....................................................................................... 96
3.6 Empirical Bayes statistics ............................................................................................................... 96

4.

Summary .......................................................................................................................................98

5.

Exporting Results .......................................................................................................................99
5.1 Displaying and saving table(s) of differentially expressed genes .................................... 99
5.2 Histogram, MAplots.......................................................................................................................102
5.2.1 p‐values histogram.................................................................................................................................... 102
5.2.2 significant genes and MA‐plot .............................................................................................................. 103
5.3 Displaying table(s) of differentially expressed genes.........................................................105
5.4 MA plots using contrasts from the linear model...................................................................110
5.5 Venn diagrams using contrasts from the linear model ......................................................112

6.

Gene filtering .......................................................................................................................... 114
6.1
6.2

7.

Present / Absent call ......................................................................................................................115
Filtering out uninteresting data .................................................................................................115

biomaRt ...................................................................................................................................... 117
7.1
7.2
7.3
7.4
7.5
7.6
7.7
7.8

Install the biomaRt package: .......................................................................................................118
ensembl...............................................................................................................................................118
Listing what is available within the ensembl database (R object ensmart) : ...........119
We tell R to restrict our search with the human genome: .................................................120
We need to know which Affymetrix chips are known: .......................................................120
Obtaining gene annotation for the “top 30:” ..........................................................................121
Retrieving sequence information: .............................................................................................122
Retrieving GO information:..........................................................................................................123

8.

Before we go.............................................................................................................................. 126

9.

Acknowledgements ................................................................................................................ 127

10.

End of lab ............................................................................................................................... 127

Page - 83 -

R and Bioconductor- Limma.

1. Set-up
These exercises are set-up for the BTCI Windows machines, with R version 2.11.1 or
later.
R may be available as a shortcut icon on the desktop
R should also be available
as the usual
Start > All Programs
menu cascade. Shown
here for R 2.9.0
The following section lists the required software and packages. In this way you can
configure your own system with the necessary elements.

1.1 Required software
Note: Current versions: R: 2.11.1 (June 2010), BioConductor: 2.6 for R2.11.x
(There is a new release every 6 months approximately.)
Required software for these exercises: (see install section, Part 0)
R version 2.11.1 or later.
BioConductor packages: affy, affydata , affyPLM, Biobase, estrogen, hgu95av2cdf,
hgu95av2probes, gcrma, matchprobes.
(info at http://www.bioconductor.org/packages/bioc/)
1.1. INSTALLING Required software
R and BioConductor are already installed on these computers. To install on your own
system refer to the Installation instructions Part 0.
To know whether a package is installed, you can use the GUI specific to your computer
system, or the standard command which works on all systems:
> installed.packages()
affy
affydata
affyio
affyPLM
[. . . ]

Package
"affy"
"affydata"
"affyio"
"affyPLM"

LibPath
"C:/PROGRA~1/R/R-29~1.0/library"
"C:/PROGRA~1/R/R-29~1.0/library"
"C:/PROGRA~1/R/R-29~1.0/library"
"C:/PROGRA~1/R/R-29~1.0/library"

The resulting list will show all the packages available on this computer.
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Important note: this is different than search() which displays the packages that have
previously been loaded with the function library() such as library(affy) for
example. This only loads the package in RAM (computer memory) for this session only.
One of the required packages is not yet installed on the lab computers and need to be
installed. The simplest way to install a package is by line-command as we have seen
previously.
Please do the following:
Launch R from the R icon on the desktop or the Start menu.
At the > prompt type the following commands:
> source("http://bioconductor.org/biocLite.R")
> biocLite("statmod")
Running biocinstall version 2.4.10 with R version 2.9.0
Your version of R requires version 2.4 of Bioconductor.
trying URL 'http://cran.fhcrc.org/bin/windows/contrib/2.9/statmod_1.4.0.zip'
Content type 'application/zip' length 213569 bytes (208 Kb)
opened URL
downloaded 208 Kb
package 'statmod' successfully unpacked and MD5 sums checked
The downloaded packages are in
C:\Documents and Settings\Administrator\Local
Settings\Temp\RtmpOtAl0x\downloaded_packages
updating HTML package descriptions

Reinstalling packages that were used in the previous lab: if the list obtained with the
command installed.packages()does not contain the packages installed in the
previous lab (hgu95av2probe, hgu95av2cdf, estrogen) they need to be re-installed with
the following commands:
>
>
>

biocLite("hgu95av2probe")
biocLite("hgu95av2cdf")
biocLite("estrogen")

2. Estrogen data set1
In this lab we will continue to analyze the estrogen dataset that was analyzed with RMA
previously, or we shall recalculate this set if necessary.
See the section on the Estrogen data set on the previous lab for more details on the
experiment setting and on the organization of the data.
1

Scholtens D, Miron A, Merchant F, Miller A, Miron P, Iglehart JD, Gentleman R. Analyzing factorial
designed microarray experiments. Journal of Multivariate Analysis, 2004; 90(1): 19-43.
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2.1

setting the PATH

Type the following commands at the > prompt to change the R > prompt PATH to the
extdata subdirectory of the estrogen R package:
> setwd(system.file("extdata",package="estrogen"))
> getwd()
> dir()

2.2

Previously calculated estrogen RMA data

There are 2 options: either you can load the file that was previously calculated and
saved in the previous lab or you can recalculate the RMA data again:
2.2.1 Reloading the previous RMA data
Check if the file R workspace file "estrogenRMA.RData" exists within this directory (it
would have been calculated during the previous lab and saved with save.image() in
the section “Saving R workspace”).
If you trust that this is the file you created, simply reload it within R as follows:
> load("estrogenRMA.RData")
> ls()
[1] "eset"
"pd"
"rawAffyData"
> library(affy)
The alternative is to recreate the file (the safest method if you are unsure,) see below.
2.2.2 Recreating the RMA data
This assumes that all the required packages are available (see previous section on setup and installation.)
Important: the current directory should be “extdata” as set above with setwd(). If the
estrogen package was overwritten, it may be necessary to download again the file
"EstrogenTargets.txt" with download.file() from the given Internet address:
>download.file("http://genic.biotech.wisc.edu/R/MATERIALS/DATA/E
strogenTargets.txt","EstrogenTargets.txt")
> dir()
[1] "EstrogenTargets.txt" "bad.cel" "estrogen.txt"

"high10-1.cel"

etc.
> library(affy)
> pd <- read.AnnotatedDataFrame("EstrogenTargets.txt",
header=TRUE,row.names=1)
> files <- paste("",pd$FileName,sep="")
> rawAffyData <- ReadAffy(filenames=files)
> eset <- rma(rawAffyData)
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The few lines above in essence summarize the process followed in the previous lab.
We can now save the R workspace in case the computer crashes, we would just need
to reload the file as in the previous section to come back to this point:
> save.image("estrogenRMA.RData")
> dir()
[1]
[4]
[7]
[10]
[13]

"bad.cel"
"EstrogenTargets.txt"
"high48-1.cel"
"low10-2.cel"
"phenoData.txt"

"estrogen.txt"
"high10-1.cel"
"high48-2.cel"
"low48-1.cel"
"targLimma.txt"

"estrogenRMA.RData"
"high10-2.cel"
"low10-1.cel"
"low48-2.cel"

We are now ready to start with the limma package.

3. Limma package: LInear Models for MicroArray data
3.1

Summary of package and methods

From the package vignette: “Limma is an R package for the analysis of gene expression
microarray data, especially the use of linear models for analysing designed experiments and the
assessment of differential expression. Limma provides the ability to analyse comparisons
between many RNA targets simultaneously in arbitrary complicated designed experiments.
Empirical Bayesian methods are used to provide stable results even when the number of arrays
is small. The normalization and data analysis functions are for two-color spotted microarrays.
The linear model and differential expression functions apply to all microarray technologies
including Affymetrix and other single-channel oligonucleotide platforms.”

The complete 88 pages user’s guide for the current install can be called with the the
following command:
> library(limma)
> limmaUsersGuide()
(note that you may have to press return twice)
Chapter 2 specifies how limma should be cited in published research. Please support
open-source, free software by using the appropriate citations!
Linear model overview (excerpts from chapter 7 of limma user’s guide):
“The package limma uses an approach called linear models to analyze designed
microarray experiments. This approach allows very general experiments to be analyzed
just as easily as a simple replicated experiment. […] The approach requires one or two
matrices to be specified. The first is the design matrix which indicates in effect which
RNA samples have been applied to each array. The second is the contrast matrix which
specifies which comparisons you would like to make between the RNA samples. For
very simple experiments, you may not need to specify the contrast matrix.”
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The first step is to estimate the variability of the data, which helps distinguish
experimental results from random variation. The model is specified by the design matrix:
each row corresponds to an array, and each column has a coefficient describing the
RNA source, one coefficient for each RNA source. The contrast matrix then serves as a
method to compare the initial coefficients amongst themselves, thus providing a method
of comparison for various question formulations.
For Affymetrix data, the linear modeling is the same as ordinary analysis of variance
(ANOVA) or multiple regression, but here the model is fitted for every gene.
Once the linear model is in place, the statistical analysis is carried by “empirical Bayes
method to moderate the standard error of the estimated log-fold change. This results in
more stable inference and improved power, especially for experiments with small
numbers of arrays.”
“Affymetrix data will usually be normalized using the affy package and rma().”

3.2

defining a design matrix
3.2.1 Preliminary R notion: factor

A vector simply contains numeric, character, logical or complex numbers. A factor
includes not only values of the corresponding categorical variable, but also the different
possible levels of that variable (even if they are not present in the data). Type ?factor
for details on all options.
Examples:
> factor(1:3)
[1] 1 2 3
Levels: 1 2 3
> factor(1:3, levels=1:5)
[1] 1 2 3
Levels: 1 2 3 4 5
> factor(1:3,
labels=c("A","B","C"))
[1] A B C
Levels: A B C
> factor(1:5, exclude=4)
[1] 1 2 3 <NA> 5
Levels: 1 2 3 5
> a<- sequence(1:5)
> a
[1] 1 1 2 1 2 3 1 2 3 4 1 2 3 4 5
> factor(a)
[1] 1 1 2 1 2 3 1 2 3 4 1 2 3 4 5
Levels: 1 2 3 4 5
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3.2.2 Building the design matrix
Because Affymetrix chips are single channel (one color) designing a matrix is easier
than for 2-color arrays.
We have used an RNA Targets file (file named "EstrogenTargets.txt" in tabdelimited text to describe the estrogen experiment:
Name
Abs10.1
Abs10.2
Pres10.1
Pres10.2
Abs48.1
Abs48.2
Pres48.1
Pres48.2

FileName
low10-1.cel
low10-2.cel
high10-1.cel
high10-2.cel
low48-1.cel
low48-2.cel
high48-1.cel
high48-2.cel

Target
EstAbsent10
EstAbsent10
EstPresent10
EstPresent10
EstAbsent48
EstAbsent48
EstPresent48
EstPresent48

Note: Difference(s) with R 2.4 and BioConductor 1.9 with R 2.5 and BioConductor 2.0

This information was carried into the eset R object along the successive steps that were taken: this
“Targets” file was first read into R with read.phenoData in an object called pd.Then we included the
same information in our rawAffyData object (of class AffyBatch), by using the phenoData argument
of the ReadAffy() function to read-in the pd object. We then created an object of class exprSet with
rma, and during this process the phenotype data (i.e. the RNA Targets table) was automatically included
in our eset object (of class exprSet). Thus the “Targets” information can be recovered using, for
example, the pData method of the exprSet class with the following command:
In R 2.4 and Bioconductor 1.9:
> targets <- pData(eset)
> targets
FileName
Target
Abs10.1
low10-1.cel EstAbsent10
Abs10.2
low10-2.cel EstAbsent10
Pres10.1 high10-1.cel EstPresent10
Pres10.2 high10-2.cel EstPresent10
Abs48.1
low48-1.cel EstAbsent48
Abs48.2
low48-2.cel EstAbsent48
Pres48.1 high48-1.cel EstPresent48
Pres48.2 high48-2.cel EstPresent48

In R 2.5 and BioConductor 2.0:
> targets <- pData(eset)
> targets
sample
low10-1.cel
1
low10-2.cel
2
high10-1.cel
3
high10-2.cel
4
low48-1.cel
5
low48-2.cel
6
high48-1.cel
7
high48-2.cel
8

(If pData is not found, just load affy with command library(affy).
R 2.9.0 behaves in the same way as R.2.5

The information about the “Targets” was given earlier from object pd (short for phenol
data.) This can be recalled with:
> pd@data
FileName
Target
Abs10.1
low10-1.cel EstAbsent10
Abs10.2
low10-2.cel EstAbsent10
Pres10.1 high10-1.cel EstPresent10
Pres10.2 high10-2.cel EstPresent10
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Abs48.1
low48-1.cel EstAbsent48
Abs48.2
low48-2.cel EstAbsent48
Pres48.1 high48-1.cel EstPresent48
Pres48.2 high48-2.cel EstPresent48
> targets <- pd@data
We have four pairs of replicate arrays, each with
a single channel. A linear model will therefore
need to estimate four parameters (one for each
set of replicates.) Hence the design matrix should
have four columns and the rows should describe
the four pairs of replicate arrays. The four
columns of the matrix correspond to
EstAbsent10, EstPresent10, EstAbsent48
and EstPresent48 respectively.
Note that this notation can accommodate replicate series with different number of
replicates.
The matrix can be defined in R starting with model.matrix() from package stats:
> find("model.matrix") # Note quotes ”” were not required with R
2.4!
[1] "package:stats"
Let’s create an R object called design and take the name from the targets object
created above from object pd:
> design <- model.matrix(~ -1 +
factor(targets$Target,levels=unique(targets$Target)))
> design
factor(targets$Target, levels = unique(targets$Target))EstAbsent10 factor(targets$Target, levels = unique(targets$Target))EstPresent10
1
0
1
0
0
1
0
1
0
0
0
0
0
0
0
0
factor(targets$Target, levels = unique(targets$Target))EstAbsent48 factor(targets$Target, levels = unique(targets$Target))EstPresent48
1
0
0
2
0
0
3
0
0
4
0
0
5
1
0
6
1
0
7
0
1
8
0
1
attr(,"assign")
[1] 1 1 1 1
attr(,"contrasts")
attr(,"contrasts")$`factor(targets$Target, levels = unique(targets$Target))`
[1] "contr.treatment"
1
2
3
4
5
6
7
8

>
If you can make your R console large enough you might be able to see 2 columns side
by side. Otherwise the printout will show one column at a time.
The following commands will help to change the long names from e.g.
“factor(targets$Target,levels=unique(targets$Target))EstAbsent10”
into the simpler and shorter version: “EstAbsent10.”
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In the next steps we shall change the name of each column (which is very long as we
have just seen) with the names from the original file.
The column “Target” in the object targets created earlier contains these names, but in
duplicates, one for each duplicate chip. The function unique()skips duplicate names:
> targets$Target
[1] EstAbsent10 EstAbsent10 EstPresent10 EstPresent10
EstAbsent48
[6] EstAbsent48 EstPresent48 EstPresent48
Levels: EstAbsent10 EstAbsent48 EstPresent10 EstPresent48
> unique(targets$Target)
[1] EstAbsent10 EstPresent10 EstAbsent48 EstPresent48
Levels: EstAbsent10 EstAbsent48 EstPresent10 EstPresent48
We can now place the names into the section “colnames” of object design with a
single command inspired from the above tests:
> colnames(design) <- unique(targets$Target)
We can now reprint the design matrix. It is indeed easier to recognize it with shorter
columns.
> design
EstAbsent10 EstPresent10 EstAbsent48 EstPresent48
1
1
0
0
0
2
1
0
0
0
3
0
1
0
0
4
0
1
0
0
5
0
0
1
0
6
0
0
1
0
7
0
0
0
1
8
0
0
0
1
attr(,"assign")
[1] 1 1 1 1
attr(,"contrasts")
attr(,"contrasts")$`factor(targets$Target, levels =
unique(targets$Target))`
[1] "contr.treatment"

Other parameters can also be defined: Let’s create the R object numParameters to
contain the number of columns of the design matrix (design contains 4 columns.) In
addition, the R object parameterNames will contain the name of the columns:
> numParameters <- ncol(design)
> numParameters
[1] 4
> parameterNames <- colnames(design)
> parameterNames
[1] "EstAbsent10" "EstPresent10" "EstAbsent48" "EstPresent48"
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3.3

Fitting the linear model

The model will be contained in the R object called “fit” and calculated by the limma
function lmFit() applied to the eset data with the design matrix called design. (See
help(lmFit) for more details.)
> fit <- lmFit(eset,design=design)
> names(fit)
[1] "coefficients"
"rank"
[4] "qr"
"df.residual"
[7] "cov.coefficients" "stdev.unscaled"
[10] "genes"
"Amean"
[13] "design"

"assign"
"sigma"
"pivot"
"method"

fit is a standard R list and its components can be accessed with the $ operator, for
example:
> fit$cov.coefficients
EstAbsent10 EstPresent10 EstAbsent48 EstPresent48
EstAbsent10
0.5
0.0
0.0
0.0
EstPresent10
0.0
0.5
0.0
0.0
EstAbsent48
0.0
0.0
0.5
0.0
EstPresent48
0.0
0.0
0.0
0.5
Some of the items can be quite long, for example df.residual contains the number
of degrees of freedom (df) for each gene and is therefore a list of 12625 numbers (each
equal to 4.) 12625 is the number of genes on this particular brand of Affymetrix chip.
Amean is the average log intensity across all experiments and later used for MA plots.
We can print the first 5 just to see:
> fit$Amean[1:5]
100_g_at
1000_at
9.555474 10.147100
>

3.4

1001_at 1002_f_at 1003_s_at
5.957489 5.564548 7.994831

Defining a contrasts matrix

In the simplest terms, “contrasts” are simply pair-wise comparisons between two series,
for example between “present at 10 hours” and “absent at 10 hours,” or any other pairwise one might be interested in.
In more statistical terms, “contrasts” are linear combinations of parameters from the
linear model fit and can be defined with the following elements:

βg = C αg .
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The linear model fit, calculated for each gene, estimated log fold changes. These values
are combined together in a vector called

αg .

C is the contrast matrix, and βg is a vector of contrasts for gene g.
The purpose of the contrast matrix simply defines the set of chips that have to be
compared to each other. Therefore the contrast matrix is creating to fit this purpose and
its final contents will depend on which comparisons one wants to make.
In this exercise, we will create a contrast matrix that allows 3 comparisons (or contrasts)
and therefore the matrix will have 3 columns. The rows will correspond to
EstAbsent10 EstPresent10 EstAbsent48 EstPresent48.
The first contrast will be a comparison between the effect of estrogen at time 10 hours
as compared to no estrogen (estrogen absent.) For this purpose, we will choose 2
opposite numbers for EstAbsent10 and EstPresent10, and assign the value of zero
to the other 2 sets which are at 48 hours. Therefore the 48 hours measurements will not
count in this comparison. Thus the first column of the matrix will be: -1, 1, 0, 0.
The second contrast will be the effect of estrogen at 48 hours, as compared to absent
estrogen also at 48 hours. We will therefore not count the 10 hours data and assign
them a zero factor. Following the same nomenclature, the second matrix column will be:
0, 0, -1, 1.
The third and final contrast will be simply the effect of time in the absence of estrogen.
Therefore we want to compare EstAbsent10 with EstAbsent48 and give a value of
zero to the experiments that do contain estrogen. The 3rd column will be: -1, 0, 1, 0
Writing each of these columns side by
side will create the contrast matrix C.

C thus represents the following rows and columns:
CONTRAST
MATRIX
EstAbsent10
EstPresent10
EstAbsent48
EstPresent48

Contrast 1
(Estrogen at
10h)
-1
1
0
0

Contrast 2
(Estrogen at
48h)
0
0
-1
1

Contrast 3
(Time effect)
-1
0
1
0

We could write the contrast matrix one column at a time, and “gluing” them together
with the function cbind():
> c1 <- c(-1, 1, 0, 0)
> c1
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[1] -1 1 0 0
> c2 <- c(0, 0, -1, 1)
> c2
[1] 0 0 -1 1
> c3 <- c(-1, 0, 1, 0)
> c3
[1] -1 0 1 0
The capital C letter is an R function of the stats package, therefore we cannot simply
call our matrix “C” as in the formula above, we will call it instead “CM,” short for
Contrast Matrix:
> CM <- cbind (c1,c2,c3)
> CM
c1 c2 c3
[1,] -1 0 -1
[2,] 1 0 0
[3,] 0 -1 1
[4,] 0 1 0
How would the formula

βg = C αg apply to one gene?

We know that each gene is represented by one averaged number within each set of
experiments (average of duplicates in each set.) We can picture the results of the
experiments as a large table with the gene names in the first row and the experimental
results in the next 4 columns. The columns are ordered by experiment as
EstAbsent10, EstPresent10, EstAbsent48 and EstPresent48. Therefore for
gene “g” we could represent it’s averaged values with the following “made-up” numbers
for easy illustration in each category as:
Gene name
g

EstAbsent10
10

EstPresent10
20

EstAbsent48
100

EstPresent48
200

We can assign these test numbers to object g in the following way:
> g <- c(10,20,100,200)
Applying the formula

βg = C αg would look like:

> g * CM
c1
c2 c3
[1,] -10
0 -10
[2,] 20
0
0
[3,]
0 -100 100
[4,]
0 200
0
>
The resulting matrix would contain, by column, the numbers that have to be compared
to each other, and zeros in the rows that are not relevant for the comparison.
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If we remember that the number of rows for the contrast matrix is equal to the number of
columns for the design matrix, the contrast matrix can also be written in a more
straightforward manner using a more formal method with the following R command:
> ncol(design)
[1] 4
> contrastsMatrix <- matrix(c(-1,1,0,0,0,0,-1,1,-1,0,1,0),
nrow=ncol(design))
The argument nrow= defines the number of rows, or lines, for the matrix. The value is
calculated by the function ncol() from the number of columns of object design
defined previously, and we have already seen that this value is 4. The number of
columns is inferred from the number of rows that we assign here and the numbers
printed within the c() function.
> contrastsMatrix
[,1] [,2] [,3]
[1,]
-1
0
-1
[2,]
1
0
0
[3,]
0
-1
1
[4,]
0
1
0
We now need to create headers for the rows and columns of the contrast matrix.
Therefore most of what follows is one way in R to manipulate character data. In one
case we will add a dash (-) as a name separator (sep = "-") and therefore the
command is a bit long. We defined parameterNames above, from the names of the
design matrix ( parameterNames <- colnames(design) )
> parameterNames
[1] "EstAbsent10"

"EstPresent10" "EstAbsent48"

"EstPresent48"

Using a subsetting notation we can call any of the names within the list, for example
let’s print the second one:
> parameterNames[2]
[1] "EstPresent10"
We now simply add a dash "-" between each of the elements.
(Note: we could as well have chosen any character for separating the 2 names. For
example we could have chosen the forward slash (“/”) instead of the dash.)
> contrastNames <- c(paste(parameterNames[2],parameterNames[1],
sep="-"),paste(parameterNames[4],parameterNames[3],sep="-"),
paste(parameterNames[3],parameterNames[1],sep="-"))
>
> contrastNames
[1] "EstPresent10-EstAbsent10" "EstPresent48-EstAbsent48"
[3] "EstAbsent48-EstAbsent10"
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>
> rownames(contrastsMatrix) <- parameterNames
>
> colnames(contrastsMatrix) <- contrastNames
>
> contrastsMatrix
EstAbsent10
EstPresent10
EstAbsent48
EstPresent48

EstPresent10-EstAbsent10 EstPresent48-EstAbsent48 EstAbsent48-EstAbsent10
-1
0
-1
1
0
0
0
-1
1
0
1
0

The matrix numbers are the same, but now we have named the rows and columns.

3.5

Fitting a linear model to the contrasts

> fit2 <- contrasts.fit(fit,contrasts=contrastsMatrix)
> names(fit2)
[1] "coefficients"
[5] "df.residual"
"stdev.unscaled"
[9] "genes"
[13] "contrasts"

3.6

"rank"
"sigma"

"assign"
"qr"
"cov.coefficients"

"Amean"

"method"

"design"

Empirical Bayes statistics

In 1763, the Reverend Thomas Bayes published an article entitled “An
Essay towards Solving a Problem in the Doctrine of Chances” 2 and had a
profound effect on the science of the next 250 years.

From Wikipedia: Bayes's theorem tells how to update or revise beliefs in light of
new evidence: a posteriori. [...] evidence or observations are used to update or to
newly infer the probability that a hypothesis may be true.
http://en.wikipedia.org/wiki/Bayes%27_theorem and
http://en.wikipedia.org/wiki/Bayesian_statistics

Bayes’s theorem can be paraphrased as
posterior = standardized likelihood x prior

In words: the posterior probability is proportional to the prior probability times
the likelihood.
In non-technical usage, "likelihood" is a synonym for "probability".
http://en.wikipedia.org/wiki/Likelihood_function

In a sense, likelihood works backwards from probability: given parameter B, we
2

T. Bayes. An essay toward solving a problem in the doctrine of chances. Philosophical Transactions of
the Royal Society, 53:370-418, 1763 – Note: reprinted in 1764, and in 1958 in Biometrica 45:293-298

http://www.stat.ucla.edu/history/essay.pdf
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use the conditional probability P(A|B) to reason about outcome A, and given
outcome A, we use the likelihood function L(B|A) to reason about parameter B.
This mode of reasoning is formalized in Bayes' theorem:

In R, it simply means that we will apply the limma function eBayes() to the R object
fit2 and rewrite the new calculations within the same object:
> fit2 <- eBayes(fit2)
> names(fit2)
[1]
[4]
[7]
[10]
[13]
[16]
[19]
[22]

"coefficients"
"qr"
"cov.coefficients"
"Amean"
"contrasts"
"var.prior"
"t"
"F"

"rank"
"df.residual"
"stdev.unscaled"
"method"
"df.prior"
"proportion"
"p.value"
"F.p.value"

"assign"
"sigma"
"genes"
"design"
"s2.prior"
"s2.post"
"lods"

The meaning of the added names can be found within the online help (?eBayes):

Of importance are the p.value and F.p.value parameters that contain test statistics
on the data that can be used for finding differentially expressed genes. The statistical
tests are very similar to the Student’s t-test.

limma moderated t-statistics and B-statistics
(From:https://stat.ethz.ch/pipermail/bioconductor/2004September/006132.html)
Statistics for Differential Expression
A number of summary statistics are computed by the eBayes() function for each
gene and each contrast. The M-value (M) is the log2-fold change, or sometimes the
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log2-expression level, for that gene. The A-value (A) is the average expression level for
that gene across all the arrays and channels. The moderated t-statistic (t) is the
ratio of the M-value to its standard error. This has the same interpretation as
an ordinary t-statistic except that the standard errors have been moderated across
genes, effectively borrowing information from the ensemble of genes to aid with
inference about each individual gene.
[...]
The p-value (p.value) is obtained from the moderated t-statistic, usually after some
form of adjustment for multiple testing.
[...]
The B-statistic (lods or B) is the log-odds that that gene is differentially expressed.
[...]
Please keep in mind that the moderated t-statistic p-values and the B-statistic
probabilities depend on various sorts of mathematical assumptions which are never
exactly true for microarray data. The B-statistics also depend on a prior guess for the
proportion of differentially expressed genes. Therefore they are intended to be taken as
a guide rather than as a strict measure of the probability of differential expression. Of
the three statistics, the moderated-t, the associated p-value and the B-statistics, we
usually base our gene selections on the p-value. All three measures are closely related,
but the moderated-t and its p-value do not require a prior guess for the number of
differentially expressed genes.
Gordon Smyth,
smyth@wehi.edu.au

4. Summary
The complete set of essential commands to arrive at this point can be summarized as:
setwd(system.file("extdata",package="estrogen"))
library(affy)
pd <- read.AnnotatedDataFrame("EstrogenTargets.txt",
header=TRUE,row.names=1)
files <- paste("",pd$FileName,sep="")
rawAffyData <- ReadAffy(filenames=files)
eset <- rma(rawAffyData)
library(limma)
targets <- pd@data
design <- model.matrix(~ -1 +
factor(targets$Target,levels=unique(targets$Target)))
colnames(design) <- unique(targets$Target)
numParameters <- ncol(design)
parameterNames <- colnames(design)
fit <- lmFit(eset,design=design)
contrastsMatrix <- matrix(c(-1,1,0,0,0,0,-1,1,-1,0,1,0),
nrow=ncol(design))
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contrastNames <- c(paste(parameterNames[2],parameterNames[1],
sep="-"),paste(parameterNames[4],parameterNames[3],sep="-"),
paste(parameterNames[3],parameterNames[1],sep="-"))
rownames(contrastsMatrix) <- parameterNames
colnames(contrastsMatrix) <- contrastNames
fit2 <- contrasts.fit(fit,contrasts=contrastsMatrix)
fit2 <- eBayes(fit2)

5. Exporting Results
5.1

Displaying and saving table(s) of differentially expressed genes

The goal of microarray experiments is to compare tissue samples at the expressed RNA
level and trying to find where the differences are. We now have in hand normalized
values that have estimated test statistics and p-values.
The function topTable() from the limma package will extract a table of the topranked genes from a linear model fit. The p-values for the coefficient/contrast of interest
are adjusted for multiple testing. The default is now “BH” (Benjamini & Hochberg
(1995))3 most suitable for microarray data.
To see the list of all options see help("p.adjust") and the section on
adjust.method in help("topTable").
Note: in previous versions the "holm" method was the default because it is conservative
and valid for any type of dependence between the p-values. The less conservative
Benjamini and Hochberg method was called "fdr".
We can use this function to obtain a list of genes that are differentially expressed
between Estrogen-Present and Estrogen-Absent at time 10 hours, followed by a list of
genes differentially expressed between Estrogen-Present and Estrogen-Absent at time
48 hours.
> topTable(fit2,coef="EstPresent10-EstAbsent10")
9735
12472
1814
11509
10214
953
9848

ID
39642_at
910_at
31798_at
41400_at
40117_at
1854_at
39755_at

logFC
AveExpr
t
P.Value
adj.P.Val
B
2.939428 7.876515 23.71715 4.741579e-09 3.128295e-05 9.966810
3.113733 9.660238 23.59225 4.955715e-09 3.128295e-05 9.942522
2.800195 12.115778 16.38509 1.025747e-07 3.511070e-04 7.977290
2.381040 10.041553 16.22463 1.112418e-07 3.511070e-04 7.916921
2.555282 9.676557 15.68070 1.472942e-07 3.576234e-04 7.705093
2.507616 8.532099 15.15848 1.945518e-07 3.576234e-04 7.490766
1.679331 12.131839 15.06365 2.048314e-07 3.576234e-04 7.450643

3

Benjamini, Y., and Hochberg, Y. (1995). Controlling the false discovery rate: a practical and
powerful approach to multiple testing. Journal of the Royal Statistical Society Series B, 57, 289–
300.
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922
140
580

1824_s_at 1.914637
1126_s_at 1.782825
1536_at 2.662258

9.238870 14.87915 2.266129e-07 3.576234e-04 7.371475
6.879918 13.83040 4.119252e-07 5.778395e-04 6.892307
5.937222 13.26247 5.795111e-07 7.316327e-04 6.610486

> topTable(fit2,coef="EstPresent48-EstAbsent48")
12472
1814
953
8195
8143
9848
642
11509
3766
732

ID
logFC
AveExpr
t
P.Value
910_at 3.855061 9.660238 29.20918 8.266125e-10
31798_at 3.597334 12.115778 21.04947 1.284430e-08
1854_at 3.340896 8.532099 20.19564 1.813478e-08
38116_at 3.758891 9.513109 16.85669 8.116230e-08
38065_at 2.993641 9.097183 16.20914 1.121213e-07
39755_at 1.765249 12.131839 15.83434 1.359405e-07
1592_at 2.296484 8.311330 15.78841 1.392293e-07
41400_at 2.243510 10.041553 15.28749 1.814762e-07
33730_at -2.041390 8.573470 -15.14298 1.961911e-07
1651_at 2.968283 10.504276 14.78097 2.392480e-07

adj.P.Val
B
1.043598e-05 11.606193
7.631722e-05 9.890557
7.631722e-05 9.641399
2.511100e-04 8.480197
2.511100e-04 8.214175
2.511100e-04 8.053134
2.511100e-04 8.033025
2.752126e-04 7.808295
2.752126e-04 7.741556
3.020507e-04 7.570470

The tables are ranked and the smallest p-values at the top. The table shows only the
top 10 results. Below is a method to create a table with the results for all genes.
How many genes are we looking at on this chip? During the RMA calculation we
created an expression set with one row per gene. So the number of rows in the slot
exprs of eset have number of genes we are looking at:
(Reminder Note: Notation that worked for R 2.4 nrow(eset@exprs) no longer works.)
> numGenes <- nrow(exprs(eset))
> numGenes
[1] 12625
This is the number of genes that are on an Affymetrix chip HGU95Av2. The name of the
genes are contained within a file called hgu95av2.cdf and also provided by the R
BioConductor package hgu95av2cdf (see next exercise.)
We can now create a table for all 12625 genes:
> completeTableEst10 <- topTable(fit2,coef="EstPresent10EstAbsent10", number=numGenes)
> names(completeTableEst10)
[1] "ID"
"logFC"
"AveExpr"
"t"
"P.Value" "adj.P.Val"
"B"
>
Note: difference with output from R2.4 and BioC 1.9:
> names(completeTableEst10)
[1] "ID"
"M"
"A"
"t"
"P.Value"
"adj.P.Val" "B"
The column names M and A have been replaced with logFC and AveExpr but contain
the same data. However, some of the indexing numbers are sometimes off by 1.
Therefore completeTableEst10 is an R list, and the various names can be called
with the $ sign, for example for the first 10 p-values:
> completeTableEst10$P.Value[1:10]
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[1] 4.743202e-09 4.961178e-09 1.024565e-07 1.114037e-07
1.473401e-07
[6] 1.945635e-07 2.048311e-07 2.265892e-07 4.119318e-07
5.796598e-07
We can also write the result in a tab-delimited text table called “Est10genes.xls”
> write.table(completeTableEst10,file="Est10genes.xls",sep="\t",
quote=FALSE,col.names=NA)
Note: in R-Basics we reviewed alternate methods to read a text table, and in the same
way there are alternate methods to write such table: write.csv(), write.csv2()
from the base package. However, we also noted that they may not work with R.2.5.
We can now do the same task for the 48 hours data:
> completeTableEst48 <- topTable(fit2,coef="EstPresent48EstAbsent48", number=numGenes)
> write.table(completeTableEst48,file="Est48genes.xls",sep="\t",
quote=FALSE,col.names=NA)
You can open the files with Microsoft Excel for further plots or data manipulation. The
path to follow depends on your computer type. To know where to look you can type the
getwd() command:
> getwd()
[1] "C:/PROGRA~1/R/R-29~1.0/library/estrogen/extdata"
>
R2.4 and BioC 1.9 output:

R 2.5 and BioC 2.0 ouput:
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Note that the ID numbers are consistent, but that the index numbers (1rst column are not always the
same and sometimes off by 1 e.g. 1814 compared to 1813 or 9735 compared to 9734.)

R 2.9 and BioC 2.4 - The change remained constant and is still true in version 2.9:

Note that the first row and first column is blank, as it should be.

5.2 Histogram, MA‐plots
(This sub-section adapted from Massimiliano Gentile; see Sources)
5.2.1 p‐values histogram
The informative genes are selected based on the adjusted p-values. Quoting:
“A more illustrative way to view the results is to plot a histogram of the raw
unadjusted p-values and compare the distribution to that observed after adjustment
to account for multiple testing correction. To make the graph even more informative
we will overlay information about how the distribution would be expected to be if
there were no experiment effect (i.e. a uniform distribution), as well as a line
indicating the cut-off for statistical significance that we arbitrarily will set to 0.05. By
the way, notice that this cut-off will control the false discovery rate and not the false
positive rate we normally associate with p-values. “
Example for the results completeTableEst10. This assumes that the following 2
commands were issued above (if not, include them here:)
> numGenes <- nrow(exprs(eset))
> completeTableEst10 <- topTable(fit2,coef="EstPresent10EstAbsent10", number=numGenes)
The follow these commands
First prepare some variables. The FDR_cutoff can be changed here to other values
without modifying the rest of the commands:
>
>
>
>
>

FDR_cutoff <- 0.05
histogram_breaks <- 20
uniform_line <- 1/histogram_breaks
p_values <- fit2$p.value
adjusted_p_values <- completeTableEst10$adj.P.Val
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Plot the histograms, first for the raw p-values (blueish) and then for the adjusted pvalues (pink)
> hist(p_values, freq = F, col="lightblue",
breaks=histogram_breaks,
main="Histogram of raw and adjusted p-values")
> hist(adjusted_p_values, density=6, add=TRUE, freq = F,
col="magenta", breaks=histogram_breaks)
Add lines (green: horizontal, red: vertical, the FDR cut off) and legend:
> abline(h=1, col="green", lwd=2)
> abline(v=FDR_cutoff, col="red", lwd=2)
> legend(x=0.5, y=3, legend=c("raw p-values","adjusted pvalues"), fill=c("lightblue","magenta"))

Quoting:
“There a clear deviation from the
uniform distribution, indicating that
there is indeed a strong
experiment effect. Although
adjusting for multiple testing
substantially shifts the lowest pvalues to less significant levels
there is still a sizeable proportion
of p-values that fall below the
significance cut-off of 0.05.”
Note: this was done on the
complete eset. Gene filtering
could help get cleaner results (see
below.)

5.2.2 significant genes and MA‐plot
We can select significant genes by selecting the adjusted p-values that are under the
FDR rate (in the example it is 0.05, or 95% confidence). Note the use of <= to signify
“less than or equal to” the value of FDR_cutoff that was set just above. Note the use of
the sign $ to select the column of adjusted p values within the R-object.
> significant_genes <completeTableEst10[completeTableEst10$adj.P.Val <= FDR_cutoff,]
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> gene_index <- rownames(significant_genes)
> dim(completeTableEst10)
[1] 12625
7
> dim(significant_genes)
[1] 326
7
> dim(exprs(eset))
[1] 12625
8
This last command shows the number of genes (probes) and the number of samples
(arrays.)
> dim(fit2)
[1] 12625

3

This past commands shows that fit2 contains 3 sections, based on the contrasts
matrix. We can access them as fit[,1], fit2[,2], and fit2[,3].
The following is one way to create an interesting MA plot (seen in previous lab). Another
method will be shown in a subsequent section.
> number_genes <- dim(exprs(eset))[1]
> status <- character (length=number_genes)
> status <- rep ("not changing", number_genes)
> names (status) <- seq (1,number_genes,1)
> status [gene_index] <- "significant"
> plotMA (fit2[,1], status=status, col=c("red", "blue"))
> text(x=11, y=3, labels=paste("FDR = ", FDR_cutoff),
col="black", font=2)
> abline(h=c(1,-1), col="green")
Note that the contrast title gets written automatically at the top of the plot
We can then repeat the same pattern for the last commands to get the other 2 sections:
> plotMA (fit2[,2], status=status, col=c("red", "blue"))
> text(x=11, y=3, labels=paste("FDR = ", FDR_cutoff),
col="black", font=2)
> abline(h=c(1,-1), col="green")
and finally:
> plotMA (fit2[,3], status=status, col=c("red", "blue"))
> text(x=11, y=2, labels=paste("FDR = ", FDR_cutoff),
col="black", font=2)
> abline(h=c(1,-1), col="green")
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fit2[,1]

fit2[,2]

fit2[,3]

Note that a large number of significant genes are between the 1 to -1 green lines, which
means that these genes would not be found by fold-change cut-off typically set at 2 fold
change (reminder: log2(2) = 1).

5.3

Displaying table(s) of differentially expressed genes

Note: this exercise involves a lot of typing and might be too timeconsuming for today. You could simply review what is proposed
and do it at a later time if you find this useful.
You can find the commands on the source material at
http://bioinf.wehi.edu.au/marray/ibc2004/lab3/lab3.html

and

http://www.bioconductor.org/workshops/2005/BioC2005/labs/lab01/estroge
n.html

So far the gene names used within the data set is a “code-name” defined by Affymetrix
for the chip design. For example in the topTable command above for
EstPresent10-EstAbsent10 the top gene was named “39642_at” and we don’t
really know what is the annotated name of this gene. In the previous lab, we saw how to
print the gene name from the CDF information. Here we shall go further: if the genes in
the topTable have standard IDs (e.g. UniGene or GenBank), then they can be linked
with external annotation information on the Internet. This exercise requires loading two
packages in R. If you need to find if these packages are present and/or need to install
them, please review the “Set-Up” section at the beginning of this lab.
Loading an installed package for use within R is done with the library() function
(there may be a GUI way on your system, but the line-command is universal across
platforms.)
> library(hgu95av2cdf)
> library(hgu95av2.db)
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We can explore quickly the contents of these packages. The [1:10] subset restricts the
listing of the gene “code names” to the first 10. If you omit it and type only
ls(hgu95av2cdf) you will list all 12625 code names!
> ls(hgu95av2cdf)[1:10]
[1] "100_g_at" "1000_at"
[6] "1004_at"
"1005_at"

"1001_at"
"1006_at"

"1002_f_at" "1003_s_at"
"1007_s_at" "1008_f_at"

> ls("package:hgu95av2.db")
[1]
[4]
[7]
[10]
[13]
[16]
[19]
[22]
[25]
[28]
[31]
[34]

"hgu95av2"
"hgu95av2_dbInfo"
"hgu95av2ALIAS2PROBE"
"hgu95av2CHRLOC"
"hgu95av2ENSEMBL2PROBE"
"hgu95av2ENZYME2PROBE"
"hgu95av2GO2ALLPROBES"
"hgu95av2MAPCOUNTS"
"hgu95av2PATH"
"hgu95av2PMID"
"hgu95av2REFSEQ"
"hgu95av2UNIPROT"

"hgu95av2_dbconn"
"hgu95av2_dbschema"
"hgu95av2CHR"
"hgu95av2CHRLOCEND"
"hgu95av2ENTREZID"
"hgu95av2GENENAME"
"hgu95av2GO2PROBE"
"hgu95av2OMIM"
"hgu95av2PATH2PROBE"
"hgu95av2PMID2PROBE"
"hgu95av2SYMBOL"

> ls(hgu95av2SYMBOL)[1:10]
[1] "1000_at"
"1001_at"
[6] "1005_at"
"1006_at"
>

"hgu95av2_dbfile"
"hgu95av2ACCNUM"
"hgu95av2CHRLENGTHS"
"hgu95av2ENSEMBL"
"hgu95av2ENZYME"
"hgu95av2GO"
"hgu95av2MAP"
"hgu95av2ORGANISM"
"hgu95av2PFAM"
"hgu95av2PROSITE"
"hgu95av2UNIGENE"

"1002_f_at" "1003_s_at" "1004_at"
"1007_s_at" "1008_f_at" "1009_at"

We are interested in obtaining the gene symbols, names and IDs from the hgu95av2
annotation package (see above, the underlined/bold elements within the output of
command ls("package:hgu95av2.db"). Bold/Underle was done manually and is
not an R feature.)
• gene symbols are contained within the hgu95av2SYMBOL environment of the
hgu95av2 annotation package,
• gene names are contained within hgu95av2GENENAME, and
• UniGene IDs are contained within hgu95av2UNIGENE.
First we extract the gene symbols with a simple ls command as above:
> geneIDs <- ls(hgu95av2cdf)
Note older versions of R allowed for the following simple commands:
geneSymbols <- unlist(as.list(hgu95av2SYMBOL))
geneNames <- unlist(as.list(hgu95av2GENENAME))
unigene <- unlist(as.list(hgu95av2UNIGENE))

However in recent versions of Bioconductor annotation packages, some gene IDs
can map to multiple gene names, multiple symbols and/or multiple unigene
clusters. Therefore this simpler method no longer works and depending to the
version or R would provide an error similar to:
arguments imply differing number of rows: 12625, 13582
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Although the 3 command lines above work in R 2.9 without giving out an error, the
method developed for taking into account the multiple names should be conserved
to make sure we do not truncate data.
Multiple names associated with the same symbol can be “collapsed” from a column
form to a semi-colon separated list on a single line. This would restore a 1-to-1
correspondence of the listing of the symbols, gene names and Unigene descriptors.
For example:
symbol
12345_a_at
11111_at

Gene name
Name 1
Name 2
Name 3
Name 1
Name2

will become (“collapse into:”)
symbol
12345_a_at
11111_at

Gene name
Name 1 ; Name 2 ; Name 3
Name 1 ; Name2

thereby making the number of rows identical in each category, and (re)establishing a 1to-1 correspondence in the row numbers across the 3 categories.
In order to create the 3 following R objects we will use R functions. Some of the text and
file manipulation function can be reviewed with the online R help are:
as.character(), unlist(), lapply(),mget().
“mget” stands for “multiple get” and extracts multiple annotation strings associated with
one symbol. “lapply” is used to “apply a function over a list or vector”, and applies our
multiple-entry-collapsing function to every element in a list of annotation strings.
> geneSymbols <as.character(unlist(lapply(mget(geneIDs,env=hgu95av2SYMBOL),
function (symbol) { return(paste(symbol,collapse=" ; ")) } )))
> geneNames <as.character(unlist(lapply(mget(geneIDs,env=hgu95av2GENENAME),
function (name) { return(paste(name,collapse=" ; ")) } )))
> unigene <as.character(unlist(lapply(mget(geneIDs,env=hgu95av2UNIGENE),
function (unigeneID) { return(paste(unigeneID,collapse=" ; "))
} )))
Next we shorten the gene names to a size of 60 characters so that they fit better within
the table. This is done with the command substring(), which simply truncates the
end of the original string of characters. Then we extract the unigene ID from the string
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which contains "Hs" (for Homo sapiens) as well as the unigene ID with the command
gsub().
> geneNames <- substring(geneNames,1,60)
> unigene <- gsub("Hs\\.","",unigene)
We can now combine everything together, and create a web link with the command
paste() with the NCBI URL to create a “unigene” link within the table (note that http,
<a href=, and > are HTML notations, quotes are used to treat these as character
strings.)
> genelist <data.frame(GeneID=geneIDs,GeneSymbol=geneSymbols,GeneName=geneNa
mes,
UniGeneHsID=paste
("<a
href=http://www.ncbi.nlm.nih.gov/UniGene/clust.cgi?ORG=Hs&CID=",
unigene,">",unigene,"</a>",sep=""))
Now we recreate the toptable for the two contrasts considered earlier,
"EstPresent10-EstAbsent10" and "EstPresent48-EstAbsent48" this time
providing a hyperlink to the UniGene website for each gene in the topTable.
> unigeneTopTableEst10 <- topTable(coef="EstPresent10EstAbsent10", n=20,fit=fit2,genelist=genelist)
> unigeneTopTableEst48 <- topTable(coef="EstPresent48EstAbsent48", n=20,fit=fit2,genelist=genelist)
In addition, the package xtable is used to export some HTML that is incorporated
within the commands.
> library(xtable)
> xtableUnigeneEst10 <xtable(unigeneTopTableEst10,display=c("d","s","s","s","s","g","g
","g","e","g","s"))
> xtableUnigeneEst48 <xtable(unigeneTopTableEst48,display=c("d","s","s","s","s","g","g
","g","e","g","s"))
> cat(file="estrogenUniGeneE10.html","<html>\n<body>")
> print(xtableUnigeneEst10,type="html",
file="estrogenUniGeneE10.html", sanitize.text.function = force,
append=TRUE)
>
cat(file="estrogenUniGeneE10.html","</body>\n</html>",append=TRU
E)
> cat(file="estrogenUniGeneE48.html","<html>\n<body>")
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> print(xtableUnigeneEst48, type="html",
file="estrogenUniGeneE48.html", sanitize.text.function = force,
append=TRUE)
>
cat(file="estrogenUniGeneE48.html","</body>\n</html>",append=TRU
E)
The display argument to the xtable function is used to specify the format of text or
numbers displayed in cells of the HTML table:
Format code
d
s
g
e

Meaning
Decimal (base ten) integer, e.g. 1, 5, 48, 2345
Character string, e.g. "Block" or “This is a text string”
General real floating-point number, e.g. 8.25
Floating point number in exponent format, e.g. 1.02E-05

Note: sanitize.text.function = force forces the HTML code to be printed
correctly within the HTML output file.
If this is not used, the html symbols < and > are translated to html symbolic text code
&lt and &gt and would render the links non functional.
Note: One minor problems remains but only for genes that have more than one name:
For example here are the last 3 lines for estrogenUniGeneE10.html 2 of which have
multiple “collapsed” names:
GeneID GeneSymbol
1244 239_at

CTSD

8195 38116_at KIAA0101

10634 40533_at EPR1

GeneName

UniGeneHsID logFC AveExpr t P.Value adj.P.Val

B

cathepsin D

121575 ;
654447

1.6

11 10

4.07e06

0.0027 4.90070893321673

KIAA0101

81892

2.3

9.5 10

4.09e06

0.0027 4.89605844752184

effector cell
peptidase
receptor 1 (nonprotein coding)

514527 ;
718461

1.3

8.5 10

4.21e06

0.0027 4.86989944602598

The link will work only for the first item. For example the catepsin D on the first line,
121575 will work but the link for 654447 will not.
However the URL is created in a standard manner, and one only needs to manually
replace the end of the URL to access the other item. For example, clicking on the first
line on 121575 (cathepsin D) will go to the following link:

Only the last digits need to be changed to go to the other item. For example here one
could simply type (or copy / paste) the other numbers to go to the alternate link.
Therefore replacing 121575 by 654447 :
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5.4

MA plots using contrasts from the linear model

For this exercise we will need the R object geneSymbols created in the previous
section. If you skipped the previous section follow these steps to create this vector now:
> library(hgu95av2cdf)
> library(hgu95av2.db)
> geneSymbols <- unlist(as.list(hgu95av2SYMBOL))
(note that there are only 12625 symbols, and therefore we can skip the more complex
method that was used in the previous section.)
As an alternate to geneSymbols you can could use geneIDs created above or
recreated as follows:
> geneIDs <- ls(hgu95av2cdf)
MA plots were defined in the previous lab. M and A are logs in log base 2. M is a log
fold change and A is an average log intensity; in this case for each gene, we will use the
average of all the A values contained in fit2 under the label Amean. lods is a
numeric vector or matrix giving the log-odds of differential expression. The funtion
order() is used to reorder the data.
On the MA plot, genes that are up-regulated will appear at the top, and genes that are
down-regulated will appear at the bottom. Since this is a comparison between 2 cases,
the up and down are relative to which is considered first. This is the role of the minus
sign in the contrast matrix. If you inverse the signs, the genes will appear on the other
end of the MA plot.
> M.Est10 <- fit2$coefficients[,"EstPresent10-EstAbsent10"]
> A <- fit2$Amean
> ord.Est10 <- order(fit2$lods[,"EstPresent10-EstAbsent10"],
decreasing=TRUE)
> top30.Est10 <- ord.Est10[1:30]
Finally make the MA plot and add the name of the top 10 genes within the plot:
> plot(A,M.Est10,pch=16,cex=0.1)
> text(A[top30.Est10], M.Est10[top30.Est10],
labels=geneSymbols[top30.Est10], cex=0.8,col="blue")
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In the same way we can plot the effect of estrogen at 48 hours and then the effect of
time as discussed before during the construction of the contrast matrix:
> M.Est48 <- fit2$coefficients[,"EstPresent48-EstAbsent48"]
> ord.Est48 <- order(fit2$lods[,"EstPresent48-EstAbsent48"],
decreasing=TRUE)
> top30.Est48 <- ord.Est48[1:30]
> plot(A,M.Est48,pch=16,cex=0.1)
> text(A[top30.Est48], M.Est48[top30.Est48],
labels=geneSymbols[top30.Est48],cex=0.8,col="blue")
> M.EstAbs48vs10 <- fit2$coefficients[,"EstAbsent48EstAbsent10"]
> ord.EstAbs48vs10 <- order(fit2$lods[,"EstAbsent48EstAbsent10"], decreasing=TRUE)
> top30.EstAbs48vs10 <- ord.EstAbs48vs10[1:30]
> plot(A,M.EstAbs48vs10,pch=16,cex=0.1)
> text(A[top30.EstAbs48vs10],M.EstAbs48vs10[top30.EstAbs48vs10],
labels=geneSymbols[top30.EstAbs48vs10],cex=0.8,col="blue")
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M.Est48

5.5

M.EstAbs48vs10

Venn diagrams using contrasts from the linear model

http://en.wikipedia.
org/wiki/John_Venn

Venn diagrams are illustrations used in the branch of mathematics
known as “set theory.” They show the mathematical or logical
relationship between different groups of things (sets).
A Venn diagram shows all the possible logical relations between the
sets.
John Venn (1834-1923) was a British philosopher and mathematician
who introduced the Venn diagram in 1881.
http://en.wikipedia.org/wiki/Venn_diagram

We can now examine which genes respond to Estrogen at either time (10 hours or 48
hours) by examining moderated F-statistics on 2 degrees of freedom and p-values
calculated from these F-statistics (remember fit2 is a list and $ helps specify its
components that can be listed with the command: names(fit2) ).
First, create independent R objects from the list components:
> F.stat <- fit2$F
> p.value <- fit2$F.p.value
What p-value cut-off should be used ? One guide is to examine control probe-clusters
which are known not to be differentially expressed.
The function grep() is similar to the unix command grep and is a general regular
expression pattern recognition method. A regular expression is a method to specify a
text pattern. In R-basics we learned for example how to list objects which start with the
letter m by using the ^ (caret) symbol which means “beginning of line.” Hence ^m is a
regular expression. In the next command we shall take a look at the p-values of the
internal Affymetrix control probes which all have the label AFFX as part of their name.
Thus the command grep below simply finds all the control probes on the chip. In this
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case “AFFX” is the pattern, and geneNames(eset) or featureNames(eset) is the
object in “which to look” for the pattern.
Note: R 2.4 and BioC notation was > i <- grep("AFFX",geneNames(eset))
Newer notation: (use featureNames instead of geneNames)
> i <- grep("AFFX",featureNames(eset))
> summary(p.value[i])
Min.
1st Qu.
Median
Mean
3rd Qu.
Max.
1.036e-10 4.822e-03 6.161e-02 2.147e-01 3.673e-01 9.828e-01
The summary() function provides statistics on the distribution of all the p-values for all
AFFX* genes. The mean value is about 2.14 E-1 (= 2.14 . 10-1 = 0.214).
We will choose a cut-off of 1.0 E-5 (= 1 . 10-5 = 0.00001) which is well below the
average p-value for the control probes.
Let’s consider those genes with moderated F-statistics with p-values below 1.0E-5,
and classify these according to whether they are significantly up or down regulated at
the early or late times:
> results <- classifyTestsF(fit2, p.value=1.0E-5)
> results
TestResults matrix
EstPresent10-EstAbsent10 EstPresent48-EstAbsent48 EstAbsent48-EstAbsent10
1000_at
0
0
0
1001_at
0
0
0
1002_f_at
0
0
0
1003_s_at
0
0
0
1004_at
0
0
0
12620 more rows ...

>
> summary(results)
-1
0
1

EstPresent10-EstAbsent10 EstPresent48-EstAbsent48 EstAbsent48-EstAbsent10
6
19
31
12583
12559
12589
36
47
5

The function vennDiagram() plots classification counts in a Venn diagram.

> vennDiagram(results, names=
c("Est10PresAbs","Est48PresAbs",
"EstAbs48vs10"))
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We can add additional parameters to the command
to colorize the circles (circle.col), change the
color of the numbers (counts.col) and specify the
width of the line of the circles(lwd, short for
linewidth.)
For example:
> vennDiagram(results, names=
c("Est10PresAbs", "Est48PresAbs",
"EstAbs48vs10"),
circle.col=c("blue","red","green"),
counts.col=c("gray25"), lwd=3))
Note: lwd = line width
We previously used topTable (e.g topTable(fit2,coef="EstPresent10EstAbsent10")) to have a closer look at individual genes.
Use the table() command below to determine how many genes were up-regulated at
10 hours, and how many of those genes were still up-regulated at 48 hours. The same
question can be answered for down-regulated genes, using the same table.
> table(E10=results[,1],E48=results[,2])
E48
E10
-1
0
1
-1
3
3
0
0
16 12550
17
1
0
6
30
Adding the third column will show more details on all 3 at the same time and will reflect
more of the numbers found within the Venn diagram (shown here side by side to save
space and paper!)
> table(E10=results[,1],E48=results[,2],Etime=results[,3])
, , Etime = -1

E48

E48
E10
-1
0
1

, , Etime = 1

, , Etime = 0

-1
0
2
0

0
3
19
0

1
0
2
5

E10
-1
0
1

-1
0
3
0
10 12531
0
5

1
0
15
25

E48
E10
-1
0
1

-1
0
4
0

6. Gene filtering (This section adapted from Massimiliano Gentile; see reference in Sources.)
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In some cases it may be possible that limma will find NO differentially expressed
genes. It would be important at that point to filter genes that play no roles and data that
is non informative to reduce the dataset. In this case, the power of the statistical testing
will be increased because most non-relevant data will have been removed.

6.1 Present / Absent call
The Affymetrix algorithm mas5 implemented in R as function mas5calls() of the
affy package can be used to create a list of present (P), absent (A) of marginal (M)
call for each probe. Refer to the original file for further details on the R code.

6.2 Filtering out uninteresting data
The multiple testing problem can be reduced if the number of genes looked at is
reduced. Some of the data has low content information: for example genes that show no
or very little variation between samples. However it is important not to introduce a bias
in the filtering. The accepted method is to use the coefficient of variability (CV) defined
as the standard deviation divided by the mean: CV = sd / mean
Note: The R code calls on the apply() function:
(Type ?apply to show complete help)
Apply Functions Over Array Margins Description
Returns a vector or array or list of values obtained by applying a function to margins of an
array.
Usage: apply(X, MARGIN, FUN, ...)
Arguments:
X
MARGIN

FUN
...

the array to be used.
a vector giving the subscripts which the function will be applied over. 1
indicates rows, 2 indicates columns, c(1,2) indicates rows and
columns.
the function to be applied: see ‘Details’. In the case of functions like +,
%*%, etc., the function name must be backquoted or quoted.
optional arguments to FUN.

If we look at the distribution of CV, we can keep the 90th percentile:
First calculate the mean and sd values:
> sd_values <- apply (exprs(eset), MARGIN=1, FUN="sd")
> mean_values <- apply (exprs(eset), MARGIN=1, FUN="mean")
Calculate CV based on the definition CV = sd / mean
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> CV_values <- sd_values /

mean_values

Select a cut-off, here 0.9:
> quantile_cut_off <- quantile(CV_values , probs=0.9)
Keep a filtered eset based on values above cut-off:
> eset_filtered <- eset[CV_values > quantile_cut_off]
We can verify the sizes with the command dim()
> dim(eset)
Features Samples
12625
8
> dim(eset_filtered)
Features Samples
1263
8
This reduced set will contain only the most informative 10% data (we chose 90%
percentile, thus 0.9). Theerfore the size of the sub-set can be adjusted by changing the
value of the cut-off.
We can verify that we picked only the highest 10% of CV and that no intensity bias was
introduced with the following plots:
> par(mfrow=c(2,1))
> hist (CV_values,

density=4, col="blue")

> abline(v=quantile_cut_off, col="red")
> hist (log(CV_values), density=4,
col="blue")
> abline(v=log(quantile_cut_off), col="red")
> par(mfrow=c(1,1))

The histograms represent the CV-values in linear
(top) and log scale (bottom) with the vertical bar
showing the cut-off.
And also:
> plot (mean_values, CV_values, col="red", main=paste("Cut-off = ",
quantile_cut_off))
> points (mean_values[CV_values>quantile_cut_off],
CV_values[CV_values>quantile_cut_off], col="blue")
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The CV-values are colored as a
function of the average of expression
(in log scale) across arrays. Blue
circles on the top part of the plot are
above the filtering cut-off.
The cut-off value printed in the title
reprensents the value of the
percentile chosen (0.9 in the
example.)

We could now use the eset_filtered as we did the eset in the previous section.
The difference is that this eset would be smaller and statistics more robust. This is
especially useful in cases where limma does not find any significant gene with the
complete set.

7. biomaRt
(This section adapted from R News by Steffen Durinck
http://www.r-project.org/doc/Rnews/Rnews_2006-5.pdf)
The new R package biomaRt is based on the BioMart query-oriented data management
system (http://www.biomart.org/) developed jointly by the European
Bioinformatics Institute (EBI) and Cold Spring Harbor Laboratory (CSHL).
This R package provides access to the same on-line biological databases from within R.
The databases are referred to as “marts” within the package.
We are going to create output directly from information retrieved online on-the-fly within
one of the databases (we will use Ensembl.) Some of the important databases are:
Database
enseml
HapMap
VEGA

Contains
25 annotated genomes (humans,
mouse, dog, etc.)
More than one million SNPs
VErtebrate Genome Annotation. High
quality manual annotations of
finished vertebrate genomes (human,
mouse, zerbra fish, pig, and dog.)
Page - 117 -

URL
http://www.ensembl.org
http://www.hapmap.org
http://vega.sanger.ac.uk

R and Bioconductor- Limma.
Uniprot
Wormbase

Gramene

Protein sequence and functional
annotation (name, function, domains,
taxonomy, post-translational modif.)
C. elegans model species:
expression patterns, RNAi
phenotypes, mutant phenotypes,
genome variations.
Comparative genomics or grasses
and plant model Arabidopsis.

http://www.ebi.uniprot.org
http://www.wormbase.org

http://www.gramene.org

Below we shall see a list of all the available databases online (27 as of this writing.)

7.1

Install the biomaRt package:

> source("http://www.bioconductor.org/biocLite.R")
> biocLite("biomaRt")
Now load the biomaRt package for use within this R session and list available online
databases:
> library( biomaRt)
> listMarts()
biomart
version
1
ensembl
ENSEMBL 54 GENES (SANGER UK)
2
snp
ENSEMBL 54 VARIATION (SANGER UK)
3
vega
VEGA 35 (SANGER UK)
4
msd
MSD PROTOTYPE (EBI UK)
5
htgt HIGH THROUGHPUT GENE TARGETING AND TRAPPING (SANGER UK)
6
QTL_MART
GRAMENE 29 QTL DB (CSHL US)
7
ENSEMBL_MART_ENSEMBL
GRAMENE 29 GENES (CSHL US)
8
ENSEMBL_MART_SNP
GRAMENE 29 SNPs (CSHL US)
9
GRAMENE_MARKER_29
GRAMENE 29 MARKERS (CSHL US)
10
GRAMENE_MAP_29
GRAMENE 29 MAPPINGS (CSHL US)
11
REACTOME
REACTOME (CSHL US)
12
wormbase_current
WORMBASE (CSHL US)
13
dicty
DICTYBASE (NORTHWESTERN US)
14
rgd__mart
RGD GENES (MCW US)
15
ipi_rat__mart
RGD IPI MART (MCW US)
16
SSLP__mart
RGD MICROSATELLITE MARKERS (MCW US)
17
g4public
HGNC (EBI UK)
18
pride
PRIDE (EBI UK)
19
uniprot_mart
UNIPROT (EBI UK)
20 ensembl_expressionmart_48
EURATMART (EBI UK)
21
bacterial_mart_52
ENSEMBL BACTERIA 52 GENES (EBI UK)
22
metazoa_mart_52
ENSEMBL METAZOA 52 GENES (EBI UK)
23
protist_mart_52
ENSEMBL PROTISTS 52 GENES (EBI UK)
24
biomartDB
PARAMECIUM GENOME (CNRS FRANCE)
25
Eurexpress Biomart
EUREXPRESS (MRC EDINBURGH UK)
26
pepseekerGOLD_mart06
PEPSEEKER (UNIVERSITY OF MANCHESTER UK)
27
Pancreatic_Expression PANCREATIC EXPRESSION DATABASE (INSTITUTE OF CANCER UK)
>

7.2 ensembl
Next we select to use the ensembl database and place this information within the R
object ensmart.
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> ensmart <- useMart("ensembl")
(Reminder note: the = notation is also valid: ensmart = useMart("ensembl") )
> slotNames(ensmart)
[1] "biomart"
"host"
"vschema"
[5] "filters"
"attributes" "archive" >

"dataset"

You do not need to know about the data structure of this object, however you can know
that it contains various subsections shown above with the command slotNames().

7.3

Listing what is available within the ensembl database (R object
ensmart) :

> datasets <- listDatasets(ensmart)
> datasets
dataset
description
version
1
oanatinus_gene_ensembl
Ornithorhynchus anatinus genes (OANA5)
OANA5
2
tguttata_gene_ensembl
Taeniopygia guttata genes (taeGut3.2.4) taeGut3.2.4
3
cporcellus_gene_ensembl
Cavia porcellus genes (cavPor3)
cavPor3
4
gaculeatus_gene_ensembl
Gasterosteus aculeatus genes (BROADS1)
BROADS1
5
lafricana_gene_ensembl
Loxodonta africana genes (loxAfr2)
loxAfr2
6
agambiae_gene_ensembl
Anopheles gambiae genes (AgamP3)
AgamP3
7
mlucifugus_gene_ensembl
Myotis lucifugus genes (myoLuc1)
myoLuc1
8
hsapiens_gene_ensembl
Homo sapiens genes (NCBI36)
NCBI36
9
choffmanni_gene_ensembl
Choloepus hoffmanni genes (choHof1)
choHof1
10
aaegypti_gene_ensembl
Aedes aegypti genes (AaegL1)
AaegL1
11
csavignyi_gene_ensembl
Ciona savignyi genes (CSAV2.0)
CSAV2.0
12
fcatus_gene_ensembl
Felis catus genes (CAT)
CAT
13
rnorvegicus_gene_ensembl
Rattus norvegicus genes (RGSC3.4)
RGSC3.4
14
ggallus_gene_ensembl
Gallus gallus genes (WASHUC2)
WASHUC2
15
tbelangeri_gene_ensembl
Tupaia belangeri genes (tupBel1)
tupBel1
16
xtropicalis_gene_ensembl
Xenopus tropicalis genes (JGI4.1)
JGI4.1
17
ecaballus_gene_ensembl
Equus caballus genes (EquCab2)
EquCab2
18
drerio_gene_ensembl
Danio rerio genes (Zv8)
Zv8
19 stridecemlineatus_gene_ensembl Spermophilus tridecemlineatus genes (speTri1)
speTri1
20
tnigroviridis_gene_ensembl
Tetraodon nigroviridis genes (TETRAODON8.0) TETRAODON8.0
21
ttruncatus_gene_ensembl
Tursiops truncatus genes (turTru1)
turTru1
22
scerevisiae_gene_ensembl
Saccharomyces cerevisiae genes (SGD1.01)
SGD1.01
23
celegans_gene_ensembl
Caenorhabditis elegans genes (WS190)
WS190
24
mmulatta_gene_ensembl
Macaca mulatta genes (MMUL_1.0)
MMUL_1.0
25
pvampyrus_gene_ensembl
Pteropus vampyrus genes (pteVam1)
pteVam1
26
mdomestica_gene_ensembl
Monodelphis domestica genes (monDom5)
monDom5
27
vpacos_gene_ensembl
Vicugna pacos genes (vicPac1)
vicPac1
28
acarolinensis_gene_ensembl
Anolis carolinensis genes (AnoCar1.0)
AnoCar1.0
29
tsyrichta_gene_ensembl
Tarsius syrichta genes (tarSyr1)
tarSyr1
30
ogarnettii_gene_ensembl
Otolemur garnettii genes (otoGar1)
otoGar1
31
trubripes_gene_ensembl
Takifugu rubripes genes (FUGU4.0)
FUGU4.0
32
dmelanogaster_gene_ensembl
Drosophila melanogaster genes (BDGP5.4)
BDGP5.4
33
eeuropaeus_gene_ensembl
Erinaceus europaeus genes (eriEur1)
eriEur1
34
mmurinus_gene_ensembl
Microcebus murinus genes (micMur1)
micMur1
35
olatipes_gene_ensembl
Oryzias latipes genes (HdrR)
HdrR
36
etelfairi_gene_ensembl
Echinops telfairi genes (TENREC)
TENREC
37
cintestinalis_gene_ensembl
Ciona intestinalis genes (JGI2)
JGI2
38
ptroglodytes_gene_ensembl
Pan troglodytes genes (CHIMP2.1)
CHIMP2.1
39
oprinceps_gene_ensembl
Ochotona princeps genes (OchPri2.0)
OchPri2.0
40
ggorilla_gene_ensembl
Gorilla gorilla genes (gorGor1)
gorGor1
41
dordii_gene_ensembl
Dipodomys ordii genes (dipOrd1)
dipOrd1
42
ppygmaeus_gene_ensembl
Pongo pygmaeus abelii genes (PPYG2)
PPYG2
43
mmusculus_gene_ensembl
Mus musculus genes (NCBIM37)
NCBIM37
44
ocuniculus_gene_ensembl
Oryctolagus cuniculus genes (RABBIT)
RABBIT
45
saraneus_gene_ensembl
Sorex araneus genes (sorAra1)
sorAra1
46
dnovemcinctus_gene_ensembl
Dasypus novemcinctus genes (dasNov2)
dasNov2
47
pcapensis_gene_ensembl
Procavia capensis genes (proCap1)
proCap1
48
btaurus_gene_ensembl
Bos taurus genes (Btau_4.0)
Btau_4.0

Page - 119 -

R and Bioconductor- Limma.
49

cfamiliaris_gene_ensembl

Canis familiaris genes (CanFam_2.0)

CanFam_2.0

>

7.4

We tell R to restrict our search with the human genome:

> ensmart <- useMart("ensembl", dataset =
"hsapiens_gene_ensembl")
Checking attributes ... ok
Checking filters ... ok
>

7.5

We need to know which Affymetrix chips are known:

Note: There used to be a command to list known arrays:
> getAffyArrays(mart = ensmart)
name
description
1
affy_hc_g110
Affy hc g 110 ID(s)
2
affy_hg_focus
Affy hg focus ID(s)
3 affy_hg_u133_plus_2 Affy hg u133 plus 2 ID(s)
4
affy_hg_u133a
Affy hg u133a ID(s)
5
affy_hg_u133a_2
Affy hg u133a 2 ID(s)
6
affy_hg_u133b
Affy hg u133b ID(s)
7
affy_hg_u95a
Affy hg u95a ID(s)
8
affy_hg_u95av2
Affy hg u95av2 ID(s)
9
affy_hg_u95b
Affy hg u95b ID(s)
10
affy_hg_u95c
Affy hg u95c ID(s)
11
affy_hg_u95d
Affy hg u95d ID(s)
12
affy_hg_u95e
Affy hg u95e ID(s)
13
affy_hugenefl
Affy hugenefl ID(s)
14
affy_u133_x3p
Affy u133 x3p ID(s)

That command has been removed. From online notes Wed, 14 Jan 2009
biomaRt : Removed getSNP, getHomolog, getAffyArrays as these functions are
replaced by getBM and getLDS
However, the following commands are also useful:
listAttributes(ensmart)
listFilters(ensmart)
To find if the Affymetrix array we are using is part of the list we can use the following
command where we create an index named i (see the Venn diagram section to
understand the grep function). We search in the “name” column only:
> i <- grep("affy",listFilters(ensmart, what = c("name")))
> listFilters(ensmart, what = c("name"))[i]
[1] "with_affy_hc_g110"
[4] "with_affy_hg_u133b"
"with_affy_hg_u133_plus_2"
[7] "with_affy_hg_u95a"
[10] "with_affy_hg_u95c"
[13] "with_affy_u133_x3p"
"with_affy_hugene_1_0_st_v1"
[16] "with_affy_huex_1_0_st_v2"

"with_affy_hg_focus"
"with_affy_hg_u133a_2"

"with_affy_hg_u133a"

"with_affy_hg_u95av2"
"with_affy_hg_u95d"
"with_affy_hugenefl"

"with_affy_hg_u95b"
"with_affy_hg_u95e"

"affy_hc_g110"

"affy_hg_focus"
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[19]
[22]
[25]
[28]
>

"affy_hg_u95a"
"affy_hg_u95c"
"affy_hg_u133a_2"
"affy_hg_u133_plus_2"

"affy_hg_u95av2"
"affy_hg_u95d"
"affy_hg_u133a"
"affy_hugenefl"

"affy_hg_u95b"
"affy_hg_u95e"
"affy_hg_u133b"
"affy_u133_x3p"

We can observe that affy_hg_u95av2 is indeed part of the list (bodl and underline added.)
There are more subsets or “filters” which can be listed with the command
listFilters().
> listFilters(ensmart)
name
1
chromosome_name
2
start
3
end
4
band_start
5
band_end
[..................]
227
prosite
ID(s)
228
interpro
ID(s)
229
with_transmembrane_domain
domains
230
with_signal_domain
domains
>

7.6

description
Chromosome name
Gene Start (bp)
Gene End (bp)
Band Start
Band End
PROSITE
Interpro
Transmembrane
Signal

Obtaining gene annotation for the “top 30:”

In a previous section (Venn diagrams) we created R objects top30.Est10 and
top30.Est48 which were evaluated to be the top 30 most differentially expressed
genes. Here we shall find the online annotation for these genes. We also created the R
object geneIDs to contain the name of the Affymetrix probe names.
top30.Est10 and top30.Est48 are indices for the gene rows:
> top30.Est10
[1] 9735 12472
546
[14] 4405
985
6699
[27] 11693 12509

1814 11509 10214
6194

7557

1157

7760

1244

953

9848

8195 10634

922

140

5300 12237

580 12542
7111

We can print the gene probe name (Affymetrix ids):
> geneIDs[top30.Est10]
[1] "39642_at"
"1854_at"
[7] "39755_at"
"33252_at"
[13] "1505_at"
"239_at"
[19] "38116_at"
"1775_at"

"910_at"

"31798_at"

"41400_at"

"40117_at"

"1824_s_at"

"1126_s_at"

"1536_at"

"981_at"

"34363_at"

"1884_s_at"

"36134_at"

"37485_at"

"40533_at"

"35249_at"

"673_at"

"37043_at"
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[25] "36833_at"
"37686_s_at"

"36634_at"

"41583_at"

"947_at"

"2042_s_at"

>
These in turn can be used to gather information online from the ensembl database.
For example: we can get the information for gene corresponding to probe 910_at:
> getGene(id="910_at",type="affy_hg_u95av2",mart=ensmart)
1

affy_hg_u95av2 hgnc_symbol
910_at
TK1

description chromosome_name
band
1 Thymidine kinase, cytosolic (EC 2.7.1.21) [Source:UniProtKB/Swiss-Prot;Acc:P04183]
17
q25.3
strand start_position end_position ensembl_gene_id
1
-1
73681755
73694909 ENSG00000167900

>
Ensembl maps all annotations at the transcript level which may result in multiple,
apparently different results. These can be distinguished by the tag towards the right
hand side of the output seen in tabular form. For example 1126_s_at has multiple
associated names:
> getGene(id="1126_s_at",type="affy_hg_u95av2",mart=ensmart)
1

affy_hg_u95av2 hgnc_symbol
1126_s_at
CD44

description
1 CD44 antigen Precursor (Phagocytic glycoprotein I)(PGP-I)(PGP-1)(HUTCH-I)(Extracellular matrix receptor
III)(ECMR-III)(GP90 lymphocyte homing/adhesion receptor)(Hermes antigen)(Hyaluronate receptor)(Heparan sulfate
proteoglycan)(Epican)(CDw44)(CD44 antigen) [Source:UniProtKB/Swiss-Prot;Acc:P16070]
chromosome_name band strand start_position end_position ensembl_gene_id
1
11 p13
1
35116993
35210522 ENSG00000026508

>
We can look at the result for all 30 entries at the same time if we remember that object
geneIDs[top30.Est10] contains the name of the probes (as shown above.) Due to
the apparent redundant results explained abov, the top 30 list will result in 64 entries
being displayed:
>
getGene(id=geneIDs[top30.Est10],type="affy_hg_u95av2",mart=ensma
rt)
affy_hg_u95av2 hgnc_symbol
1
1126_s_at
CD44
2
1505_at
TYMS
3
1536_at
CDC6
[truncated for printing...]

>

7.7

Retrieving sequence information:

The function getSequence() can be used to retrieve sequences associated with a
probe name of various types. The help command (?getSequence()) does not list all
of the available types.
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Only upon error do all the possible options get revealed:
Choose either gene_exon, transcript_exon,transcript_exon_intron,
gene_exon_intron, cdna, coding, coding_transcript_flank,
coding_gene_flank, transcript_flank, gene_flank, peptide, 3utr
or 5utr
Example for 910_at:
> getSequence(id="910_at", type="affy_hg_u95av2",
seqType="gene_flank", upstream = 20, mart = ensmart)
gene_flank affy_hg_u95av2
1 CGATCAGCCACGTCCATCGC
910_at
> getSequence(id="910_at", type="affy_hg_u95av2",
seqType="coding", upstream = 20, mart = ensmart)
1
GTGAACTTCCCGGAGGCGCAATGAGCTGCATTAACCTGCCCACTGTGCTGCCTGGCTCCCCCAGCAAGACCCGGGGGCAGATCCAGGTGATTCTCGG
GCCGATGTTCTCAGGAAAAAGCACAGAGTTGATGAGACGCGTCCGTCGCTTCCAGATTGCTCAGTACAAGTGCCTGGTGATCAAGTATGCCAAAGAC
ACTCGCTACAGCAGCAGCTTCTGCACACATGACCGGAACACCATGGAGGCACTGCCCGCCTGCCTGCTCCGAGACGTGGCCCAGGAGGCCCTGGGCG
TGGCTGTCATAGGCATCGACGAGGGGCAGTTTTTCCCTGACATCGTGGAGTTCTGCGAGGCCATGGCCAACGCCGGGAAGACCGTAATTGTGGCTGC
ACTGGATGGGACCTTCCAGAGGAAGCCATTTGGGGCCATCCTGAACCTGGTGCCGCTGGCCGAGAGCGTGGTGAAGCTGACGGCGGTGTGCATGGAG
TGCTTCCGGGAAGCCGCCTATACCAAGAGGCTCGGCACAGAGAAGGAGGTCGAGGTGATTGGGGGAGCAGACAAGTACCACTCCGTGTGTCGGCTCT
GCTACTTCAAGAAGGCCTCAGGCCAGCCTGCCGGGCCGGACAACAAAGAGAACTGCCCAGTGCCAGGAAAGCCAGGGGAAGCCGTGGCTGCCAGGAA
GCTCTTTGCCCCACAGCAGATTCTGCAATGCAGCCCTGCCAACTGA
affy_hg_u95av2
1
910_at

>

7.8

Retrieving GO information:
Note: older versions of the packages had the easy command getGO which is
now replaced by getBM
Therefore such commands to retrieve GO information from Ensembl given a
gene identifier will no longer work:
>

getGO(id="910_at", type="affy_hg_u95av2",mart=ensmart)

affy_hg_u95av2
go
1
910_at GO:0000166
2
910_at GO:0004797
go_description
evidence_code
1
IEA
2
TAS

nucleotide binding
thymidine kinase activity

ensembl_gene_id ensembl_transcript_id
1 ENSG00000167900
ENST00000301634
2 ENSG00000167900
ENST00000301634

It is therefore very important to verify that older scripts are updated to the new
commands!

Page - 123 -

R and Bioconductor- Limma.
The search now has to be written in a different way, knowing that the list of all filters can
be obtained with command listFilters(ensmart)
The list is very long (over 600 entries) and the GO information is within the first 30
> listAttributes(ensmart)
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
[...]
641
642
643
644
645
646
647
648
649
650
651
652
653
654
655
656
657
658
659
660
661
662
663
664
665
>

name
ensembl_gene_id
ensembl_transcript_id
ensembl_peptide_id
canonical_transcript_stable_id
description
chromosome_name
start_position
end_position
strand
band
transcript_start
transcript_end
external_gene_id
external_transcript_id
external_gene_db
transcript_db_name
transcript_count
percentage_gc_content
gene_biotype
transcript_biotype
source
status
transcript_status
go_biological_process_id
go_biological_process_description
go_biological_process_linkage_type
go_cellular_component_id
go_cellular_component_description
go_cellular_component_linkage_type
go_molecular_function_id
go_molecular_function_description
go_molecular_function_linkage_type
clone_based_ensembl_gene_name
clone_based_ensembl_transcript_name
clone_based_vega_gene_name
clone_based_vega_transcript_name
ccds
embl
entrezgene

description
Ensembl Gene ID
Ensembl Transcript ID
Ensembl Protein ID
Canonical transcript stable ID(s)
Description
Chromosome Name
Gene Start (bp)
Gene End (bp)
Strand
Band
Transcript Start (bp)
Transcript End (bp)
Associated Gene Name
Associated Transcript Name
Associated Gene DB
Associated Transcript DB
Transcript count
% GC content
Gene Biotype
Transcript Biotype
Source
Status (gene)
Status (transcript)
GO ID
GO Description
GO Evidence Code
GO ID
GO Description
GO Evidence Code
GO ID
GO Description
GO Evidence Code
Clone based Ensembl gene name
Clone based Ensembl transcript name
Clone based VEGA gene name
Clone based VEGA transcript name
CCDS ID
EMBL (Genbank) ID
EntrezGene ID

ensembl_gene_id
description
external_gene_id
external_gene_db
chromosome_name
start_position
end_position
family
cds_length
cds_start
cds_end
5_utr_start
5_utr_end
3_utr_start
3_utr_end
ensembl_transcript_id
ensembl_peptide_id
strand
transcript_start
transcript_end
ensembl_exon_id
exon_chrom_start
exon_chrom_end
strand
rank

Ensembl Gene ID
Description
Associated Gene Name
Associated Gene DB
Chromosome Name
Gene Start (bp)
Gene End (bp)
Ensembl Protein Family ID(s)
CDS Length
CDS Start
CDS End
5' UTR Start
5' UTR End
3' UTR Start
3' UTR End
Ensembl Transcript ID
Ensembl Protein ID
Strand
Transcript Start (bp)
Transcript End (bp)
Ensembl Exon ID
Exon Chr Start (bp)
Exon Chr End (bp)
Strand
Exon Rank in Transcript

We can create an index of the line numbers where the go_ pattern occurs:
> g <- grep("go_",listAttributes(ensmart, what = c("name")))
> g
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[1] 24 25 26 27 28 29 30 31 32
When we want to reprint the names, we still need to specify that we looked in the
“name” column:
>

listAttributes(ensmart, what = c("name"))[g]

[1]
[3]
[5]
[7]
[9]

"go_biological_process_id"
"go_biological_process_linkage_type"
"go_cellular_component_description"
"go_molecular_function_id"
"go_molecular_function_linkage_type"

"go_biological_process_description"
"go_cellular_component_id"
"go_cellular_component_linkage_type"
"go_molecular_function_description"

We can place these names into an R object called gonames:
>

gonames <- listAttributes(ensmart, what = c("name"))[g]

Let’s search the GO data for one probe:
> values <-c ("910_at")
> a <-c("affy_hg_u95av2", "chromosome_name", "start_position",
gonames)
> f <- c("affy_hg_u95av2")
> getBM(attributes=a,filters=f,values=values,mart=ensembl)
affy_hg_u95av2 chromosome_name start_position go_biological_process_id
1
910_at
17
73681755
GO:0006139
2
910_at
17
73681755
GO:0006139
[...]
23
910_at
17
73681755
GO:0006260
24
910_at
17
73681755
GO:0006260
go_biological_process_description go_biological_process_linkage_type
1 nucleobase, nucleoside, nucleotide and nucleic acid metabolic process
TAS
2 nucleobase, nucleoside, nucleotide and nucleic acid metabolic process
TAS
[...]
23
DNA replication
IEA
24
DNA replication
IEA
go_cellular_component_id go_cellular_component_description go_cellular_component_linkage_type
1
GO:0005829
cytosol
IEA
2
GO:0005829
cytosol
IEA
[...]
23
GO:0005737
cytoplasm
IEA
24
GO:0005737
cytoplasm
IEA
go_molecular_function_id go_molecular_function_description go_molecular_function_linkage_type
1
GO:0000166
nucleotide binding
IEA
2
GO:0004797
thymidine kinase activity
TAS
[...]
23
GO:0016740
transferase activity
IEA
24
GO:0019206
nucleoside kinase activity
IEA
>

The “linkage type” refers is only a 2 to 3 letters “evidence code” and refers to how the
data was annotated. The table of codes is available with long explanation on the gene
ontology web site: http://www.geneontology.org/GO.evidence.shtml
Experimental Evidence Codes
EXP: Inferred from Experiment
IDA: Inferred from Direct Assay
IPI: Inferred from Physical Interaction
IMP: Inferred from Mutant Phenotype
IGI: Inferred from Genetic Interaction
IEP: Inferred from Expression Pattern
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Computational Analysis Evidence Codes
ISS: Inferred from Sequence or Structural Similarity
ISO: Inferred from Sequence Orthology
ISA: Inferred from Sequence Alignment
ISM: Inferred from Sequence Model
IGC: Inferred from Genomic Context
RCA: inferred from Reviewed Computational Analysis
Author Statement Evidence Codes
TAS: Traceable Author Statement
NAS: Non-traceable Author Statement
Curator Statement Evidence Codes
IC: Inferred by Curator
ND: No biological Data available
Automatically-assigned Evidence Codes
IEA: Inferred from Electronic Annotation
Obsolete Evidence Codes
NR: Not Recorded
To obtain the list for one of the “top 30” e.g. geneIDs[top30.Est10] we can simply
change the “values” in the command and place everything within R object
top30.Est10_GO .
> top30.Est10_GO <- getBM(attributes=a,filters=f,
values=geneIDs[top30.Est10], mart=ensmart)
The result is about 3000 lines long and can later be exported into a tab-delimited text
file:
> write.table(top30.Est10_GO,file="Est10_GO.xls",sep="\t",
quote=FALSE,col.names=NA)

8. Before we go
It is clear that the organization of the data and deciding which biological question we
want to ask is crucial to the final computation.
In particular, the seemingly simple “pheno data” file, simplified from the original supplied
within the estrogen package, plays a key role in organizing the data, and the ensuing
design and contrast matrices.
The limma package user’s guide is 87 pages long and offers mode in-depth explanation
of some of the statistics, calculation methods and R specificities.
Page 76 of the guide shows the estrogen calculation using the original phenoData.txt
file supplied within the estrogen package.
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Finally, R and BioConductor are updated every 6 month. Some commands get
“deprecated” and eventually disappear. Some of the differences with older versions R
2.4/BioC 1.9 and with R 2.5/BioC 2.0 were highlighted in a few cases.
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10. End of lab -

-------------------------
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Notes
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Part 4
Analysis of Affymetrix Microarray Data (continued):

Time‐Course Analysis ‐

a case study using yeast2 Affymetrix arrays.
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Within the text, user input is shown as bold text or command
> is the R prompt and is not to be typed
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1. Introduction
This exercise is largely based on the article by Gillespie et al.1 developed with R 2.9 and
R 2.10 versions. The flow of the exercises is that of the paper. However, I have blended
necessary steps from additional files when possible for clarity and flow. There are a lot
of assumptions along the way, and I have added commands to try to clarify some of the
authors commands.
Relevant portion of the paper abstract: “[…] we highlight how to construct appropriate
contrasts to detect differentially expressed genes and how to generate plausible
pathways from the data. A maintained version of the R commands can be found at
http://www.mas.ncl.ac.uk/~ncsg3/microarray/”

2. Set-up
These exercises are set-up for the BTCI Windows machines. R might be available as a
shortcut icon on the desktop
R should also be available
as the usual
Start > All Programs
menu cascade.
(Shown here for R 2.9.0)
The following section lists the required software and packages. In this way you can
configure your own system with the necessary elements.

2.1 Required software
The R/Bioconductor software should already be installed on the class computers.
Required software for these exercises: R version 2.10, or R 2.11.1 or later.
BioConductor packages: affy, affyPLM, ArrayExpress, limma,Mfuzz, timecourse,
yeast2.db, yeast2probe.
Info at
http://www.bioconductor.org/packages/release/Software.html
Cran packages: GeneNet, gplots.
1

Gillespie CS, Lei G, Boys RJ, Greenall A, Wilkinson DJ. (2010) Analysing time course
microarray data using Bioconductor: a case study using yeast2 Affymetrix arrays.
BMC Res Notes. 3:81.
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See installation below:

2.2

INSTALLING Required software

R and BioConductor are already installed on these computers. To install on your own
system refer to the Installation instructions Part 0 or run the Bioconductor Lite install as
suggested in the paper from within R (- but DON’T DO IT HERE!-):
> url='http://bioconductor.org/biocLite.R'
> source(url)
> biocLite()
However we need to install the packages specific to this exercise:
Please do the following:
Launch R from the R icon on the desktop or the Start menu.
At the > prompt type the following commands:
> source("http://bioconductor.org/biocLite.R")
> biocLite(c('ArrayExpress', 'Mfuzz', 'timecourse', 'yeast2.db',
'yeast2probe'))
Additionally the following 2 packages that are not part of BioConductor are necessary:
> install.packages(c('GeneNet', 'gplots'))
--- Please select a CRAN mirror for use in this session ---

You will be asked to identify a CRAN server
from which to download.
//
Choose a USA server that is geographically
close, e.g. Iowa (IA) or Michigan (MI) for
example.
Then click OK
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2.3

Updating software

The following is not necessary today, but here for the record and to remain consistent
with the paper. The updates are not always possible between various versions of R, but
this command is useful to update a current R installation. DO NOT DO TODAY:
> update.packages(repos = biocinstallRepos())

3. Array Express E-MEXP-1551 data set
The data set is from Greenall et al.2 as detailed from their Figure 2a with five time
points:

Schematic representation of microarray time courses. For each of the three separate time
course experiments, one CDC13+ and one cdc13-1 strain were inoculated into liquid
culture and grown to early log phase at 23°C. Samples were taken (T = 0) and strains were
transferred to 30°C with further samples taken every 30 minutes from 1 to 4.5 hours
thereafter. Samples from 1, 2, 3 and 4 hours after the temperature shift (T = 1 - T = 4) were
used for the array experiment and the remaining samples were stored.

Citing the paper: “We decided that 30°C was a suitable restrictive temperature for
examination of the transcriptional response to telomere uncapping as this
temperature induces telomere uncapping in cdc13-1 strains whilst causing
minimal heat stress.
In order to generate a robust data set, a multi-time-point time course and three
biological replicates of each strain were used (Figure2a) To produce independent
biological replicates, we performed a genetic cross between a CDC13+ and a
cdc13-1 strain to generate three cdc13-1 and three CDC13+ strains. The
resulting sets of strains demonstrated reproducible cell cycle arrest, growth,
2

Greenall A, Lei G, Swan DC, James K, Wang L, Peters H, Wipat A, Wilkinson DJ, Lydall D. A genome
wide analysis of the response to uncapped telomeres in budding yeast reveals a novel role for the NAD+
biosynthetic gene BNA2 in chromosome end protection. Genome Biol. 2008; 9(10): R146.
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viability and HSP12 expression upon exposure to the 30°C restrictive
temperature (Additional data file 2). Strains were in the S288C genetic
background since the S. cerevisiae genome sequence was derived from an
S288C strain and oligonucleotides on microarray chips are based upon the
published genome sequence.”

3.1 Entering data into Bioconductor
The data used in this paper can be downloaded from ArrayExpress into R using the
commands
> library(ArrayExpress)
> yeast.raw = ArrayExpress('E-MEXP-1551')
trying URL 'http://www.ebi.ac.uk/microarray-as/ae/files/E-MEXP-1551/index.html'
Content type 'text/html;charset=ISO-8859-1' length unknown
opened URL
downloaded 8845 bytes
trying URL 'http://www.ebi.ac.uk/microarray-as/ae/files/E-MEXP-1551/E-MEXP1551.raw.1.zip'
Content type 'application/zip' length 30311885 bytes (28.9 Mb)
opened URL
downloaded 28.9 Mb
Read 1 item
trying URL 'http://www.ebi.ac.uk/microarray-as/ae/files/E-MEXP-1551/E-MEXP1551.sdrf.txt'
Content type 'text/plain' length 34138 bytes (33 Kb)
opened URL
downloaded 33 Kb
trying URL 'http://www.ebi.ac.uk/microarray-as/ae/files/A-AFFY-47/A-AFFY47.adf.txt'
Content type 'text/plain' length 1275613 bytes (1.2 Mb)
opened URL
downloaded 1.2 Mb
trying URL 'http://www.ebi.ac.uk/microarray-as/ae/files/E-MEXP-1551/E-MEXP1551.idf.txt'
Content type 'text/plain' length 5467 bytes
opened URL
downloaded 5467 bytes
Read 49 items
The object containing experiment

E-MEXP-1551

has been built.

>

A brief description of the yeast.raw object can be obtained:
> print(yeast.raw)
AffyBatch object
size of arrays = 496 × 496 features (3160 kb)
cdf = Yeast_2 (10928 affyids)
number of samples = 30
number of genes = 10928
annotation = yeast2
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Note: If the Affymetrix microarray data sets have been downloaded from the
Array Express web site into a single directory, then the .cel files can be loaded
into R using the ReadAffy() command e.g. yeast.raw = ReadAffy()
More information is contained within this R object, divided in various sub-compartments:
> class(yeast.raw)
[1] "AffyBatch"
attr(,"package")
[1] "affy"
> slotNames(yeast.raw)
[1] "cdfName"
"nrow"
[4] "assayData"
"phenoData"
[7] "experimentData"
"annotation"
[10] ".__classVersion__"

"ncol"
"featureData"
"protocolData"

> yeast.raw@phenoData
An object of class "AnnotatedDataFrame"
rowNames: Gre_MCA_6510.CEL, Gre_MCA_6671.CEL, ...,
Gre_MCA_6886.CEL (30 total)
varLabels and varMetadata description:
Source.Name:
Material.Type:
...: ...
Factor.Value.INDIVIDUAL.:
(34 total)
Below we will use phenoData which contains annotations, such as file names.

3.2 Experimental conditions
When the dataset was downloaded, the data (in the form of the .CEL files) was also
integrated into one R object called yeast.raw. The ArrayExpress() command also
summoned information about the experimental conditions, included in the phenoData
frame slot. There are a series of nested information slots that can be decoded with the
help of the R code below.
> ph = yeast.raw@phenoData
> slotNames(ph)
[1] "varMetadata"
".__classVersion__"
> slotNames(ph@data)
[1] ".Data"
"names"

"data"

"dimLabels"

"row.names" ".S3Class"

The row.names entry is composed of the .CEL file name:
> row.names(ph@data)
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[1]
[4]
[7]
[10]
[13]
[16]
[19]
[22]
[25]
[28]

"Gre_MCA_6510.CEL"
"Gre_MCA_9147.CEL"
"Gre_MCA_4108.CEL"
"Gre_MCA_0356.CEL"
"Gre_MCA_4493.CEL"
"Gre_MCA_8298.CEL"
"Gre_MCA_5948.CEL"
"Gre_MCA_1103.CEL"
"Gre_MCA_3174.CEL"
"Gre_MCA_9211.CEL"

"Gre_MCA_6671.CEL"
"Gre_MCA_7528.CEL"
"Gre_MCA_8052.CEL"
"Gre_MCA_3824.CEL"
"Gre_MCA_6052.CEL"
"Gre_MCA_3378.CEL"
"Gre_MCA_8454.CEL"
"Gre_MCA_1726.CEL"
"Gre_MCA_8016.CEL"
"Gre_MCA_9301.CEL"

"Gre_MCA_5014.CEL"
"Gre_MCA_7817.CEL"
"Gre_MCA_7031.CEL"
"Gre_MCA_2172.CEL"
"Gre_MCA_6857.CEL"
"Gre_MCA_3864.CEL"
"Gre_MCA_2822.CEL"
"Gre_MCA_2282.CEL"
"Gre_MCA_9353.CEL"
"Gre_MCA_6886.CEL"

The entry names contains the header names of all the data associated with each CEL
file. It is extremely useful to explore these names as shown here because they can help
explain why a procedure no longer works as detailed below:
Note: The following out put was obtained in the week of June 1, 2010 and had 34
entries:
> names(ph@data)
[1]
[3]
[5]
[7]
[9]
[11]
[13]
[15]
[17]
[19]
[21]
[23]
[25]
[27]
[29]
[31]
[33]

"Source.Name"
"Characteristics.Organism."
"Characteristics.BioSourceType."
"Characteristics.Individual."
"Characteristics.StrainOrLine."
"Protocol.REF.1"
"Extract.Name"
"Protocol.REF.3"
"LabeledExtract.Name"
"Protocol.REF.4"
"Hybridization.Name"
"Protocol.REF.5"
"Array.Data.File"
"Term.Source.REF.3"
"Factor.Value.TEMPERATURE."
"Factor.Value.TIME."
"Factor.Value.GENOTYPE."

"Material.Type"
"Provider"
"Characteristics.Sex."
"Characteristics.Genotype."
"Protocol.REF"
"Protocol.REF.2"
"Material.Type.1"
"Term.Source.REF"
"Label"
"Term.Source.REF.1"
"Array.Design.REF"
"Term.Source.REF.2"
"Protocol.REF.6"
"Derived.Array.Data.File"
"Unit.temperature."
"Unit.time."
"Factor.Value.INDIVIDUAL."

A newer out created on June 17, 2010 after a reload of the data directly from
ArrayExpress gave the results below with 41 entries (see below under after this
table).
IMPORTANT NOTE: not only did the number of entries change, but the
nomenclature of key components used below to create R object exp_fac was
changed as well:
was changed to: "Factor.Value..TIME." and the other 2
factors of interest were both changed from “one dot” to “two dots” after the word
Value. See below:
"Factor.Value.TIME."

Page - 137 -

R and Bioconductor- time-course analysis
> names(ph@data)
[1] "Source.Name"
"Characteristics..Organism."
[3] "Characteristics..Sex."
"Term.Source.REF"
[5] "Characteristics..Genotype."
"Characteristics..BioSourceType."
[7] "Term.Source.REF.1"
"Characteristics..StrainOrLine."
[9] "Term.Source.REF.2"
"Characteristics..Individual."
[11] "Provider"
"Protocol.REF"
[13] "Protocol.REF.1"
"Protocol.REF.2"
[15] "Extract.Name"
"Material.Type"
[17] "Term.Source.REF.3"
"Protocol.REF.3"
[19] "Labeled.Extract.Name"
"Label"
[21] "Material.Type.1"
"Protocol.REF.4"
[23] "Hybridization.Name"
"Array.Design.REF"
[25] "Term.Source.REF.4"
"Comment..Array.Design.URI."
[27] "Protocol.REF.5"
"Factor.Value..TIME."
[29] "Unit..QuantityUnit."
"Factor.Value..GENOTYPE."
[31] "Factor.Value..INDIVIDUAL."
"Factor.Value..TEMPERATURE."
[33] "Scan.Name"
"Array.Data.File"
[35] "Comment..ArrayExpress.FTP.file."
"Comment..ArrayExpress.Data.Retrieval.URI."
[37] "Protocol.REF.6"
"Derived.Array.Data.Matrix.File"
[39] "Comment..Derived.ArrayExpress.FTP.file."
"Comment..Derived.ArrayExpress.Data.Retrieval.URI."
[41] "X"
>

In bold-underlined are the entries that will be used below.
The data for the first entry can be displayed with:
(Note that the row name (Gre_MCA_6510.CEL ) is reproduced at each line.)
> ph@data[1,]
Source.Name Material.Type
Gre_MCA_6510.CEL CDC13 time0 DLY1584 whole_organism
Characteristics.Organism.
Gre_MCA_6510.CEL Saccharomyces cerevisiae
[...]
Unit.temperature. Factor.Value.TIME. Unit.time.
Gre_MCA_6510.CEL
degree_C
0
minutes
Factor.Value.GENOTYPE.
Gre_MCA_6510.CEL MAT&#945; mfa::MFA1pr-HIS3 can1 ura3 leu2 his3 lys2
Factor.Value.INDIVIDUAL.
Gre_MCA_6510.CEL
DLY1584

Each of the 34 name entries obtained from the command names(ph@data) above
could be used in such a command. The commands ph@data[,1] and
ph@data$Source.Name are equivalent:
> ph@data[,1]
[1]
[4]
[7]
[10]
[13]
[16]
[19]
[22]
[25]
[28]

"CDC13 time0 DLY1584"
"CDC13 time120 DLY1584"
"CDC13 time180 DLY1584"
"CDC13 time240 DLY1584"
"CDC13 time60 DLY1584"
"cdc13-1 time0 DLY1622"
"cdc13-1 time120 DLY1622"
"cdc13-1 time180 DLY1622"
"cdc13-1 time240 DLY1622"
"cdc13-1 time60 DLY1622"

"CDC13 time0 DLY3107"
"CDC13 time120 DLY3107"
"CDC13 time180 DLY3107"
"CDC13 time240 DLY3107"
"CDC13 time60 DLY3107"
"cdc13-1 time0 DLY3100"
"cdc13-1 time120 DLY3100"
"cdc13-1 time180 DLY3100"
"cdc13-1 time240 DLY3100"
"cdc13-1 time60 DLY3100"
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"CDC13 time120 DLY3108"
"CDC13 time180 DLY3108"
"CDC13 time240 DLY3108"
"CDC13 time60 DLY3108"
"cdc13-1 time0 DLY3102"
"cdc13-1 time120 DLY3102"
"cdc13-1 time180 DLY3102"
"cdc13-1 time240 DLY3102"
"cdc13-1 time60 DLY3102"
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After this intermission of commands to understand how the information is nestled in
various layers of the imported data, we can return to the paper which stated that “some
preprocessing is necessary:”
Note: The published command was:
> exp_fac = data.frame(data_order = seq (1, 30), strain =
ph@data$Factor.Value.GENOTYPE., replicates =
ph@data$Factor.Value.INDIVIDUAL., tps =
ph@data$Factor.Value.TIME.)
It has to be changed to take into account the “double dot” introduced after the word
Value as detailed above.
> exp_fac = data.frame(data_order = seq (1, 30), strain =
ph@data$Factor.Value..GENOTYPE., replicates =
ph@data$Factor.Value..INDIVIDUAL., tps =
ph@data$Factor.Value..TIME.)
> levels(exp_fac$strain) = c('m', 'w')
> exp_fac = with(exp_fac, exp_fac[order(strain, replicates,
tps), ])
> exp_fac$replicate = rep(c(1, 2, 3), each = 5, 2)
The resulting exp_fac object now contains the following information, extracted and
rearranged from the imported experimental information:
> exp_fac
16
28
19
22
25
17
29
20
23
26
18
30
21
24
27
1
13
4
7
10
2
14
5
8
11

data_order strain replicates tps replicate
16
m
DLY1622
0
1
28
m
DLY1622 60
1
19
m
DLY1622 120
1
22
m
DLY1622 180
1
25
m
DLY1622 240
1
17
m
DLY3100
0
2
29
m
DLY3100 60
2
20
m
DLY3100 120
2
23
m
DLY3100 180
2
26
m
DLY3100 240
2
18
m
DLY3102
0
3
30
m
DLY3102 60
3
21
m
DLY3102 120
3
24
m
DLY3102 180
3
27
m
DLY3102 240
3
1
w
DLY1584
0
1
13
w
DLY1584 60
1
4
w
DLY1584 120
1
7
w
DLY1584 180
1
10
w
DLY1584 240
1
2
w
DLY3107
0
2
14
w
DLY3107 60
2
5
w
DLY3107 120
2
8
w
DLY3107 180
2
11
w
DLY3107 240
2
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3
15
6
9
12

3
15
6
9
12

w
w
w
w
w

DLY3108
0
DLY3108 60
DLY3108 120
DLY3108 180
DLY3108 240

3
3
3
3
3

The data frame exp_fac stores all the necessary information, such as strain, time and
replicate, which are necessary for the statistical analysis.
Note that there are two yeast species on this chip, S. pombe and S. cerevisiae. Also,
amongst the 10,928 probesets (with each probeset having 11 probe pairs), there are
5,900 S. cerevisiae probesets.
In the next section we will extract only the data for further analysis with S. cerevisiae.

3.3 Pre‐processing
3.3.1 Extraction of S. cerevisiae probesets
As these microarrays contain probesets for both S. cerevisiae and S. pombe, we first
need to extract the S. cerevisiae data before normalisation. This can be done by filtering
out the S. pombe data using the s_cerevisiae.msk file from or the author’s website
the Affymetrix website (which requires free registration):
http://www.mas.ncl.ac.uk/~ncsg3/microarray/s_cerevisiae.msk
http://www.affymetrix.com/Auth/support/downloads/mask_files/s_ce
revisiae.zip
IMPORTANT NOTE: the mask file s_cerevisiae.msk might be provided in class.
Alternatively please download the s_cerevisiae.msk mask file from one of the
above web sites.
[Also] note that in our analysis, the transcript id i.e. the systematic orf name (obtained
from [Yeast Annotation File: http://www.affymetrix.com/Auth/analysis/
downloads/na24/ivt/Yeast_2.na24.annot.csv.zip ] is used for genes with no
name.
We obtain a data frame containing lists of S. cerevisiae genes, probes and transcripts
(using the function ExtractIDs() in the Additional file 1) as follows:
IMPORTANT NOTE: the additional functions: ExtractIDs.R, RemoveProbes.R might be
provided in class. Alternatively they can be downloaded from the author’s web site:
http://www.mas.ncl.ac.uk/~ncsg3/microarray/ or with the direct links:
http://www.mas.ncl.ac.uk/~ncsg3/microarray/ExtractIDs.R
http://www.mas.ncl.ac.uk/~ncsg3/microarray/RemoveProbes.R
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Make sure they files are placed in the current working directory (type getwd() if you
don’t know it’s current value).
> # Read in the mask file
> s_cer = read.table('s_cerevisiae.msk', skip = 2,
stringsAsFactors = FALSE)
> probe_filter = s_cer[[1]]
> source('ExtractIDs.R')
> c_df = ExtractIDs(probe_filter)
We also need to restrict the view of yeast.raw to the x- and y- coordinates of the S.
cerevisiae probesets in the cdf environment by using
>
>
>
>
>
>

# Get the raw dataset for S. cerevisiae only
library(affy)
library(yeast2probe)
source('RemoveProbes.R')
cleancdf = cleancdfname(yeast.raw@cdfName)
RemoveProbes(probe_filter, cleancdf, 'yeast2probe')

Error in get("xy2indices", paste("package:", cdfpackagename, sep = "")) :
object 'xy2indices' not found

(Note: It may be necessary to issue the last set of commands TWICE before it actually
works. There will be an error, however the number of attributes is correct:)
Thus the attributes of yeast.raw […] are now:
> yeast.raw
AffyBatch object
size of arrays=496x496 features (3160 kb)
cdf=Yeast_2 (5900 affyids)
number of samples=30
number of genes=5900
annotation=yeast2
notes=c("E-MEXP-1551", "")
c("E-MEXP-1551", "")
c("temperature", "time", "genotype", "individual")
c("in_vitro_design", "co-expression_design",
"time_series_design", "stimulus_or_stress_design",
"genetic_modification_design")
NULL

>
And indeed there are now only 5900 genes.

3.4 Data Quality Assessment
Before any formal statistical analysis, it is important to check for data quality. Initially, we
might examine the perfect and mismatch probe-level data to detect anomalies. Images
of the first five arrays can be obtained using:
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> op = par(mfrow = c(3, 2))
> for(i in 1:5) {
plot_title = paste ('Strain:', exp_fac$strain [i], 'Time:',
exp_fac$tps [i])
d = exp_fac$data_order [i]
image(yeast.raw [, d], main = plot_title)
}
> par(mfrow = c(1, 1))
Note: There are 30 samples. To display the others simply adapt the value of “i” in the “for loop

These commands produce the
image shown in the Additional
file 1: Figure S2 of the paper.
Data quality can be assessed by
examining such images for
anything that appears nonrandom such as rings, shadows,
lines and strong variations in
shade. The images for our data
set do not appear to have any
non-random structure and so
data quality is probably high.

Reminder note: we have seen an example in Part 01 with the file “bad.cel”
Another useful quality assessment tool is to examine density plots of the probe
intensities. The command
> d = exp_fac$data_order[1:5]
> hist(yeast.raw[, d], lwd = 2, ylab = 'Density', xlab = 'Log
(base 2) intensities')
(ylab and xlab are labels to be printed onto the plot.)
produces the image shown in the Additional file 1: Figure S3.
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Figure S3, limited to the 5 time states of the first
sample (from command above with d limit of 1:5)

Additional image created with all 30 data points.
Use all of yeast.raw omit [,d] in the command.

Typically, differences in spread (width) and position are corrected by normalization.
However, the appearance of significant multi-modality in the distribution or many
outlying observations are indicative of poor data quality.
Other exploratory data analysis techniques that should be carried include MAplots,
where two microarrays are compared and their log intensity difference for each probe
on each gene are plotted against their average.
The following commands create MA plots for 2 time points (number 1 and number 27)
versus a pseudo-median chip average of all chips:
> par(mfrow=c(1,2))
> MAplot(rawdata,which=1)
> MAplot(rawdata,which=27)
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The plot can be refined with a stronger loess line and the new smooth option:
> MAplot(yeast.raw,which=1, plot.method=”smoothScatter”, lwd =2)
> MAplot(yeast.raw,which=27,plot.method=”smoothScatter”, lwd =2)
> par(mfrow=c(1,1))

Also of interest is to examine RNA degradation (see [6]), although [11] cast some doubt
over the validity of this method. For details on how to carry out both of these methods in
R, see [12,13] for detailed instructions.
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Commands to create the RNA degradation
plot:

> RNAdeg <- AffyRNAdeg(rawdata)
> plotAffyRNAdeg(RNAdeg)

3.5 Normalizing Microarray Data
There are number of methods for normalizing microarray data. Two of the most popular
methods are GeneChip RMA (GCRMA) and Robust Multiple-array Average (RMA); see
[14,15]. Essentially, GCRMA and RMA differ in how they deal with background noise,
with GCRMA using a more sophisticated correction algorithm. However, the approach
adopted by GCRMA means that it can be time-consuming to use with large data sets in
contrast to RMA. A potential drawback of using RMA is that it assumes that the overall
levels of expression are similar for each array. However this assumption may be invalid
if, for example, mutant cells have a radically different level of transcriptional activity than
the WT. For further information regarding normalizing microarray data sets, see for
example [16,17].
Since we have thirty microarray data sets and believe that the levels of transcriptional
activity are similar across strains, we will use the RMA normalization method.
This technique normalizes across the set of hybridizations at the probe level. The data
can be normalized via
> yeast.rma = rma(yeast.raw)
Background correcting
Normalizing
Calculating Expression

The calculation should take 1 min. or less.
yeast.matrix (below) is a giant table containing the normalized expression for each
probe (table rows) for each chip (table columns) :
> yeast.matrix = exprs(yeast.rma)[, exp_fac$data_order]
The complete table is too big to print, but (for example), the first 3 rows can be written
on screen:
Page - 145 -

R and Bioconductor- time-course analysis
> yeast.matrix[1:3,]
m0
1769308_at 8.860619
1769311_at 11.246516
1769312_at 9.632986
m120
1769308_at 8.936551
1769311_at 11.370302
1769312_at 9.673280
m240
1769308_at 9.073148
1769311_at 11.605341
1769312_at 9.594282
w60
1769308_at 8.587493
1769311_at 11.375459
1769312_at 9.681305
w180
1769308_at 8.755002
1769311_at 11.472296
1769312_at 9.703869

m60
8.723357
11.202726
9.788747
m180
9.001357
11.476561
9.598665
w0
8.816134
11.308507
9.653468
w120
8.715654
11.433773
9.683896
w240
8.725156
11.444062
9.690121

m120
8.835967
11.299114
9.824055
m240
9.124745
11.592767
9.537743
w60
8.578433
11.419807
9.702018
w180
8.703288
11.395475
9.728370

m180
8.944285
11.429869
9.637483
m0
8.827501
11.133607
9.638021
w120
8.713219
11.448758
9.709233
w240
8.667149
11.359891
9.740792

m240
9.067881
11.528925
9.575285
m60
8.742436
11.276608
9.713024
w180
8.724672
11.385754
9.805882
w0
8.844624
11.066622
9.718542

m0
m60
8.90090 8.672034
11.17173 11.287753
9.46118 9.694396
m120
m180
8.907495 8.857443
11.401372 11.442882
9.783715 9.484620
w240
w0
8.741514 8.950618
11.357146 11.052183
9.825952 9.461805
w60
w120
8.670644 8.717778
11.449479 11.437824
9.680354 9.680532

>
The rest of the commands call on various columns of the exp_fac object created
earlier to rearrange the row name:
> cnames = paste(exp_fac$strain, exp_fac$tps, sep = ' ')
> colnames(yeast.matrix) = cnames
> exp_fac$data_order = 1:30
The normalization procedure consists of three steps: model-based background
correction, quantile normalization and robust averaging. The aim of the quantile
normalization is to make the distribution of probe intensities for each array in a set of
arrays the same. We illustrate its effect by studying boxplots of the raw S. cerevisiae
data against their normalized counterparts values, shown in the Additional file 1: Figure
S4. Boxplots provide a useful graphical view of data distributions and contain their
median, quartiles, maximum and minimum values. The boxplot command is in the
affyPLM package and so the figure is produced by using:
> library(affyPLM)
> par(mfrow = c(1, 2))
> #Raw data intensities
> boxplot(yeast.raw, col = 'red', main="Probe intensities")
> #Normalized intensities
> boxplot(yeast.rma, col ='blue',main="RMA expression values")
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We can also wonder how the data distribution was affected by the normalization by
plotting the histogram of the normalized data. However, the hist() command will work
differently with the normalized object (yeast.rma) and it is necessary to specify that
we want to plot the expression values (exprs). Instead of plotting a histogram with a
continuous line we will obtain a bar graph. To augment the precision of the plot we can
enhance the number of breaks from the default of about 20 to a higher number, e.g. 50:
We can plot individual arrays, or all arrays averaged together. The following 2 plots
show the plot of the first array and the average of all arrays:
> hist(exprs(yeast.rma)[,1],breaks = 50, lwd=2, ylab='Density',
xlab='Log (base 2) intensities')
> hist(exprs(yeast.rma),breaks = 50, lwd=2, ylab='Density',
xlab='Log (base 2) intensities')

hist(exprs(yeast.rma)[,1],...

hist(exprs(yeast.rma),...
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We can notice that the bumps on the left hand side have not been smoothed out by
normalization. Therefore some assumptions of normalization might not hold completely
true for some statistical calculation.
We could also look again at the MA plots, as we have in previous section (see Part 02).
For example for pair-wise comparison for the first 5:
> mva.pairs(exprs(yeast.rma)[,c(1,2,3,4,5)], log.it=FALSE)

3.6 Principal Component Analysis
Principal component analysis (PCA) is useful in exploratory data analysis as it can
reduce the number of variables to consider whilst still retaining much of the variability in
the data. In particular, PCA is useful for identifying patterns in the data. Essentially,
principal components partition the data into orthogonal linear components which explain
different contributions to the variability in the data. The first component explains the
largest contribution to variability in the original dataset, that is, retains most information,
with the second component explaining the next largest contribution to variability, and so
on. The following commands calculate the principal components
> par(mfrow = c(1, 1))
> yeast.PC = prcomp(t(yeast.matrix))
> yeast.scores = predict(yeast.PC)
which we can then plot using
> #Plot of the first two principal components
> plot(yeast.scores [, 1], yeast.scores [, 2],
xlab = 'PC 1', ylab = 'PC 2', pch = rep(seq (1, 5), 6),
col = as.numeric(exp_fac$strain))
> legend(-20, -4, pch = 1:5, cex = 0.6, c('t 0', 't 60', 't
120', 't 180', 't 240'))
Note: see also the Addendum at the end of this tutorial for 3D PCA plot method

Page - 148 -

R and Bioconductor- time-course analysis

Figure 1 - A plot of the first two principal components. The red symbols correspond to the wild

Figure 1 highlights a clear (and expected) time effect in the mutant yeast which is not
present in the wild-type strain. In particular, mutant samples are clustered by their time
points; for example, the three mutant replicates at time point 4 are clustered at the
bottom right of the figure. [note: the authors probably meant top right of the figure!]
Reminder note: the plot character (pch) is chosen
from a predefined graphical set3 and colored by
strain (col =).

There are 30 sample files and the rotation is created with the repeat (rep) and
sequence (seq) commands 6 times 5:
> seq (1, 5)
[1] 1 2 3 4 5
> rep(seq (1, 5), 6)
[1] 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5 1 2 3 4 5
>
Changing the portion of the command from rep(seq (1, 5), 6) to rep(seq (15,
19), 6) would use the filled characters instead.

3

See e.g. http://www.harding.edu/fmccown/R/
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3.7 Addendum: PCA in 3D
This was not part of the original paper. It may or may not be reviewed in class due to
time constraints.
3.7.1 Install rgl, a 3D CRAN package
This is necessary for interactive 3D display. Use the following line-command method of
install with the GUI interface if preferred:

> install.packages("rgl")
3.7.2 Install / paste plotlm3d function
Source: http://bit.ly/9gdbyG
(Redirects to a page with a very long URL on http://rwiki.sciviews.org/)
The function file contains 187 lines of code on the above page and the first line reads:
# Name
: plotlm3d
Simply copy and paste the text of the function into the main R window. Alternatively, use
the file plotlm3d.R with the source command: source plotlm3d.R
3.7.3 Replot PCA
When PCA was plotted in 2D we used the first 2 values of yeast.score. The following
uses a 3rd value and plots everything in 3D. All points are plotted as spheres which are
colored by strain with the groups command and made bigger with sphere.factor.
The optional simple.axes command provides a better “cube” look for the final plot
> open3d()
> rgl.bringtotop(stay = T)
> plotlm3d(yeast.scores [, 1],
yeast.scores [, 2],
yeast.scores [, 3],
surface
= F,
simple.axes
= F,
groups
= exp_fac$strain,
xlab
= 'x',
ylab
= 'y',
zlab
= 'z',
sphere.factor = 3)
>
The result is an interactive 3D plot. The plot on the right approximates best the position
of elements in the 2D view created earlier.
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4. Identifying differentially expressed genes
In this experiment, interest lies in differences in gene expression over time between the
wild-type and mutant yeast strains. It is expected that the wild-type expression level is
independent of time. Also we anticipate that the mutant expressions at time t = 0 are the
same as the wild-type expression level. This hypothesis is supported by the PCA plot in
Figure 1.
There are currently two main packages available to detect differentially expressed
genes using this kind of data: the timecourse package and the limma package. We
illustrate how to analyse these data using both packages.

4.1 Using the timecourse package
4.1.1 Timecourse introduction
This package assesses treatment differences by comparing time-course mean profiles
allowing for variability both within and between time points. It uses the multivariate
empirical Bayes model proposed by [18].
Further details of the timecourse package can be found in [19]. There are also
information in the package vignette, which can be called from the GUI under the
“vignettes” menu. The list of vignettes and their name(s) can be obtained with the
following command:
> vignette(package = "timecourse")
and the actual PDF vignette can be called with:
> vignette(“timecourse”, package = "timecourse")
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From the Vignette: The timecourse package aims to serve as a comprehensive library for the
analysis of developmental microarray time course data. The current version includes functions for
identifying genes of interest from longitudinal replicated developmental microarray time course
experiments with one or more biological conditions. The main functions are mb.long() and
2
mb.MANOVA(). They calculate the MB-statistics and/or ~T statistics derived in Tai and Speed
(2006) and Tai (2005), using multivariate empirical Bayes approaches. [ . . . ]
The multivariate empirical Bayes models proposed [ . . . ] have the advantage over the traditional
F-statistic in that they incorporate replicate variances, the correlations among gene expression time
point samples from longitudinal data, and moderation borrowing the information across genes into
the analysis to reduce the numbers of false positives and false negatives induced by those poorly
estimated variance-covariance matrices.
References:
- Y. C. Tai and T. P. Speed. A multivariate empirical Bayes statistic for replicated microarray time course data.
Annals of Statistics, 34(5):2387{2412, 2006.
- Y. C. Tai. Multivariate empirical Bayes models for replicated microarray time course data. PhD thesis,
Division of Biostatistics, University of California, Berkeley, May 2005.

4.1.2 Timecourse calculation:
After installing the timecourse library, we construct a size matrix describing the
replication structure using:
> library(timecourse)
Loading required package: limma
Loading required package: MASS

> size = matrix(3, nrow = 5900, ncol = 2)
To extract a list of differentially expressed we calculate the Hotelling statistic4

via:

First we create objects that contain samples information, based on the exp_fac table
object created earlier. These will be used in a subsequent command
> c.grp = as.character(exp_fac$strain)
> t.grp = as.numeric(exp_fac$tps)
> r.grp = as.character(exp_fac$replicate)
> c.grp
[1] "m" "m" "m" "m" "m" "m" "m" "m" "m" "m" "m" "m" "m" "m" "m" "w"
[17] "w" "w" "w" "w" "w" "w" "w" "w" "w" "w" "w" "w" "w" "w"

4

In statistics, Hotelling's T-square statistic [a], named for Harold Hotelling, is a
generalization of Student's t statistic that is used in multivariate hypothesis testing.
[a] Hotelling, H. (1931). "The generalization of Student's ratio". Annals of Mathematical Statistics 2 (3):
360–378. doi:10.1214/aoms/1177732979

http://en.wikipedia.org/wiki/Hotelling's_T-square_distribution
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> t.grp
[1]
[17]

0 60 120 180 240
60 120 180 240
0

0 60 120 180 240
60 120 180 240
0

0 60 120 180 240
60 120 180 240

0

> r.grp
[1] "1" "1" "1" "1" "1" "2" "2" "2" "2" "2" "3" "3" "3" "3" "3" "1"
[17] "1" "1" "1" "1" "2" "2" "2" "2" "2" "3" "3" "3" "3" "3"

> MB.2D = mb.long(yeast.matrix, times = 5, method = '2',
reps = size, condition.grp = c.grp, time.grp = t.grp,
rep.grp = r.grp)
(The calculation may require waiting a 1 to 2 minutes)
Note: the experiment is a “longitudinal two-sample problem” as reflected by method = ‘2’.
For more than two-sample we would use mb.MANOVA() instead of mb.long() (see vignette.)

4.1.3 Timcourse results
The top (say) one hundred genes can be extracted via
> gene_positions = MB.2D$pos.HotellingT2 [1:100]
> gnames = rownames(yeast.matrix)
> gene_probes = gnames[gene_positions]
4.1.3.1 Exercises to understand the commands:
The 3 commands above have the goal to extract the name of the probes for the first 100
ranking T2 values. To better understand the command let’s decompose, starting with
the name of the various compartments contained within MB.2D:
> names(MB.2D)
[1] "M"
[4] "Lambda"
[7] "con.group"
[10] "HotellingT2"

"prop"
"nu"
"percent"
"size"
"rep.group"
"time.group"
"pos.HotellingT2"

>
“M” contains the log2 values from the original matrix (yeast.matrix). HotellingT2
contains the parametric value of this statistic, while pos.HotellingT2 represents the
ranking order. We can output a few lines of each to see what this looks like:
Type the following commands to understand the contents of “M”
> dim(MB.2D$M)
[1] 5900
30
> MB.2D$M[1,1]
[1] 8.860619
> MB.2D$M[1:3,1]
1769308_at 1769311_at 1769312_at
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8.860619
> MB.2D$M[1:3,]

11.246516

9.632986

m0
m60
m120
m180
m240
m0
1769308_at 8.860619 8.723357 8.835967 8.944285 9.067881 8.90090
1769311_at 11.246516 11.202726 11.299114 11.429869 11.528925 11.17173
1769312_at 9.632986 9.788747 9.824055 9.637483 9.575285 9.46118

[…]
>
Type the following commands to understand the contents of “HotellingT2” and
“pos.HotellingT2”
> MB.2D$HotellingT2[1:10]
[1] 59.94618 52.89718 33.00957 437.92327
[7] 166.62760 273.42540 18.36381 18.57421

77.07335

84.12384

This lists the value of the T2 metric in order of the rownames, but the first one on the list
is by far not the first ranking one. The next command shows that the first ranking value
appears at row 2573, the second at row 5570 etc.:
> MB.2D$pos.HotellingT2[1:10]
[1] 2573 5570 3911 3803 4675

354 5290

741 2618 5608

This last command is similar to that which created the R object gene_positions for
the first 100 above. If we want the name of the first 10 genes (easily upgraded to 100)
we can type the complex command:
> rownames(MB.2D$M)[MB.2D$pos.HotellingT2[1:10]]
[1] "1774263_at" "1779965_at" "1776837_at" "1776626_at" "1778270_at"
[6] "1769988_at" "1779441_at" "1770749_at" "1774354_at" "1780044_at"

Using the R objects defined in the paper this is equivalent to asking for the first 10 items
contained within gene_probes:
> gene_probes[1:10]
[1] "1774263_at" "1779965_at" "1776837_at" "1776626_at" "1778270_at"
[6] "1769988_at" "1779441_at" "1770749_at" "1774354_at" "1780044_at"

>
Finally we can plot the value of the Hotelling metric for the first 100:
> plot(MB.2D$HotellingT2[MB.2D$pos.HotellingT2[1:100]], ylab =
"T2 values")
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The command could as well be
written thus, making use of the
gene_positions variable and
adding a title to the plot:
>
plot(MB.2D$HotellingT2[gene
_positions[1:100]],
ylab = "T2 values",
main = "T2 values for the
first 100")

4.1.4 Timecourse plots of individual probes
The expression profiles can also be easily obtained. The profile for the top ranked
expression is found using
> plotProfile(MB.2D, ranking = 1, gnames =
rownames(yeast.matrix))
and is shown in the Additional
file 1: Figure S5.
(Note: The image displayed in
the supplemental material is
wider. The shape (e.g. width)
of the plot depends on the
shape of the graphical
window currently displayed. )

Figure S5: Time course expression levels for the top differentially
expressed gene, ranked by their Hotelling statistic using the
timecourse library.
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The figure represents the time course variation of only the first gene (as specified with
the command portion ranking = 1) which is the default value. In other words the
same plot would be obtained with the simpler command, omitting ranking:
> plotProfile(MB.2D,

gnames = rownames(yeast.matrix))

However, the ranking variable is necessary to request the plot of genes other than the
first one. Furthermore, the visualization is here limited to a point for each value, and it
might be beneficial to “connect the dots” to perhaps see the trends more accurately.
The plotProfile() commands has an option for the type of plot:
(type ?plotProfile for info on other options.)
type:

a character indicating the plot type, "p" for points, "l" for lines, and "b" for both.

Therefore the command can be modified to
include a connecting line:
> plotProfile(MB.2D,
type = "b" ,
ranking = 1,
gnames = rownames(yeast.matrix))

If we know the name of the probe we want
to plot we can also ask the plot using this
information. For example, we created a list
above showing the first 10 genes by rank.
While we could ask for the 10th in the list we
could also ask for it by name using the
subcommand gid = to specify the name:
> plotProfile(MB.2D,
gid = "1780044_at", type="b",
gnames=rownames(yeast.matrix))
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4.2 Using the limma package
The limma package uses the moderated t-statistic described by [7,20]. The function lmFit
within the limma library fits a linear model for each gene for a given series of arrays, where
the coefficients of the fitted models describe the differences between the RNA sources
hybridised to the arrays. Precisely, we fit the model E [yg] = Xα g, where yg = (yg,1, ..., yg,
n)T contains the expression values for gene g across the n arrays, X is a design matrix
which describes key features of the experimental design used and αg is the coefficient
vector for gene g. In the analysis studied here, the yeast data consists of data from n = 30
arrays. The entries in the columns of X depend on the experimental design used: there are
two yeast strains (mutant and wild type), each measured at five separate time points, and
we are interested in comparing the gene expressions between mutant and wild type strains
over time. Thus we seek a linear model describing the ten strain × time combinations by
determining values for the ten coefficients in the coefficient vector αg. We will label these
ten coefficients as ('m0', 'm60, 'm120', 'm180', 'm240', 'w0', 'w60', 'w120', 'w180', 'w240'),
where the first five coefficients represent the levels of the mutant strain at time points t =
0, 1, 2, 3, 4 and the remaining five coefficients are the equivalent versions for the wild type
strain. Statistically speaking, the model has a single factor with ten levels. The design
matrix X links these factors to the data in the arrays by having zero entries except when an
array contributes an observation to a particular strain × time combination. For example,
array 26 measures the expression of the first wild type microarray at time t = 0 and so
contributes an observation to level 'w0', the sixth strain × time combination. Thus the entry
in row 26, column 6 of the design matrix X(26, 6) = 1. Further, the arrays are arranged in
groups of three replicates. Thus the overall experimental structure (expt_structure below)
has three arrays on level 'm0', then three arrays on 'm60', and so on. Setting up the factor
levels and the design matrix is done in R by using

> library(limma)
> expt_structure = factor(colnames(yeast.matrix))
> expt_structure
[1] m0
m60 m120 m180 m240 m0
m60 m120
[11] m0
m60 m120 m180 m240 w0
w60 w120
[21] w0
w60 w120 w180 w240 w0
w60 w120
10 Levels: m0 m120 m180 m240 m60 w0 w120 ...

m180 m240
w180 w240
w180 w240
w60

> #Construct the design matrix
> X = model.matrix(~0 + expt_structure)
> colnames(X) = c('m0', 'm60', 'm120', 'm180', 'm240', 'w0',
'w60', 'w120', 'w180', 'w240')
(Because there are 3 replicates, each columns contains three 1.)
> X
1
2
3
4
5

m0 m60 m120 m180 m240 w0 w60 w120 w180 w240
1
0
0
0
0 0
0
0
0
0
0
0
0
0
1 0
0
0
0
0
0
1
0
0
0 0
0
0
0
0
0
0
1
0
0 0
0
0
0
0
0
0
0
1
0 0
0
0
0
0
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6
1
0
0
0
0 0
0
7
0
0
0
0
1 0
0
8
0
1
0
0
0 0
0
9
0
0
1
0
0 0
0
10 0
0
0
1
0 0
0
11 1
0
0
0
0 0
0
12 0
0
0
0
1 0
0
13 0
1
0
0
0 0
0
14 0
0
1
0
0 0
0
15 0
0
0
1
0 0
0
16 0
0
0
0
0 1
0
17 0
0
0
0
0 0
0
18 0
0
0
0
0 0
1
19 0
0
0
0
0 0
0
20 0
0
0
0
0 0
0
21 0
0
0
0
0 1
0
22 0
0
0
0
0 0
0
23 0
0
0
0
0 0
1
24 0
0
0
0
0 0
0
25 0
0
0
0
0 0
0
26 0
0
0
0
0 1
0
27 0
0
0
0
0 0
0
28 0
0
0
0
0 0
1
29 0
0
0
0
0 0
0
30 0
0
0
0
0 0
0
attr(,"assign")
[1] 1 1 1 1 1 1 1 1 1 1
attr(,"contrasts")
attr(,"contrasts")$expt_structure
[1] "contr.treatment"

0
0
0
0
0
0
0
0
0
0
0
0
0
1
0
0
0
0
1
0
0
0
0
1
0

0
0
0
0
0
0
0
0
0
0
0
0
0
0
1
0
0
0
0
1
0
0
0
0
1

0
0
0
0
0
0
0
0
0
0
0
1
0
0
0
0
1
0
0
0
0
1
0
0
0

>

and then the coefficient vector αg is estimated via the command
> lm.fit = lmFit(yeast.matrix, X)
Determining the differentially expressed genes amounts to studying contrasts of the various
strain × time levels, as described by a contrast matrix C. For these data, we are mainly
interested in differences at the later time points, and so a possible set of contrasts to
investigate is that of differences between the mutant and wild type strains at each time
point, that is, ('m60-w60', 'm120-w120', 'm180-w180', 'm240-w240'). The limma
package allows complete flexibility over the choice of contrasts, however this necessarily
includes an additional level of complexity. The values in the coefficient vector of contrasts,
βg = CTαg for gene g, describe the size of the difference between strains at each time point.
The relevant R commands are

> mc = makeContrasts('m60-w60', 'm120-w120', 'm180-w180', 'm240w240', levels = X)
> c.fit = contrasts.fit(lm.fit, mc)
> eb = eBayes(c.fit)
The final command uses the eBayes function to produce moderated t-statistics which assess
whether individual contrast values βgj are plausibly zero, corresponding to no significant
evidence of a difference between strains at time point j. The moderated t-statistic is
constructed using a shrinkage approach and so is not as sensitive as the standard t-statistic
to small sample sizes. It also gives a moderated F-statistic which can be used to test
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whether all contrasts are zero simultaneously, that is, whether there is no difference
between strains at all time points.

4.3 Ranking differentially expressed genes
There are a number of ways to rank the differentially expressed genes. For example,
they can be ranked according to their log-fold change
> #see help(toptable) for more options
> toptable(eb, sort.by = 'logFC')
or by using F-statistics
> topTableF(eb)
The advantage of using F-statistics over the log fold change is that the F-statistic takes
into account variability and reproducibility, in addition to fold-change.
Our analysis is based on a large number of statistical tests, and so we must correct for
this multiple testing. In our example we use the (very) conservative Bonferroni
correction since we have a large number of differentially expressed genes and the
resulting corrected list is still long. Another common method of correcting for multiple
testing is to use the false discovery rate (fdr) (use the command ?p.adjust to obtain
further details). The following commands rank genes according to their (corrected) Fstatistic p-value and annotates the output by indicating the direction of the change for
each contrast for each gene: +1 for up-regulated expression (mutant type having higher
expression than wild type at a particular time point), -1 for down-regulated expression
and 0 for no significant change.
> modFpvalue = eb$F.p.value
> #Change 'bonferroni' to 'fdr' to use the false discovery rate
as a cut-off
> indx = p.adjust(modFpvalue, method = 'bonferroni') < 0.05
> sig = modFpvalue[indx]
> #No. of sig. differential expressed genes
>
>
>
>

nsiggenes = length(sig)
results = decideTests(eb, method = 'nestedF')
modF = eb$F
modFordered = order(modF, decreasing = TRUE)

> #Retrieve the significant probes and genes
> c_rank_probe = c_df$probe [modFordered [1:nsiggenes]]
> c_rank_genename = c_df$genename [modFordered [1: nsiggenes]]
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> #Create a list and write to a file
> updown = results[modFordered [1:nsiggenes],]
> write.table(cbind(c_rank_probe, c_rank_genename, updown),
file = 'updown.csv', sep = ',', row.names = FALSE, col.names =
FALSE)
The following code (adapted from lecture material found at [13]) plots the time course
expression for the top one hundred differentially expressed genes according to their Fstatistic (see Figure 2).
> par(mfrow=c(3,3), cex=0.5)
> for(i in 0:8){
indx = rank(modF) == nrow(yeast.matrix)-i
id = c_df$probe[indx]
name = c_df$genename[indx]
genetitle = paste(sprintf('%.30s', id), sprintf('%.30s',
name), 'Rank =', i+1)
exprs.row = yeast.matrix[indx,]
plot(0, pch=NA, xlim=range(0, 240), ylim=range(exprs.row),
ylab='Expression',
xlab='Time', main=genetitle)
for(j in 1:6){
pch_value = as.character(exp_fac$strain[5*j])
points(c(0, 60, 120, 180, 240), exprs.row[(5*j-4):(5*j)],
type='b', pch=pch_value)
}
}
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(Note: because the loop printed
here is “i in 0:8” that plots only
the first 9.
The online and PDF versions of
the paper write “i in 0:99” for
indeed the first 100). In the case it
is necessary to press ENTER after
each page of 9 plots.
The above code creates the Figure
2 of the paper which had the
following caption:
Figure 2. Time course expression
levels for the top 9 differentially
expressed genes, ranked by their
F-statistic.
When interpreting rank orderings based on statistical significance, it is important to bear
in mind that a statistically significant differential expression is not always biologically
meaningful. For example, Figure 2 contains RNR2. This gene is highly significant
because of low variation in its time course. However the actual difference in expression
levels between wild-type and mutant stains is relatively small. We address this problem
in the next section.

4.4 Comparison of the timecourse and limma packages
Both packages have different strengths. One advantage of the timecourse package
over the limma package is that it allows for correlation between repeated
measurements on the same experimental unit, thereby reducing false positives and
false negatives; these false positives/negatives are a significant problem when the
variance-covariance matrix is poorly estimated. An advantage of the limma package is
that it allows more flexibility by allowing users to construct different contrasts. In general
we might expect both packages to produce fairly similar lists of say the top 100
probesets. In the analysis of the yeast data, we can determine the overlap of the top
100 probesets by using
>
>
>
>

N = 100
gene_positions = MB.2D$pos.HotellingT2[1:N]
tc_top_probes = gnames[gene_positions]
lm_top_probes = c_df$probe[modFordered[1:N]]

> tc_top_probes[1:5]
[1] "1774263_at" "1779965_at" "1776837_at" "1776626_at" "1778270_at"

> lm_top_probes[1:5]
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[1] "1774263_at" "1776837_at" "1779441_at" "1769988_at" "1776626_at"

>

length(intersect(tc_top_probes, lm_top_probes))
[1] 53

The result is a moderately large overlap of fifty-three probesets. We note that changing
the ranking method in the limma package also yields similar results as those given by
the timecourse library.
It would be easy to see how many are in common over a longer stretch, e.g. 1000 by
simply changing the value of N. For N = 1000 the common number is calculated as 677.

4.5 Two fold‐change list
When looking for "interesting" genes it can be helpful to restrict attention to those
differential expressed that are both statistically significant and of biological interest. This
objective can be achieved by considering only significant genes which show, say, at
least a two-fold change in their expression level. This gene list is obtained using the
following code (adapted from [12])
> #Obtain the maximum fold change but keep the sign
> maxfoldchange = function(foldchange)
foldchange[which.max(abs(foldchange))]
> difference = apply(eb$coeff, 1, maxfoldchange)
> pvalue = eb$F.p.value
> lodd = -log10(pvalue)
>
>
>
>
>

#hfc: high fold-change
nd = (abs(difference) > log (2, 2))
ordered_hfc = order(abs(difference), decreasing = TRUE)
hfc = ordered_hfc[1: length(difference[nd])]
np = p.adjust(pvalue, method = ' bonferroni') < 0.05

>
>
>
>
>

#lpv: low p value(large F-value)
ordered_lpv = order(abs(pvalue), decreasing = FALSE)
lpv = ordered_lpv[1: length (pvalue[np])]
oo = union(lpv, hfc)
ii = intersect(lpv, hfc)

Figure 3 contains a "volcano" plot which illustrates the effect of using different levels of
fold change and significance thresholds. The figure is produced by using the following
code
> #Construct a volcano plot using moderated F-statistics
> par(cex = 0.5, mfrow=c(1,1))
> plot(difference[-oo], lodd[-oo], xlim = range(difference),
ylim = range(lodd))
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> points(difference[hfc], lodd[hfc], pch = 18)
> points(difference[lpv], lodd[lpv], pch = 1)
>
>
>
>
>

#Add the cut - off lines
abline(v = log (2, 2), col = 5); abline(v = - log (2, 2), col = 5)

abline (h = -log10 (0.05/5900), col = 5)
text(min(difference) + 1, -log10 (0.05/5900) + 0.2, 'Bonferroni cut off')

text(1, max(lodd) - 1, paste (length (i i), 'intersects'))

Note: some color can be added for better judging the influence of each parameter, for
example:
> points(difference[lpv], lodd[lpv], pch=1, col="red")
> points(difference[hfc], lodd[hfc], pch=18, col="blue")
The resulting black and white and colored plots appear below.

Figure 3. Volcano plot showing the Bonferroni cut-off and the two-fold change.

5. Cluster Analysis
Biological insight can be gained by determining groups of differentially expressed
genes, that is, groups of genes which increase or decrease simultaneously. This can be
achieved by using cluster analysis.

5.1 Traditional cluster analysis
In this section, we separate the top fifty differentially expressed genes into groups of
similar pattern (clusters). Clearly different genes will have different overall levels of
expression and so we first standardise their measurements by taking the expression
level of the mutant strain (at each time point) relative to the wild-type at time t = 0:
> c_probe_data = yeast.matrix [ii,]
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> #Average of WT
> wt_means = apply(c_probe_data [, 16:30], 1, mean)
> m = matrix(nrow = dim(c_probe_data) [1], ncol = 5)
> for (i in 1:5) {
mut_rep = c(i, i+5, i +10)
m [, i] = apply(c_probe_data [, mut_rep], 1, mean) wt_means
}
> colnames(m) = sort(unique(exp_fac$tps))
The heatmap in Figure 4 is obtained by using the function heatmap.2 from the library
gplots via the following code
> library(gplots)
> #Cluster the top 50 genes
> heatmap.2(m[1:50,], dendrogram ='row', Colv=FALSE,
col=greenred(75),
key=FALSE, keysize=1.0, symkey=FALSE,
density.info='none',
trace='none', colsep=rep(1:10), sepcolor='white',
sepwidth=0.05,
hclustfun=function(c){hclust(c, method='average')},
labRow = NA, cexCol=1)

Figure 4. Clustering of the top fifty
differentially expressed genes. Red and
green correspond to up- and downregulation respectively.

Figure 4 shows the relative expression levels for the mutant strain at each time point
('0', '60', '120', '180', '240'). As expected, the relative expression levels at time t = 0 are
very similar. However, as time progresses, groupings of genes appear whose levels are
up-regulated (red) or down-regulated (green). Note that the intensity of the colour
corresponds to the magnitude of the relative expression. Gene names appear on the
right side of the figure and on the left side, the cluster dendrogram shows which genes
have similar expression. The dendrogram suggests that there are perhaps six to ten
clusters.
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5.2 Soft clustering
Soft clustering methods have the advantage that a probe can be assigned to more than
one cluster. Furthermore, it is possible to grade cluster membership within particular
groupings. Soft clustering is considered more robust when dealing with noisy data; for
more details see [21,22].
The Mfuzz package implements soft clustering using a fuzzy c-means algorithm.
Analysing the data for c = 8 clusters is achieved by using
> library(Mfuzz)
> tmp_expr = new('ExpressionSet', exprs = m)
> cl = mfuzz(tmp_expr, c = 8, m = 1.25)
> mfuzz.plot(tmp_expr, cl = cl, mfrow = c(2, 4), new.window =
FALSE)

Of course, it is usually not clear
how many clusters there are (or
should be) within a dataset and so
the sensitivity of conclusions to the
choice of number of clusters (c)
should always be investigated.
For example, if c is chosen to be
too large then some clusters will
appear sparse and this might
suggest choosing a smaller value
of c.
Figure 5 shows the profiles of the
eight clusters obtained from the
Mfuzz package.
Figure 5. Eight clusters obtained using the Mfuzz package.

The probes present within each cluster can be found by using
> cluster = 1
> cl [[4]][,cluster]
1
2
3
4
5
6
1.525336e-07 3.315053e-03 4.055818e-11 9.082199e-09 2.268899e-10 8.011645e-04
7
8
9
10
11
12
5.706051e-06 3.587217e-07 1.074465e-04 4.251639e-05 1.110149e-05 4.070468e-07
13
14
15
16
17
18
2.471613e-06 7.958284e-05 8.259089e-05 1.886841e-05 5.320241e-05 1.441374e-06

Page - 165 -

R and Bioconductor- time-course analysis

6. Conclusion
The response to telomere uncapping in cdc13-1 strains was expected to share features
in common with responses to cell cycle progression, environmental stress, DNA
damage and other types of telomere damage. The statistical analysis determined lists of
probesets associated with genes involved in all of these processes. The techniques
used focused on making best use of the temporal information in time-course data. The
use of cdc13-1 strains, which uncap telomeres quickly and synchronously, also allowed
the identification of genes involved in the acute response to telomere damage. This
case study has demonstrated the power of R/Bioconductor to analyze time-course
microarray data. Whilst the statistical analysis of such data is still an active research
area, this paper presents some of the cutting-edge tools that are available to the life
science community. All software discussed in this article is free, with many of the
packages being open-source and subject to on-going development.

7. Genetic regulatory network inference

(Supplemental)

(Note: the following may take too long to accomplish in class)
(Reference numbers cite supplemental references.)
Recent research in the analysis of microarray experiments has produced several
methods for determining plausible transcriptional regulation networks from the data;
see, for example, [4-7]. Such networks can provide valuable insight into the underlying
biological mechanisms producing the data. The networks typically consist of nodes
(representing genes or proteins) and edges between nodes (representing relationships
between genes). Methods also exist for inferring dynamic gene association networks in
which the direction of causation is represented by an arrow. One such method (with an
easy-to-use R package developed by the Strimmer lab) uses a shrinkage approach to
calculate the partial correlation coefficient and works for both static and dynamic (timecourse) data; see [8-10]. Their heuristic algorithm is fast and so provides a quick insight
in the structure of the network.
It works by first creating a longitudinal R object. In our illustration, we use data on the
top one hundred differentially expressed genes. The data are stored in a matrix m,
where the rows are genes and the fifteen columns are the arrays. In order to use the R
functions in their package, as we have time course data rearrange the row order
according to the time points. The first three rows of the resulting matrix mnew are data
on the three mutant arrays at time t = 0, the next three arrays at time point t = 60, and
so on.
This is achieved by using the commands:
> exp_fac
> # rewrite exp_fac in a different order:
> exp_fac = with(exp_fac, exp_fac[order(strain, tps,
replicates), ])
> exp_fac
Page - 166 -

R and Bioconductor- time-course analysis
>
>
>
>
>

#Construct a longitudinal object
library(GeneNet)
ngenes = 100
m = yeast.matrix[ii[1:ngenes],]
mnew = m[,exp_fac$data_order[1:15]]

> mlong = as.longitudinal(t(mnew), repeats=3, time=0:4)
Next the partial correlations are computed and then (local) values are assigned to all
possible edges, from which the important edges can be determined according to a
threshold criteria. Finally a Graphviz5 file is outputted to generate the graph. Figure S1
shows the resulting network for these data and is generated by using:
> #Compute partial correlations
> pcor.dyn = ggm.estimate.pcor(mlong, method = 'dynamic')
> #Assign (local) fdr values to all possible edges
> m.edges = network.test.edges(pcor.dyn, direct=TRUE)
dim(m.edges)
Note that, in the function ggm.estimate.pcor, the default method static employs the
function pcor.shrink, whereas the dynamic method uses dyn.pcor. The difference
between the two estimators is that the latter takes the spacing between time points into
account if the input consists of multiple time course data (which must be provided as a
longitudinal object).
> #Construct graph containing top edges
> m.net = extract.network(m.edges, method.ggm='number',
cutoff.ggm=100)
>
>
>
>

#Construct a Graphviz dot file
rnames = vector('list', length(1))
rnames = c_df$genename[ii[1:ngenes]]
network.make.dot(filename='net.dot', m.net, rnames,
main='Yeast Network')

The file called “net.dot” is into the current working directory. This is a plain text file
that still needs to be later rendered into a graphics with the Graphviz software.
The file can be opened for inspection by a simple word processor such as WordPad on
Windows or TextEdit on Mac. The top and bottom portions of the file are shown here:
Digraph G {
K="0.3";
ratio="0.75";
label = "\n\n Yeast Network ";
5

http://www.graphviz.org/
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fontsize=20;
"DSE3" -> "ASH1" [dir="none",color=black, style="solid,setlinewidth(2)"];
"YLR049C" -> "SIC1" [dir="none",color=black, style="solid,setlinewidth(2)"];
"SMF3" -> "SIC1" [dir="none",color=black, style="dashed,setlinewidth(2)"];
[ . . . ]
"EGT2" -> "DSE3" [dir="none",color=grey, style="solid,setlinewidth(1)"];
"PST1" -> "PLB2" [dir="none",color=grey, style="dashed,setlinewidth(1)"];
"RNR4" -> "SIC1" [dir="back",color=grey, style="dashed,setlinewidth(1)"];
}

Note: each gene line is independent and the file can be easily edited.
The Graphviz interpretation of the net.dot file provides the following plot:

Black and grey indicate positive and negative (partial) correlation respectively.
Note: To obtain a lesser number of genes, e.g. 20, simply change the value of
cutoff.ggm from 100 to 20 and recreate the net.dot file. So only the following 2
lines need to be re-used:
> m.net = extract.network(m.edges, method.ggm='number',
cutoff.ggm=20)
> network.make.dot(filename='net.dot', m.net, rnames,
main='Yeast Network')
Illustrated below are network for cut off values of 20 and 30:
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Basic Analysis of NimbleGen
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Within the text, user input is shown as bold text or command

> is the R prompt and is not to be typed
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Tobias Straub, Adolf Butenandt Institute, Molecular Biology, Ludwig-Maximilians
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[Tim.Roloff@fmi.ch], Laboratory of Dirk Schübeler, Friedrich Miescher Institute, Basel)
are shown as footnotes.
Alternate link(s) (without illustrations):
http://www.bioon.com.cn/protocol/showarticle.asp?newsid=19680
http://www.protocol-online.org/cgi-bin/prot/view_cache.cgi?ID=3973

&
A Guideline for ChIP - Chip Data Quality Control and Normalization (PROT 47)
Matthias Siebert, Michael Lidschreiber, Holger Hartmann, and Johannes Soding
Gene Center Munich, Ludwig-Maximilians-Unoversität, Feodor-Lynen-Str. 25
81377 Munich, Germany. email feedback to: soeding@genzentrum.lmu.de
http://www.epigenome-noe.net/researchtools/protocol.php?protid=47

Alternate link(s) (without illustrations):
http://www.bioon.com.cn/protocol/showarticle.asp?newsid=19679
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1. Introduction
This exercise is largely based on the article by Tobias Straub published online (see
back cover credits.) The flow of the exercises is that of the paper. However, I have
blended necessary steps from additional files when possible for clarity and flow. There
are a lot of assumptions along the way, and I have added commands to try to clarify
some of the author’s commands.
Hybridization of chromatin immuno-precipitation (ChIP) material to tiling arrays at
NimbleGen service facilities usually leaves the customer with a set of data files
that are of limited use. Most information about the experiment is gained by either
displaying immuno-precipitate(IP)/input ratio tracks (the GFF files provided) of individual
hybridisation experiments with NimbleGen’s SignalMap software or by scanning the list
of peaks identified by the automated data analysis. Summary profiles from replicate
experiments cannot be investigated; further calculations are left to the customers. Apart
from the fact that data quality cannot be directly evaluated, raw data is not corrected for
systematic signal distortions in the generation of ratio GFF files. Furthermore, the
robustness of the provided peak finding procedures is questionable, as the algorithm
will frequently identify many "significant" peaks in noise-only experiments.
Several independent software tools are available that provide a more robust and more
detailed analysis. Unfortunately, those tools frequently tend to underperform on
datasets that are largely different from the ones they have been built for. Apart from
simple problems such as compatibility issues between different organisms and naming
conventions for chromosomes many tools aim, e.g., for identifying peaks or peak
centers. In the realm of epigenetics, however, many features are distributed rather
broadly and peak centers are not the only features defining biological states. Overall,
many tools do not provide sufficient flexibility and transparency for the user to know and
control what is actually happening with the data. This will ultimately lead to nonreproducibility and/or analysis failures once the tools are modified.
With increasing amounts of quantitative data biologists are often left with endpoints of
analyses that they simply have to trust if they are not given the possibility to look behind
the procedures. This protocol mainly aims for aiding the biologists to get a rather
unbiased look at the quantitative data of their NimbleGen tiling array experiments
during initial processing steps. Ultimately, summary tracks of the profiles will be
generated that permit visual browsing of the data, which serves as important inspiration
for downstream analyses. The procedures introduced here can in principle be applied to
any other 2-color tiling array data (Agilent) and/or 2-sample comparison data on
Affymetrix chips (single color).
The commands to be typed can simply be copy-pasted or loaded from preformed text
files. The analysis steps executed in this protocol can therefore be adjusted to any other
NimbleGen dataset by editing a few lines in a sample description file. This protocol does
not require the reader to be familiar with R/Bioconductor.
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2. Rationale of the analysis pipeline
Quality control: the validity and robustness of any analysis will depend on the
quality of the raw data. The most important quality parameters are the distribution of
raw signal intensities and the independence of IP/input ratio and absolute signal
strength. In addition, arrays with severe hybridization artifacts should be identified.
Normalization: shifts in signal intensity distributions between the two channels as
well as between arrays have to be adjusted. Dependences of ratio and absolute
signal strengths should be eliminated.
Probe summary statistics: For each probe on the array a mean ratio value of all
replicates and a statistical test for enrichment is provided.
Region summarization: The spatial organization of bound probes can be exploited
to identify statistically significant regions of binding.
Data visualization: The results of the analyses will be exported for visualization in
genome browsing applications.

3. Lab Set-up / Procedure
These exercises are set-up for the BTCI Windows machines. R might be available as a
shortcut icon on the desktop or in the list of programs in the Start menu.
R should also be available
as the usual
Start > All Programs
menu cascade.
(Shown here for R 2.9.0)
The following section lists the required software and packages. In this way you can
configure your own system with the necessary elements.

3.1 Required software
The R/Bioconductor software should already be installed on the class computers.
Required software for these exercises: R version 2.11.1 or later.
BioConductor packages: geneplotter, limma, vsn.
Info at
http://www.bioconductor.org/packages/release/Software.html
Cran packages: st, locfdr, tileHMM, gplots.
See installation below:
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3.2

INSTALLING Required software

R and BioConductor are already installed on these computers. To install on your own
system refer to the Installation instructions Part 0. To install the packages specific to this
exercise please do the following:
Launch R from the R icon on the desktop or the Start menu.
At the > prompt type the following commands:
>
>
>
>

source("http://bioconductor.org/biocLite.R")
biocLite("geneplotter")
biocLite("limma")
biocLite("vsn")

Additionally the following CRAN packages (not part of BioConductor) are necessary:
>
>
>
>

install.packages("st", dependencies=T)
install.packages("locfdr", dependencies=T)
install.packages("tileHMM", dependencies=T)
install.packages("gplots", dependencies=T)

--- Please select a CRAN mirror for use in this session ---

You will be asked to identify a CRAN server
from which to download.
//
Choose a USA server that is geographically
close, e.g. Iowa (IA) or Michigan (MI) for
example.
Then click OK

Note the “dependencies = T” (TRUE) statement which may cause other packages to
be installed.
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4. The example dataset
The protocol is demonstrated on a published data set (Straub et al, 2008). The target
protein is Drosophila MSL2, a member of the Dosage Compensation Complex that
specifically binds the X chromosome in male flies.

“Dosage Compensation is a regulatory mechanism to ensure that the level of expression of genes
on the single X chromosome of Drosophila males equals the level attained from the two X
chromosomes in females. This equalization, achieved by a twofold increase in the rate of X-linked
gene transcription in males relative to females, has been observed for a wide variety of genes with
promoters of different strengths, in many cell types, and at different developmental stages.” (1)
“In Drosophila, dosage compensation is regulated by male specific lethals (MSLs): four proteins
that bind specifically to the X chromosome in the male, but not in females. The term "male specific
lethals" is derived from the fact that mutations of these genes are lethal to male mutants, but not
females. Sex lethal, the splicing factor that directs all sex determination in the fly, regulates the
function of MSLs by regulating the splicing of pre-messenger RNA of male specific lethals. The
immediate target of SXL is a transcription factor, male specific lethal-2 (MSL-2). The msl2 produces
two transcripts that differ by an intron of 133 nucleotides in the 5' untranslated region. Most female
transcripts retain the intron, whereas most male transcripts remove it. Unlike the previously
described cases of SXL regulation, this sex-specific intron does not affect the mRNA open reading
frame.” (2)
Quoted from References:
(1) – Smith E.R. et al., The Drosophila MSL Complex Acetylates Histone H4 at Lysine 16, a Chromatin
Modification Linked to Dosage Compensation. Molecular and Cellular Biology, January 2000, p. 312318, Vol. 20, No. 1
(2)
– http://www.sdbonline.org/fly/polycomb/msl2.htm

The data comprises 3 biological replicates and includes one dye swap.
Immuno-precipitated (IP) and Input material was hybridized to a custom NimbleGen
array that uses an isothermal design layout (i.e. oligo probes of varying lengths).

4.1 Organizing the workspace folder
All data belonging to the experiment are organized into one folder (Figure 1).
Place this folder “protocol” onto e.g. the Desktop to navigate to it easily.
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Figure 1: Organization of files in folder “protocol”
This comprises the corresponding *.pair files found in the RawDataFiles folder of the
Nimblegen service DVD and the *.ndf and *.pos files found in the layout folder within
the DesignInformation folder.
The experiment folder should also contain a description file of the samples
(sample_key.txt, see below), an R script files that defines functions for some more
complicated routines (noe_source.R) and an R script file that contains the commands
of the analysis pipeline (noe_protocol.R).
Note: the folder or its zipped version will be provided in class. For other cases
the web page provided the following info:
The fully commented R script files can be downloaded from here:
http://genome1.bio.med.uni-muenchen.de/downloads.htm
An example folder containing the raw data and layout information, as well as
sample_key and R-script files can be obtained here:
http://genome1.bio.med.uni-muenchen.de/dl/protocol.zip

4.2 Creating and editing of the sample key file
The use of a sample description file facilitates recycling of the R-scripts in that
experiment-specific data is kept outside of the script.
The file 'sample_key.txt' provided here is a tab-delimited table that can be created
or edited in Microsoft Excel (Table 1). Note that a very simple text editor such as
NotePad or TextEdit suffices to create such a file although Excel is useful for larger lists.
Please note that the file has to be saved as a tab-delimited text file.
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For this protocol 3 columns are required:
- a column named 'file' that contains the name of the raw data file (*.pair),
- a column 'sample.type' that contains 'e' for enriched if IP material has been
hybridized or 'i' for input if total input chromatin has been used.
- In addition, the column 'sample.name' groups the corresponding raw data
from the two channels of the sample array.
file
sample.type
145215_532.pair
i
145215_635.pair
e
145216_532.pair
e
145216_635.pair
i
305059_532.pair
i
305059_635.pair
e
Table 1: Contents of the sample key file

sample.name
145215
145215
145216
145216
305059
305059

4.3 Reading the raw data
4.3.1 Working Path
Launch R and navigate to your experiment folder “protocol”.
In R.app for Mac OSX this is simply achieved by dragging the folder icon onto the
R icon in the launch bar (the “Dock”).
For Windows, the GUI “File > Change dir… ” menu cascade can help
browse and navigate to the target directory.
Otherwise set the working directory accordingly using the R command "setwd()". To
check that you are in the proper working directory test the contents of the folder using
"list.files()" or the equivalent command “dir()”.
4.3.2 Specific Functions
Reading of both raw data and layout information is performed by calling specific
functions that are provided in the file 'noe_source.R' and get activated upon sourcing
the script file (command “source=” below.) The file contains complex R commands that
need to be loaded only once for each session and are based on knowledge of the file
structure (e.g. the *.pair files) or other assumptions. (e.g. “assumes the probe ids
to be in col 4”). Some functions are defined within this file, for example the
functions read.pairs(), quality.control(), and nimble.image().
At first the sample key file is read to extract information about the raw data files.
> source("noe_source.R")
> sample.key.file <- "sample_key.txt"
> samples <- read.delim(sample.key.file, header=T,
comment.char="#", stringsAsFactors=F)
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> samples
1
2
3
4
5
6

file sample.type sample.name
145215_532.pair
i
145215
145215_635.pair
e
145215
145216_532.pair
e
145216
145216_635.pair
i
145216
305059_532.pair
i
305059
305059_635.pair
e
305059

>
The raw signal intensities (signals) are then loaded into a matrix with columns
corresponding to hybridization channels and rows corresponding to probes.
The name of the row is the Probe ID as provided in the NimbleGen layout.
The layout information is extracted from the headline of the first raw signal file read.
This should correspond to the name of the *.ndf and *.pos file in the folder.
Parts of the layout and position information are then read into a data frame 1.
Non-experimental probe information is omitted from both signal and layout tables.
Only experimental probes are included in the processing pipeline, therefore the number
of table rows - each corresponding to one probe - is smaller than the actual number of
probes on the array.
Both the signal matrix and the layout frame are sorted by id of the probe. This will
ensure that a probe has the same row index in both tables.
The following will take 2 to 3 min to accomplish. The unix-like command “head” is used
to inspect the first few lines of newly created objects:
> signals <- read.pairs(samples$file, samples$sample.id)
reading probes: 389361 probes
reading: 145215_532.pair
reading: 145215_635.pair
reading: 145216_532.pair
reading: 145216_635.pair
reading: 305059_532.pair
reading: 305059_635.pair
6x384688 experimental signals

> head(signals)
CHR2L00P000000177
CHR2L00P000000635
CHR2L00P000001093
CHR2L00P000001551

[,1]
34591.22
28942.89
24645.55
30384.11

[,2]
35198.78
40340.55
35794.00
37115.45

[,3]
41177.89
36529.78
47713.22
40872.78

1

[,4]
37656.33
36914.45
49935.78
38624.67

[,5]
46924.11
58334.33
46255.11
50796.67

[,6]
65523.33
62743.89
65526.67
62412.00

Comment 1: Due to rather frequent and not obvious layout changes in the raw data
(.pair) and also in the array design files (.ndf, .pos), names and column position
might have to be adjusted in the read.layout() function in the “noe_source.R” file
in order to ensure correct loading of the required data. The same should be kept in mind
when using other Nimblegen array designs.
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CHR2L00P000002009 27632.89 41403.78 40585.22 40391.11 46224.55 63422.22
CHR2L00P000002467 33133.11 41606.89 42721.45 43072.67 54783.45 65523.33

> layout.name <- get.layout.info(samples$file[1])
> layout <- read.layout(layout.name)
reading 2006-02-16_Becker_DMEL_ChIP.ndf
reading 2006-02-16_Becker_DMEL_ChIP.pos
merging..
384688 layout rows kept

> head(layout)
sequence

probe.id
x
y chr

1 CHR2L00P000000177
523 991 2L
2 CHR2L00P000000635
188 576 2L
3 CHR2L00P000001093
751 107 2L
4 CHR2L00P000001551
549 1023 2L
5 CHR2L00P000002009
531 391 2L
6 CHR2L00P000002467
239 1007 2L

1
2
3
4
5
6

TGCCGCTAATCAGAAATAAATTCATTGCAACGTTAAATACAGCACAATATATGATCGCGTATGCGA
TGCCGCTAATCAGAAATAAATTCATTGCAACGTTAAATACAGCACAATATATGATCGCGTATGCGA
TGCCGCTAATCAGAAATAAATTCATTGCAACGTTAAATACAGCACAATATATGATCGCGTATGCGA
TGCCGCTAATCAGAAATAAATTCATTGCAACGTTAAATACAGCACAATATATGATCGCGTATGCGA
TGCCGCTAATCAGAAATAAATTCATTGCAACGTTAAATACAGCACAATATATGATCGCGTATGCGA
TGCCGCTAATCAGAAATAAATTCATTGCAACGTTAAATACAGCACAATATATGATCGCGTATGCGA

pos length
177
66
635
66
1093
66
1551
66
2009
66
2467
66

After reading of the data, the tables for sample description, raw signals, and layout are
saved into separate R data files (.rda). This speeds up reading of the raw data next
time they are needed. These files were included in the protocol.zip folder.
> save(samples, file="samples.rda")
> save(signals, file="signals.rda")
> save(layout, file="layout.rda")

5. Quality controls
5.1 Intensity and log2 intensity plots
At first we look at the distribution of signal intensities of the single channels (Figure 2).
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> par(mfrow = c(3, 2))
> for(i in 1:6) {
plot(density(signals[,i]),
main = samples$file[i] )
}

0

0.00015

Density

0.00000

We can enhance this to plot all 6 on the same
plot and specify the file plotted (note curly
brackets!)

145215_635.pair

0.00010

145215_532.pair

> plot(density(signals[,1]))
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50000

N = 384688 Bandwidth = 481.7

In an ideal case, the log-transformed signals should be close to normal distribution,
which is an important prerequisite for a good signal-to-noise ratio.
Subsets of the signal matrix can be generated by calling signals[i,j] where i
defines row(s) and j column(s). signals[,1] will therefore extract the raw intensities
of the first raw data file read. Changing j to 2 to 6 will address the other channels and
hybridizations accordingly. The Q-Q plots will allow a better estimation of normality than
simple density plots. Here we even can look at the perfect normality indicated by the red
dashed line created by qqline(). (Note: the get the red color replace the command
col=1 for col = “red”).
The commands provided show the plots for the first sample:
>
>
>
>

par(mfrow=c(1,2))
plot(density(log2(signals[,1])))
qqnorm(log2(signals[,1]), pch=".")
qqline(log2(signals[,1]), lty=2, col=1)
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Figure 2: Distribution of raw signal intensities (density plot and Q-Q plot) of channel one.
This can be enhanced to plot for all 6 samples, specifying the file name as well.
(Note the curly brackets and semi colons).
> par(mfrow = c(3, 4))
> for(i in 1:6) {
> plot(density(log2(signals[,i])), main = samples$file[i]);
qqnorm(log2(signals[,i]), pch=".");
qqline(log2(signals[,i]), lty=2, col="red");
print(i)
}
>
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The plots shown here indicate an almost perfect distribution of the raw signal intensities.
You might want to have a look at the hybridisation of the array with sample name
'305059', signals[,6]. Here, a saturation effect can be observed: note the right-hand
edge of the log2 plot.

5.2 MA plots
Surrogate for factor binding or enrichment is the IP/input ratio of our signals. It is
therefore essential that the ratio is independent of the absolute signal strength. Very
often in microarray studies this is not the case and frequently ratios increase with
increasing signals.
The systematic deviation has to be corrected for by normalization measures. We display
this dependence using MA plots where M indicates the ratio and A the average signal
(Figure 3). A similar problem regards the variance or standard deviation of the signals.
The stronger the skews are, the stronger the counter measures have to be and the
more the raw data will be manipulated leading almost certainly to higher noise than
obtained for raw data of better quality2. Eventually, noisy profiles will almost certainly
increase the number of false positive binding events.
A is the average signal intensity of each probe of the 2 channels of the 1st array.
M is the signal ratio log2(channel2/channel1) each probe of the 1st array.
> par(mfrow=c(1,2))
> A = (log2(signals[,2]) + log2(signals[,1]))/2
> M = (log2(signals[,2]) - log2(signals[,1]))
> require(affy)
> ma.plot(A, M, plot.method="smoothScatter", cex=0.8, main="MA
plot")
> require(vsn)
> meanSdPlot(log2(signals[,1:2]), ranks=TRUE, main="SD versus
rank")

Figure 3: Plots for visualization of ratio (MA plot) and variance (SD versus rank)
dependence on absolute signal intensities.
2

Comment 2: As already pointed out in the protocol we would like to emphasize that
normalization can not make poor raw data look good.
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Note: require() is very similar to library()
The un-normalized signals for array #1 do not indicate major skews and we can happily
include the data in our experimental set.
A page combining all diagnostic plots above for one array (indicated by its sample name
in the samples table) with 2 channels can be obtained using a function predefined in
noe_source.R. The number specified is that of the sample bar code and is the first
part of the .pair file name.
> samples
1
2
3
4
5
6

file sample.type sample.name
145215_532.pair
i
145215
145215_635.pair
e
145215
145216_532.pair
e
145216
145216_635.pair
i
145216
305059_532.pair
i
305059
305059_635.pair
e
305059

>
> quality.control(signals, samples, "145215")

5.3 Reconstructed array image
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Next, we want to have a look at the
reconstructed array image in order to
identify major artifacts that occurred during
the processing steps such as scratches on
the array surface. Information on the
physical position of each probe is given in
the X and Y columns of the layout table.
This code will display the pseudo-colored
image of one channel
(Figure 4).
Figure 4: Reconstructed array image of channel
one.

> nimble.image( log2(signals[,1]), layout)

5.4 Correlation and outliers

Finally, pair wise correlation plots of all
signals in an experimental set might
facilitate the identification of outlier
hybridizations that might have to be
excluded from analysis. The following code
provides pair-wise scatter plots of all
channels as well as pair wise spearman
correlation coefficients. The function
correlate.batch() was defined in
noe_source.R.
> correlate.batch(log2(signals))

Note: The result and purpose of this function is similar to that we have learned
with Affymetrix data called mva.pairs().

6. Normalizing the data
Inter-array comparison shows that the raw signals of our 3*2 channels are spread quite
differently. Furthermore there might be some ratio and variance distortions based on
signal intensities. We therefore introduce a data normalization step that should correct
for most of these problems. Many different algorithms have been proposed, most of
which perform equally well on high quality data. The vsn normalization (Huber et al,
2002) provided by the 'vsn' package from Bioconductor is suggested here. This
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package is particularly suited to address all problems mentioned above, while other
procedures like quantile normalization mainly corrects for the spread of the data3.
In cases of severe distortions, other normalization procedures might be tested.
However, one should keep in mind that strong distortions will lead to high noise even
(and a high false positive rate of binding definition) with or even more with correction by
normalization. Therefore the primary aim should always be to generate good raw data.
> # load the vsn package needed for normalisation
> require(vsn)
> # normalisation of all channels using the vsn2 function
> normalized.signals <- exprs(vsn2(signals, subsample=20000,
verbose=F))
> # signal distribution boxplots before and after normalisation
> par(mfrow=c(1,2))
> boxplot(log2(signals)~col(signals), main="before
normalization")
> boxplot(normalized.signals~col(normalized.signals),
main="after normalization")

Figure 5: Signal distributions of all experimental channels before and after vsn normalization.
3

Comment 3: VSN normalization is model-based data transformation according to
parameters estimated form the non-normalized data. Often two color arrays show dye
specific skews which can lead to an over-correction when using VSN normalization. For
inter-array normalization we prefer to use scale normalization which is a less stringent
normalization contained in the limma package [normalizeBetweenArrays(
data_object, method=?scale?, ?)]. In this case however, the inter-array
normalization does not take care of any kind of background problems or signal intensity
distortions. Thus, in case one channel of an array is skewed in the low signal intensity
range additional normalization such as loess normalization [limma package
normalizeWithinArrays(data_object, method=?loess?, ?)] can be
performed prior to inter-array normalization.
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The effect on ratio biases can be shown with the following code.
Note that
a) the initial skew is very mild and
b) the vsn normalization creates some small additional distortions on the data.
> # MA before and after normalization displayed for the 3rd
array (channels 5 and 6)
> require(affy)
> par(mfrow=c(1,2))
> A = (log2(signals[,6]) + log2(signals[,5]))/2
> M = (log2(signals[,6]) - log2(signals[,5]))
> ma.plot(A, M, plot.method="smoothScatter", main="before
normalization", cex=0.8)
> A = (normalized.signals[,6] + normalized.signals[,5])/2
> M = (normalized.signals[,6] - normalized.signals[,5])
> ma.plot(A, M, plot.method="smoothScatter", main="after
normalization", cex=0.8)

Question: How would you create the same plots for the 1st and 2nd arrays?
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7. Identification of enriched probes
We now test every single probe for significant enrichment across all replicates4. This
procedure involves applying a test statistics on all signals of each probe with
subsequent estimation of its local false discovery rate (fdr). Fdr determination allows for
the correction of the massive multiple testing problem on high-density tiling data. This
problem would lead to a very high rate of false positives if a cut-off on the test statistic
alone would be used for defining bound probes.
Among the many testing algorithms available we chose 'SAM', which in our hands
performs well on different array platforms and targets (Tusher et al, 2001). In principle
other algorithms can easily be implemented as the 'st' package used here nicely
interfaces with different tests. In addition, we also calculate the simple mean of ratios for
each probe.
> # compute the mean ratios of all 3 replicates, takes dye swaps
into account
> pmean <- probe.mean(normalized.signals, samples$sample.type)
> # density plot of mean ratios
> plot(density(pmean), main="mean")
> # compute the sam statistic for the probes
> pstat <- probe.stat(normalized.signals, samples$sample.type)
> plot(density(pstat), main="sam statistic")
Note: the SAM statistic will require a couple minutes to compute at least. The plot
parameter is still set for 2 plots on the same page from the previous plots and therefore
the following plot should be obtained:

4

Comment 4: The probe level statistics section only works if the arrays represent
replicate experiments, thus for comparing different experimental conditions, one needs
to run the analysis separately.
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>
>
>
>
>

require(locfdr)
par(mfrow=c(1,1))
# compute fdr for each probe
# generates a plot to display the fits
lfdr <- locfdr(pstat)$fdr
Warning message:
In locfdr(pstat) : f(z) misfit = 24.3.
increased df

Rerun with

>
This creates the following plot and
a warning
(df = degrees of freedom)

> # lets define an fdr cutoff of 0.02
> cutoff <- lfdr < 0.02
>
> require(geneplotter)
> # generation of a
stacked histogram to
show the ratios of
probes above and below
cutoff
> x <list(pmean[cutoff],
pmean[!cutoff])

Figure 6: Mean ratio histogram of statistically defined
enriched and non-enriched probes.
> histStack(x, breaks=seq(floor(min(pmean)),
ceiling(max(pmean)), length=51), col=c(2,0),
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xlab="mean log2(ratio)", main="fdr threshold < 0.02")
> legend("topright", c("enriched", "non-enriched"), fill=c(2,0),
bty="n")

8. Identification of enriched regions
Additional power for identifying bound regions is obtained by including the spatial
organization of the probes. This allows for definition of enriched states not only on the
enrichment ratio of the single probe but by an increased enrichment on a run of several
adjacent probes. Usually this step involves either a so-called sliding-window approach
or hidden Markov model (HMM). Both methods have their variations and limitations. In
downstream analyses I usually try to avoid working with categorized data (i.e. bound
and unbound definitions), therefore I do not spend too much time finding the best region
summarization method. Here I introduce a HMM package that is fairly easy to operate
from within R and that produces plausible results on good data (Humburg et al, 2008).
The analysis will produce a vector pstate that defines for every probe whether it is in a
bound region (value 1) or unbound region (value 0). Furthermore the function will return
a table of regions that have been identified as enriched or bound.
Note: Some of the calculations will require a few minutes to take place.
> # compute HMM states for each probe based on the sam statistcs
(pstat)
> hmm.out <- stateHMM(pstat, layout)
Loading required package: tileHMM
Viterbi training: 5 iterations
Number of iterations: 5
Log likelihood of best model: 23876.8787779312
Last change in log likelihood: 0.0511210376971576
EM algorithm: 15 iterations
Number of iterations: 11
Log likelihood of final model: 26120.1715321632
Last change in log likelihood: 0.00417501360789174

>
>
>
>

# retrieve the state for each probe
pstate <- hmm.out$probe.state
# get a table of bound regions
regions <- hmm.out$regions

> # generation of a stacked histogram to show the ratios of
enriched and non-enriched probes
> x <- list(pmean[pstate==1], pmean[pstate!=1])
> histStack(x, breaks=seq(floor(min(pmean)),
ceiling(max(pmean)), length=51), col=c(2,0), xlab="mean
log2(ratio)", main="hmm enriched")
> legend("topright", c("enriched", "non-enriched"), fill=c(2,0),
bty="n")
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Looking at the histogram (Figure 7) now indicates that the HMM function picks up more
probes than thresholding on the FDR of the individual probe statistic. However,
thresholding is in general a rather subjective measure with little biological meaning. One
should not stick too much to the calculated bound and unbound categories, as there are
probably many in-between states that are biologically meaningful.
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Figure 7: Histogram of
enriched and non-enriched
probes identified by a HMM
based region summarization
approach.
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9. Export the data for visualization outside R
After we looked only at summarized data so far, the next step involves displaying the
computed values along the genome.
While it is possible to perform these plots within R, the export of the data and import into
one of the genome browsers is more convenient.
We will export continuous track information using either the GFF, SGR or WIG format
depending on the genome browser. Here I chose the WIG format to export mean ratio,
SAM statistic and hidden Markov state5.
Bound regions are written into a GFF file. All files can be read and displayed in the
Integrated Genome Browser (http://igb.bioviz.org/). The genome
corresponding to our data here is the 2004 version of Drosophila melanogaster, which
has to be loaded before data import.

5

Comment 5: The wiggle output files are tailored towards presentation in the integrated
genome browser. Slight adjustments to the formats have to be made to display the files
in UCSC genome browser or similar visualization tools.
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Note: The functions write.wiggle() an write.gff.regions() (and others) are
defined within the file noe_source.R that was “sourced” at the beginning of the
tutorial.
The following file export will require 1 to 3 minutes... The .wig file should be about 9 to
10 Mb each. The GFF file should be less than 100 Kb.
> # create a file in wiggle format that contains the mean signal
ratios of all replicates
> write.wiggle(pmean, layout, "mean.wig", descr="mean")
> # create a file in wiggle format that contains the sam
statistic
> write.wiggle(pstat, layout, "stat.wig", descr="stat")
> # create a file in wiggle format that contains the HMM states
(1 - enriched, 0 - non-enriched)
> write.wiggle(pstate, layout, "state.wig", descr="hmmstate")
> # create a gff file of the bound regions identified by tileHMM
> write.gff.regions(regions, "bound_regions.gff")
While the .wig file contain an extensive list of each position, the .gff file is much
smaller because it describes data in terms of region spans. You can inspect these plain
text files with a simple word processor such as NotePad or WordPad (which will read it
faster than MSWord).
Here are the first few lines of the .wig files:
==> mean.wig <==
##Mon Jun 28 09:27:05 2010
track type=wiggle_0 name="mean" description="mean" visibility=full
color=200,100,0 altColor=0,100,200 priority=20
chr2L 177
243
0.1
chr2L 635
701
0.08
chr2L 1093
1159
0.21
==> stat.wig <==
##Mon Jun 28 09:27:36 2010
track type=wiggle_0 name="stat" description="stat" visibility=full
color=200,100,0 altColor=0,100,200 priority=20
chr2L 177
243
0.09
chr2L 635
701
0.07
chr2L 1093
1159
0.19
==> state.wig <==
##Mon Jun 28 09:29:58 2010
track type=wiggle_0 name="hmmstate" description="hmmstate" visibility=full
color=200,100,0 altColor=0,100,200 priority=20
chr2L 177
243
0
chr2L 635
701
0
chr2L 1093
1159
0

The .gff file contains lines for chromosomes 2L, 2R, 3L, 3R and X. The dataset is
meant for the X chromosome, with the other chromosome sections serving as
background. Therefore there are many more entries for X while the other regions are
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smaller and incomplete. The number of lines can be counted after reading the .gff file
into an R object. This is one way to accomplish this task:
> g <- read.table("bound_regions.gff")
> dim(g)
[1] 777
8
> names(g)
[1] "V1" "V2" "V3" "V4" "V5" "V6" "V7" "V8"
> g$V1
[1] 2L 2L 2L 2L 2L 2L 2L 2L 2L 2L 2L 2L 2L 2L 2L 2L 2L 2L 2L
2L 2L 2L 2L
[ . . . . . . . .]
[760] X X X X X X X X X X X X X X X X X X
Levels: 2L 2R 3L 3R X
> grep("2L",g$V1)
[1] 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24
[25] 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48
[49] 49 50 51 52 53

> length(grep("2L",g$V1))
[1] 53
> length(grep("2R",g$V1))
[1] 50
> length(grep("3L",g$V1))
[1] 43
> length(grep("3R",g$V1))
[1] 87
> length(grep("X",g$V1))
[1] 544
>

10. Visualize with Integrated Genome Browser (IGB)
Open a web browser and navigate to: http://igb.bioviz.org/
IGB is “an interactive, zoomable, scrollable software program you can use to visualize
and explore genome-scale data sets, such as tiling array data, next-generation
sequencing results, genome annotations, microarray designs, and the sequence itself.
IGB is implemented using the Java programming language and should run on any
computer.”
Within the left side vertical menu click on Download, the resulting page will look similar
to the following:
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The web page gives ample details on the following 2 questions:
Which IGB Should I Use?: Click on the first IGB icon, info within the same page
details the specific needs and usage for the Large Memory version.
How Do I launch IGB?: When you click the icon, your browser will download and launch
the IGB software using a mechanism called Java Web Start.
Clicking on the IGB icon automatically downloads a file called igb.jnlp which is then
launched and will download any other necessary components.
A series of panels will come up from various processes: the web browser, the Java
engine and even Windows security. Click OK, run, and unblock when asked until the
actual IGB browser comes up.

It is possible that the IGB genome browser come up with the Rat genome (Rattus
norgegicus) by default. This needs to be changed! The genome corresponding to our
data here is the 2004 version of Drosophila melanogaster, which has to be loaded
before data import.
Make sure that the Tab “Data Access”
is selected and on the left hand side,
change from Rattus norvegicus to
Drosophila melanogaster.
Then on the right of that panel select
which build (D_melanogaster_2004):

Now that the reference
genome has been uploaded
we can import the files that
were created in R with the
help of the File menu.
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With a menu cascade File > Open file select one by one the files created within
R: mean.wig, stat.wig, state.wig, and bound_regions.gff.

For each file a new rectangular panel will
open on the left hand side. These can be
grabbed and rearranged. On the right
panel select the chromosome to analyze.

For example the “Coordinates” panel can be moved up. Here is an example screen after
Chromosome X has been chosen:

and then after zooming more

(Note: background was black and colors are reversed for better printing - except
coordinates panel).
The image created by the original author follows:
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12. End of lab -

-------------------------

---------------------------
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Notes
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Part 6

Gene Ontologies & Gene Sets
in Analysis of Differential Expression.
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Within the text, user input is shown as bold text or command

> is the R prompt and is not to be typed
Source material:
Analysis of Gene Expression Data Short Course, JSM2005
Terry Speed1,2, Jean Yang3, Ben Bolstad2 & James Wettenhall1
Augst 6-7, 2005
1. Walter and Eliza Hall Institute of Medical Research
2. University of California, Berkeley
3. University of Sydney
http://bioinf.wehi.edu.au/marray/jsm2005/

&
GOstats package vignette
http://www.bioconductor.org/packages/bioc/2.6/vignettes/GOstats/
inst/doc/GOstatsHyperG.pdf

&
goTools package vignette
http://www.bioconductor.org/packages/2.7/bioc/vignettes/goTools/
inst/doc/goTools.pdf
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1. Introduction
This tutorial is based on the online course by Speed, Yang, Bolstad and Wettenhall
published online (see back cover for complete credits.) Since the original script was
written there has been many changes to R. Some commands needed to be modified
while others were defunct and needed a new method, adapted from the corresponding
vignette. Therefore the R code provided on the web site does not work as-is with the
current R & bioConductor versions The following tutorial adaptation keeps traces of all
original commands and the errors created, therefore making this a journey into how a
script can be renewed and updated.
.
http://bioinf.wehi.edu.au/marray/jsm2005/
In this lab, we move beyond the analysis of individual genes, and consider sets of
genes in microarray experiments. Sets of genes from a list of differentially expressed
genes can be clustered together based on common behavior in one or more microarray
experiment (clustering lab).
Another approach is to form gene sets based on a priori knowledge of common
biological features shared by the genes (as described in the Gene Ontology (GO)
database [2] for example).
The GO analysis can be formalized to include statistical tests to determine whether a
particular Gene Ontology (GO) is over-represented (or under-represented) in the list of
differentially expressed genes from the microarray experiment.
For example if 10% of the most differentially expressed genes were associated with the
GO term apoptosis (GO:0006915), this would seem to be an unusually large proportion
of the gene list, given that apoptosis is such a specific type of biological process.
To determine how much larger than "usual" this proportion is, it must be compared to
the proportion of apoptosis-related genes in a reference gene list. That reference list
could be the entire set of genes on the microarray, or in fact the entire set of genes in
the GO database.
We will use the Bioconductor GOstats package to determine which gene ontologies
(GOs) found in gene lists are statistically over-represented or under-represented.
Another useful software tool for statistical analysis of GOs is
http://gostat.wehi.edu.au/ ([1]).
The second approach to gene set analysis we will examine in this list is quite different.
We begin with a known set of genes and then test whether this set as a whole is
differentially expressed in a microarray experiment. This type of test is useful when
comparing one's microarray data with that of previous authors who have performed
similar microarray experiments, because the lists of most differentially expressed genes
reported by the previous authors can be regarded as a "gene set" and tested to
determine whether the genes are also differentially expressed in the current context.
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Gene set testing was introduced by Mootha et al. [5] and Lamb et al. [6] in 2003.
Mootha et al. define the concept of a gene set enrichment test. For a given set of genes,
one can test whether the set as a whole is up-regulated, down-regulated or differentially
expressed with individual genes possibly going in either direction.
Sometimes performing the traditional differential expression analysis of individual genes
will yield no statistically significant results, but there may be stronger evidence for
differential expression of gene sets.

2. Lab Set-up / Required software
These exercises are set-up for the BTCI Windows machines. R might be available as a
shortcut icon on the desktop or in the list of programs in the Start menu.
R should also be available
as the usual
Start > All Programs
menu cascade.
(Shown here for R 2.9.0)
The following section lists the required software and packages. In this way you can
configure your own system with the necessary elements.

2.1 Required software
The R/Bioconductor software should already be installed on the class computers.
Note: the original exercise was written for R 2.1.x with required package list:
affy_1.6.7, annotate_1.5.16, Biobase_1.5.12, estrogen_1.5.0,
genefilter_1.6.3, GO_1.8.2, GOstats_1.1.3, goTools_1.0.6, graph_1.5.9,
hgu95av2_1.8.4, hgu95av2cdf_1.5.1, hgu133acdf_1.5.1, hgu133a_1.8.4,
limma_2.0.2, multtest_1.6.0, RBGL_1.3.13, Ruuid_1.5.3, reposTools_1.5.19,
statmod_1.1.1, xtable_1.2-5

By omitting the version number the requested packages list can be updated with the
following list:
affy, annotate, Biobase, estrogen, genefilter, GOstats, goTools, graph,
hgu95av2, hgu95av2cdf, hgu133acdf, hgu133a, limma, multtest, RBGL, Ruuid,
reposTools, statmod, xtable

Info at: http://www.bioconductor.org/packages/release/Software.html
See installation below:

2.2

INSTALLING Required software

R and BioConductor are already installed on these computers. To install on your own
system refer to the Installation instructions Part 0. To install the packages specific to this
exercise please do the following:
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Launch R from the R icon on the desktop or the Start menu.
At the > prompt type the following commands:
> source("http://bioconductor.org/biocLite.R")
> biocLite(c("affy", "annotate", "Biobase", "estrogen",
"genefilter", "GOstats", "goTools", "graph", "hgu95av2",
"hgu95av2cdf", "hgu133acdf", "hgu133a.db", "limma", "multtest",
"RBGL", "Ruuid", "reposTools", "statmod", "xtable"))
Using R version 2.11.1, biocinstall version 2.6.7.
Installing Bioconductor version 2.6 packages:
[1] "affy"
"annotate"
"Biobase"
"estrogen"
"genefilter"
[6] "GO"
"GOstats"
"goTools"
"graph"
[11] "hgu95av2cdf" "hgu133acdf" "hgu133a"
"limma"
[16] "RBGL"
"Ruuid"
"reposTools" "statmod"
Please wait...

"hgu95av2"
"multtest"
"xtable"

also installing the dependencies ‘GSEABase’, ‘Category’
trying URL
'http://www.bioconductor.org/packages/2.6/bioc/bin/macosx/leopard/contr
ib/2.11/GSEABase_1.10.0.tgz'
Content type 'application/x-gzip' length 489177 bytes (477 Kb)
opened URL
Warning message:
In getDependencies(pkgs, dependencies, available, lib) :
package ‘reposTools’ is not available
>

Obsolete package:
The 'reposTools' package used to be part of the infrastructure of the BioConductor
project. It served as the initial backbone for R package installation for BioC. This has
changed in the last BioConductor release in the fall. Now BioC installs by slurping some
startup scripts directly from R. So r-bioc-repostools is obsolete, and we should remove.
Nothing else depends on this package, so removal is harmless.

3. Gene Ontologies
3.1 Introduction
From http://en.wikipedia.org/wiki/Gene_Ontology : "The Gene Ontology,
or GO, is a trio of controlled vocabularies that are being developed to aid the description
of the molecular functions of gene products, their placement in and as cellular
components, and their participation in biological processes. Terms in each of the
vocabularies are related to one another within a vocabulary in a polyhierarchical (or
Directed Acyclic Graph) manner; terms are mutually exclusive across the three
vocabularies. Each term consists of a definition, an alphanumerical identifier, and a
phrase (the term itself)."
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In practice, one thinks of the Directed Acyclic Graph (DAG) as an (upside-down) tree,
with the top three nodes being molecular function, cellular component and biological
process. Then one can test whether a gene list contains a larger than usual proportion
of genes found under a certain node of the GO tree. Technically it is a DAG, not a tree,
because branches can merge together, but the concept of a tree may be helpful in
understanding how GOs work. The reader is referred to the Gene Ontology consortium
website for more information: http://www.geneontology.org/ [3].

In computer science and information science, an ontology is a formal representation of the
knowledge by a set of concepts within a domain and the relationships between those concepts. (1)
The Gene Ontology project (http://www.geneontology.org) provides an ontology of defined
terms representing gene product properties. The ontology covers three domains:
- cellular component, the parts of a cell or its extracellular environment;
- molecular function, the elemental activities of a gene product at the molecular level, such
as binding or catalysis;
- and biological process, operations or sets of molecular events with a defined beginning
and end, pertinent to the functioning of integrated living units: cells, tissues, organs, and
organisms.(2)
GO describes how gene products behave in a cellular context. [. . .] For example, the gene product
cytochrome c can be described by the molecular function term oxidoreductase activity, the
biological process terms oxidative phosphorylation and induction of cell death, and the cellular
component terms mitochondrial matrix and mitochondrial inner membrane.(3) (These are
“attributes” to the gene product “cytochrome c” but is not itself in any of the 3 ontologies.)
The GO ontology is structured as a directed acyclic graph, and each term has defined relationships
to one or more other terms in the same domain, and sometimes to other domains. The GO
vocabulary is designed to be species-neutral, and includes terms applicable to prokaryotes and
eukaryotes, single and multicellular organisms. (2,3)
Quoted References:
(1)
– http://en.wikipedia.org/wiki/Ontology_(computer_science)
(2)
– http://en.wikipedia.org/wiki/Gene_Ontology
(3)
– http://www.geneontology.org/GO.doc.shtml

4. GOstats example
This exercise uses the Estrogen data that we have used previously with the limma
package: we read in the Estrogen data, normalize it and fit a linear model in order to
find differentially expressed genes. This can be accomplished with the following R code:
>
>
>
>
>
>
>
>
>

library(limma)
library(affy)
library(hgu95av2cdf)
library("annotate")
datadir <- system.file("extdata",package="estrogen")
#
#
#
#

Please ensure that either "EstrogenTargets.txt" from
http://bioinf.wehi.edu.au/marray/jsm2005/Data/ EstrogenTargets.txt
is in the current working directory as given by getwd(), or that you
provide the read.phenoData function with a full path to
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>
>

# "EstrogenTargets.txt", e.g. "C:/JSM/EstrogenTargets.txt"
# or "C:\\JSM\\EstrogenTargets.txt".

> setwd(datadir)
> getwd()
[1]
"/Library/Frameworks/R.framework/Versions/2.11/Resources/li
brary/estrogen/extdata"
> download.file("http://bioinf.wehi.edu.au/marray/jsm2005/
Data/EstrogenTargets.txt","EstrogenTargets.txt")
trying URL 'http://bioinf.wehi.edu.au/marray/jsm2005/Data/
EstrogenTargets.txt'
Content type 'text/html;charset=ISO-8859-1' length 1464 bytes
opened URL
==================================================
downloaded 1464 bytes

>
Note Change:
> pd <- read.phenoData("EstrogenTargets.txt",header=TRUE,
row.names=1,as.is=TRUE)
Error: read.phenoData is defunct, use read.AnnotatedDataFrame
instead
> pd <- read.AnnotatedDataFrame("EstrogenTargets.txt",
header=TRUE, row.names=1,as.is=TRUE)
> slotNames(pd)
[1] "varMetadata" "data" "dimLabels"
".__classVersion__"
> pData(pd)
FileName
Target
Abs10.1
low10-1.cel EstAbsent10
Abs10.2
low10-2.cel EstAbsent10
Pres10.1 high10-1.cel EstPresent10
Pres10.2 high10-2.cel EstPresent10
Abs48.1
low48-1.cel EstAbsent48
Abs48.2
low48-2.cel EstAbsent48
Pres48.1 high48-1.cel EstPresent48
Pres48.2 high48-2.cel EstPresent48
> rownames(pData(pd))
[1] "Abs10.1" "Abs10.2" "Pres10.1" "Pres10.2" "Abs48.1"
[6] "Abs48.2" "Pres48.1" "Pres48.2"
> abatch <- ReadAffy(filenames=pData(pd)$FileName,
celfile.path=datadir)
> abatch
AffyBatch object
size of arrays=640x640 features (11 kb)
cdf=HG_U95Av2 (12625 affyids)
number of samples=8
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number of genes=12625
annotation=hgu95av2
notes=
> slotNames(abatch)
[1] "cdfName"
"nrow"
[4] "assayData"
"phenoData"
[7] "experimentData"
"annotation"
[10] ".__classVersion__"

"ncol"
"featureData"
"protocolData"

> protocolData(abatch)
An object of class "AnnotatedDataFrame"
sampleNames: low10-1.cel, low10-2.cel, ..., high48-2.cel
total)
varLabels and varMetadata description:
ScanDate: NA

>

(8

# abatch@phenoData <- pd # DO NOT DO

> eset <- rma(abatch)
Background correcting
Normalizing
Calculating Expression

> slotNames(eset)
[1] "assayData"
"phenoData"
[4] "experimentData"
"annotation"
[7] ".__classVersion__"

"featureData"
"protocolData"

For more info on these names type ?eSet
> pData(eset)
low10-1.cel
low10-2.cel
high10-1.cel
high10-2.cel
low48-1.cel
low48-2.cel
high48-1.cel
high48-2.cel

sample
1
2
3
4
5
6
7
8

Proceeding with pData(eset) would result in an error
Note: Difference(s): We have already noted this change in the Limma tutorial

In R 2.4 and Bioconductor 1.9:

In R 2.5 and BioConductor 2.0:

> targets <- pData(eset)
> targets
FileName
Target
Abs10.1
low10-1.cel EstAbsent10
Abs10.2
low10-2.cel EstAbsent10
Pres10.1 high10-1.cel EstPresent10
Pres10.2 high10-2.cel EstPresent10
Abs48.1
low48-1.cel EstAbsent48
Abs48.2
low48-2.cel EstAbsent48
Pres48.1 high48-1.cel EstPresent48
Pres48.2 high48-2.cel EstPresent48

> targets <- pData(eset)
> targets
sample
low10-1.cel
1
low10-2.cel
2
high10-1.cel
3
high10-2.cel
4
low48-1.cel
5
low48-2.cel
6
high48-1.cel
7
high48-2.cel
8
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R 2.11.1 behaves in the same way as R.2.5

The information about the “Targets” was given earlier from object pd (short for pheno
data.) This can be recalled with:
> targets <- pd@data
> design <- model.matrix(~ -1 +
factor(targets$Target,levels=unique(targets$Target)))
> design
1
2

factor(targets$Target, levels = unique(targets$Target))EstAbsent10
1
1

[ . . . ]
7
8
attr(,"assign")
[1] 1 1 1 1 1 1 1 1
attr(,"contrasts")
attr(,"contrasts")$`factor(targets$sample, levels =
unique(targets$sample))`
[1] "contr.treatment"

0
1

> unique(targets$Target)
[1] "EstAbsent10"

"EstPresent10" "EstAbsent48"

"EstPresent48"

> colnames(design) <- unique(targets$Target)
> numParameters <- ncol(design)
> parameterNames <- colnames(design)
> fit <- lmFit(eset,design=design)
> contrastNames <- c(paste(parameterNames[2],
parameterNames[1],sep="-"), paste(parameterNames[4],
parameterNames[3],sep="-"), paste(parameterNames[3],
parameterNames[1],sep="-"))
>
> contrastsMatrix <- matrix(c(-1,1,0,0,0,0,-1,1,1,0,1,0),nrow=ncol(design))
> rownames(contrastsMatrix) <- parameterNames
> colnames(contrastsMatrix) <- contrastNames
> fit2 <- contrasts.fit(fit,contrasts=contrastsMatrix)
> fit2 <- eBayes(fit2)
> names(fit2)
[1] "coefficients"
[4] "qr"
[7] "cov.coefficients"
[10] "Amean"
[13] "contrasts"
[16] "var.prior"
[19] "t"
[22] "F"

"rank"
"df.residual"
"stdev.unscaled"
"method"
"df.prior"
"proportion"
"p.value"
"F.p.value"
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> slotNames(fit2)
[1] ".Data"
Note Change:
> numGenes <- nrow(eset@exprs)
Error: no slot of name "exprs" for this object of class "ExpressionSet"
Error in nrow(eset@exprs) :
error in evaluating the argument 'x' in selecting a method for function
'nrow'

We have detailed that change in the Normalization section of the Affy tutorial. Using
a nomenclature without the @ symbol can fix the problem: exprs(eset)
> nrow(exprs(eset))
[1] 12625
> numGenes <- nrow(exprs(eset))
> completeTableEst10 <- topTable(fit2,coef="EstPresent10EstAbsent10",number=numGenes)
> save.image("EstrogenLinearModelFit.RData")
We will consider the comparison of "Estrogen Present" vs "Estrogen Absent" at time 10
hours, and take the top 50 genes with most evidence of differential expression
according to the B statistic (also known as lod score or log odds of differential
expression).
> ord.Est10 <- order(fit2$lods[,"EstPresent10-EstAbsent10"],
decreasing=TRUE)
> top50.Est10 <- ord.Est10[1:50]
We now load the annotation package for the hgu95av2 chip used in the Estrogen
experiment, and obtain Locus Link IDs for the top 50 most differentially expressed
genes in the "Estrogen Present" vs "Estrogen Absent" (time 10hrs) comparison.
Note Change: (after a time no deprecation warning will be given at all)
> library(hgu95av2)
******* Deprecation warning *******:
The package 'hgu95av2' is deprecated and will not be supported in the future.
Instead we strongly recommend that you should start using the 'hgu95av2.db' package.

We hope you will enjoy these new packages.

> library(hgu95av2.db)
> geneIDs <- ls(hgu95av2cdf)
> geneIDs[1:5]
[1] "100_g_at" "1000_at"
"1001_at"
>
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Note Change: (after a time no deprecation warning will be given at all)
> LocusLinkIDs <as.character(unlist(lapply(mget(geneIDs,env=hgu95av2LOCUSID),
function (LL.ID) { return(paste(LL.ID,collapse="; ")) } )))

Error: object 'hgu95av2LOCUSID' not found
Error in mget(geneIDs, env = hgu95av2LOCUSID) :
error in evaluating the argument 'envir' in selecting a
method for function 'mget'
>
We need to find a replacement for the LOCUSID entry. For this we can examine the
contents of the package:
> ls("package:hgu95av2.db")
[1]
[5]
[9]
[13]
[17]
[21]
[25]
[29]
[33]

"hgu95av2"
"hgu95av2_dbschema"
"hgu95av2CHRLENGTHS"
"hgu95av2ENSEMBL2PROBE"
"hgu95av2GENENAME"
"hgu95av2MAP"
"hgu95av2ORGPKG"
"hgu95av2PMID"
"hgu95av2SYMBOL"

"hgu95av2_dbconn"
"hgu95av2ACCNUM"
"hgu95av2CHRLOC"
"hgu95av2ENTREZID"
"hgu95av2GO"
"hgu95av2MAPCOUNTS"
"hgu95av2PATH"
"hgu95av2PMID2PROBE"
"hgu95av2UNIGENE"

"hgu95av2_dbfile"
"hgu95av2_dbInfo"
"hgu95av2ALIAS2PROBE"
"hgu95av2CHR"
"hgu95av2CHRLOCEND"
"hgu95av2ENSEMBL"
"hgu95av2ENZYME"
"hgu95av2ENZYME2PROBE"
"hgu95av2GO2ALLPROBES" "hgu95av2GO2PROBE"
"hgu95av2OMIM"
"hgu95av2ORGANISM"
"hgu95av2PATH2PROBE"
"hgu95av2PFAM"
"hgu95av2PROSITE"
"hgu95av2REFSEQ"
"hgu95av2UNIPROT"

We will use hgu95av2ENTREZID instead but keep the R object as LocusLinkIDs
> LocusLinkIDs <- as.character(unlist(lapply(mget(geneIDs,
env=hgu95av2ENTREZID), function (LL.ID) {
return(paste(LL.ID,collapse="; ")) } )))
> length(LocusLinkIDs)
[1] 12625
> is.vector(LocusLinkIDs)
[1] TRUE
> LocusLinkIDs[1:5]
[1] "5875" "5595" "7075" "1557" "643"
> LocusLinkIDs[89:102]
[1] "NA"
[9] "2057"

"1544"
"627"

"4953"
"NA"

"5335" "4582"
"10244" "NA"

"27"
"5575"

"5336"

"1439"

> topLocusLinkIDs <- LocusLinkIDs[top50.Est10]
> topLocusLinkIDs <- topLocusLinkIDs[topLocusLinkIDs!="NA"]
The last command insures that there is no “NA” in the list.
We now load the GOstats package and use the GOHyperG function to search for
statistically over-represented GOs within the top 50 most differentially expressed genes
from the Estrogen set, compared with the GOs represented by all of the genes on the
hgu95av2 chip.
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The test for statistical significance is based on a hypergeometric test. For more
information, we refer to the help for the GOHyperG function which can be obtained be
typing ?GOHyperG. The latter part of the help file, describing the statistical test is
reproduced below:
> library(GOstats)
Loading required package: Category
Loading required package: graph
> ?GOHyperG
Description
Use hyperGTest instead.

Details [. . .] For each GO term in the specified category that has at least one annotation in the selected
gene set (x), we determine how many of its Entrez Gene annotations are in the universe set and how many are
in the selected set. With these counts we perform a Hypergeometric test using phyper. This is equivalent to
using Fisher's exact test.

Note Change: We were told in the Help file to use hyperGTest instead
> goHyperG <- GOHyperG(unique(topLocusLinkIDs),
lib="hgu95av2", what="MF")
Error: 'GOHyperG' is defunct.
Use 'hyperGTest' instead.
See help("Defunct")
So let’s start again with the new command:
> ?hyperGTest
This will prompt the following question within the Help window:
Help on topic 'hyperGTest' was found in the following packages:
Hypergeometric Tests for GO term association
(in package GOstats in library ...)
Hypergeometric Test for association of categories and genes
(in package Category in library ...)
Click on the first choice
To learn more about GOstats call the vignette within R:
> vignette("GOstatsHyperG", package="GOstats")
Or go online:
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http://www.bioconductor.org/packages/bioc/2.6/vignettes/GOstats/
inst/doc/GOstatsHyperG.pdf
Or select the appropriate PDF link from
http://www.bioconductor.org/packages/bioc/2.6/html/GOstats.html
(Note that 2.6 in the URL denotes the current version as of this writing. To see previous
versions change 2.6 to lower number, e.g. 1.8, 2.2 etc.)
From the Vignette: To perform an analysis using the Hypergeometric-based tests, one needs to
define a gene universe (usually conceptualized as the number of balls in an urn) and a list of
selected genes from the universe. While it is clear that the selected gene list determines to a large
degree the results of the analysis, the fact that the universe has a large effect on the conclusions
is, perhaps, less obvious.
For microarray data, one can use the unique gene identiers assayed in the experiment as the gene
universe. However, the presence of a gene on the array does not necessarily mean much. Some
arrays, such as those from Affymetrix, attempt to include probes for as much of the genome as
possible. Since not all genes will be expressed under all conditions (a widely held belief is that
about 40% of the genome is expressed in any tissue), it may be sensible to reduce the universe to
those that are expressed. [ . . . ]
Once a gene universe has been established, one can apply any number of methods to select
genes. For the example analysis we use a simple t-test to identify differentially expressed genes
among the two subgroups in the sample population. It is worth noting that the effect of increasing
the universe size with genes that are irrelevant to the questions at hand, in general, has the effect
of making the resultant p-values look more signicant. For example, in a universe of 1000 genes
where 400 have been selected, suppose that a GO term has 40 gene annotations from the
universe of 1000. If 10 of the genes in the selected gene list are among the 40 genes annotated at
this category, then the Hypergeometric p-value is 0.99. However, if the gene universe contained
5000 genes, the p-value would drop to 0.001.

The new command does not work in the same way and requires different parameters.
We can keep the same list of 50 from above with topLocusLinkIDs and consider that
the “selected” group. We need to define a “universe” to compare it with.
The following is derived from the GOstats vignette.
We begin our non-specific filtering by removing probe sets that have no Entrez Gene
identifier in our annotation data.
> entrezIds <- mget(featureNames(eset), envir =
hgu95av2ENTREZID)
> length(entrezIds)
[1] 12625
>
> haveEntrezId <- names(entrezIds)[sapply(entrezIds, function(x)
!is.na(x))]
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> haveEntrezId[1:5]
[1] "100_g_at" "1000_at"

"1001_at"

"1002_f_at" "1003_s_at"

> numNoEntrezId <- length(featureNames(eset)) length(haveEntrezId)
> numNoEntrezId
[1] 901
> set <- eset[haveEntrezId,]
> haveGo <- sapply(mget(featureNames(set), hgu95av2GO),
function(x) { if (length(x) == 1 && is.na(x))
FALSE
else TRUE
})
> haveGo[1:5]
100_g_at
TRUE

1000_at
TRUE

1001_at 1002_f_at 1003_s_at
TRUE
TRUE
TRUE

> length(haveGo)
[1] 11724
> numNoGO <- sum(!haveGo)
> numNoGO
[1] 435
> set <- set[haveGo, ]
> dim(eset)
Features
12625
> dim(set)
Features
11289

Samples
8
Samples
8

Now use the IQR of each probe set across samples to remove those probe sets that
have little variation across samples.
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IQR: In descriptive statistics, the interquartile
range (IQR), also called the midspread or
middle fifty, is a measure of statistical
dispersion, being equal to the difference
between the third and first quartiles. Unlike
(total) range, the interquartile range is a robust
statistic, having a breakdown point of 25%, and
is thus often preferred to the total range. The
IQR is used to build box plots, simple graphical
representations of a probability distribution.
http://en.wikipedia.org/wiki/Interq
uartile_range

>
>
>
>

iqrCutoff <- 0.5
setIqr <- apply(exprs(set), 1, IQR)
selected <- setIqr > iqrCutoff
selected[1:5]
100_g_at
1000_at
1001_at 1002_f_at 1003_s_at
FALSE
FALSE
FALSE
FALSE
FALSE
> nsFiltered <- set[selected, ]
> nsFiltered
ExpressionSet (storageMode: lockedEnvironment)
assayData: 1674 features, 8 samples
element names: exprs
protocolData
sampleNames: low10-1.cel, low10-2.cel, ..., high48-2.cel
varLabels and varMetadata description:
ScanDate: NA
phenoData
sampleNames: low10-1.cel, low10-2.cel, ..., high48-2.cel
varLabels and varMetadata description:
sample: arbitrary numbering
featureData: none
experimentData: use 'experimentData(object)'
Annotation: hgu95av2

(8 total)

(8 total)

> dim(nsFiltered)
Features Samples
1674
8
Here we ensure that each probe set maps to exactly one Entrez Gene ID. If multiple
probes are found to map to the same Entrez Gene ID, we select the probe with largest
IQR (from the computation above).
> numNsWithDups <- length(featureNames(nsFiltered))
> numNsWithDups
[1] 1674
> nsFilteredIqr <- setIqr[selected]
> length(nsFilteredIqr)
[1] 1674
> nsFilteredIqr[1:5]
1005_at 1008_f_at
1009_at
1024_at 1025_g_at
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0.8778096 0.5089893 0.6480128 0.5109162 0.9028945
The function findLargest is part of the the genefilter package.
> library("genefilter")
> uniqGenes <- findLargest(featureNames(nsFiltered),
nsFilteredIqr, "hgu95av2")
> nsFiltered <- nsFiltered[uniqGenes, ]
> length(nsFilteredIqr)
[1] 1674
> numSelected <- length(featureNames(nsFiltered))
> numSelected
[1] 1502
Finally, we can define the gene universe we will use for the Hypergeometric tests.
> affyUniverse <- featureNames(nsFiltered)
> length(affyUniverse)
[1] 1502
> affyUniverse[1:5]
[1] "38924_s_at" "266_s_at"

"35688_g_at" "32589_at"

"34756_g_at"

> entrezUniverse <- unlist(mget(affyUniverse, hgu95av2ENTREZID))
> length(entrezUniverse)
[1] 1502
> entrezUniverse[1:5]
38924_s_at
"10006"

266_s_at 35688_g_at
"100133941" "100272147"

32589_at
"10036"

34756_g_at
"10038"

> if (any(duplicated(entrezUniverse))) stop("error in gene
universe: can't have duplicates!")
>
> chipAffyUniverse <- featureNames(eset)
> chipAffyUniverse[1:5]
[1] "100_g_at" "1000_at"
"1001_at"
"1002_f_at" "1003_s_at"
> length(chipAffyUniverse)
[1] 12625
> chipEntrezUniverse <- mget(chipAffyUniverse, hgu95av2ENTREZID)
> length(chipEntrezUniverse)
[1] 12625
> chipEntrezUniverse <- unique(unlist(chipEntrezUniverse))
> length(chipEntrezUniverse)
[1] 8800
Summary of non-specific filtering: Our non-specific filtering procedure removed probes
missing either Entrez Gene identifiers or mappings to GO terms. The inter-quartile
range (IQR) was used with a cutoff of 0.5 to select probes with sufficient variability
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across samples to be informative; probes with little variability across all samples are
inherently uninteresting.
Finally, the set of remaining probes was refined by ensuring that each probe maps to
exactly one Entrez Gene identifier. For those probes mapping to the same Entrez
Gene ID, the probe with largest IQR was selected. Producing a set of Entrez Gene
identifiers that map to a unique set of probes at the non-specific filtering stage is
important because genes are mapped to GO categories using Entrez Gene IDs and we
want to avoid double counting any GO categories. In all, the filtering left 1502 genes.
Often one wishes to perform many similar analyses using slightly different sets of
parameters and to facilitate this pattern of usage the main interface to the
Hypergeometric tests, hyperGTest, takes a single parameter object as its argument.
This argument is an instance of class GOHyperGParams. Using a parameter class
instead of individual arguments makes it easier to organize and execute a series of
related analyses.
From the Vignette: Here is a description of all the arguments needed to construct a
GOHyperGParams instance:
geneIds A vector of gene identifiers that defines the selected list of genes. This is often the output
of a test for differential expression among two sample groups. For experiments using Ametrix
expression arrays, this should be a vector of Entrez Gene IDs. If you are using the YEAST
annotation package, the vector will consist of yeast systematic names.
universeGeneIds A vector of gene identifiers that defines the universe of possible genes. We
recommend using the set of gene IDs that result from non-specific filtering. The identifiers should be
of the same type as the geneIds; for Ametrix arrays, these will be Entrez Gene IDs. annotation A
string giving the name of the annotation data package that corresponds to the chip used in the
experiment.
ontology A two-letter string specifying one of the three GO ontologies: BP, CC, or MF. The
hyperGTest function only tests a single GO ontology at one time.
pvalueCutoff A numeric values between zero and one used as a p-value cutoæor p-values
generated by the Hypergeometric test. When the test being performed is non-conditional, this is only
used as a default value for printing and summarizing the results. For a conditional analysis, the
cutoff is used during the computation to determine perform the conditioning: child terms with a pvalue less than pvalueCutoff are conditioned out of the test for their parent term.
conditional A logical value. If TRUE, the test performed uses the conditional algorithm.
Otherwise, a standard Hypergeometric test is performed. When 'conditional(p) == TRUE', the
'hyperGTest' function uses the structure of the GO graph to estimate for each term whether or not
there is evidence beyond that which is provided by the term's children to call the term in question
statistically overrepresented. The algorithm conditions on all child terms that are themselves
significant at the specified p-value cuto. Given a subgraph of one of the three GO ontologies, the
terms with no child categories are tested first. Next the nodes whose children have already been
tested are tested. If any of a given node's children tested significant, the appropriate conditioning is
performed.
testDirection A string which can be either \over" or \under". This determines whether the test
performed detects over or under represented GO terms.
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> hgCutoff <- 0.001
> params <- new("GOHyperGParams", geneIds = entrezUniverse ,
universeGeneIds = chipEntrezUniverse,
annotation = "hgu95av2.db",
ontology = "BP", pvalueCutoff = hgCutoff, conditional = FALSE,
testDirection = "over")
> params
A GOHyperGParams instance
category: GO
annotation: hgu95av2
In fact this term is a container for all the information and each of them can be verified
with the help of the @ command (examples below)
> slotNames(params)
[1] "ontology"
"conditional"
[4] "universeGeneIds"
"annotation"
[7] "categorySubsetIds" "categoryName"
[10] "testDirection"

"geneIds"
"datPkg"
"pvalueCutoff"

> params@ontology
[1] "BP"
> params@conditional
[1] FALSE
> params@pvalueCutoff
[1] 0.001
We would also like to perform a conditional test. Instead of having to de_ne a new GOHyperGParams instance by hand, we can create a copy and update just the parameter
of interest.
> paramsCond <- params
> conditional(paramsCond) <- TRUE
> paramsCond@conditional
[1] TRUE
A similar approach would work to create a parameter object for testing a different GO
ontology or to create an object for testing under representation.
First run the test:
> hgOver <- hyperGTest(params)
> hgCondOver <- hyperGTest(paramsCond)
Then check the results
> hgOver
Gene to GO BP

test for over-representation
Page - 217 -

R and Bioconductor- time-course analysis
4378 GO BP ids tested (87 have p < 0.001)
Selected gene set size: 1397
Gene universe size: 7757
Annotation package: hgu95av2
> hgCondOver
Gene to GO BP Conditional test for over-representation
4378 GO BP ids tested (52 have p < 0.001)
Selected gene set size: 1397
Gene universe size: 7757
Annotation package: hgu95av2
It is easy to re-run the test with e.g. a cut-off of 0.05 by changing the parameters and
rerunning the same commands. The result for p< 0.05 would be:
hgOver
Gene to GO BP test for over-representation
4378 GO BP ids tested (435 have p < 0.05)
Selected gene set size: 1397
Gene universe size: 7757
Annotation package: hgu95av2

> slotNames(hgOver)
[1] "goDag"
[5] "geneIds"

"pvalue.order"
"testName"

"conditional"
"pvalueCutoff"

"annotation"
"testDirection"

>
The content of the slot Names can be called with the @ command form or with the
parentheses form: e.g. hgOver@goDag or goDag(hgOver):
> goDag(hgOver)
A graphNEL graph with directed edges
Number of Nodes = 4378
Number of Edges = 9002
> conditional(hgOver)
[1] FALSE
> annotation(hgOver)
[1] "hgu95av2"
> length(geneIds(hgOver))
[1] 1397
> geneIds(hgOver)[1:5]
38924_s_at
266_s_at 35688_g_at
32589_at 34756_g_at
"10006" "100133941" "100272147"
"10036"
"10038"
> testName(hgOver)
[1] "GO" "BP"
> pvalueCutoff(hgOver)
[1] 0.001
> testDirection(hgOver)
[1] "over"
Some slots still require special attention, for example the pvalue.order data is
accessed with the command pvalues (here showing the first 5):
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> pvalues(hgOver)[1:5]
GO:0006259
GO:0006139
0.000000000000000000003300900 0.000000000000000134807820594
GO:0006281
GO:0006974
0.000000000000001459944094541 0.000000000000001739382277676
GO:0006260
0.000000000000049004830836984

The following are also documented in the Vignette:
> oddsRatios(hgOver)[1:5]
GO:0006259 GO:0006139 GO:0006281
3.033029
1.668814
3.478653
> expectedCounts(hgOver)[1:5]
GO:0006259 GO:0006139 GO:0006281
66.27511 417.28104
34.93851
> geneCounts(hgOver)[1:5]
GO:0006259 GO:0006139 GO:0006281
141
547
82
> universeCounts(hgOver)[1:5]
GO:0006259 GO:0006139 GO:0006281
368
2317
194

GO:0006974 GO:0006260
3.040241
3.593919
GO:0006974 GO:0006260
45.38404
29.17545
GO:0006974 GO:0006260
98
70
GO:0006974 GO:0006260
252
162

> length(geneIdUniverse(hgOver)[[3]])
[1] 194
> geneIdUniverse(hgOver)[[3]][1:5]
[1] "10036" "10038" "10039" "10111" "1022"
> geneMappedCount(hgOver)
[1] 1397
> universeMappedCount(hgOver)
[1] 7757
To make it easy for non-technical users to review the results, the htmlReport function
generates an HTML file that can be viewed in any web browser. The output generated
by htmlReport as called below is output to your current working directory (getwd())
> htmlReport(hgOver, file = "ALL_hgo.html")
The top part of the HTML file is shown here:
Gene to GO BP test for over-representation
GO:0006259

0.000

3.033

Exp
Count
66

GO:0006139

0.000

1.669

GO:0006281
GO:0006974
GO:0006260
GO:0006807

0.000
0.000
0.000
0.000

3.479
3.040
3.594
1.576

GOBPID

Pvalue

OddsRatio

Count

Size

141

368

417

547

2317

35
45
29
465

82
98
70
585

194
252
162
2580
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The same process needs to be repeated for the other 2 ontologies: CC and MF.
Calculations can be simplified by re-using the params format described above to
change the various options.
In some way we already have what we wanted: a table with the results, in this case as
an HTML format. However, we can still use the R code that was proposed to see if it
can be used with few modifications. All the names containing goHyperG have to be
changed. We will add a few commands to better review the results:
The command bestGOs <- goHyperG$pvalues[goHyperG$pvalues < 0.2]
can be rewritten as:
> bestGOs <- pvalues(hgOver)[pvalues(hgOver) < 0.2]
We can see how many were selected by looking at the size of the following R objects:
> length(pvalues(hgOver))
[1] 4378
> length( bestGOs)
[1] 1257

> # Inspect some of the p-values and corresponding GOs.
> bestGOs[1:5]
GO:0006259
GO:0006139
0.000000000000000000003300900 0.000000000000000134807820594
GO:0006281
GO:0006974
0.000000000000001459944094541 0.000000000000001739382277676
GO:0006260
0.000000000000049004830836984

> # order p-values
> bestGOs <- sort(bestGOs)
The following command was adapted to BP from the example of MF: (getGOTerm is
part of package “annotate”)
> bestGOs.terms <- getGOTerm(names(bestGOs))[["BP"]]
> length(bestGOs.terms)
[1] 1257
The next command series operate some text formatting on the results:
> bestGOstring <- unlist(bestGOs.terms)
> numCh <- nchar(bestGOstring)
> length(numCh)
[1] 1257
> # Limit names of GO terms to 25 characters
> bestGOstring2 <- substr(bestGOstring, 1, 25)
> bestGOstring3 <- paste(bestGOstring2, ifelse(numCh > 17,
"...", ""), sep="")
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The command bestGOs.counts <- goHyperG$goCounts[names(bestGOs)]
could possibly be replaced with:
> bestGOs.counts <- length(bestGOs)
> length(bestGOs)
[1] 1257
Finally we can output the table (in text format) and displayed completely (suggested,
remove the # to apply) or the first 5 items displayed for review here:
> bestGOsTable <- data.frame("GO Term"= I(bestGOstring3),
"p.value"=round(bestGOs,3),"No. of Genes"=bestGOs.counts)
> # bestGOsTable
> bestGOsTable[1:5,]
GO.Term p.value No..of.Genes
GO:0006259
DNA metabolic process...
0
1257
GO:0006139 nucleobase, nucleoside, n...
0
1257
GO:0006281
DNA repair
0
1257
GO:0006974 response to DNA damage st...
0
1257
GO:0006260
DNA replication
0
1257
>
The original continued as such: We now look at the GO annotations associated with the
hgu95av2 chip (as used above), and consider how long the GOs are, i.e. how many
nodes they are away from the basic Molecular Function (MF), Biological Process (BP)
and Cellular Component (CC) nodes. We will then look at how many probes (genes) on
the chip have multiple GOs associated with them. Finally we will look at information
about where the GO information was obtained from for the genes on the hgu95av2 chip.
Firstly, we look at the lengths of the GOs associated with the hgu95av2 chip. A gene
with a GO of length zero is classified as MF, BP or CC, but is not classified any more
specifically than that. The longest GO length on this chip is 14. The majority of genes on
the chip of GO annotations with lengths between 0 and 4, with only 1000 or so having
more specific GO annotations (with longer lengths). Of course describing how specific a
GO annotation is cannot really be done quantitatively, so one must not read too much
into the meaning of the GO lengths.
> affyGO <- eapply(hgu95av2GO, getOntology)
> table(sapply(affyGO, length))
0
1
2
3
4
5
1953 1685 2031 2077 1562 1159
10
98

11
80

12
38

13
40

14
6

15
16

6
828

7
548

8
316

16
8

17
2

21
2

9
176

>
For each GO annotation on the hgu95av2chip, we can find out where this annotation
information was obtained from, i.e. the evidence for this annotation.
> affyEv <- eapply(hgu95av2GO, getEvidence)
Page - 221 -

R and Bioconductor- time-course analysis
> table(unlist(affyEv, use.names = FALSE))
EXP
4458
ISS
4996

IC
IDA
IEA
649 18727 76882
NAS
6507

ND
1039

IEP
429

IGI
220

IMP
3605

IPI
5603

RCA
TAS
33 13767

Where:
Symbol
IMP
IGI
IPI
ISS
IDA
IEP
IEA
TAS
NAS
ND
IC

Meaning
inferred from mutant phenotype
inferred from genetic interaction
inferred from physical interaction
inferred from sequence similarity
inferred from direct assay
inferred from expression pattern
inferred from electronic annotation
traceable author statement
non-traceable author statement
no biological data available
inferred by curator

5. goTools
5.1 goTools Introduction
Another R package to consider when looking at GO annotations for genes on a
microarray chip is the goTools package. This does not have some of the sophisticated
statistical features of the GOstats package, but it is very easy to use when performing
simple GO analysis.
Rather than considering GOs of all possible lengths separately, it allows the user to ask
what proportion of the genes in the list are under a certain node in the tree, or directed
acyclic graph (DAG) to be precise.
It is particularly useful for comparing gene lists and asking what proportion of the genes
in each list fall within one branch of the GO tree (DAG).
The goTools algorithm is reproduced from the vignette of that package:
1. Read in a list of sets of probe id you want to compare.
2. Map each probe id to corresponding ontologies in the GO tree, if any.
3. Create the set of GO ids of interest used to compare your datasets (endnode).
The function EndNodeList will create a set of nodes of the DAG located one
level under MF, BP or CC, but you can use any sets of GO ids.
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4. For each GO id, go up the GO tree until reaching the nodes in endnode. Search
may be limited to MF, BP or CC if specified in goType.
5. Compute the percentage of direct children found under each node in endnode.
6. Return the results. Plot them if plot=TRUE.
The default end node list contains the direct children of MF (molecular function), BP
(biological process), and CC (cellular component), giving 31 different ontologies (nodes)
all together. The output obtained from goTools is the proportion of genes in the list
found under each these ontologies in the DAG.

5.2 goTools Example
Suggestion: Quit and restart R
Firstly, let's load the goTools package, load the probeID data set included in the
data subdirectory of the goTools package, which can be found using the R command,
system.file("data",package="goTools"). These are examples built-in the
package.
The ls() command lists all of the R objects present in memory after loading the
probeID data set. We see that there is a list object, affylist which contains three
vectors of 100 Affy probe set IDs (i.e. gene IDs). The probe IDs in the affylist object
are randomly chosen from the Affymetrix hgu133a chip.
> library(GO.db)
Loading required package: AnnotationDbi
Loading required package: Biobase
Welcome to Bioconductor
Vignettes contain introductory material. To view, type
'openVignette()'. To cite Bioconductor, see
'citation("Biobase")' and for packages 'citation(pkgname)'.
Loading required package: DBI

Note Changes:
> library(GO)
Error in library(GO) : there is no package called 'GO'
The package is now GO.db
Other change: DO NOT LOAD the annotate library!
If you have done so before loading goTools you will get the following reply which
seems innocuous:
Attaching package: 'goTools'
Page - 223 -

R and Bioconductor- time-course analysis
The following object(s) are masked from 'package:annotate':

getOntology

However the calculation will be stuck in an endless loop without giving an error!
> # library(annotate) # DO NOT LOAD
> library(goTools)
> system.file("data",package="goTools")
[1] "/Library/Frameworks/R.framework/Resources/library/goTools/data"

(Note: this is a Mac directory. On a PC the echoed directory will be in a different place
and will look something like: [1] "C:/PROGRA~1/R/R-211.1/library/goTools/data")
> data(probeID)
> ls()
[1] "affylist"

"operonlist"

> length(affylist)
[1] 3
> names(affylist)
[1] "L1" "L2" "L3"
This means that there are 3 gene lists. We can look how many genes are in each
> length(affylist[[1]])
[1] 100
> length(affylist[[2]])
[1] 90
> length(affylist[[3]])
[1] 70
Note: the commands could also have been written with notation:
> length(affylist$L3)
[1] 70
We can see the name of the first 5 probes within the first list. Similar commands would
show the name of the other lists:
> affylist[[1]][1:5]
[1] "215828_at"
[5] "203172_at"

"201849_at"

"219719_at"

"213690_s_at"

Now we use the ontoCompare function from the goTools package to compare the
gene ontologies represented by the genes in the three gene lists. This function returns
the percentage of probe set IDs associated with the immediate children of the nodes
contained in endnode. endnode will be discussed shortly. By default, it is the set of gene
ontologies (GOs) which are immediate children of the nodes Biological Process (BP),
Molecular Function (MF) and Cellular Component (CC).
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To learn more about the ontoCompare function type ?ontoCompare
Description
This functions will allow you to describe and compare sets of oligo ids using Gene Ontology database
Usage
ontoCompare(genelist,probeType=c("GO","hgu133a"),
goType="All", endnode, method=c("TGenes", "TIDS", "none"), plot=FALSE,
...)
ontoPlot(objM, names.arg=NULL,beside=TRUE, las=2,legend.text=TRUE,
...)

To speed calculations we will work on a subset of the lists otherwise the calculation
might take a long time. We will take the first 10 of each list:
> subset = c(L1 = list(affylist[[1]][1:10]), L2 =
list(affylist[[2]][1:10]) , L3 = list(affylist[[3]][1:10]))
> subset
$L1
[1] "215828_at"
"201849_at"
"219719_at"
[6] "219620_x_at" "202374_s_at" "217914_at"

"213690_s_at" "203172_at"
"202235_at"
"219184_x_at"

$L2
[1] "205392_s_at" "213620_s_at" "213982_s_at" "200876_s_at" "217890_s_at"
[6] "205331_s_at" "215690_x_at" "213944_x_at" "218088_s_at" "208455_at"
$L3
[1] "205392_s_at" "213620_s_at" "213982_s_at" "200876_s_at" "217890_s_at"
[6] "205331_s_at" "215690_x_at" "213944_x_at" "218088_s_at" "208455_at"

Run the function and place results into the res R object (short for results.) The
calculation can be as long as 5 minutes:
> res <- ontoCompare(subset, probeType = "hgu133a")
Starting ontoCompare...
> class(res)
[1] "matrix"
> > dim(res)
[1] 37 3
> res[,1:3]
catalytic activity
transporter activity
binding
enzyme regulator activity
molecular transducer activity
extracellular region
membrane-enclosed lumen
macromolecular complex
organelle
organelle part
cell part
synapse
metabolic process
immune system process

[,1] [,2] [,3]
0.1 0.4 0.4
0.3 0.0 0.0
0.7 0.6 0.6
0.1 0.1 0.1
0.0 0.2 0.2
0.0 0.1 0.1
0.1 0.0 0.0
0.1 0.5 0.5
0.4 0.5 0.5
0.3 0.1 0.1
0.8 0.8 0.8
0.0 0.1 0.1
0.3 0.4 0.4
0.1 0.1 0.1
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growth
viral reproduction
cellular process
cellular component organization
death
reproductive process
biological adhesion
signaling process
signaling
multicellular organismal process
developmental process
locomotion
pigmentation
cellular component biogenesis
positive regulation of biological process
negative regulation of biological process
regulation of biological process
response to stimulus
localization
establishment of localization
multi-organism process
biological regulation
NotFound

0.0
0.0
0.6
0.1
0.1
0.0
0.0
0.0
0.0
0.0
0.1
0.0
0.0
0.0
0.1
0.1
0.1
0.1
0.3
0.5
0.1
0.2
0.2

0.1
0.1
0.7
0.3
0.1
0.1
0.2
0.4
0.3
0.2
0.2
0.1
0.1
0.3
0.1
0.1
0.5
0.1
0.2
0.0
0.1
0.6
0.2

0.1
0.1
0.7
0.3
0.1
0.1
0.2
0.4
0.3
0.2
0.2
0.1
0.1
0.3
0.1
0.1
0.5
0.1
0.2
0.0
0.1
0.6
0.2

The default usage of ontoCompare (see help file ?ontoCompare) is with
plot=FALSE and therefore nothing is plotted at this point. We could re-run the
command as with plot=TRUE as suggested in the original tutorial with the command:
# > res <- ontoCompare(subset, probeType = "hgu133a", plot=TRUE)
However we have all the results within R object res already and rerunning the command
would mean waiting for the calculation again. We can instead use the command that
plot=TRUE would call upon: ontoPlot and provide res as the argument in a
command that would read ontoPlot(res). However, some of the names in the matrix
(see text version avbove) are quite long and would be truncated.
We can remedy that by calling on the margin parameter (mai=c(b,l,t,r)) similar to
the number of row parameters for a plot. The parameter takes 4 arguments for the width
of the bottom, left, top and right margins respectively, measured in inches (the
parameter mar works in the same way with unit in next lines rather than inches.) We
can also add a title to the plot with the main= parameter.
> par(mfrow=c(1,1))
> par(mai=(c(3.5,0.5,0.5,0)))
> ontoPlot(res, main="first 10 in each list")
[1,]
[2,]

[,1] [,2] [,3] [,4] [,5] [,6] [,7] [,8] [,9] [,10] [,11] [,12] [,13] [,14]
1.5 4.5 7.5 10.5 13.5 16.5 19.5 22.5 25.5 28.5 31.5 34.5 37.5 40.5
2.5 5.5 8.5 11.5 14.5 17.5 20.5 23.5 26.5 29.5 32.5 35.5 38.5 41.5

[1,]
[2,]

[,15] [,16] [,17] [,18] [,19] [,20] [,21] [,22] [,23] [,24] [,25] [,26] [,27]
43.5 46.5 49.5 52.5 55.5 58.5 61.5 64.5 67.5 70.5 73.5 76.5 79.5
44.5 47.5 50.5 53.5 56.5 59.5 62.5 65.5 68.5 71.5 74.5 77.5 80.5
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Note Change: In previous R versions (e.g. R 2.5 the calculation was very rapid.
This difference might be due to the changes in the .db annotation method.
Using R 2.5 the complete comparison of all items in all 3 lists would look like this:
(and would take much longer in later R versions such as R 2.11.1):
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From the goTools Vignette: Methods for computing percentages
ontoCompare allows you to choose from 3 different methods to estimate the percentage of probes
under each element of endnode. The default method is TGenes.
1. TGenes: for each end node, return the number of direct children found / total number of
probe ids. This includes oligos which do not have GO annotations.
2. TIDS: for each end node, return the number of direct children found / total number of GOids
describing the list.
3. none: for each end node, return the number of direct children found.

5.3 How to set up the "end nodes"
The default end nodes list is defined by a call to the function EndNodeList. It contains
all immediate children of Molecular Function (GO:0003674), Biological Process
(GO:0008150) and Cellular Component (GO:0005575).
> class(EndNodeList())
[1] "character"
> class(EndNodeList)
[1] "function"
> EndNodeList()
"GO:0003674"
is_a
"GO:0009055"

"GO:0005575"
is_a
"GO:0003824"
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[ . . . ]
"GO:0051234"
is_a
"GO:0071554"

"GO:0051704"

"GO:0065007"

>
The following was part of the original tutorial and also found in the vignette. It is here for
reference and does not need to be run in class.
From the goTools Vignette: Customized end node list
If you want to use more ontologies to describe your set of genes, you can use the function
CustomEndNodeList(id,rank) to create a bigger set of end nodes. It returns all GO ids
childrenof id up to rank levels below id.
> MFendnode <- CustomEndNodeList("GO:0003674", rank = 2)
Finally, the code below shows you how to use a custom end node list, and also how to modify the
goType argument to select only Molecular Function (MF) ontologies.
> res <- ontoCompare(subset, probeType = "hgu133a", endnode = MFendnode,
goType = "MF")
You can also create a list of GO ids of nodes of interest and pass it directly to the endnode
argument in ontoCompare. GO ids must be in the following format: "GO:XXXXXXX."

6. Gene Set Analysis
6.1 Introduction to Gene Set Analysis
Now we turn our attention to tests for differential expression involving a set of genes.
Mootha et al. [5] and Lamb et al. [6] made this method popular in 2003. We will use a
"gene set enrichment test", which is closely based on the one defined by Mootha et al.
The gene set test can be used to test whether previous author's lists of differentially
expressed genes are also differentially expressed in a current experiment similar to that
of the previous authors.
Another possible application is to try to find differential expression in microarray
experiments which show no strong differential expression when testing for individual
differentially expressed genes, but they might show more evidence of differential
expression when testing a predefined set of genes.
Defining a useful gene set for this sort of analysis is not always trivial. One possibility is
to use a set of genes which share common gene ontologies, i.e. choose a set of genes
which are all associated with GOs below a certain node in the GO DAG (Directed
Acyclic Graph).
We will begin with some artificial examples to illustrate the concept of gene set tests
with a small number of made-up t-statistics. Then we will use two sets of genes thought
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to be regulated by the Estrogen Receptor (ERalpha) to demonstrate testing for
differential expression of gene sets in the Estrogen data set.
The geneSetTest function in the limma package [8] is described in its help file,
reproduced below:
This is essentially a stream-lined approach to Gene Set Enrichment Analysis
introduced by Mootha et a.l (2003). Usually, 'statistics' is intended to hold t-like
statistics, meaning that the gene-wise null hypotheses would be rejected for large
positive or large negative values. Then 'alternative="greater"' can be
used to test whether genes in the set tend to be up-regulated,
'alternative="less"' can be used to test whether the gene set is downregulated, while 'alternative="two.sided"' tests whether the gene set
holds highly ranked genes without regard to direction of change.
Important note: if 'statistics' is an F-like statistic for which only large values are
relevant for rejecting the null hypothesis, then you must use
'alternative="greater"' to get meaningful results.
We now demonstrate the use of the geneSetTest function in limma using a miniscule
set of artificial made-up t-statistics, where as usual, a positive t statistic means that a
gene is up-regulated (i.e. expressed more highly in a condition of interest), whilst a
negative value means that the gene is down-regulated. A t-statistic close to zero means
that the gene is not differentially expressed.
In the first example we use, the artificial t-statistics will range from -9 to 9, and we will
select a set of three genes for the test, those with t-statistics of -8, -6 and -5, i.e. we will
use the 2nd, 4th and 5th t-statistics from our vector of artificial t-statistics. If these tstatistics represented real genes, all three genes would show strong evidence of
differential expression (down-regulation) individually, so they should certainly show
strong evidence of differential expression as a set as well. The value returned by
limma's geneSetTest function is a p-value.
> library(limma)
> sel <- c(2,4,5)
> sel
[1] 2 4 5
> stat <- -9:9
> stat
[1] -9 -8 -7 -6 -5 -4 -3 -2 -1

0

1

2

3

4

5

6

7

8

> stat[sel]
[1] -8 -6 -5
> geneSetTest(sel,stat,nsim=100)
[1] 0.1561935
Warning message:
In wilcox.test.default(x, y, alternative = wilc.alt, conf.int = FALSE) :
cannot compute exact p-value with ties

> geneSetTest(sel,stat,ranks.only=TRUE)
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[1] 0.1561935
Warning message:
In wilcox.test.default(x, y, alternative = wilc.alt, conf.int = FALSE) :
cannot compute exact p-value with ties

If we did a test for up-regulation of the set, we would expect a large p-value (low
evidence of up-regulation):
> geneSetTest(sel,stat,alternative="greater",nsim=100)
[1] 0.988648
On the otherhand, a test for down-regulation should give a small p-value:
> geneSetTest(sel,stat,alternative="less",nsim=100)
[1] 0.01651187

6.2 Gene Set Analysis Example
We will again use the Estrogen data set, included in the estrogen R package. If you still
have the R session open which you used to run through the GOstats exercises, you
can use the fit2 linear model fit object (and other objects previously computed). If you
have closed your R session, but saved your data with the save.image command, then
you can load it with:
> datadir <- system.file("extdata",package="estrogen")
> setwd(datadir)
> getwd()
(If you have not saved the file previously, then simply re-run the commands that lead to
the fit2 linear model. Alternatively ask someone else in the class for their copy of
EstrogenLinearModelFit.RData.)
We will use two sets of genes which are thought to be ER-regulated, i.e. regulated by
the Estrogen Receptor alpha. The first set (Jin et al [4]) contains genes that have been
experimentally verified to be ER-regulated and the second set (O'lone et al [7]) contains
a large list of genes which are predicted to be ER-regulated by a model (so they may or
may not be ER-regulated).
These gene sets (particularly the first one) should be differentially expressed between
the breast cancer cells with estrogen reintroduced and the serum-starved breast cancer
cells with no estrogen, because in the cells reintroduced to estrogen, the estrogen
receptors (ERs) will bind the estrogen and as a result become activated, gaining the
ability to regulate gene expression in the cells, hence resulting in differential expression
between the cells with and without estrogen.
The data required for this exercise is available at
http://bioinf.wehi.edu.au/marray/jsm2005/Data/knownERgenes.txt
and http://bioinf.wehi.edu.au/marray/jsm2005/Data/predictedERgenes.txt.
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Now, having loaded the Estrogen linear modeling data or rerun the analysis (above),
ensure that the two gene list files are in your current working directory, as given by the
R command getwd().
>download.file("http://bioinf.wehi.edu.au/marray/jsm2005/Data/kn
ownERgenes.txt" , "knownERgenes.txt")
>download.file("http://bioinf.wehi.edu.au/marray/jsm2005/Data/pr
edictedERgenes.txt" , "predictedERgenes.txt")
Then read the gene lists into R:
> known <read.table("knownERgenes.txt",header=TRUE,as.is=TRUE,sep="\t")
> names(known)
[1] "Acc"
"UGCluster" "LLID"
> knownERgenes <- known$UGCluster
> known[1:5,]
1
2
3
4
5

Acc
BT006851
BC021281
M14745
BC027258
BC062429

UGCluster LLID
Hs.19383 183
Hs.480218 9429
Hs.150749 596
Hs.150749 596
Hs.194143 672

> predicted <read.table("predictedERgenes.txt",header=TRUE,as.is=TRUE,sep="\t
")
> predictedERgenes <- predicted$UGCluster
> predicted[1:5,]
1
2
3
4
5

Acc
BC013410
BC011046
BC069698
BC010883
BC011392

UGCluster
LLID
Hs.353175
56895
Hs.273621 1267; 7266
Hs.997
8909
Hs.475392
55831
Hs.368610
9061

> # library(hgu95av2) # DEPRECATED : change to .db version
> library(hgu95av2.db)
> unigene <- unlist(as.list(hgu95av2UNIGENE))
> knownERgenesOnChip <- match(knownERgenes,unigene)
> knownERgenesOnChip <knownERgenesOnChip[!is.na(knownERgenesOnChip)]
> predictedERgenesOnChip <- match(predictedERgenes,unigene)
> predictedERgenesOnChip <predictedERgenesOnChip[!is.na(predictedERgenesOnChip)]
Now we will use the moderated t-statistics calculated previously for the comparison of
estrogen present and estrogen absent 10 hours after the estrogen was reintroduced into
the cells. We try all three types of tests - "two-sided", "greater" (for genes up-regulated
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in the sample with estrogen present), and "less" (for genes down-regulated in the
sample with estrogen present).
We expect to get better (smaller) p-values for the known ER-regulated genes than for
the predicted ER-regulated genes. The recent review of Estrogen-repressed genes in
breast cancer cells by Zubairy and Oesterreich [9] suggests that the majority of genes
regulated by estrogen receptors are actually repressed (down-regulated), so we should
expect a lower p-value for the "less" test (at least for the known ER-regulated genes).
Note Change:
> geneSetTest(knownERgenesOnChip,completeTableEst10$t,"two.sided")
Error in match.arg(alternative, c("mixed", "either", "down", "up", "less",

:

'arg' should be one of “mixed”, “either”, “down”, “up”, “less”,
“greater”

the parameter for the “two.sided” is now called “either”
> geneSetTest(knownERgenesOnChip,completeTableEst10$t,"either")
[1] 0.1764895
> geneSetTest(knownERgenesOnChip,completeTableEst10$t,"greater")
[1] 0.08824475
> geneSetTest(knownERgenesOnChip,completeTableEst10$t,"less")
[1] 0.9117644
> set.seed(0)
> geneSet <sample(predictedERgenesOnChip,length(knownERgenesOnChip))
> geneSetTest(geneSet,completeTableEst10$t,"either")
[1] 0.8642067
> geneSetTest(geneSet,completeTableEst10$t,"greater")
[1] 0.5679183
> geneSetTest(geneSet,completeTableEst10$t,"less")
[1] 0.4321033
> geneSet <sample(predictedERgenesOnChip,length(knownERgenesOnChip))
> geneSetTest(geneSet,completeTableEst10$t,"either")
[1] 0.600243
> geneSetTest(geneSet,completeTableEst10$t,"greater")
[1] 0.3001215
> geneSetTest(geneSet,completeTableEst10$t,"less")
[1] 0.6998976
> geneSet <sample(predictedERgenesOnChip,length(knownERgenesOnChip))
> geneSetTest(geneSet,completeTableEst10$t,"either")
[1] 0.05388651
> geneSetTest(geneSet,completeTableEst10$t,"greater")
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[1] 0.02694325
> geneSetTest(geneSet,completeTableEst10$t,"less")
[1] 0.9730602
> class(geneSet)
[1] "integer"
> length(geneSet)
[1] 25
> geneSet
[1] 8831 10223
[14] 13501 2389

9623
8126

4802
776

8824
4727

8240
464

3476 8912
7153 12456

5492
9140

9320
1629

5450
8755

8014
607

5740
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Partek Tutorials

Part 7 of hands‐on Tutorials

Partek ‐ Gene Expression.
Down Syndrome Study
Breast Cancer Study
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Partek Tutorials
The Partek Tutorial and Data Repository provides tutorials and data sets for analysis in
Partek. Partek tutorials use specific data sets to show how to do data analysis and
visualization. For the greatest learning benefit, they are designed to be used with their
corresponding, provided data set. User Guides do not have a specific data set associated
with them and are useful for learning general information. Note: The tutorials, user guides,
and data sets in this section require Partek® Genomics SuiteTM. If you have any questions
contact Partek support.

General Information:
Technical Support:
Address

inquire@partek.com
inquire@partek.com
Partek Incorporated
12747 Olive Blvd., Suite 205
St. Louis, Missouri 63141
U.S.A.
+1 314-878-2329
+1 314-275-8453

Telephone:
Fax:

Source material: http://www.partek.com/Tutorials/
Affymertrix section in tab Gene Expression:

Gene Expression
Affymetrix
Down Syndrome Study
Tutorial: Learn how to analyze a disease vs. normal study across multiple
tissues with a focus on ANOVA contrasts and interactions
(January 2009)
Data [56M]
CHP Files [3.3M]
Breast Cancer Study
Tutorial: Learn how to analyze a time/dose experimental design with a batch
effect (August 2009)
Data [972K]

Printing permission:
If you can print out the materials, that would be ideal.
Marni Portner
Account Executive
Partek Incorporated
+1 (314) 878-2329 x33
www.partek.com

Notes
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Affymetrix Down Syndrome Study Data for Gene
Expression
Down syndrome is caused by an extra copy of chromosome 21; it is the most common
wholechromosomal disorder in humans. The study used in this tutorial revealed a
significant upregulation of chromosome 21 genes at gene expression level in individuals
with Down syndrome. This dysregulation is largely specific to chromosome 21 only and
not to any other chromosomes. This experiment was performed using the Affymetrix
GeneChip! Human U133A. It included 25 samples taken from 10 human subjects and 4
different tissues.
The data for this study is available as experiment number GSE1397 on the Gene
Expression Omnibus: ://www.ncbi.nlm.nih.gov/geo/.
This tutorial will illustrate how to:
"
"
"
"
"

Import Affymetrix CEL files
Perform exploratory analysis using PCA scatter plot
Perform inferential statistics using ANOVA
Generate a list of genes of interest
View genes on the chromosome

Importing Affymetrix® CEL Files
The data and library files for this experiment can be downloaded by going to Help > On
line Tutorials from the Partek main menu. The specific URL for the Down Syndrome
Data is located below:
://www.partek.com/Tutorials/microarray/Gene_Expression/Down_Syndrome/Down_Syndr
omeGE.zip
Download the data to your local disk. For this example, the data is stored at C:\Partek
Training Data\ Down_Syndrome_GE, the CDF file and annotation files are stored in the
C:\Microarray Libraries\Affymetrix\HG_U133A folder.
"

Select Gene Expression from the Workflows panel on the right side of the tool
bar in the Partek main window (Figure 1)
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Figure 1: Gene expression workflow
"
"

Click on Import samples under the Import option and select Import from
Affymetrix Cel Files, then click OK
Click the Browse button to select the C:\Partek Training
Data\Down_Syndrome_GE folder. By default, all the files with a .CEL extension
are selected (Figure 2)

Figure 2: Selecting the folder that contains .CEL files of the experiment
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"
"
"

Click the Add File > button to move all the .CEL files to the right panel. 25 files
will be processed
Click Next >
Specify C:\Partek Training Data\Down_Syndrome_GE\sampleInfo
DownSyndrome.txt.fmt as the Sample Information File (Figure 3)

Figure 3: Specifying Input Files
"

Click Customize… to configure the import options (Figure 4)

Figure 4: Configuring Algorithm Options
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"
"
"
"

Select the Outputs tab from the Advanced Import Options dialog (Figure 5)
Make sure the output chip images based on Original, Summarized and
Difference values are selected
In the Extract Time Stamp and Date From CEL File panel, makes sure the Date
button is selected to extract the chip scan date. This information can help you to
detect if there is batch effects caused by the process time
Click OK (Figure 5)

Figure 5: Specifying more outputs values
"

Click the Import button on the Import Affymetrix CEL Files dialog (Figure 3)

After the CEL file importing is finished, the result file will be automatically opened in
Partek as spreadsheet 1 (Down_Syndrome_GE); you will see 25 rows representing 25 chips
and ~22,000 columns representing genes in this spreadsheet. Columns 48 were
incorporated from the sample information file which describe the samples, the rest of the
columns were extracted from the .CEL files. (Figure 6)

Figure 6: Viewing the Analytical Spreadsheet with .CEL file images
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"

Double click on any of the chip image thumbnails to enlarge the image and to
examine the chip (Figure 7)

Figure 7: Viewing a chip image
Click on the + button to zoom in the image; click on the – button to zoom out. You can
view the pseudo array image to identify any anomalies with the chip such as scratches,
hybridization errors, and scanning errors if you suspect there might be a problem with the
microarray chip. This check is usually performed to find if the chip is an outlier from the
rest of the data in the QA/QC check of the gene expression workflow.
Note: For additional information on importing data into Partek, Chapter 4 Importing and
Exporting Data in the Partek User’s Manual is a good resource as well as the FAQ
document on the Partek tutorial webpage. The Partek User’s Manual is available from the
Partek Genomic Suite menu under Help> Online Help. It is recommended that you go
through Chapter 6 The Pattern Visualization System! in the online help before going
through this section of the tutorial if you have not done so already. In addition, this tutorial
covers specific information; for general information covering a variety of subjects, see the
Partek Online Help.

Exploratory Data Analysis
Explore the data in spreadsheet 1 (Down_Syndrome_GE) by plotting a Principal
Components Analysis (PCA) scatter plot, as it is an excellent method for visualizing high
dimensional data.
"

Click on the Principal Components Analysis (PCA) step in QA/QC section of
the Workflows dialog. The Scatter Plot dialog box with your PCA plot will
appear as shown in (Figure 8)
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Figure 8: Viewing a PCA scatter plot of the Down syndrome data. Each dot represents a
chip; the color of the dot represents the Type of the sample
In the scatter plot, each point represents a chip, and corresponds to a row on the
spreadsheet. Click on any point in the scatter plot, and the corresponding row will be
highlighted in the spreadsheet. The color of the dot represents the type of the sample: red
represents the Down syndrome sample and blue represents the normal sample. Points that
are close together in the plot are similar across the whole genome, and points that are far
apart in the plot are dissimilar.
Press the mouse wheel and drag it to rotate the plot or choose the Rotate Mode option ( ).
Press and drag the left mouse button to rotate the plot to examine the grouping pattern or
outliers of the data on the first 3 principal components (PCs). There is not a clear separation
between Down syndrome and normal samples in this data.
Within the scatter plot viewer, click on the Plot Properties icon (
plot as follows (Figure 9):
"
"
"

) and configure the

Color the points by column 6. Tissue
Size the points by column 7. Type
Click Apply
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Figure 9: Configuring the scatter plot Properties dialog, color by Tissue, Size by Type
Notice now that the data is clustered by different tissues. Another way to see the cluster
pattern is to put an ellipse on Tissue.
"
"
"
"
"

Select the Ellipsoids tab on the Plot Properties dialog
Click the Add Ellipse/Ellipsoid button
Select the Ellipse radio button
Double click on Tissue to move it to the Grouping Variable(s) panel
Click OK (Figure 10)
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Figure 10: Adding an Ellipse on Tissue
Now, rotate the plot. You can see that the data is separated by tissues, and within some of
the tissues, the two types are separated. For instance in the Astrocyte tissue, the Down
syndrome samples (little dots) are on the left, and the normal samples (big dots) are on the
right (Figure 11).
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Figure 11: Viewing a scatter plot of data colored by Tissue, sized by Type, and grouped by
Tissue
PCA is an example of exploratory data analysis and is useful for identifying outliers and
major effects in the data. From the scatter plot, you can see that tissue is the biggest source
of variation. There are a lot of genes that express differently among the 4 tissues, but not as
many genes that express differently between Down syndrome and normal across the whole
genome.
When you examine the Gender effect using the rendering properties, you will find that
there is not a very clear separation between male and female. This part is for you to do on
your own.
You can also follow the workflow to draw a histogram to examine the samples. Click on
Histogram in the QA/QC section of the Workflow to get the Histogram dialog box as
shown in (Figure 12).
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Figure 12: Viewing the histogram of all 25 samples.
The histogram plots a line for each of the samples with the intensity of the probes graphed
on the xaxis and the frequency of the probe intensity on the yaxis. This allows you to
view the distribution of the intensities to identify any outliers. In this dataset, all of the
samples follow the same distribution pattern indicating that there are no obvious outliers in
the data. As demonstrated with the PCA, if you click on any of the lines in the histogram
the corresponding row will be highlighted in the spreadsheet Down_Dyndrome_GE. You
can also change the way the histogram displays the data by clicking on the Plot Properties
button in the histogram. This part is for you to do on your own.
In the next step, you are going to do inferential statistics to find differently expressed genes
between Down syndrome and normal.

Identifying Differentially Expressed Genes using the ANOVA
Analysis of variance (ANOVA) is a very powerful technique for identifying differentially
expressed genes in a multifactor experiment such as this one. In this data set, the ANOVA
will be used to generate a list of genes that are significantly different between Down
syndrome and normal; the difference is bigger than 1.3 fold.
The ANOVA model should include Type since it is the factor of interests. From the
exploratory analysis, tissue was found to be a big source of variation; therefore, tissue
should be included in the model. In the experiment, multiple samples were taken from the
same subject, so Subject needs to be included in the model; otherwise, the ANOVA
assumption that samples within groups are independent will be violated. In addition, the
PCA scatter plot showed that different tissues behaved differently from different types, so a
Type *Tissue interaction should be included in the model.
The ANOVA model needs to include Type, Tissue, Subject(Type), and Type*Tissue.
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"
"
"

To invoke the ANOVA dialog, click Detect differentially expressed genes in the
Analysis section of the workflow
In the Experimental Factor(s) panel, select Type, Tissue and Subject by pressing
<Ctrl> and left clicking
Use the Add Factor > button to move the selections to the ANOVA Factor(s)
panel (Figure 13)

Figure 13: Configuring the ANOVA model. Including Type, Tissue and Subject factors in
the model
"
"

To specify the interaction click and drag to select both Type and Tissue on the
Factor(s) panel
Select the Add Interaction > button to add the Type * Tissue interaction in the
ANOVA Factor(s) panel (Figure 14)

Figure 14: Adding the Type and Tissue interaction to the ANOVA model
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Random vs. Fixed Effects – Mixed Model ANOVA
Most factors in analysis of variance (ANOVA) are fixed effects, whose levels represent all
the levels of interest; in this study, Type and Tissue are fixed effects. If the levels of a factor
only represent a random sample of all the levels of interest (for instance, Subject in this
study), the factor is a random effect. The 10 subjects in this study represent only a random
sample of the global subjects of which an inference is being made. The random effects
appear in red on the spreadsheet and in the ANOVA dialog.
Here is another way to tell if a factor is random or fixed: imagine repeating the experiment.
Would the same levels of each factor be used again?
"
"
"
"

Type – Yes, the same types would be used again  a fixed effect
Tissue – Yes, the same tissues would be used again  a fixed effect
Gender  Yes, the same genders would be used again  a fixed effect
Subject  No, the samples would be taken from other subjects a random effect

You can specify which factors are random and which are fixed when you import your data
(shown above), or after importing by rightclicking on the column corresponding to a
categorical variable, selecting Properties, and checking Random effect. By doing that, the
ANOVA will automatically know which factors to treat as random and which factors to
treat as fixed.
Nested/Nesting Relationships
The subject factor in the ANOVA model is listed as “Subject (Type)” this means that
“Subject is nested in Type”. Partek can automatically detect this sort of hierarchical design
and will calculate accordingly.
Linear Contrasts
By default, the computation only outputs a pvalue of each factor/interaction; therefore, to
get the fold change and ratio between Down syndrome and normal, a contrast must be set
up.
"
"
"
"
"

Click on the Contrast button to invoke the Configure dialog
Choose Type from the Select Factor/Interaction dropdown list, which is the
default. All of the levels in this factor are listed on the Candidate Level(s) panel
on the left of the dialog (Figure 15).
Select Down Syndrome from the Candidate Level(s) panel and move it to the
Down Syndrome (Group 1) panel
The label will be changed to the subgroup name automatically, you can also
manually specify the label name
Select Normal from the Candidate Level(s) panel and move it to the Normal
(Group 2) panel. Your Configure of… spreadsheet will look like (Figure 15).
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Since the data is log2 transformed, Partek will automatically detect this and will
automatically select the radio button Yes in the Log Transform Status. Partek will use the
geometric mean to calculate the fold change and mean ratio from the contrast between the
Down Syndrome and Normal samples.

Figure 15: Adding Down Syndrome vs. Normal contrast to the computation
"
"

Click Add Contrast to add the Down Syndrome vs. Normal contrast (Figure 15)
Click OK to apply the configuration
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Figure 15: Configuring the Adding Contrasts dialog
"
"

By default the Specify Output File is checked and give a name of the output. If
you would prefer not to save the output file, simply uncheck this box.
Click OK or Apply in the ANOVA dialog to compute the 3way mixedmodel
ANOVA

The result will be displayed in a child spreadsheet. In the child result spreadsheet, each row
represents a gene, and the columns represent the computation result of that gene (Figure
16). By default, the genes are sorted in ascending order by the pvalue of Type, which
means the most significantly differently expressed gene between Down syndrome and
normal is at the top of the spreadsheet.

Figure 16: Viewing the ANOVA result in the child spreadsheet
Viewing the Sources of Variation
"
"

View the sources of variation across the whole genome by clicking Plot Sources
of Variation from the workflow while the child result spreadsheet is active
A Sources of Variation Plot dialog box will appear. You have a choice of
viewing the sources of variation as a bar chart or a pie chart. Select Bar Chart
from the pull down list. Select OK. The Sources of Variation plot is shown in
(Figure 17)
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Figure 17: Viewing the Sources of Variation plot, Tissue is the biggest source of variation
This plot presents the signal vs. noise across all the genes. All the factors in the ANOVA
model are listed on the Xaxis (random error). The Yaxis represents the average mean
square of all the genes. Mean square is ANOVA’s measure of variance. Compare each
signal bar to the error bar; if a bar is higher than the error bar, it means that factor
contributed significant variation to the data across all the variables. Notice, that this plot is
very consistent with the results in the PCA scatter plot. In this data, on average, Tissue is
the biggest source of variation.
Note: To view the source of variation of each gene, right click on a row header, and select
the Sources of Variation item from the popup menu.
Create Gene List
Now that you have obtained statistical results from our microarray experiment, you can
now take the result of 22283 genes and create a new spreadsheet of just those genes that
pass a certain criteria. This will make managing the data more streamlined by focusing
on just those genes with the most differential expression or substantial fold change. In
Partek, the list creator can be used to specify numerous conditions to use in the
generation of our list of genes of interest. The following section will illustrate how to use
the list manager to create commonly sought lists.
"
"
"

To invoke the List Creator, click Create Gene List in the workflow. The List
Creator dialog box will open. To create criteria for our gene list, click on the
Specify New Criteria button to open the Configure Criteria dialog box
As this is the first criteria, Partek will by default name the criteria A. When
creating your own criteria, you can change this name to something more
meaningful to you
Ensure that the 1/ANOVA3way (ANOVAResults) spreadsheet is selected as this is
the spreadsheet we will be using to create our new gene list
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"

Ensure that 5. Pvalue(Type) column is selected and that we include pvalues
significant with FDR of 0.05 as shown in (Figure 18)

Figure 18: The configure criteria dialog box for creating a gene list.
In the Configure Criteria section of the dialog box, you can select different criteria in the
dropdown list and change the numerical cut off for your gene list. There is additional
information regarding the criteria options available in the help bubble, which can be
viewed by leftclicking on the yellow bubble with a question mark. The number of genes
that pass your cut off criteria will be shown next to the # pass field. In this example, 20
genes pass our criteria of FDR with 0.05. That is, 5% of the genes in that list are expected
to not demonstrate significant differential expression outside of this experiment.
"

Select OK to add this gene list criteria to the List Creator dialog box as shown in
(Figure 19)
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Figure 19: Adding gene list criteria based on a pvalue of (Type) to our List Creator
Next, you can add a gene list criteria based on the fold change between our Down
Syndrome and Normal samples.
"
"
"

Click on the Specify New Criteria in our List Creator dialog box to open a new
Configure Criteria dialog box
Leave the default file name as B, likewise leave the spreadsheet as 1/ANOVA
3way(ANOVAResults), change the Column to 11.FoldChange(Down Syndrome vs.
Normal)
In the Configure criteria box change the numerical values to match those as shown
in (Figure 20)
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Figure 20: Adding gene list criteria based on a foldchange of Down Syndrome vs. Normal
to our List Creator
As you can see from Figure 9, there are 268 genes that have a fold change less than 1.3
and 754 genes with a fold change greater than 1.3 for a total of 1022 genes. Select OK.
Now you have two sets of gene list criteria in List Creator dialog box. List A for the 20
genes that pass the FDR of the pvalue for type and 1022 genes that pass the fold change of
Down Syndrome vs. Normal. You can do several things at this point. One thing you can do
is to create a new spreadsheet in Partek with the list of genes that pass one of the created
criteria.
"
"
"

Select Criteria A to highlight it in the List Creator and select the Save List button
A new dialog box will appear, which will allow you to name the new spreadsheet.
The default name is listA.txt. Select OK.
Go back to the main Partek window and you will see that a third spreadsheet has
been created, listA. ListA is a child of the 1 (Down_Syndrome_GE) spreadsheet.
This spreadsheet can now be used for further analysis such as hierarchical
clustering, gene ontology, integration of copy number data, or exportation into other
data analysis tools such as pathway analysis.

Another thing you can do with the two gene list criteria in the List Creator is to see if a any
genes overlap our two criteria by joining them in a Venn Diagram and looking at the
intersection of both gene lists.
"
"
"

In the List Creator select both gene criteria list A and gene list criteria B by left
clicking on both while holding down the Ctrl key
Select the Venn Diagram button to view the two sets of genes
Left click on the intersection. You will see an asterisk appear next to the number in
the intersection of the Venn diagram as shown in (Figure 21)
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Figure 21: The Venn diagram of the two gene list criteria with the intersection selected
As Figure 10 shows, there are 12 genes that are common in both list A and list B.
By clicking OK in the Venn diagram, you create new gene list criteria in our List Creator
with just those genes found in the intersection. This gene list criteria is denoted as C and is
described as “Venn Diagram of A and B”. You can now create a new gene list spreadsheet
of the intersection by selecting the gene list criteria C and clicking on the Save List button.
You should take some time on your own creating new gene list criteria of your own to
become familiar with the List Creator tool in Partek.
Adding Gene Annotation
In the previous steps, after the data was imported, the GeneChip! annotation file was
linked to the data, so now that you are finished doing the analysis, the child result
spreadsheet will automatically have the link to the annotation file. More information can be
added to the genes in the new columns if the genes are laid out on rows.
"

Right click on the 2nd column header (2. Column ID) in the ANOVA result
spreadsheet and choose Insert Annotation from the popup menu (Figure 22)
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Figure 22: Inserting Annotation in the ANOVA result spreadsheet
"

Next, add the Chromosomal Location information after the probe set ID column
by selecting the corresponding checkboxes and clicking OK (Figure 23)

Figure 23: Configuring the Annotation, adding Gene Title, Gene Symbol, and
Chromosomal Location to each gene on the result spreadsheet
Among the first 20 genes that passed FDR at 5%, 10 genes are on chromosome 21.
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"

Right click on the first row header and select Probe Set Details to get more
information about that gene (Figure 24)

Figure 24: Getting gene information
"

To get a dot plot of a specific gene, right click on the row header and select Dot
Plot (Orig. Data) from the popup menu (Figure 25)

Figure 8: Dot plot of the most differently expressed gene between Down syndrome and
normal. Each dot is a sample. The Xaxis represents the expression value of the gene; the
Yaxis represents different types. The dots the box& whiskers are colored by Type
In the plot, each dot is a sample of the original data. The XAxis represents the expression
of the gene and the YAxis represents the frequency of the value in the 2 type groups.
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The average expression of each group is different from each other. In this example, the
mean of the Down syndrome samples is 6.3, but the mean of the normal samples is 6.0.
The line from the box in the Box & Whiskers represents the median of the samples in a
group.
Generating Gene Lists from a Volcano Plot
Generate a list of genes with pvalues that passed a pvalue threshold of 0.05 and Down
syndrome upregulated 1.3 fold.
"
"
"
"

Select View > Volcano Plot from the Partek main menu
Choose X Axis to represent the 11. FoldChange(Down Syndrome vs. Normal),
and the Y axis to represent the 9. pvalue(Down Syndrome vs. Normal)
Color the gene with the 9. pvalue(Down Syndrome vs. Normal) (Figure 26)
Click OK

Figure 9: Configuring the volcano plot dialog. XAxis representing the mean ration of
Down syndrome vs. Normal, YAxis representing the pvalue of this contrast
In the plot, each dot represents a gene. The Xaxis represents the fold change of the
contrast, and the Yaxis represents the pvalue. The Down syndrome upregulated genes
are on the right side. The genes that have larger and more significant changes between the
two Down syndrome and normal groups are on the upper right and upper left corner
(Figure 27).
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Figure 10: Viewing the volcano plot of Down syndrome vs. Normal contrast, each dot
represents a gene, the XAxis represents fold change of the contrast, and the YAxis
represents pvalue of the contrast
Draw a horizontal line to represent the pvalue as 0.05, and two vertical lines indicating the
–1.3 and 1.3 fold change.
"
"
"

Select Edit > Plot Properties or the icon ( ) within the Volcano Plot viewer
Choose the Axes page
Click the Set Cutoff Lines button and configure the dialog like (Figure 28)

Figure 28: Setting the Cutoff Lines for the volcano plot
"

Check Select all points in a section to allow Partek to automatically select all the
points in any given section

The plot will be divided into six sections; by clicking on the upperright section, all 445
genes in that section will be selected (Figure 29).
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Figure 29: Selecting genes that significantly upregulated in Down syndrome comparing to
Normal
"

Rightclick anywhere in the plot and choose Create List to create a list including
the genes from the section selected.

Note: if no column is selected, all of the columns will be included in the gene list; if some
columns are selected, only selected columns will be included in the list
Specify a name for the gene list, and write a brief description about the list (Figure 30).

Figure 11: Specifying a name for the gene list
After the list is generated, you can view the List Manager immediately (via the popup
dialog), or, you can view the List Manager later by going to Tools > List Manager from
the Partek main menu.
"

Click OK on the popup dialog to open list manager, by default it is shows the
folder that contains the newly created list
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"

Click to select the list and click the View In Spreadsheet button; the list will be
opened in a spreadsheet

The list can be saved as a text file and imported into downstream analysis software.
Note: For additional information on ANOVA in Partek, Chapter 11 Inferential Statistics!
chapter in Partek User’s Manual is a good resource as well as the FAQ document on the
Partek tutorial webpage. The Partek User’s Manual is available from the Partek Genomic
Suite under Help> Online Help. If you need additional assistance with this data set, you
can call our technical support staff at +13148782329 or email @partek.com.

Copyright # 2009 by Partek Incorporated. All Rights Reserved. Reproduction of this material without expressed written
consent from Partek Incorporated is strictly prohibited.
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Analyzing Treatment and Time in Partek: A Breast
Cancer Study
The data for this study is available as experiment number GSE 848 on the Gene
Expression Omnibus: ://www.ncbi.nlm.nih.gov/geo/. This study looks at the effects
of four different drug treatments at 2 time points on estrogen receptor positive
breast cancer cells. This experiment was performed using the Affymetrix
GeneChip! Human U95A. The study includes 8 treatment combinations (4
treatments x 2 time points) replicated 2 times. In addition, 2 control samples were
collected yielding 18 samples. The values are transformed to log base 2 scale by
f(x) = log(x+1).
This tutorial will illustrate how to:
"
"
"
"
"
"

Add an annotation link to the data
Do exploratory analysis using a PCA scatter plot
Do exploratory analysis using Hierarchical clustering
Do explanatory analysis using ANOVA
Remove batch effects from the data
Generate a list of genes of interest

Note: It is recommended that you go through Chapter 6 The Pattern
Visualization System! chapter in the Partek Online Help before going though this
tutorial if you have not done so already. In addition, this tutorial covers specific
information; for general information covering a variety of subjects, see the Partek
Online Help.
The data and library files for this experiment can be downloaded by going to Help
> Online Tutorials from the Partek main menu. Download the data and the
annotation file to your local disk. The annotation file HG_U95Av2_annot.csv can
also be downloaded from the Affymetrix web site. You should extract the zip file to
the directory C:/Partek Example Data/ Breast Cancer (Gene Expression)/Breast
Cancer; and extract the annotation file to C:/Microarray
Libraries/Affymetrix/HG_U95Av2 folder.
"
"

Select File > Open… from main menu and use the file selector to choose
Breast Cancer.txt.fmt
Double click the file to open it in the Analytical Spreadsheet! (Figure 1)
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Figure 1: Opening a data file
After opening the file in Partek, there are 18 rows and 12,631 columns in the
spreadsheet. The first column contains the Filename listing the GEO GSM number,
which also is an identifier for the microarray. Treatment, Time, and Batch are on
columns 2, 3, and 4, respectively. Column 6 marks the beginning of the genes. The
data is transformed (Figure 2).

Figure 2: Viewing the data file in the spreadsheet
Adding an Annotation Link to the Data
Note: When importing data into Partek, the software will automatically link the
correct annotation file to the spreadsheet upon creation of the spreadsheet. This is
an example of how to manually add an annotation file to a spreadsheet. For more
information regarding manually adding annotation files to a spreadsheet or creating
a custom annotation file, please see the user guide Adding Annotations from the
Partek Tutorials web page.
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To add an annotation link to a spreadsheet, make sure the spreadsheet is active.
"
"
"
"
"
"

Select File > Properties from the Partek main menu, this will invoke the
Configure Genomic Properties dialog (Figure 3)
Choose 3’IVT for the type of the genomic data, because this is a gene
expression chip
Leave Marker ID in column label selected by default
Select the Browse button to select the Probeset annotation file. The Chip
name entry will be automatically filled in; however, you can manually edit
the name
Change the Species to Homo sapiens
Select OK to make the changes and dismiss the dialog. To save the
changes select File > Save to overwrite the existing file

Figure 3: Configure genomic properties of the spreadsheet
Exploratory Data Analysis
Explore the data in Analytical Spreadsheet! by plotting a Principal Components
Analysis (PCA) scatter plot. The PCA scatter plot is an excellent method for
visualizing highdimensional data. Make sure no columns are selected by selecting
the upperleft cell of the spreadsheet before you draw the plot.
You can invoke the plot by selecting Principal Components Analysis from the
QA/QC section of the Gene Expression workflow or by selecting the scatter plot
accelerator button (

) on the tool bar.
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Figure 4: Viewing the PCA scatter plot of the data, each dot represents a chip
(sample). Dots are colored by Treatment
In the scatter plot, each point represents a chip, which is a row on the spreadsheet;
therefore, selecting any point in the scatter plot will highlight the corresponding
row in the spreadsheet. The color of the dot represents different treatments. Points
that are close together in the plot are similar across the whole genome, and points
that are far apart in the plot are dissimilar.
Press the mouse wheel and drag it to rotate the plot or choose the Rotate Mode
option in the scatter plot viewer ( ). Press and drag the left mouse button to rotate
the plot to examine the grouping pattern or outliers of the data on the first 3
principal components (PCs). There is not a clear separation among different
treatments in this data.
Within the scatter plot viewer, select the Plot Properties icon (
the plot as follows (Figure 5):
"
"
"
"
"

) and configure

Color the points by the column Treatment
Size the points by the column Time
Shape the points by the column Batch
Connect the points by the column Treatment combination
Select Apply
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Figure 5: Configuring the scatter plot properties dialog, configured as Color by
Treatment, Size by Time, Shape by Batch, and Connect by Treatment Combination
Notice now that the data is clustered by batches. Another way to see the cluster
pattern is to put an ellipse on Batch.
"
"
"
"
"

Select the Ellipsoids tab on the Plot Properties dialog
Select the Add Ellipse/Ellipsoid button
Select the Ellipse radio button
Double click on Batch to move it to the Grouping Variable(s) panel from
the Categorical Variable(s) panel
Select OK (Figure 6)

Figure 6: Adding an Ellipse to two different batches
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Now, rotate the plot. You can see that the data is separated by batches (Figure 7).

Figure 7: Viewing a scatter plot of the data colored by Treatment, sized by Time,
and shaped and grouped by Batch
PCA is an example of exploratory data analysis and is useful for identifying outliers
and major effects in the data. The results of the scatter plot show that batch is the
biggest source of variation, which indicates that there are many genes that express
differently between the 2 batches.
Another way to visualize the cluster pattern of the data is to do hierarchical
clustering on the samples. The steps outlined below, provide just one example of
how clustering can be used in Partek to find relationships between samples. This
example provides a more hands on, manual approach to setting up a hierarchical
cluster, but there are oneclick clustering tools available from many Partek
workflows.
"
"
"
"
"
"
"

Select Tools > Discover > Hierarchical Clustering from the Partek main
menu to invoke the Creating Hierarchical Clusters dialog
Leave Cluster on Rows, which is the default setting (Figure 8)
Select None from the Show Intensity Plot dropdown list
Choose Pearson’s Dissimilarity as the Row dissimilarity
Choose Ward’s method as the Row method of clustering
Leave all other options at their default settings
Select OK
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Figure 8: Creating hierarchical clusters on samples, by using Pearson’s
Dissimilarity to calculate row dissimilarity and using Ward’s method for row
clustering
Within the cluster viewer, select the Plot Properties icon (
plot as follows:

) and configure the

On the Style page:
"
"
"

Specify the Row Dendrogram color By Cluster of 6 (Figure 9)
Specify the Dendrogram Line Width as 4
Select Apply
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Figure 9: Configuring the Style page to color the dendrogram by cluster of 6 and
change the dendrogram line with to 4
On the Row Annotation Page:
"
"
"
"
"
"
"
"

Change the Color Columns Width to 40 (Figure 10)
Select the Label Color Columns checkbox
Select the Label Format as Column Name
Select Label in box
Set Precision to Show all
Select Batch from the dropdown list and select the Add Color Column
button
Select Time from the dropdown list and select the Add Color Column
button
Select OK

Analyzing Treatment and Time in Partek: A Breast Cancer Study

8

Figure 10: Configuring the row annotation page, adding column color for Batch,
Treatment, and Time. Change the column width to 40; label the color columns
using the column name
Notice that the data is clustered by different batches (Figure 11).

Figure 11: Hierarchical clustering of the samples. Samples are mostly clustered by
Batch.
Identifying Differentially Expressed Genes using ANOVA
Analysis of variance (ANOVA) is a very powerful technique for identifying
differentially expressed genes in a multifactor experiment. In this data set,
ANOVA will be used to generate a list of genes that are significantly regulated by
each treatment by 2 fold.
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The ANOVA model should include Treatment and Time since they are the factors
of interest. Include the Treatment * Time interaction in the model, since whether
different treatments behave differently as time goes by is also of interest. From the
exploratory analysis done earlier, batch was found to be a big source of variation;
therefore, batch should be included in the model.
The ANOVA model needs to include Treatment, Time, Batch, and
Treatment*Time.
"
"
"

To invoke the ANOVA dialog, select Detect differentially expressed
genes from the Analysis section of the Gene Expression workflow
In the Candidate Variable(s) panel, select Treatment, Time and Batch
Use the Add Factor> button to move the selections to the ANOVA
Factor(s) panel (Figure 12)

Figure 12: Configuring the ANOVA model. The model includes three factors:
Treatment, Time, and Batch
"
"

To specify the interaction click and drag to select both Treatment and
Time on the Factor Candidate Variable(s) panel
Select the Add Interaction> button to add the Treatment * Time
interaction in the ANOVA Factor panel (Figure 13)
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Figure 13: Adding a Treatment and Time interaction to the ANOVA model
Note: If you want to save the result, select the Specify Output File check box and
specify a name; if you do not check the box, the result spreadsheet will not be saved
at that time.
Random vs. Fixed Effects – Mixed Model ANOVA
Most factors in analysis of variance (ANOVA) are fixed effects, whose levels
represent all the levels of interest; in this study, Treatment and Time are fixed
effects. If the levels of a factor only represent a random sample of all the levels of
interest (for instance, Batch in this study), the factor is a random effect. The 2 cell
culture batches in this study represent only a random sample of the global cell
cultures of which an inference is being made. The random effects appear in red on
the spreadsheet and in the ANOVA dialog.
Here is another way to tell if a factor is random or fixed: imagine repeating the
experiment. Would the same levels of each factor be used again?
"
"
"

Treatment  The same treatments would be used again  a fixed effect
Time  The same time points would be used again  a fixed effect
Batch  No, different cell culture would be used a random effect

You can specify which factors are random and which are fixed by simply right
clicking on the column header corresponding to a categorical variable, selecting
Properties, and checking Random effect. By doing that, the ANOVA will
automatically know which factors to treat as random and which factors to treat as
fixed.
Linear Contrasts
By default, the computation only outputs a pvalue and F ratio of each
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factor/interaction; therefore, to get the fold change and ratio between each treatment
and control, a contrast must be setup. Four contrasts will be added in the
computation.
"
"

Select the Contrasts button within the ANOVA dialog to invoke the
Configure dialog
Choose Treatment * Time interaction from the Select Factor/Interaction
dropdown list. All of the levels in this factor are listed on the Candidate
Level(s) panel on the left of the dialog box(Figure 14)

Figure 14: Adding a contrast between E2 vs. Control at all treatment time points
Add E2 vs. Control contrast:
" Select E2*8, E2*48 from the Candidate Level(s) panel and move them to
the E2 (Group 1) panel
" Select Control*0 from the Candidate Level(s) panel and move them to the
Control (Group 2) panel
" Since the data is log2 transformed, Partek will automatically use the
geometric mean to calculate the fold change and mean ratio.
" Select Add to add the E2 vs. Control contrast
Add E2+ICL vs. Control contrast:
" Select E2+ICL*8, E2+ICL*48 from the Candidate Level(s) panel and
move them to the E2+ICL (Group 1) panel
" Select Control*0 from the Candidate Level(s) panel and move them to the
Control (Group 2) panel
" Select Add to add the E2+ICL vs. Control contrast
Add E2+Ral vs. Control contrast:
" Select E2+Ral*8, E2+Ral*48 from the Candidate Level(s) panel and
move them to the E2+Ral (Group 1) panel
" Select Control*0 from the Candidate Level(s) panel and move them to the
Control (Group 2) panel
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"

Select Add to add the E2+Ral vs. Control contrast

Add E2+TOT vs. Control contrast:
" Select E2+TOT*8, E2+TOT*48 from the Candidate Level(s) panel and
move them to the E2+TOT (Group 1) panel
" Select Control*0 from the Candidate Level(s) panel and move them to the
Control (Group 2) panel
" Select Add to add the E2+TOT vs. Control contrast
The added contrasts should look like Figure 15.

Figure 15: Four contrasts are added to the computation, they are E2 vs. Control,
E2+ICI vs. Control, E2+Ral vs. Control, and E2+TOT vs. Control
"
"

Select OK to apply the configuration
Select OK or Apply in the ANOVA dialog to compute the 3way mixed
model ANOVA

The result will be displayed in a child spreadsheet. In the child result spreadsheet,
each row represents a gene, and the columns represent the computation result of
that gene (Figure 16). By default, the genes are sorted in ascending order by the
Treatment pvalue, which means the most significant differently expressed gene
among different treatments is at the top of the spreadsheet.

Figure 16: Viewing the ANOVA results in the child spreadsheet
Viewing the Sources of Variation
View the sources of variation across the whole genome by selecting View >
Sources of Variation from the Partek main menu while the child result spreadsheet
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is active (Figure 17). When prompted to select the plot type, select Bar Chart.

Figure 17: Viewing the Sources of Variation plot. Batch is the biggest source of
variation
This plot presents the signal vs. noise across all genes. All the factors in the
ANOVA model are listed on the Xaxis (random error). The Yaxis represents the
average mean square of all the genes. Mean square is ANOVA’s measure of
variance. Compare each signal bar to the error bar; if a bar is higher than the error
bar, it means that factor contributed significant variation to the data across all the
variables. Notice, that this plot is very consistent with the results in the PCA scatter
plot. In this data, on average, Batch is the biggest source of variation.
Note: To view the source of variation for each gene, rightclick on the row header,
and select Sources of Variation from the popup menu.
Visualizing the ANOVA Results of One Gene
The gene on the row, “trefoil factor 1” will be used to do the following exercises.
"

To get a detailed ANOVA result of a gene, rightclick on the row header
and select HTML Report from the popup menu (Figure 18)
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Figure 18: Viewing part of ANOVA HTML report
"

To get a dot plot of a specific gene, rightclick on the row header and
select Dot Plot (Orig. Data) from the popup menu (Figure 19)

Figure 19: Viewing the dot plot of the gene expressed differently in different
treatment groups.
In the plot, each dot is a sample of the original data. The YAxis represents the
expression of the gene from the original data spreadsheet and the XAxis represents
the 4 treatment groups.
Most of the replicates in each treatment are not separated from each other, e.g. the
two control samples are at time zero, showing very little reproducibility. This
actually is caused by a batch effect. Do the following configuration to see the batch
effect more clearly:
"
"
"

Select the Configure Plot button ( ) in the dot plot viewer
Change the plot to Group by Batch in the Configure Plot section
Select OK (Figure 20)
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Figure 20: Grouping the sample by Batch
"
"
"
"
"

Select the Plot Properties icon ( ) in the dot plot viewer and configure
the plot
On the Style page, Color the dots by Treatment (Figure 21)
Size the dots by Time
Connect the dots by Treatment Combination
On the Labels page, choose the Column radio button for In Point Label,
and select Time from the dropdown list to label the points (Figure 22)

Figure 21: Configuring the dot plot. Color the dots by Treatment, Size by Time, and
Connect by Treatment Combination
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Figure 22: Configuring the dot plot. Label by Time
Notice that by looking at the plot, you can see little reproducibility is largely due to
batch effect (Figure 23).

Figure 23: Viewing the dot plot that shows a batch effect. Each dot is a sample. The
Yaxis represents the expression value of the gene; the Xaxis represents different
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batches. The dots are Colored by Treatment, Sized by Time, Connected by
Treatment Combination, and Labeled by Time
When a twoway interaction is specified in the ANOVA model, you can visualize
the interaction by rightclicking on the row header and selecting ANOVA
Interaction Plot from the popup menu. By default, the graph plots the LS mean
intensity of the samples on the Yaxis and the different treatment groups on the X
axis. To make the interaction easier to interpret, change the configuration of the
graph to show the time points on the Xaxis by following these steps:
"
"
"
"

Select the Configure Plot button ( ) in the ANOVA Interaction Plot
viewer
Select Time from the XAxis dropdown list (Figure 24)
Select Treatment from Separate by dropdown list
Select OK

Figure 24: Configuring the interaction plot, choose XAxis to represent Time,
separate the samples by different treatments
"
"
"
"

Select the Plot Properties icon ( ) in the ANOVA Interaction Plot
viewer
Select the Style tab, and select lines from the Plot Style dropdown list
(Figure 25)
Select the Legend tab, and change the orientation of the Color legend to
Vertical by selecting the radio button (Figure 26)
Select OK
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Figure 25: Choosing the line style for the interaction plot

Figure 26: Changing the legend orientation
In the interaction plot (Figure 27), the Xaxis represents the time points, the Yaxis
represents gene expression, each line represents a treatment, and each dot represents
the mean gene expression in treatment at one time point.
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Figure 27: Viewing the interaction plot. Each point represents the least square
mean of a treatment at one time point. Points are colored by treatment and are also
connected by a line
Notice from the plot that E2, E2+ICI and E2+Ral down regulate the gene slightly at
48 hours as compared to 8 hours; however, E2+TOT upregulated quite a bit. Select
the
button to look at the treatment and time effect on the other genes.
Removing Batch Effects
By including Batch in the ANOVA model, the variability due to this technical
effect is measured and taken into account when calculating the pvalues for the
biological effects, so that in effect, the batch effect is removed. However, in order
to visualize what the data looks like with the technical batch effect removed, the
original intensity data must be changed to account for what the data would look like
if the batch effects are removed. The Remove Batch Effect tool operates much
like ANOVA in reverse calculating the variation attributed to the effect being
removed and then adjusting the original intensity values to remove the effect. Once
the effect is removed from the intensity values, tools such as PCA or clustering, can
be used to visualize what the data would look like if the technical effect was
removed. This allows the biological effects that were hidden in the technical effect
to become more pronounced and easier to identify.
Now, remove the batch effect using the same ANOVA model, and then revisualize
the data. Leave the ANOVA result spreadsheet open; you will come back to
compare the ANOVA result after you remove the batch effect.
Make sure the original (parent) spreadsheet is active by clicking on it (spreadsheet
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1).
"

Select Stat > Remove Batch Effect from the Partek main menu to invoke
the Remove Batch Effects dialog (Figure 28)

Figure 28: Configuring the batch remover dialog
The ANOVA model should include the following: Treatment, Time, Batch, and
Treatment * Time (as in Figure 12 and Figure 13). You do not need to configure
the contrasts.
"

Select Save Model (Figure 29)

The factors will be in the Candidate Effect(s) panel in the batch remover dialog.
"
"

Double click on 4. Batch to move it to the Remove Effect(s) panel. Use the
default setting to display the results in a new spreadsheet (Figure 29)
Select OK

Figure 29: Selecting the batch effect to remove
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The result is a new spreadsheet; the layout is the same as the parent spreadsheet, but
the gene expression values are changed.
"
"
"
"

Draw a PCA scatter plot on the remove result spreadsheet by clicking on
the Scatter Plot icon while the remove result spreadsheet is open
Select the Plot Properties icon within the scatter plot viewer to render the
data and examine the batch effect
On the Style page, change the Drawing Mode to Mixed and leave all the
other settings as the default settings (Figure 30)
Select Apply

Figure 30: Changing the drawing mode to mixed
"
"

On the Ellipsoids page, select the Add Centroid button, double click on
Batch to move it to Grouping Variable(s) panel from the Categorical
Variable(s) panel and leave everything else as the default settings
Select OK (Figure 31)
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Figure 31: Adding a centroid to A and B batches
Rotate the plot; notice the centroids of Batch A and Batch B are in the same
position (Figure 32).

Figure 32: Viewing the PCA scatter plot. It shows no batch effect, the centroid of
batch A and B is the same
After performing hierarchical clustering on the remove result spreadsheet, the data
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is no longer clustered by the two batches (Figure 33). This has been left for you to
do on your own; however, the configuration of the clustering is the same as that of
Figure 11.

Figure 33: Viewing the hierarchical clustering of the result spreadsheet. It shows
no batch effect, the samples are not clustered by different batches
Run the same 3way ANOVA as in Figure 12 and Figure 13 on the remove result
spreadsheet, and compare this result with the ANOVA result from the original
spreadsheet. All the pvalues of Batch are 1; all the pvalues of other factors and
interactions are perfectly kept intact. Draw a Sources of Variation plot to examine
this result (Figure 34).
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Figure 34: Viewing the sources of variation plot. It shows no batch effect, the
variation of the batches is 0
Next, examine that breast cancer gene. Rightclick on the row header in the
spreadsheet, select Dot Plot, and use the same configuration as in Figure 23 to
render the plot (Figure 35).
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Figure 35: Viewing the dot plot. It shows no batch effect. Each dot is a sample. The
Yaxis represents the expression value of the gene, Xaxis represent different
batches. The dots are colored by Treatment, Sized by Time, Connected by
Treatment Combination, and Labeled by Time.
Generating Gene Lists from a List Manager
Generate lists of genes with pvalues that passed FDR at 10% and treatment
regulated 2 fold. This is done by creating two criteria, one for the genes with p
values that pass FDR at 10% and a second criterion for the genes that are regulated
2 fold. Once these two criteria have been created, an intersection of the two criteria
will provide a list of genes that passed both criteria.
Create a list of genes that pass the above criteria for the pairwise comparison of E2
vs. Control by following these steps.
"

Select Create Gene List from the Analysis section of the Gene Expression
workflow
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"
"
"
"
"
"

Select the Specify New Criteria button
Type E2 FDR 10% in the Name field
Make sure the Spreadsheet is set to 1/1 (ANOVAResults)
From the Column pull down menu, select 9. Pvalue (E2*48 and E2 * 8
vs Control * 0)
Make sure that the Includes pvalues is set to significant with FDR of and
type in 0.1 in the box to the right of this pulldown menu. (Figure 36)
Select OK to close this criteria

Notice that the criteria for the E2 FDR of 10% are now listed in the List Creator.
Once the second criteria for fold change is created, both criteria will be used to find
the genes the match both criteria.

Figure 36: Creating a gene list criteria for E2 vs. Control with an FDR of 10%
Next, create criteria to specify the genes that regulate 2 fold for the E2 vs Control
by following these steps.
"
"
"
"
"
"

Select the Specify New Criteria button
Type E2 2 Fold in the Name field
Make sure the Spreadsheet is set to 1/1 (ANOVAResults)
From the Column pull down menu, select 11. FoldChange(E2*48 and
E2*8 vs. Control*0)
From the Configure criteria make sure that both the fold change boxes
have check marks in the and that the one criteria is set to less than 2 and
that the other criteria is set to greater than 2
Select OK to close this criteria

There are now two criteria in our List Creator dialog box. To find the intersection
of these two gene list criteria, select both the E2 FDR 10% and E2 2 Fold by using
the CTRL or SHIFT keys and leftclicking on the two criteria. Select the
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Intersection (And) button to generate a new criteria called E2 FDR 10% and E2 2
Fold which contains the 218 genes that pass both the FDR 10% criteria and the fold
change criteria of greater than 2 or less than 2.
Save the gene list with 218 genes E2 FDR 10% and E2 2 Fold by selecting the Save
List button and name the list E2. This saves a copy of the gene list to the computer
and adds the gene list to the spreadsheet tree in Partek.
Repeat the above steps to generate lists for E2+ICI, E2+Ral and E2+TOT vs.
control, respectively.
An alternative method for finding the intersection of multiple gene lists is to create
a Venn diagram and selecting the intersection, follow these steps to find the
intersection of the gene lists from the three treatments.
"

Use the CTRL key to select the three gene list criteria E2+ICI, E2+Ral,
and E2+TOT as shown in Figure 37

Figure 37: Selecting the E2+ICI, E2+Ral, and E2+TOT gene list criteria before
invoking the Venn diagram
"
"

Select Venn Diagram to see how the three gene list criteria overlap
Figure 38
Select on the intersection of the 3 circles in the Venn diagram and select
OK to create a new gene list criteria called Venn Diagram of E2+ICI and
E2+Ral and E2+TOT
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Figure 38: Viewing the Venn diagram of the three gene list criteria
In this example, a gene list of the 7 genes that were common between the three
treatments was created by finding the intersection. Any section of the Venn
diagram can be added to the gene list by leftclicking on the section of interest. An
asterisk appears in any section that has been selected and those pieces of the
diagram that have an asterisk will be included in the gene list criteria when OK is
selected. By default, the intersection of the Venn diagram will automatically be
selected as denoted by the asterisk.
Note: Any time the gene list creator box is closed all of the criteria will be lost that
have not been saved to the computer or Partek. In order to invoke a Venn diagram
on gene lists that have already been saved follow these steps.
"
"
"

Select Tools > List Manager after creating all the lists. The lists are
displayed in the Lists panel
Select E2+ICI, E2+Ral, and E2+TOT to enable the Venn Diagram
button
Invoke the Venn Diagram (Figure 37)
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Figure 37: Viewing the Venn diagram of the three gene lists: E2+ICI, E2+Ral and
E2+TOT
Select any section in the diagram and the number of the section will be highlighted
in black (Figure 37). You can get the list of the genes in the selected section by
selecting File > Create List from Selected in the Venn diagram menu (Figure 38).
Specify a name and select OK.

Figure 38: Creating a list from the Venn diagram. Specify the name of the list,
which includes the name of the gene that appears in all of the three lists, as
Common List
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If you select more than three lists (for example, all 4 lists generated by this data
set), select the Intersect button to get a list of genes that appear in each of those 4
lists. Selecting the Union button will generate a list of all the genes that appear in
the lists; however, each gene will appear only once even if it is found in both lists.
Biological Interpretation of the Gene Lists
Once a list of genes has been created, it is possible to see which functional groups
the genes fall into as well as how well represented these differentially expressed
genes are in the functional groups. To learn more about biological interpretation
and gene ontology in Partek, please read the GO Enrichment tutorial found on the
Tutorials webpage. A URL for this tutorial is provided below for convenience.
http://www.partek.com/Tutorials/microarray/GO_Enrichment/GO_Enrichment.pdf

End of Tutorial
This is the end of the Treatment and Time tutorial. If you need additional assistance
with this data set, you can call our technical support staff at +13148782329 or
email @partek. .

Copyright # 2009 by Partek Incorporated. All Rights Reserved. Reproduction of this material without express written
consent from Partek Incorporated is strictly prohibited.
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1. General Statistics Overview
(Source: http://geocities.com/h_murray_miller/stats.htm
Contents Courtesy of Julia Chevan, PT, Cert. MDT)

Statistics is not a magic act. At its core, is the effort to understand variation. In this
incomplete overview I’ll provide some definitions of basic statistics terminology and
attempt to provide a flow chart that helps you to understand the type of information
provided by some common statistical tests. I am by no means a mathematician, my goal
is for a conceptual understanding not mathematical […]

1.1 Levels of Measurement
There are four levels of measurement. These levels are a hierarchy with nominal at the
lower end and ratio at the top. As you move from higher to lower you lose information
and have less ability to mathematically and statistically manipulate the data.
1.1.1 Nominal
Qualitative data with no natural ordering; Characteristics or attributes may be
randomly coded numerically but the numbers really provide no information about
the variable. For instance you might have the categories male and female and
code them "1" and "2" respectively.
1.1.2 Ordinal
Qualitative data with an ordering. For instance if you were to measure ADL’s1
using a scoring system of 1=dependent, 2=max assist, 3=mod assist, 4=min
assist, 5=independent.
1.1.3 Interval
Quantitative data in which there is a clear ordering and the distance between
objects is specified but there is no meaningful zero point (absence of attribute).
For instance temperature measured in Fahrenheit.
1.1.4 Ratio
Quantitative data which have a rational and meaningful zero.

1.2 Measures of Central Tendency
1.2.1 Mode
numeric value that occurs most frequently.
1.2.2 Median
the point on the numeric scale above which and below which 505 of the cases
fall.
1.2.3 Mean
sum of scores divided by total number of scores, arithmetic average.

1

ADL = Activities of Daily Living [Note:The source web site is related the physical therapy]
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1.3 Measures of Variability
1.3.1 Range
highest score minus the lowest score.
1.3.2 Standard deviation
used with interval or ratio level data, summarizes the average amount of
deviation of all values of a distribution from the mean.
1.3.3 Variance
value of the standard deviation before a square root is taken. Variance is not
typically reported in research but is often used in inferential statistical tests.

1.4 Inferential Statistics: how to draw conclusions about a population from
a sample.
1.4.1 Null hypothesis
the statement that there is no true relationship between variables and any
observed relationship is due to chance alone.
1.4.2 Type I Error
Reject the null hypothesis when it is true. The probability of committing a Type I
error is the level of significance of a given statistical test.
1.4.3 Type II Error
Accept a null hypothesis when it is false.
1.4.4 Parametric vs. Nonparametric tests
Parametric tests require measurement on at least an interval scale and typically
have a number of other assumptions regarding the distribution of variables.
Nonparametric tests are applied to data collected on nominal or ordinal scales
and have relatively far fewer assumptions.

1.5 Tables and charts about the tests themselves:
What question do you want to answer?
Question
How well does one
variable predict another?

Analysis type
Regression analysis

What is the degree that two variables are related?
Question
Ratio/Interval data?
Ordinal data?

Analysis type
Pearson Product Moment Correlation
Spearman Rank Correlation

Is there a difference between/among group means?
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Question
Nominal data?
Ordinal data?
Ordinal data?
Ordinal data?
Ratio/interval data?
Ratio/interval data?

Analysis type
Chi square
Kruskal-Wallis One-way ANOVA by ranks (if
less than 2 groups/comparisons)
Wilcoxon Signed-Ranks test (more than 2
groups/comparisons, paired data)
Mann-Whitney U Test or Wilcoxon Rank Sum
test (more than 2 groups/comparisons,
unpaired data)
t-test (if only 2 groups/comparisons, may be
done paired or unpaired)
ANOVA (if more than 2 groups/comparisons)

1.6 Statistical tests commonly used
Test
t-test
ANOVA

Bonferroni test
Scheffe test
Tukey test
Dunnett test

Linear
Regression
Analysis
Pearson
Product
Moment
Correlation

Assumptions/Requirements
Ratio/interval data
Paired or unpaired data
2 groups to be compared
Ratio/interval data
Comparison among >3 group
means
Paired or unpaired data
Repeated measures possible
Following ANOVA
Within subjects, between
subjects or mixed design
Following ANOVA (post hoc)
Within or between subjects
design
Following ANOVA (post hoc)
Within or between subjects
design
Following ANOVA (post hoc)
Within or between subjects
design
Comparisons only to 1 group
mean
Ratio/interval data
Homogeneity of variance
Linearity
Ratio/interval data
Linear relationship
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What will it tell me?
Is there a difference
between group means?
Is there a difference
among group means?

Where did differences
occur among group
means?
Where did differences
occur among group
means?
Where did differences
occur among group
means?
Where did differences
occur among group
means?
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Spearman
Rank
Correlation
Chi Square

Ratio/interval/ordinal data
Linear relationship
Nominal/ordinal data

What is the degree of
relationship between two
variables?
Is the distribution of
observed frequencies
different from the
expected frequencies?

2. Logarithm properties
History: Logarithms were created / discovered by
Scottish mathematician John Napier to facilitate calculations
in astronomy, dynamics, physics, and astrology.
His 37 pages work Mirifici Logarithmorum Canonis
Descriptio, containing 90 pages of tables, was published in
1614 (a translation into English by Edward Wright was
published in 1616).
(see http://en.wikipedia.org/wiki/John_Napier)

2.1 What are logarithms? Modern definition:
The base b logarithm of x, logbx, is the power to which b needs to be raised in order to
obtain x. This can be written as:

logbx = y

means that

(Logarithmic form)

by = x.

(Exponential form)

Note: logbx is only defined if b and x are both positive, and b ≠ 1.
Three algebraic properties of Logs:
Property 1: logb 1 = 0 since b0 = 1 (by definition.)
Property 2: logb b = 1 since b1 = b
Property 3: logb bx = x since bx = bx
(they are indeed equal)

2.2 Base of log
The two best known logarithms are in base 10 and base e (e = 2.718…).
log10x is called the common logarithm of x, and is sometimes written as log 10.
logex is called the natural logarithm of x and is sometimes written as ln x.
For micro-array data, logarithm transformation is almost always in base 2.
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Note: Log base 2 or “binary logarithm” is often used in computer science and information theory (where it
is frequently written lg x, or ld x, from Latin logarithmus dualis.)

Logarithms to various bases: middle
(red) is to base e, bottom (green) is to
base 10, and top (purple) is to base
1.7. Logarithms of all bases pass
through the point (1, 0), because any
number raised to the power 0 is 1, and
through the points (b, 1) for base b,
because any number raised to the
power 1 is itself.
http://en.wikipedia.org/wiki/Logarithms

2.3 Computations with logs
Logarithms switch the focus from normal numbers to exponents. As long as the same
base is used, this makes certain operations easier. If one takes the following notation
log(a) = A and log(b) = B, the formulas below can be easier to remember:
Operation with numbers Operation with exponents

(just remember that
= 1 / b)
(source http://en.wikipedia.org/wiki/Logarithm)

2.4 Logs and microarrays

Page - 302 -

Logarithmic identity

R and Bioconductor – Appendix – A –
Logarithms transform array intensity
values into more bell-shaped
distributions similar enough to the
Normal, Gaussian shape to apply
statistics.
This illustration shows the raw
intensity and log2 intensity of the
estrogen arrays (no normalization
step).
The shape of the Log intensity
curves is more dome-shaped and
spread, albeit not a perfect bell.
Microarray data are often summarized as log base 2 values, and it is important to know
and understand that fact when looking at result tables.
When comparing experiment and control, the log of the ratio of average intensity is
calculated. The intensity can be from green and red channels on spotted arrays or from
2 groups of chips in the case of Affymetrix data.
The most useful formula is: log(a/b) = log(a) – log(b)
This is also called the “log ratio” as it is the logarithm of the ratio of a over b.
Using logs has two major advantages:
a) log ratios are symmetrical around 0 but simple ratio are not symmetrical around
1. Example:
Average of 1/10 + 10 is about 5
Average of log(1/10) and log(10) is 0
b) log transformation makes the distribution of measured values symmetrical and
almost normal. (The Normal or Gaussian distribution is perhaps the most known
and important distribution in statistics.)
Understanding some basic calculations:
Typically data are summarized as fold-change. Example:
Gene Name Fold Change t statistic raw p-value
1451867_x_at -13.36

-131.892

BH-value

D3_1

D3_2

D3_3

Z10_1

Z10_2

Z10_3

2.79596e-07 0.00485722 8.88946 8.91168 8.86056 5.12841 5.19505 5.11774

Average =
8.887
Difference of average =
Fold Change = 2 3.74 =
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as reported in the Fold Change column to 2 decimals. It is reported as -13.36 simply
because of the way the compared to D, Z is downregulated. One can make the
calculation thus as well:
Average =
8.887
5.147
Difference of average =
-3.74
Fold Change = 2 -3.74 = 0.07483377 = 1 / 13.36295
In conclusion, the Z series is down-regulated 13 times, and the minus sign reflects the
down-regulation.

3. t statistic
The t statistic is used to determine whether two means are statistically different. In other
words, if we observe 2 means, can we say that their difference is meaningful.
The formula uses the means of the two samples, their standard deviation and sample
size. The t value is then evaluated against your significance level (alpha) to determine if
your null hypothesis can be rejected or not.

t statistic

(see http://en.wikipedia.org/wiki/T_statistic)

In probability and statistics, the t-distribution or Student's t-distribution is a
probability distribution that arises in the problem of estimating the mean of a normally
distributed population when the sample size is small. […] Student's distribution arises
when (as in nearly all practical statistical work) the population standard deviation is
unknown and has to be estimated from the data.
Suppose X1, ..., Xn are independent random variables that are normally distributed with
expected value µ and variance σ2. Let
be the sample mean,
2
2
and Sn be the sample variance (note: σ is the population variance)

It is readily shown that the quantity
is normally distributed (i.e. Normal or
Gaussian distribution) with mean 0 and variance 1, since the sample mean
is
normally distributed with mean µ and standard deviation
(Central Limit Theorem.)
A related quantity
is calculated in a similar manner but the population
standard deviation σ is substituted by the sample standard deviation Sn. The distribution
of T is now called the t-distribution and has zero mean and a standard deviation that
depends on the degrees of freedom (d.f.) of the data. Degrees of freedom is a
function of the number of independent measurements minus the number of parameters
estimated as intermediate steps. In the t-test we are estimating one parameter, the
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population standard deviation. Thus, df = n – 1 as reflected in the formula of Sn2
above.

t statistic calculations (http://en.wikipedia.org/wiki/Student's_t-test)
3.1 Independent t-test and equal sample sizes

This equation is only used when the two sample sizes (that is, the n or number of
participants of each group) are equal.

Where s is the grand standard deviation (or pooled sample standard deviation), 1 = group
one, 2 = group two. The denominator is the standard error of the difference between two
means.

3.2 Unequal sample sizes
This equation is only used when the two sample sizes are unequal. It is assumed that the
two distributions have the same variance. The t statistic to test whether the means are
different can be calculated as follows:

Where s2 is the unbiased estimator of the variance, n = number of participants, 1 = group
one, 2 = group two. n − 1 is the number of degrees of freedom for either group, and the
total sample size minus 2 is the total number of degrees of freedom.
The statistical significance level associated with the t value calculated in this way is the
probability that, under the null hypothesis of equal means, the absolute value of t could be
that large or larger just by chance—in other words, it's a two-tailed test, testing whether
the means are different where either one or the other might be the larger one if they are
different (see Press et al, 1999, p. 616).
Press, William H.; Saul A. Teukolsky, William T. Vetterling, Brian P. Flannery (1992).
Numerical Recipes in C: The Art of Scientific Computing. Cambridge University Press, p.
616. ISBN 0-521-43108-5.
See web reference for formulas for dependent t-test and alternative tests if the variance
cannot be assumed equal as is necessary for the t-test.
In our example we have 3 samples in each group D and Z, therefore we can apply the
formula above. We can calculate it in separate steps:
First calculate the average of each group:
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Average for group D = 8.88723
Average for group Z = 5.14706
Difference of average = 3.74016
Then we calculate s X1-X2, the estimated sample “grand standard deviation” with equal
sample size (here our sample size is 3), defined above as the square root of the sum of
the sample variance divided by the common sample size.
First we calculate sX1 for the D group (formula seen above
.)
sX1 = square of sum differences of each measure to average of sample group divided
by the degrees of freedom 3 – 1 = 2.
2

s 2X1=

2

2

(8.88946 - 8.88723) + (8.91168 - 8.88723) + (8.86056 - 8.88723)
----------------------------------------------------------------------------------------- = 0.000657032
(3 – 1)

In the same way we can calculate sX2 for the Z group:
2

s2X2 =

2

2

(5.12841 - 5.14706) + (5.19505 - 5.14706) + (5.11774 - 5.14706)
---------------------------------------------------------------------------------------- = 0.001755262
(3 – 1)

Thus
(Note that here the formula calls for n and not n – 1.)
Therefore t = X1 – X2 / sx1-x2 = 3.74016 / 0.028356625 = 131.8974543
The minus sign in the reported results simply means that the difference of average was
calculated as 5.14706 - 8.88723 = - 3.74016
Note: these calculations can be done with a spreadsheet. In Excel the calculations can
be done with the following formulas: AVERAGE, VAR, SQRT and SUM.

If the spreadsheet covers cells A2 to F2,the formulas can be written as
Average of D group =AVERAGE(A2:C2)
Average of Z group =AVERAGE(D2:F2)
Difference of averages =SUM(B6-E6)
Calculated sample variance for group D =VAR(A2:C2)
Calculated sample variance for group Z = =VAR(D2:F2)
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Estimated grand standard deviation =SQRT(SUM(B8+E8)/3)
t-statistic = Difference of averages divided by estimated grand standard deviation. If
results are in columns I6 and I10 respectively, this is equal to =I6/I10

4. raw p-value
What are p-values ? (exerpts from http://en.wikipedia.org/wiki/P-value)
In statistical hypothesis testing, the p-value is the probability of obtaining a result at
least as extreme as a given data point, assuming the data point was the result of
chance alone. The fact that p-values are based on this assumption is crucial to their
correct interpretation.
More technically, the p-value of an observed value tobserved of some random variable T
used as a test statistic is the probability that, given that the null hypothesis is true, T will
assume a value as or more unfavorable to the null hypothesis as the observed value
tobserved.
Generally, one rejects the null hypothesis if the p-value is smaller than or equal to the
significance level, often represented by the Greek letter α (alpha). If the null hypothesis
is rejected this would be described as being "statistically significant at the 5 % level".
Frequent misunderstandings:
1.
2.
3.
4.

The p-value is not the probability that the null hypothesis is true
The p-value is not the probability that a finding is "merely a fluke"
The p-value is not the probability of falsely rejecting the null hypothesis.
The p-value is not the probability that a replicating experiment would not
yield the same conclusion.
5. 1 − (p-value) is not the probability of the alternative hypothesis being true
(see (1)).
6. The significance level of the test is not determined by the p-value.
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The p-value is a
probability based on
the distribution that is
best suited to describe
the sample such as
the t distribution used
here. The t distribution
tends to the Normal
(Gaussian) distribution
for larger sample size
n. This is because
when n gets larger the
degrees of freedom
(often n-1) become
very large.
The (empirical) raw p-value of the observed test statistic is calculated based on the tdistribution or the distribution used by the selected method. It is called “raw” because
it has not been adjusted to multiple testing.
In multiple testing error rates increase with the number of hypotheses (each gene is a
test with a corresponding null hypothesis) and therefore has to be controlled by
adjusting the raw p-value of the observed test statistic of each individual hypothesis and
obtaining a corresponding adjusted p-value (see below: correction for multiple testing.)
EzArray uses the program R as the back-engine for its calculations. The p-values and tstatistics would be calculated as thus for the D and Z values that we used above:
# Assign D values to vector x:
x <- c(8.88946,8.91168,8.86056)
# Assign Z values to vector y:
y <- c(5.12841,5.19505,5.11774)
# perform t-test according to the mulltest in R package:
t.test(x, y, "two.sided", paired = FALSE,
var.equal = FALSE, conf.level = 0.95)
The results would be printed as:
Welch Two Sample t-test
data: x and y
t = 131.8975, df = 3.313, p-value = 2.795e-07

alternative hypothesis: true difference in means is not equal to
0

95 percent confidence interval:
3.654563 3.825770
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sample estimates:
mean of x mean of y
8.887233 5.147067
If equal variance could be assumed for groups D and Z the degrees of freedom would
be df = 3 + 3 – 2 = 4
However, we cannot infer equal and the Welch2 modified two-sample t-test is performed
instead of the regular t-test. The calculation of the degrees of freedom is therefore a bit
more complicated.
Welch Modified Two-Sample t-Test3:
In this case statistic is t <- (mean(x) - mean(y) - mu) / s2 with s2 <- sqrt( var(x)/nx +
var(y)/ny ), nx <- length(x), ny <- length(y). If x and y come from normal populations, the
distribution of t under the null hypothesis can be approximated by a t-distribution with
(non-integral) degrees of freedom 1 / ( (c^2)/(nx-1) + ((1-c)^2)/(ny-1) ) where c <- var(x)
/ (nx * s2^2).
Calculating degrees of freedom with this formula gives df = 3.313273963 and is
approximated 3.313 in the R output above.

5. Benjamini & Hochberg
This is the adjusted value for testing the null hypothesis based on Benjamini,Y. and
Hochberg,Y. (1995)4.
This number will therefore be compensated for multiple testing (comparing m
hypothesis simultaneously.) The 2 main categories are familywise error rate (FWER)
and False discovery rate (FDR.)
The question (null hypothesis) is essentially always the same: e.g. is the mean
observed for the treated sample different than the mean of the controls ?
FWER and FDR (see http://en.wikipedia.org/wiki/Familywise_error_rate
and http://en.wikipedia.org/wiki/False_discovery_rate)
In statistics, familywise error rate (FWER) is the probability of making one or more false
discoveries, or type I errors among all the hypotheses when performing multiple
pairwise tests.
2

Welch B. L. (1938), The Significance of the Difference Between Two Means when the Population
Variances are Unequal Biometrika, 29( 3/4), 350-362
3

http://www.uni-muenster.de/ZIV/Mitarbeiter/BennoSueselbeck/shtml/helpfiles/t.test.html
4

Benjamini,Y. and Hochberg,Y. (1995) Controlling the false discovery rate: a practical and powerful
approach to multiple testing. J. Roy. Stat. Soc. B., 57, 289–300
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False discovery rate (FDR) control is a statistical method used in multiple hypothesis
testing to correct for multiple comparisons. It controls the expected proportion of
incorrectly rejected null hypotheses (type I errors) in a list of rejected hypotheses. It is a
less conservative comparison procedure with greater power than familywise error rate
(FWER) control, at a cost of increasing the likelihood of obtaining type I errors.
The q value is defined to be the FDR analogue of the p-value. The q-value of an
individual hypothesis test is the minimum FDR at which the test may be called
significant. One approach is to directly estimating q-values rather than fixing a level at
which to control the FDR.
The following table defines some random variables related to the m hypothesis tests.

•
•
•
•
•
•
•
•

# declared nonsignificant

# declared
significant

Total

# true null
hypotheses

U

V

m0

# non-true null
hypotheses

T

S

m − m0

Total

m−R

R

m

m0 is the number of true null hypotheses
m − m0 is the number of false null hypotheses
U is the number of true negatives
V is the number of false positives
T is the number of false negatives
S is the number of true positives
H1...Hm the null hypotheses being tested
In m hypothesis tests of which m0 are true null hypotheses, R is an observable
random variable, and S, T, U, and V are unobservable random variables.

The m specific hypotheses of interest are assumed to be known, but the number of true
null hypotheses m0 and of alternative hypotheses m1, are unknown. V is the number of
Type I errors (hypotheses declared significant when they are actually from the null
distribution). T is the number of Type II errors (hypotheses declared not significant when
they are actually from the alternative distribution).
In terms of random variables,

or equivalently,

The false discovery rate is an expected value given by
one wants to keep this value below a threshold α.
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Step-up and step-down procedures (Finner H. and Roters M. (1998) Asymtotic
comparison of step-down and step-up multiple test procedures based on exchangeable
test statistics. The Annals of Statistics. 26(2), 505–524.
“The step-down procedure starts with the most significant p-value by comparing it
with the smallest α-value and down the ordered list [see e.g. the Holm example above.]
[…] In contrast to the step-down method the inherent characteristic of the step-up
method is to start by comparing the least significant p-value with the largest α-value and
so on.”

6. Corrections for multiple testing
(This section inspired by “Data Analysis Tools for DNA Microarrays” by Sorin Draghici)5
The significance level α can be defined as the acceptable probability of a Type I error
(rejecting the null hypothesis when in fact it is true. The genes are declared differentially
regulated but in fact they are not. These are false positives.)
One way to test the null hypothesis is to calculate the t statistic. For each gene, if the t
statistic is more extreme than a threshold tα the null hypothesis will be rejected and the
gene called differentially expressed. However, it is possible that this may be so just by
random effects and we will have made a wrong decision (Type I error). If we do not
make a mistake, we will draw the correct conclusion for this gene with probability
Prob(correct) = 1 – p.
If we have R genes (e.g. 10,000) and want to draw the correct conclusion for all genes
we need to multiply the probability to be correct for each gene AND the next AND the
next etc. Therefore the probability to be globally correct and draw the correct conclusion
from all experiments is:
Prob(all correct) = (1 – p) . (1 – p) . . . (1 – p) = (1 – p) R
Knowing this, we can calculate the probability of being wrong somewhere:
Prob(wrong somewhere) = 1 – Prob(all correct) = 1 – (1 – p) R
Being wrong here means making a mistake for at least one gene, and this is in fact the
value of α for the whole experiment.
For large number this probability of something being “wrong somewhere” (having at
least one Type I error) quickly approaches 1: for an array of 10,000 genes at 0.01
significance this would be: 1 – (1 – p) R = 1 – (1 – 0.01) 10,000 = 0.9910,000
= 1 - 2.248775 . 10-44 = 0.9999999999999999999……99997751225 ≈ 1.
5

Data Analysis Tools for DNA Microarrays. Sorin Draghici. Publisher: Chapman & Hall
/CRC Press. ISBN: 1584883154. e.g quick link at http://tinyurl.com/y4v2wa
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6.1 Šidàk correction
The probability of making a Type I error is equal to the probability of making at least one
such mistake as we just saw: Prob(wrong somewhere) = 1 – (1 – p) R
This formula can be rewritten as αe = 1 – (1 – αc) R where the probability of making a
Type I error is αe at the experiment level (multiple comparison) and αc at the gene level
(single comparison.) We can calculate the level for each individual gene (αc) in order to
keep the global experiment Type I error level less or equal to αe. This can be done with
the derived formula, also known as the Šidàk correction:
______
αc = R√ 1– αe

6.2 Bonferroni correction
In the case of small number we can write the following approximation:
αe = 1 – (1 – αc) R = 1 – (1 – R.αc +….) ≈ R.αc
From this approximation we can calculate an experimental level αc
αe = R . αc . R => αc = αe / R
This formula is simple and only an approximation. Unfortunately neither Šidàk nor
Bonferroni corrections are suitable for gene expression analysis because of the
extremely large number of genes R.

6.3 Holm’s step‐wise correction
Less conservative adjustments of the p-values can be made with methods that rank the
p-values for all the R genes and make successive (step-wise) small adjustments. Each
gene is measured in 2 groups (e.g. treated and control.) By definition the null
hypothesis is that there is no difference in the mean of the 2 groups. For each gene we
will calculate a test statistic (e.g. a t test) to generate a p value for this gene. The p
value is the probability that the test statistic have the observed value just by chance
(when the null hypothesis is true.)
The steps are as follows:
1. choose the experiment significance level αe.
2. Order the genes in increasing order of p-values (smaller value are at the top.)
Gene p-value
g1
p1
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g2
g3
…
gk
…
gR

p2
p3
…
pk
…
pR

3. Compare the p-values of each gene depending on its position in the ordered list
with the following formula: compare p1 with αe / R (note that for for this first gene
this is the Bonferrroni correction hence this procedure is sometimes referred to
as the Holm-Bonferroni correction.) Then compare p2 with αe /(R-1), then for p3
compare with αe / (R-2) then for gene k along the list, compare with αe / (R-k+1).
Finally for the last gene, compare with αe / (R – R +1) = αe / 1 = αe
Gene
g1
g2
g3
…
gk
gk+1
…
gR

p-value
p1
p2
p3
…
pk
pk+1
…
pR

Test
p1 < αe / R
p2 < αe / R –1
p3 < αe / R – 2

Test result
TRUE
TRUE
TRUE

pk < αe / R – k +1
pk+1 < αe / R – k

TRUE
FALSE

pR < αe

FALSE

At some point along the way the test will not be true. Let’s call this point k along the list,
where it is the last time that pk < αe /(R – k +1) is in fact true. We will reject the null
hypothesis for all genes from 1 to k and mark these genes as different between the
2 groups at the chosen significance level αe. For the remaining genes down the list,
from k+1 to R, we will accept the null hypothesis and declare these genes not
significantly different at the chosen significance level αe.

6.4 The false discovery rate (FDR) correction
The statistical procedures discussed above assume that the variables are independent.
On the other hand we know that many genes depend on other genes in sometimes
complex cascades of events. While we cannot take into account all the specific
dependencies, the original FDR idea was further extended to allow for some
dependency6. In the list of choices during the multiple testing procedure it appears as
“Benjamini & Yekutieli step-up FDR.”
The FDR procedure is very similar to the Holm procedure and genes are ordered as per
their p-value. The only difference is the test used to determine if the null hypothesis is
accepted or rejected. In the Holm procedure, αe was divided by a denominator that was
larger and larger (from R down to 1) along the p-value-ordered gene list. Here the

6

Benjamini,Y. and Yekutieli,D. (2001) The control of the false discovery rate under
dependency. Ann Stat., 29:1165–1188.
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denominator remains R all along, but αe is multiplied by the value of k (the number of
the gene in the list.) Thus the procedure would be as follows:
1. choose the experiment significance level αe (as in Holm)
2. Order the genes in increasing order of p-values (smaller value are at the top, as
in Holm.)
3. Compare p1 with αe / R, compare p2 with 2.αe / R, p3 with 3.αe / R, pk with k.αe /
R, and finally pR with R.αe / R=αe
Gene
g1
g2
g3
…
gk
gk+1
…
gR

p-value
p1
p2
p3
…
pk
pk+1
…
pR

Test
p1 < αe / R
p2 < 2 . αe / R
p3 < 3 . αe / R

Test result
TRUE
TRUE
TRUE

pk < k . αe / R
pk < (k+1)αe / R

TRUE
FALSE

pR < αe

FALSE

In a similar way as we did for Holm, we will reject the null hypothesis for which the
test is TRUE (genes ordered as 1 to k) and accept the null hypothesis of no difference
for gene numbered k+1 to R in the ordered list

6.5 Westfall and Young permutation correction
Westfall and Young7 permutation correction is a step-down procedure similar to Holm,
with many steps of bootstrapping (random resampling.) This method will be useful for
genes that are tightly correlated (for example in the same biochemical pathway) but it is
very computationally intensive because of the large number of permutations.
Briefly the method works as follows:
1. calculate p-values based on the original dataset, and rank them in order of
ascending values (smallest values are at the top of the list.)
2. by permutation create sets of pseudo-data: e.g. randomly assign the “control”
and “treated” labels to create artificial groups. This can be done thousands or
tens of thousands of times
3. compute the p-value for all genes using the Holm step down procedure. Repeat
this computation for each new pseudo group.

7

Westfall P.H., Young S.S. (1993) Resampling-based Multiple Testing. Wiley, New
York.
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4. The adjusted p-value for a gene will be the proportion of times the value of the
test statistic for the real labels (T) is less or equal to the value of the test statistic
calculated for a random permutation (Tp):
number of permutation where T ≤Tp
adjusted p-value = ------------------------------------------------total number of permutations

7. Multiple Comparison exercise within Excel
Multiple comparison is an issue for microarray data because we want to look at a lot of
genes at the same time, and some of the observations might lead to false positive data.
Typical statistics for one gene could use a confidence level α=0.05 and in some more
stringent case even 0.01. The confidence level is compared to the p-value calculated for
the gene based on the experiment.
If we want to look at 10,000 genes at the same time and ignore the multiple comparison
issue, we need to look at 10,000 p-values, and let’s assume that each will be 0.05. The
implication is that there could be up to 5% false positives within a set of 10,000 and
that means that we could have 500 false positive just by chance!
The following exercise is based on an exercise in chapter 9 of the book “Data Analysis
Tools for DNA Microarrays” by Sorin Draghici (quick online link:
http://tinyurl.com/y4v2wa).
The exercise consists on the following: we will generate a set of 20 columns each
containing 10,000 random numbers. Then we will separate them as 2 groups of 10, that
could be e.g. normal and cancerous cells, and perform a paired Student t-test on the 2
groups.

7.1

Open Microsoft Excel

This exercise will make use of Microsoft Excel for simplicity. (Note: OpenOffice
http://www.openoffice.org/ or NeoOffice www.neooffice.org could be used instead)

7.2

Create 20 x 10,000 random numbers

Within the first raw and first column (cell A1) write the
following formula to generate a random number (case
insensitive): RAND()and press return. A random
number with 8 decimal digits will appear.
Click again within that cell until you see the outline
(blue on Mac, black on PC) and a small handle at the
bottom right of the cell. Grab the handle (the cursor
will change to a square) and fill the first row until the
letter T and not further.
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Now grab the handle again and fill all the way to row
10,000.
Thus you should have columns A through T and all
the way to 10,000 filled with numbers, and that should
be highlighted so that you can copy those numbers.
Now copy these numbers with the menu Edit > Copy (or
place the numbers within the clipboard.

, CTRL C on a PC) to

Create a new worksheet with the menu File > New Workbook (
Use the Edit > Paste Special… and choose the
“values” option to paste the numbers within the new
workbook.

, CRTL N on PC).

Note: if the content of the cells is not pasted as
values only, the numbers will change at every step
because we will paste the random formula instead of
the actual numbers!

7.3

These “gene” expression values are the dataset

Now consider the first 10 columns as “cancer data” and the remaining 10 columns as
“control data.” We will now use the t-test to calculate a p-value for every gene in a
separate column and sort the whole block of data by the p-values. The top ~500 “genes”
should have p-values lower than 0.05.
Place the cursor within the first cell of the V column (cell
V1) and write the following formula starting with the equal
sign:
=TTEST(A1:J1,K1:T1,2,2) and press return.
A1:J1 is array 1 (cancer) and K1:T1 is array2 (control).
The third parameter (here 2) indicates that the data
has equal variance (the technical statistics term is
homoscedstic) and the fourth parameter (here 2 also)
indicates that we are conducting a 2-tail test since we
have no a priori knowledge that the “genes” would be
preferentially either up- or down-regulated (if that were
the case we would choose a one-tail test). For the 2tailed test this means that the 0.05 value gets split at
both ends of the distribution curves as 0.025 each as
illustrated here.

2-tailed => 0.025 on each side

Click on the V1 cell and grab the side handle to fill the column to 10,000 as we did for
the other columns. This will calculate the p-value for each row.
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With menu short-cut
(Ctrl –A on PC) select all the
data within the workbook.
With menu Data > Sort… bring the sorting window and
choose to sort by column V in Ascending order (smaller
values will be on top). Press OK

7.4

Results

You should find that approximately 500 of the “genes” have a p-value less than 0.05.
Here are the result of the run that was created while writing this exercise. The cut-off
was at row 513:

From chapter 9 of book cited above: “An even more convincing example can be made
with one’s own real data. If you have data involving two groups of sample, merely
change the labels of the sample or, equivalently, move them randomly from one group
to another. A subsequence t-test will always provide approximately 5% “regulated”
genes for any labelling and hopefully many more when the real labels are used.”

8. END
-------------------------

---------------------------
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Notes
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1. General introduction on microarrays:
WIKI. DNA microarray:
http://en.wikipedia.org/wiki/DNA_microarray
NIH: An (Opinionated) Guide to Microarray Data Analysis
http://discover.nci.nih.gov/microarrayAnalysis/Microarray.Home.jsp
Free PDF book (Finland): "DNA Microarray Data Analysis, second edition”
http://www.csc.fi/csc/julkaisut/oppaat/1999‐2008/arraybook_overview

2. Commercial microarray types:
Brand
Affymetrix
Roche Nimblegen
Spotted Arrays

Link
http://www.affymetrix.com/
http://www.nimblegen.com/
-

Processed at GEC*
Yes
Yes
Yes**

Brand
Link
Processed at GEC*
Agilent
http://www.home.agilent.com/
No
Combimatrix
http://www.combimatrix.com/
No
Illumina
http://www.illumina.com/
No
Applied Microarrays http://www.appliedmicroarrays.com/
No
*GEC: Gene Expression Center, University of Wisconsin-Madison
http://www.biotech.wisc.edu/ServicesResearch/Gec/
**In house methods

3. Suggested reading on Statistical methods:
3.1 Statistical methods comparisons
Ian B Jeffery, Desmond G Higgins, Aedín C Culhane (2006), "Comparison and
evaluation of methods for generating differentially expressed gene lists from
microarray data", BMC Bioinformatics, 7:359.
http://www.biomedcentral.com/1471‐2105/7/359
Abstract excerpt: “Firstly we found little agreement in gene lists produced by the
different methods. Only 8 to 21% of genes were in common across all 10 feature
selection methods. Secondly, we evaluated the class prediction efficiency of each gene
list in training and test cross-validation using four supervised classifiers.”
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3.2 Affymetrix reading
GeneChip® Expression Analysis - Data Analysis Fundamentals
http://www.affymetrix.com/support/downloads/manuals/data_analysis_fundamentals_manual.pdf

(Chapter 6: Statistical Analysis)
Sample Pooling for Microarray Analysis: A Statistical Assessment of Risks and Biases
http://www.affymetrix.com/support/technical/technotes/pooling_technote.pdf

4. Gene Expression Analysis
http://www.broad.mit.edu/cancer/software/genepattern/desc/expression.html
There are four broad categories of gene expression analysis:

4.1 Differential Analysis/Marker Selection
Differential analysis, also known as marker selection, is the search for genes that are
differentially expressed in distinct phenotypes using either e.g. the signal-to-noise ratio
or the t-test statistic.

4.2 Class Prediction (Supervised Learning)
Supervised learning, also known as class prediction, is the search for a gene
expression signature that predicts class (phenotype) membership. The basic
methodology for class prediction is to start with two data sets, a training set and test set;
use your training data set to build a classifier (class predictor) based on your chosen
classification method; and use your test data set to test the classifier.

4.3 Class Discovery (Unsupervised Learning)
Unsupervised learning, also known as class discovery, is the search for a biologically
relevant unknown taxonomy identified by a gene expression signature or a biologically
relevant set of co-expressed genes.
The basic methodology for class discovery is clustering: the data is clustered based on
a chosen clustering method and then the clusters is validated through gene annotations,
enrichment analysis (are the clusters enriched by genes from functionally important
categories, pathways, or processes), or by replicating the results in other data sets.

4.4 Pathway Analysis
Pathway analysis is the search for sets of genes differentially expressed in distinct
phenotypes. Gene Set Enrichment Analysis (GSEA) determines whether an a priori
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defined set of genes shows statistically significant, concordant differences between two
biological states (e.g. phenotypes).

5. Imaging software
Most are proprietary, for reference only.
Name
Imagene
GenePix Pro
Nimblescan
Spotfinder

Notes
http://www.biodiscovery.com/index/imagene
http://www.moleculardevices.com/pages/software/gn_genepix_pro.html

http://www.nimblegen.com/products/software/
http://www.tm4.org/spotfinder.html

6. Analysis software
6.1 Commercial
Name
ArrayStar®

Partek® Genomics
SuiteTM

Name
GenSpring GX
(Agilent)
GenePix Pro
GCOS
(GeneChip®
Operating
Software
Affymetrix)
MatLab
(MathWorks)

Notes
ArrayStar v2.1: useful for gene expression runs. Reads
data files from Affymetrix, Illumina and Roche NimbleGen.
Imports.txt files for spotted array runs and data from other
sources.
15 days free trial download
http://www.dnastar.com/products/arraystar.php
Partek® Genomics SuiteTM (Partek GS) is a
comprehensive suite of advanced statistics and interactive
data visualization specifically designed to reliably extract
biological signals from noisy data.
http://www.partek.com/partekgs
Notes
15 days free trial download
http://www.chem.agilent.com/en‐US/Products/software/
lifesciencesinformatics/genespringgx/
http://www.moleculardevices.com/pages/software/gn_genep
ix_pro.html
http://www.affymetrix.com/products_services/software/spec
ific/gcos.affx

http://www.mathworks.com/
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GeneSifter
(Geospiza)

Web-based expression Analysis software with statistical and
visual tools.
http://www.geospiza.com/
Webinars that allow hands on practice with public data:
http://www.geospiza.com/Support/training.shtml

6.2 Public or open source
Affymetrix Tools (free; free registration required):
Expression Software freely provided by Afftymetrix for extracting data from .CEL and
Console
.DAT files with various background correction, normalization and
summarization methods.
http://www.affymetrix.com/products_services/software/specific/
expression_console_software.affx
NetAffx
Enables researchers to correlate their Affymetrix GeneChip array results
with array design and annotation information.
http://www.affymetrix.com/analysis/index.affx
Microarray Software Suite ‐ http://www.tm4.org/
MADAM:
The Microarray Data Manager, implemented in Java, facilitates the
MicroArray DAta
entry of data into a relational database.
Manager
http://www.tm4.org/madam.html
Spotfinder
TIGR Spotfinder reads paired 16-bit or 8-bit TIFF image files
generated by most microarray scanners for the the quantification
of gene expression.
http://www.tm4.org/spotfinder.html
MIDAS:
MIDAS is a normalization tool to help compensate for variability
Microarray Data
between slides and fluorescent dyes, as well as other systematic
Analysis System
sources of error. Data filtering: remove poor or questionable data..
http://www.tm4.org/midas.html
MeV:
Normalized and filtered expression files can be analyzed using
MultiExperiment
TIGR Multiexperiment Viewer (MeV). MeV is a versatile microarray
Viewer
data analysis tool, incorporating sophisticated algorithms for
clustering, visualization, classification, statistical analysis and
biological theme discovery. MeV can handle several input file
formats. These include the “.mev” and “.tav” files generated by
TIGR Spotfinder and TIGR MIDAS, and also Affymetrix® (“.txt”)
and Genepix® (“.gpr”) files.
http://www.tm4.org/mev.html
We have assembled a guide for normalizing Affymetrix® .CEL
files, which covers RMAExpress, BioConductor, and AMP.
http://www.tm4.org/normalizing.html
AMP: Automated
Web-based application that allows the normalization of microarray data.
Microarray
AMP Users can upload data in the form of Affymetrix CEL files, and
Pipeline
define an analysis pipeline by selecting several intuitive options on the
following pages. AMP will performs data normalization (e.g. RMA),
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basic statistical analysis (e.g. t-test, ANOVA), and analysis of annotation
using gene classification (e.g. Gene Ontology term assignment). The
analyses are performed without user intervention and the results are
presented in a web-based summary that allows data to be downloaded in
a variety of formats compatible with further directed analysis.
http://www.tm4.org/amp.html
Publicly Available Software Tools
(Source: http://corelabs.cgrb.oregonstate.edu/affymetrix/analysis/publicsoftware )
SAM
SAM reports local false discovery rates and miss rates. It also handles
time course data, does non-parametric tests and pattern discovery.
http://www‐stat.stanford.edu/~tibs/SAM/
Bioconductor An open source and open development software project for the
analysis and comprehension of genomic data
http://www.bioconductor.org
dChip
DNA-Chip Analyzer (dChip) is a software package for probe-level and
high-level analysis of Affymetrix gene expression microarrays and SNP
microarrays. Reference: Li and Wong paper in PNAS, Jan 2, 2001 Vol
98 No. 1 31-36
http://www.biostat.harvard.edu/complab/dchip/
RMA express
A program to compute gene expression summary values for Affymetrix
GeneChip® data using the Robust Multichip Average expression
summary. RMA consists of three steps: a background adjustment,
quantile normalization, and finally summarization.
http://rmaexpress.bmbolstad.com/
BRBBRB ArrayTools is an integrated package for the visualization and
ArrayTools
statistical analysis of DNA microarray gene expression data. Developed
at the National Cancer Institute
http://linus.nci.nih.gov/BRB‐ArrayTools.html
Additional Tools
GenePattern Download or use Web-based version.
http://www.broad.mit.edu/cancer/software/genepattern/
Description (https://cabig.nci.nih.gov/tools/GenePattern)
Intended Audiences: Biomedical researchers. Areas of focus include:
Microarray Analysis, SNP Analysis, Proteomics.
Area of Focus: Data Analysis and Statistical Tools
Local Tools (Madison Campus)
EZarray
Web-based. Works with R/Bioconductor in the background
Two servers, one accessible only from Campus
http://genic.biotech.wisc.edu/ezarray/

7. Gene Ontologies and Pathways

http://corelabs.cgrb.oregonstate.edu/affymetrix/analysis/ontology
Page - 325 -

R and Bioconductor – Appendix – B –
There are tools to look at Gene Ontology and potential pathways to which your genes of interest
may belong.
Tools for Gene Ontologies and Pathways
Gene
The Gene Expression Omnibus is a high-throughput gene expression /
Expression molecular abundance data repository, as well as a curated, online
Omnibus
resource for gene expression data browsing, query and retrieval.
http://www.ncbi.nlm.nih.gov/geo/
Gene
The Gene Ontology project provides a controlled vocabulary to describe
Ontologies gene and gene product attributes in any organism.
http://www.geneontology.org/
Affymetrix
Affymetrix has it gene ontology software embedded within its NetAffx
Gene
online analysis center.
Ontology
http://www.affymetrix.com/analysis/index.affx
Mining Tool GO Manual:
http://www.affymetrix.com/support/technical/manual/go_manual.affx
ErmineJ
A free software for gene expression analysis in the context of functional
categories (e.g., Gene Ontology). ErmineJ performs analyses of "gene
sets" in expression microarray data. A typical goal is to determine
whether particular biological pathways are" doing something interesting"
in the data. The software is designed to be used by biologists with little or
no informatics background.
http://www.bioinformatics.ubc.ca/ermineJ/
BRBThis approach is included for gene sets based on Gene Ontology
ArrayTools categories, BioCarta Pathways, Kegg Pathways and for user-specified
gene sets. The power of the method is based on two factors. First, since
the number of gene sets is usually much less than the number of
individual genes, the penalty for multiple comparisons is much less. This
applies regardless of the method used to control for multiple
comparisons, be it controlling the false discovery rate or more traditional
methods. The second factor is that a gene set can be identified as
significant if many of the component genes are differentially expressed,
but none individually at a sufficiently strong level to pass the stringent
threshold necessitated by the multiple comparison penalty. In analysis of
data I have found several instances where individual gene analysis
resulted in very few differentially expressed genes, but analysis of gene
sets identified highly significant GO categories and signalling pathways
that were biologically important.
http://linus.nci.nih.gov/BRB‐ArrayTools.html
Pathguide
Website resource with information of about 220 biological pathways.
http://www.pathguide.org
KEGG
KEGG: Kyoto Encyclopedia of Genes and Genomes.
PATHWAY http://www.genome.jp/kegg/
Database
KEGG PATHWAY is a collection of manually drawn pathway maps
representing our knowledge on the molecular interaction and reaction
networks for: 1. Metabolism 2. Genetic Information Processing
3. Environmental Information Processing 4. Cellular Processes
5. Human Diseases 6. Drug Development (structure relationships. KEGG
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GenMAPP

drug structure maps)
http://www.genome.jp/kegg/pathway.html
A free computer application designed to visualize gene expression and
other genomic data on maps representing biological pathways and
groupings of genes.
http://www.genmapp.org/

8. Gene lists manipulations.
Gene Lists
DAVID

Venn
Diagrams

DAVID 2008 Functional Annotation Bioinformatics Microarray
Analysis
Functional Annotation
Gene-annotation enrichment analysis, functional annotation
clustering , BioCarta & KEGG pathway mapping, gene-disease
association, homologue match, ID translation, literature match and
more
Gene Functional Classification
Provide a rapid means to reduce large lists of genes into
functionally related groups of genes to help unravel the biological
content captured by high throughput technologies. More
Gene ID Conversion
Convert list of gene ID/accessions to others of your choice with the
most comprehensive gene ID mapping repository. The ambiguous
accessions in the list can also be determined semi-automatically.
More
Gene Name Batch Viewer
Display gene names for a given gene list; Search functionally
related genes within your list or not in your list; Deep links to
enriched detailed information:
http://david.abcc.ncifcrf.gov/
Creation of Venn diagram from 2 or 3 lists of genes. Program
genevenn

example of venn diagram for 3 lists
http://www.bioinformatics.org/gvenn/
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Note: Venn diagrams can also be created within R. For example the
limma package has command vennDiagram().

9. Data Repositories for microarray data.

http://corelabs.cgrb.oregonstate.edu/affymetrix/analysis/repository
Repositories
NCBI's GEO

ArrayExpress

Stanford
Microarray
Database
The Gene
Expression
Database
(GXD)
Yale
Microarray
Database

A high-throughput gene expression / molecular abundance data
repository, as well as a curated, online resource for gene expression
data browsing, query and retrieval.
http://www.ncbi.nlm.nih.gov/geo/
ArrayExpress is a public repository for microarray data, which is
aimed at storing well annotated data in accordance with MGED
recommendations. Run by European Bioinformatics Institute.
http://www.ebi.ac.uk/arrayexpress/
Stores raw and normalized data from microarray experiments, as well
as their corresponding image files. In addition, SMD provides
interfaces for data retrieval, analysis and visualization.
http://genome‐www5.stanford.edu/
A community resource for gene expression information from the
laboratory mouse. GXD stores and integrates different types of
expression data and makes these data freely available in formats
appropriate for comprehensive analysis.
http://www.informatics.jax.org/mgihome/GXD/aboutGXD.shtml
The Yale Microarray Database Project is a collaborative effort
between several laboratories and centers to archive microarray
images and provide statistical tools through a web interface.
http://info.med.yale.edu/microarray/

-------------------------

---------------------------
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